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Develop your applications quickly and easily with the
world's mostintuitive mikroC for 8051 Microcontrollers.

Highly sophisticated IDE provides the power you need with
the simplicity of a Windows based point-and-click
environment.

With useful implemented tools, many practical code
examples, broad set of built-in routines, and a
comprehensive Help, mikroC for 8051 makes a fast and
reliable tool, which can satisfy needs of experienced
engineers and beginners alike.
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DISCLAIMER:

mikroC for 8051 and this manual are owned by mikroElektronika and are protected by copyright law
and international copyright treaty. Therefore, you should treat this manual like any other copyrighted
material (e.g., a book). The manual and the compiler may not be copied, partially or as a whole with-
out the written consent from the mikroEelktronika. The PDF-edition of the manual can be printed for
private or local use, but not for distribution. Modifying the manual or the compiler is strictly prohibit-
ed.

HIGH RISK ACTIVITIES:

The mikroC for 8051 compiler is not fault-tolerant and is not designed, manufactured or intended for
use or resale as on-line control equipment in hazardous environments requiring fail-safe performance,
such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic
control, direct life support machines, or weapons systems, in which the failure of the Software could
lead directly to death, personal injury, or severe physical or environmental damage ("High Risk
Activities"). mikroElektronika and its suppliers specifically disclaim any express or implied warranty
of fitness for High Risk Activities.

LICENSE AGREEMENT:

By using the mikroC for 8051compiler, you agree to the terms of this agreement. Only one person
may use licensed version of mikroC for 8051 compiler at a time.

Copyright © mikroElektronika 2003 - 2008.

This manual covers mikroC version 1.0.0.0 and the related topics. Newer versions may contain
changes without prior notice.

COMPILER BUG REPORTS:
The compiler has been carefully tested and debugged. It is, however, not possible to
guarantee a 100 % error free product. If you would like to report a bug, please contact us at the
address office@mikroe.com. Please include next information in your bug report:
- Your operating system
- Version of mikroC for 8051
- Code sample
- Description of a bug

CONTACT US:
mikroElektronika

Voice:  + 381 11 36 28 830
Fax: +381 11 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com

Windows is a Registered trademark of Microsoft Corp. All other trade and/or services marks are the
property of the respective owners.
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CHAPTER _

Introduction to
mikroC 8051

The mikroC 8051 is a powerful, feature-rich development tool 8051 microcon-
trollers. It is designed to provide the programmer with the easiest possible solution
to developing applications for embedded systems, without compromising perform-

ance or control.
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1.1. mikroC IDE
Features
mikroC for 8051 allows you to quickly develop and deploy complex applications:

- Write your C source code using the built-in Code Editor (Code and
Parameter Assistants, Code Folding, Syntax Highlighting, Auto
Correct, Code Templates, and more.)

- Use included mikroC libraries to dramatically speed up the
development: data acquisition, memory, displays, conversions,
communication etc.

- Monitor your program structure, variables, and functions in the
Code Explorer.

- Generate commented, human-readable assembly, and standard
HEX compatible with all programmers.
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- Inspect program flow and debug executable logic with the integrated Software
Simulator.

- Get detailed reports and graphs: RAM and ROM map, code statistics, assembly
listing, calling tree, and more.

- mikroC 8051 provides plenty of examples to expand, develop, and use as
building bricks in your projects. Copy them entirely if you deem fit — that’s why
we included them with the compiler.

Where to Start

- In case that you’re a beginner in programming 8051 microcon
trollers, read carefully the 8051 Specifics chapter. It might give you
some useful pointers on 8051 constraints, code portability, and good
programming practices.

- If you are experienced in C programming, you will probably want to
consult mikroC Specifics first. For language issues, you can always
refer to the comprehensive Language Reference. A complete list of
included libraries is available at mikroC Libraries.

- If you are not very experienced in C programming, don’t panic!
mikroC 8051 provides plenty of examples making it easy for you to
go quickly. We suggest that you first consult Projects and Source
Files, and then start browsing the examples that you're the most
interested in.
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MIKROELEKTRONIKA ASSOCIATES LICENSE STATEMENT AND
LIMITED WARRANTY

IMPORTANT - READ CAREFULLY

This license statement and limited warranty constitute a legal agreement (“License
Agreement”) between you (either as an individual or a single entity) and
mikroElektronika (“mikroElektronika Associates”) for software product
(“Software”) identified above, including any software, media, and accompanying
on-line or printed documentation.

BY INSTALLING, COPYING, OR OTHERWISE USING SOFTWARE, YOU
AGREE TO BE BOUND BY ALL TERMS AND CONDITIONS OF THE
LICENSE AGREEMENT.

Upon your acceptance of the terms and conditions of the License Agreement,
mikroElektronika Associates grants you the right to use Software in a way provided
below.

This Software is owned by mikroElektronika Associates and is protected by copy-
right law and international copyright treaty. Therefore, you must treat this Software
like any other copyright material (e.g., a book).

You may transfer Software and documentation on a permanent basis provided. You
retain no copies and the recipient agrees to the terms of the License Agreement.
Except as provided in the License Agreement, you may not transfer, rent, lease, lend,
copy, modify, translate, sublicense, time-share or electronically transmit or receive
Software, media or documentation. You acknowledge that Software in the source
code form remains a confidential trade secret of mikroElektronika Associates and
therefore you agree not to modify Software or attempt to reverse engineer, decom-
pile, or disassemble it, except and only to the extent that such activity is expressly
permitted by applicable law notwithstanding this limitation.
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If you have purchased an upgrade version of Software, it constitutes a single prod-
uct with the mikroElektronika Associates software that you upgraded. You may use
the upgrade version of Software only in accordance with the License Agreement.

LIMITED WARRANTY

Respectfully excepting the Redistributables, which are provided “as is”, without
warranty of any kind, mikroElektronika Associates warrants that Software, once
updated and properly used, will perform substantially in accordance with the accom-
panying documentation, and Software media will be free from defects in materials
and workmanship, for a period of ninety (90) days from the date of receipt. Any
implied warranties on Software are limited to ninety (90) days.

mikroElektronika Associates’ and its suppliers’ entire liability and your exclusive
remedy shall be, at mikroElektronika Associates’ option, either (a) return of the
price paid, or (b) repair or replacement of Software that does not meet
mikroElektronika Associates’ Limited Warranty and which is returned to
mikroElektronika Associates with a copy of your receipt. DO NOT RETURN ANY
PRODUCT UNTIL YOU HAVE CALLED MIKROELEKTRONIKA ASSOCI-
ATES FIRST AND OBTAINED A RETURN AUTHORIZATION NUMBER. This
Limited Warranty is void if failure of Software has resulted from an accident, abuse,
or misapplication. Any replacement of Software will be warranted for the rest of the
original warranty period or thirty (30) days, whichever is longer.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW,
MIKROELEKTRONIKA ASSOCIATES AND ITS SUPPLIERS DISCLAIM ALL
OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESSED OR
IMPLIED, INCLUDED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE,
AND NON-INFRINGEMENT, WITH REGARD TO SOFTWARE, AND THE
PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES.

IN NO EVENT SHALL MIKROELEKTRONIKA ASSOCIATES OR ITS SUPPLI-
ERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSE-
QUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITA-
TION, DAMAGES FOR LOSS OF BUSINESS PROFITS AND BUSINESS
INFORMATION, BUSINESS INTERRUPTION, OR ANY OTHER PECUNIARY
LOSS) ARISING
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OUT OF THE USE OF OR INABILITY TO USE SOFTWARE PRODUCT OR
THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES,
EVEN IF MIKROELEKTRONIKA ASSOCIATES HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, MIKROELEK-
TRONIKA ASSOCIATES’ ENTIRE LIABILITY UNDER ANY PROVISION OF
THIS LICENSE AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTU-
ALLY PAID BY YOU FOR SOFTWARE PRODUCT PROVIDED, HOWEVER, IF
YOU HAVE ENTERED INTO A MIKROELEKTRONIKA ASSOCIATES SUP-
PORT SERVICES AGREEMENT, MIKROELEKTRONIKA ASSOCIATES’
ENTIRE LIABILITY REGARDING SUPPORT SERVICES SHALL BE GOV-
ERNED BY THE TERMS OF THAT AGREEMENT.

HIGH RISK ACTIVITIES

Software is not fault-tolerant and is not designed, manufactured or intended for use
or resale as on-line control equipment in hazardous environments requiring fail-safe
performance, such as in the operation of nuclear facilities, aircraft navigation or
communication systems, air traffic control, direct life support machines, or weapons
systems, in which the failure of Software could lead directly to death, personal
injury, or severe physical or environmental damage (“High Risk Activities”).
mikroElektronika Associates and its suppliers specifically disclaim any expressed or
implied warranty of fitness for High Risk Activities.

GENERAL PROVISIONS

This statement may only be modified in writing signed by you and an authorised
officer of mikroElektronika Associates. If any provision of this statement is found
void or unenforceable, the remainder will remain valid and enforceable according to
its terms. If any remedy provided is determined to have failed for its essential pur-
pose, all limitations of liability and exclusions of damages set forth in the Limited
Warranty shall remain in effect.

This statement gives you specific legal rights; you may have others, which vary,
from country to country. mikroElektronika Associates reserves all rights not specif-
ically granted in this statement
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mikroElektronika
Visegradska 1A,
11000 Belgrade,
Europe.

Phone: + 381 11 36 28 830
Fax: +381 11 36 28 831
Web: www.mikroe.com
E-mail: office@mikroe.com

TECHNICAL SUPPORT

In case you encounter any problem, you are welcome to our support forums at
www.mikroe.com/forum/. Here, you may also find helpful information, hardware
tips, and practical code snippets. Your comments and suggestions on future devel-
opment of the mikroC for 8051 are always appreciated — feel free to drop a note or
two on our Wishlist.

In our Knowledge Base www.mikroe.com/en/kb/ you can find the answers to
Frequently Asked Questions and solutions to known problems. If you can not find
the solution to your problem in Knowledge Base then report it to Support Desk
www.mikroe.com/en/support/. In this way, we can record and track down bugs more
efficiently, which is in our mutual interest. We respond to every bug report and ques-
tion in a suitable manner, ever improving our technical support.
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HOW TO REGISTER

The latest version of the mikroC for 8051 is always available for downloading from
our website. It is a fully functional software libraries, examples, and comprehensive
help included.

The only limitation of the free version is that it cannot generate hex output over 2
KB. Although it might sound restrictive, this margin allows you to develop practi-
cal, working applications with no thinking of demo limit. If you intend to develop
really complex projects in the mikroC for 8051, then you should consider the possi-
bility of purchasing the license key.

Who Gets the License Key

Buyers of the mikroC for 8051 are entitled to the license key. After you have com-
pleted the payment procedure, you have an option of registering your mikroC. In
this way you can generate hex output without any limitations.

How to Get License Key

After you have completed the payment procedure, start the program. Select Help »
How to Register from the drop-down menu or click the How To Register Icon
Fill out the registration form (figure below), select your distributor, and click the

Send button.
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[€]How To Register

Step 1. Fill in the form below. Please, make sure you fill in all required fields.

Step 2. Make sure that you provided a valid email address in the "EMAIL" edit box. This email will be used for
sending you the activation key.

Step 3. Make sure you select a correct distributor which will make the registration process faster, If your
distributor is not on the list then select "Other” and type in distributor's email address in the box below.

Step 4. Press the SEND button to send key request. A default email client will open with ready-to-send message.
Mote: If ernail client does not open, you may copy text of the message and paste it manually into a new email
message before sendinag it to your distributor's email.

l NAME™ |Marko Jovanovic

I' ADDRESS ;]Er.tr:r your address

] Enter invoice number if available

“:;W*_‘ﬂ marko@nmikroe.com

From the list

have made the payment and I wish to request activation key for mikroC for 8051

Name:
Marko Jovanovic

Address:

oduct key:
4F5A-5B6266-34775F-68509

istributor:
Select your distributor
from the list

B Copy to SEND Cancel
; dipboard
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This will start your e-mail client with message ready for sending. Review the infor-
mation you have entered, and add the comment if you deem it necessary. Please, do
not modify the subject line.

Upon receiving and verifying your request, we will send the license key to the e-
mail address you specified in the form.

After Receving the License Key

The license key comes as a small autoextracting file — just start it anywhere on your
computer in order to activate your copy of compiler and remove the demo limit. You
do not need to restart your computer or install any additional components. Also,
there is no need to run the mikroC for 8051 at the time of activation.

Notes:

- The license key is valid until you format your hard disk. In case you need to
format the hard disk, you should request a new activation key.

- Please keep the activation program in a safe place. Every time you upgrade the
compiler you should start this program again in order to reactivate the license.
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Environment

The mikroC for 8051 is an user-friendly and intuitive environment:
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IDE OVERVIEW

Globals
TypeDef
Tags
Includes

E::_h-p.mﬂm Delay_us (corst ursigned long Time_in_us)
B [bust in] Function e (vobd)
i} unsigned Clock_KHz

.

Massage Text
& fies Compled in 31 me

Project Unked Successhully

LUnked in 78 ms

Projact LedBhriing. mepeof complated: 312 ms-
Finished successhaly: 19 mar 2008, 13:09:32

- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Auto Correct for common typos and Code
Templates (Auto Complete).

- The Code Explorer (with Keyboard shortcut browser and Quick Help browser) is
at your disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings
window

- Library manager enables simple handling libraries being used in a project

- The Error Window displays all errors detected during compiling and linking.
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-The source-level Software Simulator lets you debug executable logic
step-by-step by watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create a project.

- Help files are syntax and context sensitive.

- Like in any modern Windows application, you may customize the layout of
mikroC for 8051 to suit your needs best.

- Spell checker underlines identifiers which are unknown to the project. In this
way it helps the programmer to spot potential problems early, much before the
project is compiled.

- Spell checker can be disabled by choosing the option in the Preferences dialog
(F12).

MAIN MENU OPTIONS

Available Main Menu options are:

- File

- Edit

- View

- Project
- Run

- Tools

- Help

Related topics: Keyboard shortcuts
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FILE MENU OPTIONS

The File menu is the main entry point for manipulation with the source files.

|1 MewUnit  Cheln
* Open Chrl+0
Recent Files »
H zave ChH+5
Fi‘ Save As
L Close Chrl+F4
‘o Print..  Ctrl+P
B Exit Alt+
File Description
[ MewUnit  Crl+h Open a new editor window.
> Open source file for editing or image file for
[ Cpen Chrl+0 ewing.
Recent Files b Reopen recently used file.
H save ChS Save changes for active editor.
Save the active source file with the different name
i savess.. or change the file type.
W Close Alb+F4 Close active source file.
& Print. .. Chrl+P Print Preview.
& Exit Al Exit IDE.

Related topics: Keyboard shortcuts, File Toolbar,
Managing Source Files

14 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroC for 8051 Environment

EDIT MENU OPTIONS

<2 Undo Chrl+Z
o Redo Shift+Ctr+Z
gl Cut Chrl+
e, Copy ChrlHC
| Paste Chrl+Y
2 Delete
Select Al ChrlA,
' Find... Ctrl+F
<l Find Next F3
“J Find Previous  Shift+F3
)ﬂ Replace. .. Chrl4R
|0 FindInFies...  Al+F3
+  @otoLine... Ctrl+i
Advanced r
Edit Description
&y Undo cirl+z | | Undo last change.
£ Redo shift+ciri+z | | Redo last change.
oo Cut ctrl+x | | Cut selected text to clipboard.
22 Copy ctri+c | | Copy selected text to clipboard.
T Paste crley | | Paste text from clipboard.
< Delete Delete selected text.
Select Al crrieg, | | Select all text in active editor.
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2 Find... cirieF | | Find text in active editor.
2 Find Hext - Flpd next occurence of text in active
editor.
: : . Find previous occurence of text in active editor.
‘}:‘ Find Previous  Shift+F3
/2 Replace. .. rhi+r | | Replace text in active editor.
Find text in current file, in all opened files, or in
] FindInFies...  AE+F3 . ’ ’
F sl files from desired folder.
+ ' Gotoline.. -G | Goto to the desired line in active editor.
Advanced s | | Advanced Code Editor options

Advanced »

Description

Comment selected code or put single line com-

{..}  Comment Shift+Ckrl+, . . .
ment if there is no selection.
Uncomment selected code or remove single line
.0 Uncomment  ShiftCerl4, comment if there is no
selection.
5= Indent shift+ckr+1 | | Indent selected code.
2% Qutdent shift+ciri+u | | Outdent selected code.
Changes selected text case to lowercase.
A3 Lowercase Chrl+Alk+L
Changes selected text case to uppercase.
a8l Uppercase Crl+Al+U
: Changes selected text case to titlercase.
@ Titlecase Chrl+AE+T
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Find Text

Dialog box for searching the document for the specified text. The search is per-
formed in the direction specified. If the string is not found a message is displayed.

Find Text

Search far:

E E E B E

Replace Text

Dialog box for searching for a text string in file and replacing it with another text
string.

@ Replace Text

Search for: |mikru:uEIektru:unika

Beplace with: |mikn:|E

E EEE S

e
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Find In Files

Dialog box for searching for a text string in current file, all opened files, or in files
on a disk.

The string to search for is specified in the Text to find field. If Search in directories
option is selected, The files to search are specified in the Files mask and Path fields.

Grep search

Text to find: milkroElektronila

Cptions
| Case sensitive

Go To Line

Dialog box that allows the user to specify the line number at which the cursor should
be positioned.

Go To Line

Go TuLlnENuher
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Regular expressions

By checking this box, you will be able to advance your search, through Regular
expressions.

Search for: |

=

H E

Related topics: Keyboard shortcuts, Edit Toolbar, Advanced Edit Toolbar
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mikroC for 8051

VIEW MENU OPTIONS

Toolbars r

Cebug Windows r

Routines Lisk

o

Project Settings
T Code Explorer
Projeck Manager  Chrl+F11
Library Manager
Bookmarks

Messages

Marro Editaor

7 Windows

View

Description

Toolbars r

Show/Hide toolbars.

Debug Windows

Show/Hide debug windows.

E Routines List

Show/Hide Routine List in active editor.

Project Settings

Show/Hide Project Settings window.

'EE Code Explorer

Show/Hide Code Explorer window.

Project Manager Shift+Ctrl+F11

Show/Hide Project Manager window.

Library Manager Show/Hide Library Manager window.
Bookmatks Show/Hide Bookmarks window.
Messages Show/Hide Error Messages window.

Marro Editar

Show/Hide Macro Editor window.

Windows

Show Window List window.
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TOOLBARS

File Toolbar
(e H e

File Toolbar is a standard toolbar with following options:

Icon Description

B Opens a new editor window.

. | Open source file for editing or image file for viewing.

[H | Save changes for active window.

B Save changes in all opened windows.

i Close current editor.

428 Close all editors.

-5l
& Print Preview.

i

Edit Toolbar

@ IER

Edit Toolbar is a standard toolbar with following options:

Icon Description

£y Undo last change.

P Redo last change.
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b Cut selected text to clipboard.

By Copy selected text to clipboard.

Paste text from clipboard.

Y

Advanced Edit Toolbar

Lt B an 2

i
1

L

Advanced Edit Toolbar comes with following options:

Icon Description

Comment selected code or put single line comment if there is no selec-
tion

o

Uncomment selected code or remove single line comment if there is no
selection.

o1

Pl Select text from starting delimiter to ending delimiter.

e Go to ending delimiter.

,,_'] Go to line.

Indent selected code lines.

E_—
S | Outdent selected code lines.
- Generate HTML code suitable for publishing current source code on

the web.
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Find/Replace Toolbar
P BT

Find/Replace Toolbar is a standard toolbar with following options:

Icon

Description

2

Find text in current editor.

b

Find next occurence.

a3

Find previous occurence.

2

Replace text.

5

Find text in files

Project Toolbar

B B R | e | B

Project Toolbar comes with following options:

Icon

Description

la,

Open new project wizard. wizard.

Open Project

Save Project

Add existing project to project group.

G
&
|
o
—

Remove existing project from project group.
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w3 Add File To Project
o Remove File From Project
% Close current project.
Build Toolbar
| NN e

Build Toolbar comes with following options:

Icon Description
o Build current project.
_"q:'*'... Build all opened projects.
_{ﬁ. Build and program active project.
_&; Start programmer and load current HEX file.
@| | Open assembly code in editor.
M | View statistics for current project.

Debugger

J TS S T S g o

Debugger Toolbar comes with following options:
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Icon Description

@} Start Software Simulator.

=4 Run/Pause debugger.

Eh Stop debugger.

= | Step into.
@ Step over.
L Step out.

o Run to cursor.

&) Toggle breakpoint.

= Toggle breakpoints.

(@ Clear breakpoints.

e View watch window

: View stopwatch window

Styles Toolbar

Office 2003 Blue ~

]
Qffice 2003 Olive

Office =P

Chocolate

Arctic

Silverfox I
Soft zand il

Styles toolbar allows you to easily customize your workspace.
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Tools Toolbar

= 4 F

Tools Toolbar comes with following default options:

Icon Description

= Run USART Terminal

~| | EEPROM

| ASCII Chart

E) Seven segment decoder tool

The Tools toolbar can easily be customized by adding new tools in Options(F12)
window.

Related topics: Keyboard shortcuts, Integrated Tools, Debugger Windows

26 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroC for 8051 Environment

PROJECT MENU OPTIONS

0 Buid Chrl+F32

2 Build Al Projects Shift+F9

}\!} Build + Program Chrl+F11
Edit Search Paths. ..

|| Clean Project Folder. ..

% addFile To Project...
¥

Remowe File From Project

Mew Project, .. Shift+Ckel+M

=% OpenProject...  Shift+Chrl4+0

I;_:’E} Open Project Group,..
E_IE Close Project Group

Eﬂ Save Project As...

Recent Projects 3

E"_E Close Project
Project Description

*. Buid ctr+Fa || Build active project.
2 Buildal shift+Fa || Build all projects.
e Build +Program ctrl+F11 || Build and program active project.
@ View Assembly View Assembly.

Edit Search Paths. .. Edit search paths.
/=) Clean Project Folder. .. Clean Project Folder
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L7 add File Ta Project... Add file to project.
(T Remove File From Project Remove file from project.
5 Mew Froject... Open New Project Wizard
5% OpenProject...  shift+Ctrl+0 | Open existing project.
5 Save Project Save current project.
% Open Project Group... Open project group.
5 Close Project Group Close project group.
B9 save Projoct . Save active project file with the different
= name.
Recent Prajects ¢ || Open recently used project.
8 Close Project Close active project.

Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project
Manager, Project Settings
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RUN MENU OPTIONS

E‘E} Start Debugger Fa
Eﬁtﬂ Stop Debugger Cirl+F2
?{, Pause Debugger F&
&0 Step Into F7
@iy Step Quer Fa
(g8 Step Qut Ctrl+F3
@ Jump To Interrupt F2Z
@ Toggle Breakpaint F5
i=)| Breakpoints Shift+F4
lElY Clear Breakpoints  Shift+Ctrl+F5
gt Watch Window shift+F5
{f—j View Stopwatch

Disassembly mode Alt+D

Run Description
=h  Start Debugger Fa || Start Software Simulator.
= Stop Debugger Chl+Fz || Stop debugger.
E‘” Fause Debugger F& | Pause Debugger.
20 Step Into F7 || Step Into.
“,  Step Over Fa || Step Over.
(8 Step Out ctrl+Fs || Step Out.
M Jump To Interrupt £2 | Jump to interrupt in current project.
E  Toggle Breakpoint Fs || Toggle Breakpoint.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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i=| showjHide Breakpoints  shift+F4 || Breakpoints.

©, Clear Breakpoints  shift+Ctrl+Fs || Clear Breakpoints.

Wakch WWindow shift+rFs || Show/Hide Watch Window

&
(5 Wiew Stopwatch Show/Hide Stopwatch Window

Toggle between C source and
disassembly.

Disassembly mode Chrl+D

Related topics: Keyboard shortcuts, Debug Toolbar

TOOLS MENU OPTIONS

mE Programmer F11

)

USART Terminal Ctrl+T
EEPR.CM Editor
Asdii Chart

Seven Segment Convertor

3y -

Expart Code To HTML
LCD Custom Character

GLCD Bitmap Editor

£

LUDP Terminal

Al Options F12
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Tools Description
&% PicFlash Programmer  F11 | | Run mikroElektronika Programmer
B USART Terminal ChrlT Run USART Terminal
] EEPROM Editor Run EEPROM Editor
A Ascii Chart Run ASCII Chart
|F__| Sewen Segment Canvertar Run 7 Segment Display Decoder

Generate HTML code suitable for publishing

E t Code To HTML
L0 Export CodeTo source code on the web.
Generate your own custom LCD
LD Cusktom Character
characters
@ GLCD Bitmap Editar Generate bitmap pictures for GLCD
LDP Terminal UDP communication terminal.
= Options Fiz | | Open Options window

HELP MENU OPTIONS

Related topics: Keyboard shortcuts, Tools Toolbar

&) Help

Fl

Check For Updates
mikroElektronika Suppaort Forums
mikroElektronika Web Page

How To Reqisker

Abouk
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Help Description

& Help F1 | Open Help File.

Quick Help.

Check if new compiler version is available.
Check For Updates

Open mikroElektronika Support Forums in

mikroElekironika Support Forums a default browser.

Open mikroElektronika Web Page in a

mikroElektronika Web Page default browser.
How To Register Information on how to register
About Open About window.

Related topics: Keyboard shortcuts

KEYBOARD SHORTCUTS

Below is a complete list of keyboard shortcuts available in mikroC for 8051 IDE.
You can also view keyboard shortcuts in the Code Explorer window, tab Keyboard.

IDE Shortcuts
F1 Help
Ctrl+N New Unit
Ctrl+O Open
Ctrl+Shift+O Open Project
Ctrl+Shift+N Open New Project
Ctrl+K Close Project
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Ctrl+F9 Compile
Shift+F9 Compile All
Ctrl+F11 Compile and Program
Shift+F4 View breakpoints
Ctrl+Shift+F5 Clear breakpoints
F11 Start 8051Flash Programmer
F12 Preferences
Basic Editor Shortcuts
F3 Find, Find Next
Shift+F3 Find Previous
Alt+F3 Grep Search, Find in Files
Ctrl+A Select All
Ctrl+C Copy
Ctrl+F Find
Ctrl+R Replace
Ctrl+P Print
Ctrl+S Save unit
Ctrl+Shift+S Save All
Ctrl+V Paste
Ctrl+X Cut
Ctrl+Y Delete entire line
Ctrl+Z Undo
Ctrl+Shift+Z Redo

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Advanced Editor Shortcuts

Ctrl+Space Code Assistant
Ctrl+Shift+Space Parameters Assistant
Ctrl+D Find declaration
Ctrl+E Incremental Search
Ctrl+L Routine List
Ctrl+G Goto line
Ctrl+J Insert Code Template
Ctrl+Shift+. Comment Code
Ctrl+Shift+, Uncomment Code
Ctrl+number Goto bookmark
Ctrl+Shift+number Set bookmark
Ctrl-+Shift+I Indent selection
Ctrl+Shift+U Unindent selection
TAB Indent selection
Shift+TAB Unindent selection
Alt+Select Select columns
Ctrl+Alt+Select Select columns
Ctrl+Alt+L Convert selection to lowercase
Ctrl+Alt+U Convert selection to uppercase
Ctrl+Alt+T Convert to Titlecase
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Software Simulator Shortcuts
F2 Jump To Interrupt
F4 Run to Cursor
F5 Toggle Breakpoint
Fo6 Run/Pause Debugger
F7 Step into
F8 Step over
F9 Debug
Ctrl+F2 Reset
Ctrl+F5 Add to Watch List
Ctrl+F8 Step out
Alt+D Dissasembly view
Shift+F5 Open Watch Window
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IDE OVERVIEW

The mikroC for 8051 is an user-friendly and intuitive environment:

Globals
TypeDef
Tags
Includes

[::hmm Delay_us (corst unskgned long Time_in_us) 10 orary Managee
i avei frens) 28 =l
(ot o] & [ eutton
| nde @[] can_sl

.

Message Text

Projact LedBhriing. mepeof complated: 312 ms-
Finished successhaly: 19 mar 2008, 13:09:32

- The Code Editor features adjustable Syntax Highlighting, Code Folding, Code
Assistant, Parameters Assistant, Auto Correct for common typos and Code
Templates (Auto Complete).

- The Code Explorer (with Keyboard shortcut browser and Quick
Help browser) is at your disposal for easier project management.

- The Project Manager alows multiple project management

- General project settings can be made in the Project Settings window

- Library manager enables simple handling libraries being used in a project

- The Error Window displays all errors detected during compiling and linking.
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- The source-level Software Simulator lets you debug executable
logic step-by-step by watching the program flow.

- The New Project Wizard is a fast, reliable, and easy way to create
a project.

- Help files are syntax and context sensitive.

- Like in any modern Windows application, you may customize the layout of
mikroC for 8051 to suit your needs best.

- Spell checker underlines identifiers which are unknown to the project. In this
way it helps the programmer to spot potential problems early, much before the
project is compiled.

Spell checker can be disabled by choosing the option in the Preferences dialog
(F12).

CUSTOMIZING IDE LAYOUT

Docking Windows

You can increase the viewing and editing space for code, depending on how you
arrange the windows in the IDE.

Step 1: 2.1. Click the window you want to dock, to give it focus.

Project Manager
f = LH = :
o | (] 2] | (S | fmil el | e Y
= E‘ FirstProject.mcproj A
=l Sources

% FirstProject.c
1 Header Files
| Binaries
1 Project level defines
1 Image Files
] Dutput Files
| Other Files
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Step 2: 2.2.
Drag the tool
window from
its current
location. A
guide diamond
appears. The
four arrows of
the diamond
point towards
the four edges
of the IDE.

Step 3: 2.3. Move the pointer

over the corresponding portion
of the guide diamond. An out-
line of the window appears in

' the designated area.
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Step 4: To dock the window in the position indicated, release the mouse button.

Tip: To move a dockable window without snapping it into place, press CTRL
while dragging it.

Saving Layout

Once you have a window layout that you like, you can save the layout by typing

the name for the layout and pressing the Save Layout Icon |

To set the layout select the desired layout from the layout drop-down list and click

the Set Layout Icon | .To remove the layout from the drop-down list, select

the desired layout from the list and click the Delete Layout Icon |y | .

Debug Layout w o o s

<Default Layout:
Code Layout

laypout]

Auto Hide

Auto Hide enables you to see more of your code at one time by minimizing tool
windows along the edges of the IDE when not in use.

- Click the window you want to keep visible to give it focus.
- Click the Pushpin Icon
on the title bar of the window.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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= 1 festProjectawgeo)
= £ Souxces
B secon®romctc
L) Header Fies
L) bnarins

Ly ssepsammag B 0 Soun

L) Propect kel defiros |
I Image Fles L Hea

ErTe

L) Cther Flos

When an auto-hidden window loses focus, it automatically slides back to its tab on
the edge of the IDE. While a window is auto-hidden, its name and icon are visible
on a tab at the edge of the IDE. To display an auto-hidden window, move your point-
er over the tab. The window slides back into view and is ready for use.
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ADVANCED CODE EDITOR

The Code Editor is advanced text editor fashioned to satisfy needs of
professionals. General code editing is the same as working with any standard text-
editor, including familiar Copy, Paste and Undo actions, common for Windows
environment.

Advanced Editor Features

- Adjustable Syntax Highlighting

- Code Assistant

- Code Folding

- Parameter Assistant

- Code Templates (Auto Complete)
- Auto Correct for common typos

- Bookmarks and Goto Line

You can configure the Syntax Highlighting, Code Templates and Auto Correct from
the Editor Settings dialog. To access the Settings, click Tools » Options from the
drop-down menu, click the Show Options Icon =" orpress F12 key.
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Options @

Editor Settings

Project Files
~ Restore Last Opened Project
" Restore all Opened Files
' Save Breakpoints
" Save Bookmarks

If Opened File Is Externally Modified

== @ Erompt For action
Auto Complete i

) Reload file, but do not prompt

(' Ignore externally made changes

Auto Save
V' Enable Auto Save

Timeout Interval: 3 minutes

Highlighter

& Highlight begin..end pairs
+/ Highlight brackets
Spelling

¥ Check Spelling

aranaaaay

Comment style
[@' st | )} (single line)

Advanced Editor Options

3 Open options dizglog

oK Apply Cancel
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Code Assistant

If you type the first few letters of a word and then press Ctrl+Space, all valid iden-
tifiers matching the letters you have typed will be prompted in a floating panel (see
the image below). Now you can keep typing to narrow the choice, or you can select
one from the list using the keyboard arrows and Enter.

s

wanable  gfr ungigned char SP

vanable  zfr unsigned char SPDR
vanable  sfr ungsigned char SPSH
wanable  zfr unzigned char SPCH

Code Folding

Code folding is IDE feature which allows users to selectively hide and display sec-
tions of a source file. In this way it is easier to manage large regions of code within
one window, while still viewing only those subsections of the code that are relevant
during a particular editing session.

While typing, the code folding symbols ( - and + ) appear automatically. Use the
folding symbols to hide/unhide the code subsections.

%vuid main () {

FO = 0O;

Pz = 0O;

Led Indc ()

LeD Que (1,1, cxc[0]) 2
LCD out (2,1,txt[1]):
delay ms (10007 ;

Led Cmd(l):

LD Que(1,1,cxc[1]):
LCD_out (2,4, txt[2]) 2
delagr_ms (5007 ;

K

void maini){ |

If you place a mouse cursor over the tooltip box, the collapsed text will be shown
in a tooltip style box.
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void maini){ [:0

Loy
wold main() {
PO = 0O;
Pz = 0O;

Led Initc():

LCD Out{l,1,txt[0]):
LCD Out{2,1,txt[1]):
delay ms (1000} ;

Led Crodil)

LCD Out{1,1,txt[1]);

LCD Out (2,4, txt[2]);
delay ms(500) ;

Parameter Assistant

The Parameter Assistant will be automatically invoked when you open parenthesis
“( or press Shift+Ctrl+Space. If the name of a valid function precedes the parenthe-
sis, then the expected parameters will be displayed in a floating panel. As you type
the actual parameter, the next expected parameter will become bold.

channel : char
ADC Res

Code Templates (Auto Complete)

You can insert the Code Template by typing the name of the template (for instance,
whiles), then press Ctrl+] and the Code Editor will automatically generate a code.

You can add your own templates to the list. Select Tools » Options from the drop-
down menu, or click the Show Options Icon = and then select the Auto Complete
Tab. Here you can enter the appropriate keyword, description and code of your tem-

plate.
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Autocomplete macros can retreive system and project information:

- $DATES - current system date

- $TIMES - current system time

- ¢pevICES - device(MCU) name as specified in project settings

- sDEVICE CLOCKS - clock as specified in project settings

- SCOMPILER? - current compiler version
These macros can be used in template code, see template ptemplate provided with
mikroC for 8051 installation.

Auto Correct

The Auto Correct feature corrects common typing mistakes. To access the list of rec-
ognized typos, select Tools » Options from the drop-down menu, or click the Show
Options Icon = and then select the Auto Correct Tab. You can also add your own

preferences to the list.

Also, the Code Editor has a feature to comment or uncomment the selected code by
simple click of a mouse, using the Comment Icon ;1 and Uncomment Icon {.}
from the Code Toolbar.

Bookmarks

Bookmarks make navigation through a large code easier. To set a bookmark, use
Ctrl+Shift+number. To jump to a bookmark, use Ctrl+number.

Goto Line

The Goto Line option makes navigation through a large code easier. Use the short-
cut Ctrl+G to activate this option.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 45



CHAPTER 2

Environment mikroC for 8051

CODE EXPLORER

The Code Explorer gives clear view of each item declared inside the source code.
You can jump to a declaration of any item by right clicking it. Also, besides the list
of defined and declared objects, code explorer displays message about first error and
it's location in code.

e Code Explarer [X |

T e

+ Functions
Globals
TypeDef
Tags
Includes

Following options are available in the Code Explorer:

Icon Description

= Expand/Collapse all nodes in tree.

] Locate declaration in code.
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ROUTINE LIST

Routine list diplays list of routines, and enables filtering routines by name. Routine
list window can be accessed by pressing Ctrl+L.

You can jump to a desired routine by double clicking on it.
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PROJECT MANAGER

Project Manager is IDE feature which allows users to manage multiple projects.
Several projects which together make project group may be open at the same time.
Only one of them may be active at the moment.

Setting project in active mode is performed by double click on the desired project in
the Project Manager.

5 Project Manager %]
A EER EENEENDE
5 [ FirstProject.mcproj

=1 Sources

g FirstProject.c
Header Files
Binaries

Project level defines
Imange Files

Cukput Files

% FirstProject. b
% FirstProject. asm
% FirstProject.|st
1 Cther Files

winindndn

Following options are available in the Project Manager:

Icon Description

Save project Group.
L=

[ Open project group.

B Close the active project.

22 Close project group.

) Add project to the project group.
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Remove project from the project group.

1% | Add file to the active project.
K|

Remove selected file from the project.

Y Build the active project.

I Run mikroElektronika's Flash programmer.

For details about adding and removing files from project see Add/Remove Files

from Project.

Related topics: Project Settings, Project Menu Options, File Menu Options, Project

Toolbar, Build Toolbar, Add/Remove Files from Project
PROJECT SETTINGS WINDOW

Following options are available in the Project Settings Window:

- Device - select the appropriate device from the device drop-down list.
- Oscillator - enter the oscillator frequency value.
- Memory Model - Select the desired memory model.

=" Praject Settings LY |

=l Device

Mame: AT8955253

- @ O zcillatar

Value: | 008.000000 | MHz

=I[TTf] Memary Model -

%) Smal ) Large
() Compact Related topics: Memory Model, Project

Manager
I
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LIBRARY MANAGER

Library Manager enables simple handling libraries being used in a project. Library
Manager window lists all libraries (extencion .mcl) which are instantly stored in the
compiler Uses folder. The desirable library is added to the project by selecting check
box next to the library name.

In order to have all library functions accessible, simply press the button Check All

"] and all libraries will be selected. In case none library is needed in a project,

.t

press the button Clear All 77| and all libraries will be cleared from the project.

Only the selected libraries will be linked.
[ Library Manager 28
wdbed |l e =
#[] Button
+ [ ] Conversions
# [ ] Ctype
+ [ ] Doprntf
+[ ] Doprnti
+ [ ] Doprntl
+[v] aled
[]aElcd_Forts
+[w] Led
[]Lcd_Constants
#[ ] Math
[ ] one_wire
A ]psz
[ ra4as
# [ ] sofware_izc
+[w] sofware_SPI
#[ ] software_Lart
+[ ] sound
+[ ] sprintf
+-[ ] sprinki
+[ ] sprint
+[ ] stdlib
+[ ] string
[ ] Te963C
- [v] Time
+[ ] Trigon
+ [v] UaRT
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Icon Description

- Refresh Library by scanning files in "Uses" folder.Useful when new
libraries are added by copying files to "Uses" folder.

™ Rebuild all available libraries. Useful when library sources are avail-
able and need refreshing.

& Include all available libraries in current project.

e No libraries from the list will be included in current project.

] | Restore library to the state just before last project saving.

Related topics: mikroC for 8051 Libraries, Creating New Library
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ERROR WINDOW

In case that errors were encountered during compiling, the compiler will report them
and won’t generate a hex file. The Error Window will be prompted at the bottom of
the main window by default.

The Error Window is located under message tab, and displays location and type of
errors the compiler has encountered. The compiler also reports warnings, but these
do not affect the output; only errors can interefere with the generation of hex.

Messages

Errors Warnings Hints
Line Message No. Message Text Unit
1] 1 mikroc8051.exe MSF -DBG -pATS958253 £S5 -C 011111114 -fo10 ...
0 125 All files Preprocessed in 31ms
0 121 Compilation Started LedBlinking.c
21 300 Syntax Error: expected 7', but';’ found LedBlinking.c
21 399 3 expected but ‘P2 found LedBlinking.c
22 421 '} expected '’ found LedBlinking.c
31 421 } expected '}’ found LedBlinking.c
1] 102 Finished (with errors): 06 Mar 2008, 09:26:59 Led8linking.mcproj

Double click the message line in the Error Window to highlight the line where the
error was encountered.

Related topics: Error Messages

STATISTICS

After successful compilation, you can review statistics of your code. Click the
Statistics Icon e

Memory Usage Windows
Provides overview of RAM and ROM usage in the form of histogram.

RAM Memory
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Data Memory

Displays Data memory usage in form of histogram.

Statistics ®
= Memory Usage
= RAM RAM Memary Usage (locations)

Hdata
iData
bD ata
Pdata
SFR
GPFR
= ROM _ _
ROM allocation 34% of 96
= Procedures
Size
Locations

[B6%0196 | 33 Free data RAM
B3 Used data RAM

Free data RAM Used data RAM

XData Memory

Displays XData memory usage in form of histogram.

Statistics ®
= Memory Usage
= RAM RAM Memory Usage (locations)

Data (100%of 75 75 Free Xdata RAM

0 Used Xdata RAM

iData
bD ata
Pdata
SFR
GFR
= ROM
ROM dllocation
= Procedures
Size
Locations

Free ¥data REM Used Ydata RAM |
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iData Memory

Displays iData memory usage in form of histogram.

Statistics
= Memory Usage
= RAM
Data [i00% ot 128 128 Free Ideta RAM
Xdata 0 Used Idata RAM

bD ata
Pdata
SFR
GPFR
= ROM
ROM Allocation
= Procedures
Size
Locations
0% o1 128

Free ldata RAM Used ldata RAM

Ra&M Memory Usage (locations)

bData Memory

Displays bData memory usage in form of histogram.

Statistics

= Memory Usage
= RAM RAM Memory Usage (locations)
Dl 16 Free Bdata RAN
Xdala 0 Used Bota RAM
iData
Pdata
SFR
GPFR
= ROM
ROM Allocation
= Procedures
Size
Locations

Free Bdata RAM Used Brlata RAM
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PData Memory

Displays PData memory usage in form of histogram.

Statistics ®
= Memory Usage
= RAM RAM Memory Usage (locations)

ks (100%of 75 75 Free Pdata RAM
#data 0 Used Pelata RAM

iData
bD ata
SFR
GPFR
= ROM
ROM Allocation
= Procedures
Size
Locations

Free Pdéta RAM .Used Pd;a‘ta RAM.

Special Function Registers

Summarizes all Special Function Registers and their addresses.

Statistics
= Memoey Usage 1}
2 RaM Specid brcion regen [SFR)
Uaa —
Ya2a Addeas Fiagster S
Daa 030 E
= :
a a2 DFL
&Pa M2 DAL
B ROM 083 oF
ROM Alocsbon 3 [=H
5 Paoceduses D4 DPIL
D35 SPOR
D87 PCON
D38 TCON
2SS THOD
DS T
De3E m
De3C THO v
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General Purpose Registers

Summarizes all General Purpose Registers and their addresses. Also displays
symbolic names of variables and their addresses.

= Memory Usage
= RAM General purpose registers (GPR)
Data
Adata Address Register 2]
iData 0x00 E]
bDals 001 R
- Pdata
SFR 0x02 R2
0403 R3
= ROM 0x04 R4
ROM Allocation 0x05 RS
- Procedures 008 RE
Size
Locations 0k07 A7
0=09C0 advancedB051_bmp [_advancedB051_bmp)
0x40 GLCD_C51 _GLCD_CS1)
0x41 GLCD_C52 _GLCD_CS2)
0x42 GLCD_RS (GLCD_RS)
0283 GLCD_Rw [_GLCD_Rw)
05 GLCD_RST (_GLCD_RST)
0xdd GLCO_EN [_GLCD_EN) v
ROM Memory
ROM Memory Usage
Displays ROM memory usage in form of histogram.
Statistics =
= Memory Usage
= RaM ROM Memory Uisage (locations)
D2l Free ROM 80 % of 12,287 9,362 Free ROM
?(data 2,425 Used ROM
iData
bData
Pdata
SFR
GPR
ROM Allocation
= Procedures
Size
Locations
Used ROM 20 % of 12,287
Free ROM Used ROM

56 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroC for 8051

CHAPTER 2
Environment

ROM Memory Allocation
Displays ROM memory allocation.

P Mensor lasge 0x0000  0x0Z0443 A
& RAM 0x0003 0x020000 =
Data 0x0006  0x00
Kdata 0x0007  0x00
iData 0x0008  0x00
bData 0x0009  0x00
Pdata 0x0004 0x00
SFR 0x000B  0x020000
0x000E  0x00
GPR 0x000F  0x00
= ROM 020010 0x00
10M Allocation 0x0011 0x00
- Procedures 020012 0x00
Size 0x0013  0x020000
Lincalitria 0x0016 0x00
0x0017  0x00
0x0018  0x00
0x0019  0x00
0x00LA  0x00
0x001B  0x0Z0000
0x00LE  0x00
0x00LF  0x00
0x0020  0x00 3

Procedures Windows

Provides overview procedures locations and sizes.

Procedures Size Window

Displays size of each procedure.

Memory Usage
= RaM
Data
Wdata Gled_Box |
iData Gled_Image |
bData Y
Pdata Gled_V_Line |
SFR Glod_Line -
GPR :
= ROM Glod_Wite_Text [T
ROM Allocation Gled_Set_Font RE
= Procedures
Gled_Fill
Locations

Glod_Read_Data {8
Gled_Set_Side fll
Strobe 5

CC2D &

delay2s |

ROM usage by procedure (ROM locations)

Defay_ﬂ:ug. s

100

Procedures Size Windowl

300
ROM locations

200
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Procedures Locations Window
Displays how functions are distributed in microcontroller’s memory.

= Memoy Usage
= RAM

Data
Hdata
iData
bl ata
Pdata
SFR
GPR
= ROM
ROM Allocation
= Procedures
Size

Procedures by ROM location

500 1,000 1,500 2,000
ROM Address

Macro Editor

A macro is a series of keystrokes that have been 'recorded' in the order performed.
A macro allows you to 'record' a series of keystrokes and then 'playback’, or repeat,
the recorded keystrokes.

[ | Macro Editar 2= E]
oL G
Mame
3 2
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The Macro offers the following commands:

Icon

Description

oy

Starts 'recording' keystrokes for later playback.

o

Stops capturing keystrokesthat was started when the Start Recordig
command was selected.

4

Allows a macro that has been recorded to be replayed.

55
=

New macro.

&

Delete macro.

Related topics: Advanced Code Editor, Code Templates
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INTEGRATED TOOLS

USART Terminal

The mikroC for 8051 includes the USART communication terminal for RS232 com-
munication. You can launch it from the drop-down menu Tools » USART Terminal
or by clicking the USART Terminal Icon _1 from Tools toolbar.

RS232 Terminal X

Settings Communication
Com Port: Echo | Send | SendFile
Baud: Append: [[] CR [[] Send as typing Start Logaing
Stop Bits: CLr [ Send as number Clear History
Paiity: J Format
O @ asci O HEX QODEC
Data bits: Connected to COM1
et Sent: Echo
Commands
RIS DTR
® 0ff @ Off
O0on Oon
| Eonnect [USART Terminal jinect
Status
Send Receive LTS DSR
< © (% L *]
Log Files
Bead from:
Wwiite to:
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ASCII Chart
The ASCII Chart is a handy tool, particularly useful when working with LCD dis-

play. You can launch it from the drop-down menu Tools » ASCII chart or by click-
ing the View ASCII Chart Icon i from Tools toolbar.

Ascii Chart

NUL SOH STX ETX EOT ENOQ ACK BEL BS HT LF VT
0 1 Z 3 4 5 6 7 (=] 9 10 11
DLE DC1 DC2 DC3 DC4 NAK SYN ETB CAN EM SUB ESC

e - - = e

16 |17 [ 18 | 19 | 20 | 21 | 22 | 23 | 24 | 25 | 26 | 27
SPC ! $ i
So | @E 355 1370 38 39 28 43

0 4

o
D
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EEPROM Editor

The EEPROM Editor is used for manipulating MCU's EEPROM memory. You can
launch it from the drop-down menu Tools » EEPROM Editor. When Use this EEP-
ROM definition is checked compiler will generate Intel hex file project name.ihex
that contains data from EEPROM editor.

When you run mikroElektronika programmer software from mikroC for 8051 IDE
- project name.hex file will be loaded automatically while ihex file must be loaded
manually.

EEPROM Editor

Load... Address: Bx B8

Walue: |FF ]
SAVE... W' Use this EEPROM definition

Data Memory Size: 2048 Bykes

0 |1 23| |56 |7 s o|alsc|p|E|fF =
8x 00 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x81 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
8x82 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x83 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x84 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x85 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x86 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x87 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
8x88 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x89 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x8n |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x8B |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x8C |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x8D |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@xB8E |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
@x8F |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
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7 Segment Display Decoder

The 7 Segment Display Decoder is a convenient visual panel which returns deci-
mal/hex value for any viable combination you would like to display on 7seg. Click
on the parts of 7 segment image to get the requested value in the edit boxes. You can
launch it from the drop-down menu Tools » 7 Segment Decoderor by clicking the
Seven Segment Icon .EL from Tools toolbar.

Seven Segment Editor

]

' Comron cathode

$CF

Comron anode

-am» -

Decode in;

() decimal walue

AN @ Orervae
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UDP Terminal
The mikroC for 8051 includes the UDP Terminal. You can launch it from the drop-

down menu Tools » UDP Terminal.

% UDP Communication Terminal

Settings
IP ddhess: [192.168.20.60 Comect |
Port: 10001
Send:
|mikroE lektronika T zend 1
Append: [ CH [~ Send az buping
[~ LF [ Send az number
rnikroE lektronika
Clear
Receive
 ASCI " HE= " DEC
Clear

64 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroC for 8051 Environment

Graphic LCD Bitmap Editor

The mikroC for 8051 includes the Graphic LCD Bitmap Editor. Output is the
mikroC for 8051 compatible code. You can launch it from the drop-down menu
Tools » GLCD Bitmap Editor.

mikroElektronika Graphic LCD Bitmap generator =
KS0102 | 76963 | Nokis3110|

File loaded: truck.bmp
Pickure preview — 128x64 pix | bw

[ Load BMP Picture ]

( Create CODE |

(NNENNENNE RN

[ InvertPICTURE |

GLCD Size [ controfler

(%) 12864 (KS0108)

s A
/7 GLCD Picture name: truck.hmp =
/7 GLCD Model: KSO188 128x64 =
s
& Copy CODE to Clipboard
unsigned char const truck_bmpliB24]1 = { [ it B et
a. 8, -, . 8. 8, . . 8. . B. 8. 8. 8, 8. 8. i
o o iin ol a: gk oo il e G-k o= oo e Mgi il | QmiroeascaL cods
@. 8. 8. @, @, 0, 0. 0. @, ©. 8. 0. 0, 0. 8, @, | OmkoBASICcods
@A, 8. 8. 8, @8, B, @, B, 6, B, 6, 6. 8, B, 6, A4, (® mikroC code
a. 8, If - B. B, A, . B8, B, 8, @8, 8. B, 0. i
e, @8, @8, 8. 8. 8, 8, B, B, B, B, B, B, B, B, B,
v_\er: 2.0.1 - 27012005 System status: Win NT like OS5
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LCD Custom Character

mikroC for 8051 includes the LCD Custom Character. Output is mikroC for 8051
compatible code. You can launch it from the drop-down menu Tools > LCD Custom

Character.
1 LCD custom character L||E|E|
T " | = i = =)
Bx 7 5x10 Save... Load .. Fill all Clear all Invert
Fant Prewview:

. . Qi e i I:I D E
™ 5w 10+ curzor line I:l

CGRAM address:

. Char:

fm]
4F

Char data row: o :|

A

GENERATE

OPTIONS

Options menu consists of three tabs: Code Editor, Tools and Output settings

Code editor

The Code Editor is advanced text editor fashioned to satisfy needs of professi
onals.

Tools

The mikroC for 8051 includes the Tools tab, which enables the use of shortcuts to
external programs, like Calculator or Notepad.
You can set up to 10 different shortcuts, by editing ToolO - Tool9.
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Options

Editor

Tooll : Press button to open file dislog

Tool2

Mo |

J Dutput
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Output settings

By modifying Output Settings, user can configure the content of the output files.
You can enable or disable, for example, generation of ASM and List file.

Options [Z|
| Output Settings

: ¥ Generate ASM file

Lor ¥ Include HEX opcodes
Output Setlings V Include ROM constants
V Include ROM Addresses

v Generate list file
W Include debug info

V' Include source lines in output files

Optimization level:

iFour @]
Compiler

Case sensitive

oK Apply Cancel
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REGULAR EXPRESSIONS

Introduction

Regular Expressions are a widely-used method of specifying patterns of text to
search for. Special metacharacters allow you to specify, for instance, that a particu-
lar string you are looking for, occurs at the beginning, or end of a line, or contains
n recurrences of a certain character.

Simple matches

Any single character matches itself, unless it is a metacharacter with a special mean-
ing described below. A series of characters matches that series of characters in the
target string, so the pattern "short" would match "short" in the target string. You
can cause characters that normally function as metacharacters or escape sequences
to be interpreted by preceding them with a backslash "\ .

For instance, metacharacter "~" matches beginning of string, but "\~" matches
character "~", and "\\" matches "\", etc.

Examples :

unsigned matches string 'unsigned’
\*unsigned matches string '“unsigned’

Escape sequences

Characters may be specified using a escape sequences: "\n" matches a newline,
"\t" a tab, etc. More generally, \xnn, where nn is a string of hexadecimal digits,
matches the character whose ASCII value is nn.

If you need wide(Unicode)character code, you can use '\x{nnnn}', where 'nnnn'
- one or more hexadecimal digits.

\xnn - char with hex code nn

\x{nnnn) - char with hex code nnnn (one byte for plain text and two bytes for
Unicode)

\t - tab (HT/TAB), same as \x09

\n - newline (NL), same as \x0a

\r - car.return (CR), same as \x0d

\f - form feed (FF), same as \x0c

\a - alarm (bell) (BEL), same as \x07

\e - escape (ESC) , same as \x1b
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Examples:

unsigned\x20int matches 'unsigned int' (note space in the middle)
\tunsigned matches 'unsigned' (predecessed by tab)

Character classes

You can specify a character class, by enclosing a list of characters in [], which will
match any of the characters from the list. If the first character after the "[" is "~",
the class matches any character not in the list.

Examples:

count[aeiou]r finds strings 'countar', 'counter', etc. but not 'countbr',

'countecr', €tC.

count[*aeiou]r finds strings "countbr', 'countcr', etc. but not
'countar', 'counter', etc.
Within a list, the "-" character is used to specify a range, so that a-z represents all

characters between "a" and "z", inclusive.

If you want - itself to be a member of a class, put it at the start or end of the list,
or escape it with a backslash.
If you want '1', you may place it at the start of list or escape it with a backslash.

Examples:
[-az] matches 'a', 'z'and '-'
[az-] matches 'a', 'z' and '-'
[a\-z] matches 'a', 'z' and '-'

[a-z] matches all twenty six small characters from 'a' to 'z’
[\n-\x0D] matches any of #10,#11,#12,#13.

[\d-t] matches any digit, '-' or "t".
[1-a] matches any char from ']1'..'a".
Metacharacters

Metacharacters are special characters which are the essence of regular
expressions.There are different types of metacharacters, described below.
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Metacharacters - Line separators

~ - start of line

$ - end of line

\A - start of text

\z - end of text

. - any character in line

Examples:

~PORTA - matches string ' PorRT2 ' only if it's at the beginning of line
PORTAS - matches string ' PorRT2 ' only if it's at the end of line
~PORTAS - matches string ' porTa ' only if it's the only string in line
PORT . r - matches strings like 'PorT2', 'PORTE', 'PORT1' and so on

The "~ metacharacter by default is only guaranteed to match beginning of the input
string/text, and the "$" metacharacter only at the end. Embedded line separators will
not be matched by "~" or "$".

You may, however, wish to treat a string as a multi-line buffer, such that the "~ will
match after any line separator within the string, and "$" will match before any line
separator.

Regular expressons works with line separators as recommended at
www.unicode.org ( http://www.unicode.org/unicode/reports/tr18/ ):

Metacharacters - Predefined classes

\w - an alphanumeric character (including " ")
\W - a nonalphanumeric

\d - a numeric character

\D - a non-numeric

\s - any space (same as [\t\n\z\£])

\S - anon space

You may use \w, \d and \s within custom character classes.

Example:
routi\de - matches strings like 'routile', 'routiée' and so on, but not
'routine', 'routime' and so on.
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Metacharacters - Word boundaries

A word boundary ("\b") is a spot between two characters that has a "\w" on one
side of it and a "\w" on the other side of it (in either order), counting the imaginary
characters off the beginning and end of the string as matching a "\w" .

\b - match a word boundary)
\B - match a non-(word boundary)

Metacharacters - lterators

Any item of a regular expression may be followed by another type of metacharac-
ters - iterators. Using this metacharacters,you can specify number of occurences of
previous character, metacharacter or subexpression.

* - zero or more ("greedy"), similar to {0,}

+ - one or more ("greedy"), similar to {1,}

2 - zero or one ("greedy"), similar to {0,1}

{n} - exactly n times ("greedy")

{n,} - at least n times ("greedy")

{n,m} - at least n but not more than m times ("greedy")
*2 - zero or more ("non-greedy"), similar to {0,}?

+2 - one or more ("non-greedy"), similar to {1,}?

2?2 - zero or one ("non-greedy"), similar to {0,1}?
{n}? - exactly n times ("non-greedy")

{n,}? - at least n times ("non-greedy")

{n,m}? - at least n but not more than m times ("non-greedy")

So, digits in curly brackets of the form, {n,m}, specify the minimum number of
times to match the item n and the maximum m. The form {n} is equivalent to {n,n}
and matches exactly n times. The form {n,} matches n or more times. There is no
limit to the size of n or m, but large numbers will chew up more memory and slow
down execution.

If a curly bracket occurs in any other context, it is treated as a regular character.
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Examples:
count. *r B—nuﬂchessﬂingslﬂ«:'counter', 'countelkjdflkjOr’ and
'countr’
count. +r - matches strings like 'counter', 'countelkjdflkjor' but not
'countr’
count. ?r - matches strings like 'foobar', 'foobbr' and 'foobr' but

not 'foobalkj9r'

counte{2}r —nunchessning 'counteer'’

counte{2,}r —nunchessningshke'counteer', 'counteeer’',
'counteeer’' etc.

counte{2,3}r —HHHCheSSUingShke'counteer‘,Or'counteeer'but

not 'counteeeer'

A little explanation about "greediness". "Greedy" takes as many as possible, "non-
greedy" takes as few as possible.

For example, 'b+' and 'b*' applied to string 'abbbbc' return 'bbbb', 'b+?'
returns 'b', 'b*?' returns empty string, 'b{2,3}?' returns 'bb', 'b{2,3}"'
returns 'bbb' .

Metacharacters - Alternatives

You can specify a series of alternatives for a pattern using " |" to separate them, so
that fee | fie|foe will match any of "fee", "fie", or "foe" in the target string (as
would £ (e|i|o)e)). The first alternative includes everything from the last pattern
delimiter (" (", "[", or the beginning of the pattern) up to the first "|", and the
last alternative contains everything from the last " |" to the next pattern delimiter.
For this reason, it's common practice to include alternatives in parentheses, to min-
imize confusion about where they start and end.

Alternatives are tried from left to right, so the first alternative found for which the
entire expression matches, is the one that is chosen. This means that alternatives are
not necessarily greedy. For example: when matching rou|rout against

"routine", only the "rou" part will match, as that is the first alternative tried, and
it successfully matches the target string (this might not seem important, but it is
important when you are capturing matched text using parentheses.) Also remember
that "|" is interpreted as a literal within square brackets, so if you write
[fee|fie|foe] You're really only matching [feio|].

Examples:
rou(tine| te) —nunchessuings'routine' Or 'route'.
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Metacharacters - Subexpressions

The bracketing construct ( ... ) may also be used for define regular subexpres-
sions. Subexpressions are numbered based on the left to right order of their opening
parenthesis. First subexpression has number ' 1

Examples:

(int) {8,10} matches strings which contain 8, 9 or 10 instances of the

'int'
routi ([0-9] | a+) e matches 'routile', 'routile' , 'routine',
'routinne', 'routinnne' etcC.

Metacharacters - Backreferences

Metacharacters \1 through \9 are interpreted as backreferences. \ matches previ-
ously matched subexpression #.

Examples:

(.)\1+ matches 'aaaa’' and 'cc'.

(.+)\1+ matches 'abab' and '123123"

(['"1?) (\d+)\1 matches "13" (in double quotes), or '4' (in single
quotes) or 77 (without quotes) etc

74 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2
mikroC for 8051 Environment

MIKROC FOR 8051 COMMAND LINE OPTIONS

LBage:mikroCSOSl [-'opts' [-'opts']] ['infile' [-'opts']]
[-'opts']]
Infile can be of * . c and * .mc1 type.
The following parameters and some more (see manual) are valid:
- : MCU for which compilation will be done.
- #0 : Set oscillator.
- sp : Add directory to the search path list.
- 17 : Add directory to the #include search list.
- i : Output files generated to file path specified by filename.
- 8 : Save compiled binary files (* .nc1) to 'directory’.
- 0 : Miscellaneous output options.
- DBG : Generate debug info.
- : Set memory modelopts (s | ¢ | L (small, compact, large)).
- L : Check and rebuild new libraries.
- ¢ : Turn on case sensitivity.

Example:
mikroc8051.exe -MSF -DBG -pAT89S8253 -ES -011111114 -fol0 -
N"C:\Lcd\Lcd.mcproj"
-SP"C:\Program Files\Mikroelektronika\mikroC

8051\defs\"
-SP"C:\ProgramFiles\Mikroelektronika\mikroC
8051\uses\"
-SP"C:\Lcd\" "Lcd.c" "System.mcl" "Math.mcl"
"Math Double.mcl" "Delays.mcl" "__Lib Lcd.mcl"

"__LiE_Lchonsts.mcl"

Parameters used in the example:
-usF : Short Message Format; used for internal purposes by IDE.

-pBG : Generate debug info.

-pAT8958253 : MCU AT89S8253 selected.
-£s : Set small memory model.

-011111114 : Miscellaneous output options.
-f010 : Set oscillator frequency [in MHz].

-N"C:\Lcd\ Led.mcproj" -SP"C:\ProgramFiles\Mikroelektronika\mikroC
8051\ defs\ " : Output files generated to file path specified by filename.
-SP"C:\Program Files\Mikroelektronika\mikroC 8051\defs\" : Add

directory to the search path list.

-SP"C:\Program Files\Mikroelektronika\mikroC 8051\uses\" : Add
directory to the search path list.

-SP"C:\Lcd\" "Lcd.c" "System.mcl" "Math.mcl" "Math Double.mcl"
"Delays.mcl" " Lib Led.mel” " Lib LedConsts.mcl” : Add
directory to the search path list.
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PROJECTS

The mikroC 8051 organizes applications into projects, consisting of a single project
file (extension .mcproj) and one or more source files (extension .c). MikroC for
8051 IDE allows you to manage multiple projects (see Project Manager). Source
files can be compiled only if they are part of a project.

The project file contains the following information:

- project name and optional description,

- target device,

- memory model,

- device flags (config word),

- device clock,

- list of the project source files with paths,
- header files (*.h),

- binary files (*.mcl),

- image files,

- other files.

Note that the project does not include files in the same way as preprocessor does,
see Add/Remove Files from Project.

NEW PROJECT

The easiest way to create a project is by means of the New Project Wizard, drop-
down menu Project » New Project or by clicking the New Project Icon =% from

Project Toolbar.

New Project Wizard Steps
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Step One- Provides basic information on settings in the following steps.

New Project Wizard

Step Two - Select the device from the device drop-down list.

New Project Wizard

Step 1/6
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Step Three - enter the oscillator frequency value.

New Project Wizard

Step 2/6

Step Four - Select the desired memory model.

New Project Wizard

Step 3/6

1] e ———— __-__.
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Step Five - Specify the location where your project will be saved.

New Project Wizard

Step 4/6

Project File Mame:
ID:\ProjectsiFirstProjectiFirstPraject meproj

n 4 Back Next |— Cancel |

Step Six - Add project file to the project if they are avaiable at this point. You can

always add project files later using Project Manager

New Project Wizard

Add File To Project: :
!D:'l.Projects‘J.FirstProject\Deﬁnt‘h =] Add
File Mame
D:\Projects\FirstProject\Definit.h
Remove
Remove All

Related topics: Project Manager, Project Settings, Memory Model

N i 4 Back I Next 5 |7 Cancel Il
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CUSTOMIZING PROJECTS
Edit Project

You can change basic project settings in the Project Settings window. You can
change chip, oscillator frequency, and memory model. Any change in the Project
Setting Window affects currently active project only, so in case more than one proj-
ect is open, you have to ensure that exactly the desired project is set as active one in
the Project Manager.

Managing Project Group

mikroC for 8051 IDE provides covenient option which enables several projects to
be open simultaneously. If you have several projects being connected in some way,
you can create a project group.

The project group may be saved by clicking the Save Project Group Icon i from
the Project Manager window. The project group may be reopend by clicking the
Open Project Group Icon [# . All relevant data about the project group is stored

in the project group file (extension .mpg)
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ADD/REMOVE FILES FROM PROJECT

The project can contain the following file types:

.c source files

.h header files

.mc1 binary files

.p1d project level defines files (future upgrade)

image files

- .hex, .asm and .1st files, see output files. These files can not be added or
- removed from project.

- other files

2=| Project Manager [% |
gy M G2 | o S G | B

= | Te963C_240x128.mcproj

= Sources
£ TE963C_240x128.
% bitmap.c
Header Files
TEIE3C.h
Binaries
bitmapz . ml
Project level defines
Imane Files
sample.jpg
Cukput Files
=] TE963C_240x128.hex
5| TE9R3C_240x125,asm
% TE9E3IC_240x128.Ist
—|-I] Other Files

% D3 ATE958253 - doc3286, pdf

e N
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The list of relevant source files is stored in the project file (extension .mcpro).

To add source file to the project, click the Add File to Project Icon | f Each added
source file must be self-contained, i.e. it must have all necessary definitions after
preprocessing.

To remove file(s) from the project, click the Remove File from Project Icon ! oF

Note: For inclusion of the header files (extension . 1), use the preprocessor directive
#include. See File Inclusion for more information.

Related topics: Project Manager, Project Settings, Memory Model
Source Files

Source files containing C code should have the extension . c. The list of source files
relevant to the application is stored in project file with extension .mcproj, along
with other project information. You can compile source files only if they are part of
the project.

Use the preprocessor directive #include to include header files with the extension
.h. Do not rely on the preprocessor to include source files other than headers — see
Add/Remove Files from Project for more information.

MANAGING SOURCE FILES

Creating new source file

To create a new source file, do the following:

1. Select File » New Unit from the drop-down menu, or press Ctrl+N, or click
the New File Icon | § from the File Toolbar.

2. A new tab will be opened. This is a new source file. Select File » Save from
the drop-down menu, or press Ctrl+S, or click the Save File [con [ from

the File Toolbar and name it as you want.
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If you use the New Project Wizard, an empty source file, named after the project
with extension . c, will be created automatically. The mikroC 8051 does not require
you to have a source file named the same as the project, it’s just a matter of conven-
ience.

Opening an existing file

1. Select File » Open from the drop-down menu, or press Ctrl+O, or click the
Open File Icon | *» from the File Toolbar. In Open Dialog browse to the
location of the file that you want to open, select it and click the Open button.

2. The selected file is displayed in its own tab. If the selected file is already open,

its current Editor tab will become active.

Printing an open file

1. Make sure that the window containing the file that you want to print is the
active window.

2. Select File » Print from the drop-down menu, or press Ctrl+P.

3. In the Print Preview Window, set a desired layout of the document and click
the OK button. The file will be printed on the selected printer.

Saving file

1. Make sure that the window containing the file that you want to save is the
active window.

2. Select File » Save from the drop-down menu, or press Ctrl+S, or click the
Save File Icon | from the File Toolbar.

Saving file under a different name

1. Make sure that the window containing the file that you want to save is the
active window.

2. Select File » Save As from the drop-down menu. The New File Name dialog
will be displayed.

3. In the dialog, browse to the folder where you want to save the file.

4. In the File Name field, modify the name of the file you want to save.

5. Click the Save button.
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Closing file

1. Make sure that the tab containing the file that you want to close is the active
tab.

2. Select File » Close from the drop-down menu, or right click the tab of the file
that you want to close and select Close option from the context menu.

3. If the file has been changed since it was last saved, you will be prompted to
save your changes.

Related topics:File Menu, File Toolbar, Project Manager, Project Settings,
CLEAN PROJECT FOLDER

This menu gives you option to choose which files from your current project you
want to delete.

Clean Project Folder

Below is the list of all files in the project folder, Files in bold are those
generated by the compiler and they can be easily recreated when the
project is rebuilt.

Select which files vou want to remave from the project falder, Please note
that selected files will be permanently deleted from vour disk if you click

LedBlinking.asm

] LedBlinking.c

[] LedBlinking. cp
LedBlinking.dbg
LedBlinking.dct
LedBlinking.dit
[] LedBlinking.hex
] LedBlinking.ihex

] LedElinking.ini
LedBlinking.lst
] LedElinking. mdl

[] LedElinking. mcproj
LedBlinking.mcproj_callertable.txt
LedBlinking.mil
] LedBlinking. user . dic

Clean Cancel

C:\Program FilesiMikroelekironikalmilyoC 8051\ExamplesiLed Blinking),
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COMPILATION

When you have created the project and written the source code, it's time to compile
it. Select Project > Build from the drop-down menu, or click the Build Icon [

from the Project Toolbar. If more more than one project is open you can compile all
open projects by selecting Project » Build All from the drop-down menu, or click

the Build All Icon @~ from the Project Toolbar.

Progress bar will appear to inform you about the status of compiling. If there are
some errors, you will be notified in the Error Window. If no errors are encountered,
the mikroC for 8051 will generate output files.

OUTPUT FILES

Upon successful compilation, the mikroC for 8051 will generate output files in the
project folder (folder which contains the project file .mcpro7). Output files are sum-
marized in the table below:

Format Description File Type
Intel HEX Intel style hex records. Use this file to pro-
gram 8051 MCU.
mikro Compiled Library. Binary distribu-
tion of application that can be included in

.hex

Bi ; .mcl
fnary other projects.
Overview of 8051 memory allotment:
List File instruction addresses, registers, routines Lt
and labels.
Assembler File Human readable assembly with symbolic -

names, extracted from the List File.

ASSEMBLY VIEW

After compiling the program in the mikroC for 8051, you can click the View
Assembly icon | g or select Project > View Assembly from the drop-down
menu to review the generated assembly code (.asm file) in a new tab window.
Assembly is human-readable with symbolic names.

Related topics:Project Menu, Project Toolbar, Error Window, Project Manager,
Project Settings
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ERROR MESSAGES
COMPILER ERROR MESSAGES

- Syntax Error: expected [ ¢=], but[ <s] found.
- Array element cannot be a function.

- Function cannot return array.

- Inconsistent storage class.

- Inconsistent type.

-[ 2s] tag redefined | ©s] .

- Illegal typecast[ 2] [ %s].

-1 %s] 1s not a valid identifier.

- Invalid statement.

- Constant expression required.

- Internal error [ <s] .

- Too many actual parameters.

- Not enough parameters.

- Invalid expresion.

- Identifier expected, but [ =s] found.

- Operator [ ¢s] not applicable to this operands [ =] .
- Assigning to non-lvalue [ ¢s] .

- Cannot cast[ 2s] to[ %s].

- Cannot assign [ ¢s] to[ %s] .

- lvalue required.

- Pointer required.

- Argument is out of range.

- Undeclared identifier ' 2= in expression.

- Too many initializers.

- Cannot establish this baud rate at[ <s] MHz clock.
- Stack overflow.

- Invalid operator [ <s] .

- Expected variable but constant [ %s] found.

- Expected constant but[ <s] found.

- [ 2s] cannot be used outside a loop.

- Unknown type [ 2s] .

- Variable [ <=1 is redeclared.

- Demo Limit.

- [ 2s] has already been declared [ %= .

- Type mismatch: expected [ ¢s], but[ ¢s) found.
- File [ #s) not found.
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- There is not enough RAM space for all variables.
- There is not enough ROM space.

- Invalid type in array.

- Path to your project.c :1: error: Not a header name "%s"
- #include [ %=]

- [ %s] error in preprocessor.

- Division by zero.

- Incompatible types: [ ¢s] [ %s].

- Assembler instruction [ <s] was not found..
- Project name must be specified.

- Unknown commmand line Option: [ %s] .

- File exstension missing: [ ¢s] .

- Bad FO argument: [ %s] .

- Preprocessor exited with error code [ ¢s] .

- Bad absolute address [ <s] .

- Recursion or cross-calling of [ <s] .

- No files specifed.

- Device parameter missing (for example -PATS2...).
- Invalid parameter string.

- Specifier needed.

-[ 2=] not found [ =s] .

- Index out of bounds.

- Array dimension must be greater then 0.

- Const expression expected.

- Integer const expected.

- Recusion in definition.

- Array corupted.

- Arguments cannot be of void type.

- Arguments cannot have explicit memory specificator.
- Bad storage class.

- Pointer to function required.

- Function required.

- Pointer required.

- Illegal pointer conversion to double.

- Integer type needed.

- Members can not have memory specifier.

- Members can not be of bit or sbit type.

- Too many initializers.

- Too many initializers of subaggregate.

- Already used [ =s] .

- [llegal expression with void.
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- Address must be greater than 0.

- [ 2s] Identifier redefined.

- User abort.

- Expression must be greater then 0.

- Invalid declarator expected '(" or identifier.

- Typdef name redefined: [ <= .

- Declarator error.

- Specifer/qualifier list expected.

- [ 2s] already used.

- ILevel can be used only with interrupt service routines.
- ;" expected but [ 5] found.

- Expected'[{'.

- [ 2s] Identifier redefined.

- '(" expected but [ 2s] found.

- ") expected but [ 2s] found.

- 'case' out of switch.

- ""expected but[ 5] found.

- 'default' label out of switch.

- Switch expression must evaluate to integral type.
- While expected but [ ==] found.

- Void func cannot return values.

- 'continue' outside of loop.

- Unreachable code.

- Label redefined.

- Void type in expression.

- Too many chars.

- Unresolved type.

- Arrays of objects containing zero-size arrays are illegal.
- Invalid enumerator.

- [Level can be used only with interrupt service routines.
- [Level value must be integral constant.

- [Level out of range [0..4].

- '} expected but[ 5] found.

- '(" expected but [ 2s] found.

- 'break’ outside of loop or switch.

- Empty char.

- Nonexistent field [ <s] .

- [llegal char representation: [ s .

- Initializer syntax error: multidimension array missing subscript.
- Too many initializers of subaggregate.

- At least one Search Path must be specified.
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- Not enough RAM for call satck.

- Parameter [ ©s] must not be of bit or sbit type.

- Function must not have return value of bit or sbit type.
- Redefinition of [ 5] already defined in| 5] .

- Main function is not defined.

- System routine not found for initialization of: [ 2s] .
- Bad agregate definition | ¢s] .

- Unresolved extern|[ <s] .

- Bad function absolute address [ s .

- Not enough RAM [ ¢5] .

- Compilation Started.

- Compiled Successfully.

- Finished (with errors): 01 Mar 2008, 14:22:26

- Project Linked Successfully.

- All files Preprocessed in [ 2s] ms.

- All files Compiled in [ ¢s] ms.

- Linked in[ ¢s] ms.

- Project[ ¢s] completed: [ 5] ms.

COMPILER WARNING MESSAGES

- Illegal file type: [ 2s] .

- Bad or missing fosc parameter. Default value 8MHz used.
- Specified search path do not exisit: [ 2s] .

- Specified include path do not exisit: [ 2s] .

- Result is not defined in function: [ ¢s] .

- Initialization of extern object [ %s] .

- Suspicious pointer conversion.

- Implicit conversion of pointer to int.

- Unknown pragma line ignored: [ ¢s] .

- Implicit conversion of int to ptr.

- Generated baud rate is[ %s) bps (error =[ 2s] percent).

- Unknown memory model [ ¢s] small memory model used instead.
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SOFTWARE SIMULATOR OVERVIEW

The Source-level Software Simulator is an integral component of the mikroC for
8051 environment. It is designed to simulate operations of the 8051 MCUs and
assist the users in debugging C code written for these devices.

After you have successfully compiled your project, you can run the Software
Simulator by selecting Run » Start Debugger from the drop-down menu, or by
clicking the Start Debugger Icon =i from the Debugger Toolbar. Starting the
Software Simulator makes more options available: Step Into, Step Over, Step Out,

Run to Cursor, etc. Line that is to be executed is color highlighted (blue by default).

Note: The Software Simulator simulates the program flow and execution of instruc-
tion lines, but it cannot fully emulate 8051 device behavior, i.e. it doesn’t update
timers, interrupt flags, etc.

Watch Window

The Software Simulator Watch Window is the main Software Simulator window
which allows you to monitor program items while simulating your program. To
show the Watch Window, select View > Debug Windows » Watch from the drop-
down menu.

The Watch Window displays variables and registers of the MCU, along with their
addresses and values.

There are two ways of adding variable/register to the watch list:

- by its real name (variable's name in "C" code). Just select desired variable/reg
ister from Select variable from list drop-down menu and click the Add Button
& Add
- by its name ID (assembly variable name). Simply type name ID of the
variable/register you want to display into Search the variable by assemby

name box and click the Add Button & adgd
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Variables can also be removed from the Watch window, just select the variable that
you want to remove and then click the Remove Button . € remove

- Add All Button 1, addall  adds all variables.
- Remove All Button ' .. Remaove &l removes all variables.

You can also expand/collapse complex variables, i.e. struct type variables,
strings...

Values are updated as you go through the simulation. Recently changed items are
colored red.

Watch ¥Yalues
ERENEN Do eh o0 o] @ i |
H ﬁ apertis b add all

.5 elect variable from list:

TE963C_dataPort 1] 0030
TEDE3C_cnklrsk 1] 0094
TE2E3C_griwidth 0 Q0020

P_= 0x0003FE Cyicle= 560.00
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Double clicking a variable or clicking the Properties Button .+ Properties  opens
the Edit Value window in which you can assign a new value to the selected
variable/register. Also, you can choose the format of variable/register representation
between decimal, hexadecimal, binary, float or character. All representations except
float are unsigned by default. For signed representation click the check box next to
the Signed label.

An item's value can be also changed by double clicking item's value field and typ-
ing the new value directly.

[E] Edit value B

0100 0000 1000 0011 0001 00100110 1111

Fepresentation
iDec i Hex (%1 Bin ) Floak ) Char
Signed L oK, ] [ Cancel ]

Stopwatch Window

The Software Simulator Stopwatch Window is available from the drop-down menu,
View » Debug Windows > Stopwatch.

The Stopwatch Window displays a current count of cycles/time since the last
Software Simulator action. Stopwatch measures the execution time (number of
cycles) from the moment Software Simulator has started and can be reset at any
time. Delta represents the number of cycles between the lines where Software
Simulator action has started and ended.

Note: The user can change the clock in the Stopwatch Window, which will recalcu-
late values for the latest specified frequency. Changing the clock in the Stopwatch
Window does not affect actual project settings — it only provides a simulation.
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Stopwatch (%]
Cyrles: Time:
Current Count; S 2,60 us
Celka: 2 2,40 us
Stopwatch: 8 9,60 us

RAM Window

The Software Simulator RAM Window is available from the drop-down menu,
View > Debug Windows > RAM.

The RAM Window displays a map of MCU’s RAM, with recently changed items
colored red. You can change value of any field by double-clicking it.

RAM X

RAM | History |

e |...01 | . | = | . | =T I = I . | . | = | = | . | = '|'oe | = "I'Ascn ”2
0000 | BC 0o 00 00 OO OO OO OO OO  OD OO0 OO 0o i) 0o 0o =
m 00 00 00 00 00 00 00 00 Q00 00 00 00 00 00 00 00  ..ceeninennanenn
‘&E 0o 0o 00 00 OO OO OO OO ©O OO OO OO ] 0o 0o L1 I I RO
-UC‘TD 00 00 00 00 00 00 00 OO 00 00 00 00 00 00 00 00 ceeciniienniinenn
E 0o 0o 0o 00 | 00 OO OO0 OO0 OD OO0 OO o1 ui] i) ] 0o
E‘ 00 00 00 00 00 00 00 . 00 00 00 00 00 00 00 00 00 ceoereviiiiiinens
_0; uin] 0o 00 00 00 00 00 . 00 | OO 00O 00 | OO0 0o ui] il 00 | crvesrarannanans
E oo 0o 00 00 OO 0D OO0 OO OO OO OO oo 0o i) 0o {1, S RO R RO
‘OE 00 | BC 55 0E 0o 0o | 00 . 00 | 0O | OO 0o oo i} il 0o 0o
‘UE oo oo 0o 0o 0o 00 | 0D | OO | OO | OO 0o i) ] i) 0o 00 | rovvvnavnnvinnss
E ui] . 0o 00 00 00 | 00 | 0O . 00 | 00 | OO i) oo oo ao i) 00 | sosovessevnvnnsa
‘U—C;.U- 0o oo 0o 0o oo 00 | 0D | OO | 00 | OO 0o | 00 il 0o ] D0 | sosniranninanans
E 00 00 00 00 00 OO0 Q00 . 00 00 00 00 00 00 00 00 00 @ ceocceoceiraciiens l"_'
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SOFTWARE SIMULATOR OPTIONS

Name Description

Start Debugger | Start Software Simulator.

Run/Pause .
Debugger Run or pause Software Simulator.

Stop Dbebugger | Stop Software Simulator.

Toggle breakpoint at the current cursor position. To view all
Toggle breakpoints, select Run > View Breakpoints from the
Breakpoints drop—down menu. Double clicking an item in the
Breakpoints Window List locates the breakpoint.

Run to cursor | Execute all instructions between the current instruction and
cursor position.

Execute the current C (single or multi—cycle) instruction,

Step Into then halt. If the instruction is a routine call, enter the routine
and halt at the first instruction following the call.

Step Over Execute the current C (single or multi—cycle) instruction,
then halt.

Step Out Execute all remaining instructions in the current routine,

return and then halt.

Related topics: Run Menu, Debug Toolbar
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CREATING NEW LIBRARY

mikroC for 8051 allows you to create your own libraries. In order to create a library
in mikroC for 8051 follow the steps bellow:

1. Create a new C source file, see Managing Source Files
2. Save the file in the compiler's Uses folder:

DriveName:\ Program Files\Mikroelektronika\mikroC
8051\ Uses\ Lib Example.c

3. Write a code for your library and save it.

4.Add 1ib Example.c file in some project, see Project Manager. Recompile
the project.

5. Compiled file  1ib Example.mcl should appearin .. .\mikroC 8051\ Uses\
folder.

6. Open the definition file for the MCU that you want to use. This file is placed
in the compiler's Defs folder:
DriveName:\ Program Files\Mikroelektronika\mikroC 8051\ Defs\
and it is named MCU NAME.m1k, for example AT8958253.mlk
7.Add the 1ibrary 2lias and Library Name at the end of the definition file,
for example #pragma SetLib ([ Example Library, _ Lib Example])
8. Add Library to mlk file for each MCU that you want to use with your library.
9. Click Refresh button in Library Manager

Multiple Library Versions

Library Alias represents unique name that is linked to corresponding Library .mc1
file. For example UART library for AT89S8253 is different from UART library for
AT89S4051 MCU. Therefore, two different UART Library versions were made, see
m1k files for these two MCUs. Note that these two libraries have the same Library
Alias (UART) in both m1k files. This approach enables you to have identical repre-
sentation of UART library for both MCUs in Library Manager.

Related topics: Library Manager, Project Manager, Managing Source Files
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The following topics cover the specifics of mikroC compiler:

- ANSI Standard Issues

- Predefined Globals and Constants
- Accessing Individual Bits

- Interrupts

- 8051 Pointers

- Linker Directives

- Built-in Routines

- Code Optimization
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ANSI STANDARD ISSUES
Divergence from the ANSI C Standard

Tentative declaration are not supported.
Function recursion is not supported because of no easily-usable stack and limited
memory 8051 Specific

C Language Exstensions

mikroC for 8051 has additional set of keywords that do not belong to the ANSI stan-
dard C language keywords:

- code

- data

- idata
- bdata
- xdata
- pdata
- small
- compact
- large
- at

- sbit

- bit

- sfr

- ilevel

Related topics: Keywords, 8051 Specific
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PREDEFINED GLOBALS AND CONSTANTS

To facilitate programming of 8051 compliant MCUs, the mikroC for 8051 imple-
ments a number of predefined globals and constants.

All 8051 SFR registers are implicitly declared as global variables of volatile
unsigned int. These identifiers have an external linkage, and are visible in the entire
project. When creating a project, the mikroC for 8051 will include an appropriate
(*.c) file from defs folder, containing declarations of available

SFR registers and constants.

PO = 1.

For a complete set of predefined globals and constants, look for “Defs” in the
mikroC for 8051 installation folder, or probe the Code Assistant for specific letters
(Ctrl+Space in the Code Editor).

ACCESSING INDIVIDUAL BITS

The mikroC for 8051 allows you to access individual bits of 8-bit variables. It also
supports sbit and bit data types

Accessing Individual Bits Of Variables

Simply use the direct member selector (.) with a variable, followed by one of iden-
tifiers ro, r1, .., r15 with F15 being the most significant bit.

There is no need of any special declarations. This kind of selective access is an
intrinsic feature of mikroC for 8051 and can be used anywhere in the code.
Identifiers r0-r15 are not case sensitive and have a specific namespace. You may
override them with your own members r0-r15 within any given structure.

If you are familiar with a particular MCU, you can also access bits by name:

// Clear TRISB3
TRISBbits.TRISB3 = 0;

See Predefined Globals and Constants for more information on register/bit names.

Note: If aiming at portability, avoid this style of accessing individual bits, use the
bit fields instead.
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sbit type

The mikroC Compiler have sbit data type which provides access to bit-addressable
SFRs. For example:

sbit LEDA at P0.BO;
sbit name at sfr-name.<Bbit-position>;

The previously declared SFR (sfr-name) is the base address for the sbit. It must be
evenly divisible by 8. The bit-position (which must be a number from 0-7) follows

the dot symbol ('.") and specifies the bit position to access. For example:

sbit OV = PSW.B2;
sbit CY = PSW.B7;

bit type

The mikroC Compiler provides a bit data type that may be used for variable decla-
rations. It can not be used for argument lists, and function-return values.

bit bf; // bit variable
All bit variables are stored in a bit addressable portion 0x20-0x2F segment located
in the internal memory area of the 8051. Because this area is only 16 bytes long, a
maximum of 128 bit variables may be declared within any one scope.
There are no pointers to bit variables:
bit *ptr; // invalid
An array of type bit is not valid:
bit arr [ 5] ; // invalid
Bit variables can not be initialized nor they can be members of structures and

unions.

Related topics: Bit fields, Predefined globals and constants
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INTERRUPTS

8051 derivates acknowledges an interrupt request by executing a hardware generat-
ed LCALL to the appropriate servicing routine ISRs. ISRs are organized in IVT. ISR
is defined as a standard function but with the org directive afterwards which con-
nects the function with specific interrupt vector. For example org 0x000B is IVT
address of Timer 0 Overflow interrupt source of the AT89S8253.

For more information on interrupts and IVT refer to the specific data sheet.

Function Calls from Interrupt

Calling functions from within the interrupt routine is allowed. The compiler takes
care about the registers being used, both in "interrupt" and in "main" thread, and per-
forms "smart" context-switching between them two, saving only the registers that
have been used in both threads. It is not recommended to use function call from
interrupt. In case of doing that take care of stack depth.

Interrupt Priority Level

8051 MCUs has possibilty to assign different priority level trough setting appropri-
ate values to coresponding SFRs. You should also assign ISR same priority level by
ilevel keyword followed by interrupt priority number.

Available interrupt priority levels are: 0 (default), 1, 2 and 3.

void Timer0ISR(void) org 0x000B ilevel 2 {
//set Timer0OISR to be ISR for Timer 0 Overflow priority level 2.
}

Related topics: ANSI standard issues
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LINKER DIRECTIVES

The mikroC uses an internal algorithm to distribute objects within memory. If you
need to have a variable or routine at specific predefined address, use the linker direc-
tives absolute and org.

Directive absolute

Directive absolute specifies the starting address in RAM for a variable. If the vari-
able is multi-byte, higher bytes will be stored at the consecutive locations.

Directive absolute is appended to declaration of a variable:

short x absolute 0x22;
// Variable x will occupy 1 byte at address 0x22

int y absolute 0x23;
// Variable y will occupy 2 bytes at addresses 0x23 and 0x24

Be careful when using the absolute directive, as you may overlap two variables by
accident. For example:

char i absolute 0x33;
// Variable i will occupy 1 byte at address 0x33

long jjjj absolute 0x30;

// Variable will occupy 4 bytes at 0x30, 0x31, 0x32, 0x33; thus,
// changing i changes jjjj highest byte at the same time, and
vice versa

Directive org
Directive org specifies a starting address of a routine in ROM.

Directive org is appended to the function definition. Directives applied to non-defin-
ing declarations will be ignored, with an appropriate warning issued by the linker.

Here is a simple example:
void func(int par) org 0x200 {

// Function will start at address 0x200
nop;

Note: See also funcall pragma.

102 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 3
mikroC for 8051 Specifics

INDIRECT FUNCTION CALLS

If the linker encounters an indirect function call (by a pointer to function), it assumes
that any of the functions addresses of which were taken anywhere in the program,
can be called at that point. Use the #pragma funcall directive to instruct the linker
which functions can be called indirectly from the current function:

#pragma funcall <func name> <called func>[, <called func>,...]
A corresponding pragma must be placed in the source module where the function
func name is implemented. This module must also include declarations of all func-

tions listed in the called func list.

These functions will be linked if the function func name is called in the code no
matter whether any of them was called or not.

Note: The #pragma funcall directive can help the linker to optimize function frame
allocation in the compiled stack.

BUILT-IN ROUTINES

The mikroC for 8051 compiler provides a set of useful built-in utility functions.
The 1o, Hi, Higher, Highest routines are implemented as macros. If you want
to use these functions you must include bui 1t in.h header file (located in the in1-

clude folder of the compiler) into your project.

The pelay us and Delay ms routines are implemented as “inline”; i.e. code is gen-
erated in the place of a call, so the call doesn’t count against the nested call limit.

The vdelay ms, Delay Cycand Get Fosc kHz are actual C routines. Their sources
can be found in pelays.c file located in the uses folder of the compiler.

-Lo - Delay us - Clock Khz

- Hi - Delay ms - Clock_Mhz

- Higher - Vdealy ms - Get Fosc khz
- Highest - Delay Cyc
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Lo
Prototype unsigned short Lo (long number);
Returns Lowest 8 bits (byte)of number, bits 7..0.
Description Function returns the lowest byte of number. Function does

not interpret bit patterns of number — it merely returns 8 bits
as found in register.

This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call
limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic
Types and Pointers).

Examp]e d = 0x1AC30F4;
tmp = Lo(d); // Equals 0xF4
Hi
Prototype unsigned short Hi (long number) ;
Returns Returns next to the lowest byte of number, bits 8..15.
Description Function returns the lowest byte of number. Function does

not interpret bit patterns of number — it merely returns 8 bits
as found in register.

This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call
limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic
Types and Pointers).

Example d = 0x1AC30F4;
tmp = Hi(d); // Equals 0x30
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Higher
Prototype unsigned short Higher (long number) ;
Returns Returns next to the highest byte of nunber, bits 16..23.
Description Function returns next to the highest byte of number. Function

does not interpret bit patterns of number — it merely returns 8
bits as found in register.

This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call
limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic
Types and Pointers).

Example d = Ox1AC30F4;
tmp = Higher(d); // Equals O0xAC
Highest
Prototype unsigned short Highest (long number) ;
Returns Returns the highest byte of number, bits 24..31.
Description Function returns next to the highest byte of number. Function

does not interpret bit patterns of number — it merely returns 8
bits as found in register.

This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call
limit.

Requires Arguments must be variable of scalar type (i.e. Arithmetic
Types and Pointers).

Example d = 0x1AC30F4;
tmp = Highest(d); // Equals 0x01
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Delay_us
Prototype void Delay us(const unsigned long time in us);
Returns Nothing.
Description Creates a software delay in duration of time in us

microseconds (a constant). Range of applicable constants
depends on the oscillator frequency.

This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call

limit.
Requires Nothing
Example Delay us(1000); /* One millisecond pause */
Delay_ms

Prototype void Delay ms(const unsigned long time in us);

Returns Nothing.

Description Creates a software delay in duration of time in ms
microseconds (a constant). Range of applicable constants
depends on the oscillator frequency.

This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call
limit.

Requires Nothing

Example Delay ms(1000); /* One millisecond pause */
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Vdelay_ms
Prototype void Vdelay ms(unsigned time in ms);
Returns Nothing.
Description Creates a software delay in duration of time in ms millisec-

onds (a variable). Generated delay is not as precise as the
delay created by pelay ms.

Note that vdelay ms is library function rather than a built-in
routine; it is presented in this topic for the sake of conven-

ience.

Requires Nothing

Example pause 1000;
VA
Vdelay ms (pause); // ~ one second pause

Delay_Cyc

Prototype void Delay Cyc(char Cycles div by 10);

Returns Nothing.

Description Creates a delay based on MCU clock. Delay lasts for 10
times the input parameter in MCU cycles.
Note that belay cyc is library function rather than a built-in
routine; it is presented in this topic for the sake of conven-
ience. There are limitations for cycles div by 10 value.
Value cycles div by 10 must be between 2 and 257.

Requires Nothing

Example Delay Cyc(10); /* Hundred MCU cycles pause */
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Clock_Khz
Prototype unsigned Clock Khz(void) ;
Returns Device clock in KHz, rounded to the nearest integer.
Description Function returns device clock in KHz, rounded to the nearest
integer.

This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call

limit.

Requires Nothing

Example Delay Cyc(10); /* Hundred MCU cycles pause */

Clock_Mhz

Prototype unsigned short Clock Mhz(void) ;

Returns Device clock in MHz, rounded to the nearest integer.

Description Function returns device clock in MHz, rounded to the nearest
integer.
This is an “inline” routine; code is generated in the place of
the call, so the call doesn’t count against the nested call
limit.

Requires Nothing

Examp]e clk = Clock Mhz();
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Get_Fosc_kHz

Prototype unsigned long Get Fosc kHz(void);

Returns Device clock in KHz, rounded to the nearest integer.

Description Function returns device clock in KHz, rounded to the nearest
integer.

Note that cet rosc kiz is library function rather than a
built-in routine; it is presented in this topic for the sake of

convenience.
Requires Nothing
Example clk = Clock Khz();

CODE OPTIMIZATION

Optimizer has been added to extend the compiler usability, cut down the amount of
code generated and speed-up its execution. The main features are:

Constant folding

All expressions that can be evaluated in the compile time (i.e. are constant) are being
replaced by their results. (3 + 5 -> 8);

Constant propagation
When a constant value is being assigned to a certain variable, the compiler recog-

nizes this and replaces the use of the variable by constant in the code that follows,
as long as the value of a variable remains unchanged.

Copy propagation

The compiler recognizes that two variables have the same value and eliminates one
of them further in the code.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 109



CHAPTER 3
Specifics mikroC for 8051

Value numbering

The compiler "recognizes" if two expressions yield the same result and can there-
fore eliminate the entire computation for one of them.

"Dead code" ellimination

The code snippets that are not being used elsewhere in the programme do not affect
the final result of the application. They are automatically removed.

Stack allocation

Temporary registers ("Stacks") are being used more rationally, allowing VERY com-
plex expressions to be evaluated with a minimum stack consumption.

Local vars optimization

No local variables are being used if their result does not affect some of the global or
volatile variables.

Better code generation and local optimization

Code generation is more consistent and more attention is payed to implement spe-
cific solutions for the code "building bricks" that further reduce output code size.
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8051 SPECIFICS
Types Efficiency

First of all, you should know that 8051 ALU, which performs arithmetic operations,
is optimized for working with bytes. Although mikroC is capable of handling very
complex data types, 8051 may choke on them, especially if you are working on
some of the older models. This can dramatically increase the time needed for per-
forming even simple operations. Universal advice is to use the smallest possible
type in every situation. It applies to all programming in general, and doubly so with
microcontrollers. Types efficiency is determined by the part of RAM memory that
is used to store a variable/constant. See the example.

Nested Calls Limitations

There are no Nested Calls Limitations, except by RAM size. A Nested call repre-
sents a function call to another function within the function body. With each func-
tion call, the stack increases for the size of the returned address. Number of nested
calls is equel to the capacity of RAM which is left out after allocation of all vari-
ables.

Note: There are many different types of derivates, so it is necessary to be familiar
with characteristics and special features of the microcontroller in you are using.
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8051 MEMORY ORGANIZATION

The 8051 microcontroller's memory is divided into Program Memory and Data
Memory. Program Memory (ROM) is used for permanent saving program being
executed, while Data Memory (RAM) is used for temporarily storing and keeping
intermediate results and variables.

Program Memory (ROM)

Program Memory (ROM) is used for permanent saving program (CODE) being exe-
cuted. The memory is read only. Depending on the settings made in compiler, pro-
gram memory may also used to store a constant variables. The 8051 executes pro-
grams stored in program memory only. code memory type specifier is used to refer
to program memory.

8051 memory organization alows external program memory to be added.
How does the microcontroller handle external memory depends on the pin EA log-
ical state.

Address FFFF hex

EA pin=1

EA pin=0 Additional ROM
‘ Memory
(64K max.)

Address FFFF hex

External ROM
Memory

Address 4000 hex

(L e, Address 3FFF hex

Embedded ROM
Memory

Microcontroller
8051
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Internal Data Memory

Up to 256 bytes of internal data memory are available depending on the 8051 deriv-
ative. Locations available to the user occupy addressing space from 0 to 7Fh, i.e.
first 128 registers and this part of RAM is divided in several blocks. The first 128
bytes of internal data memory are both directly and indirectly addressable. The
upper 128 bytes of data memory (from 0x80 to 0xFF) can be addressed only indi-
rectly.

Since internal data memory is used for CALL stack also and there is only 256 bytes
splited over few different memory areas fine utilizing of this memory is crucial for
fast and compact code. See types efficiency also.

Memory block in the range of 20h to 2Fh is bit-addressable, which means that each
bit being there has its own address from 0 to 7Fh. Since there are 16 such registers,
this block contains in total of 128 bits with separate addresses ( Bit 0 of byte 20h
has the bit address 0, and bit 7 of byte 2Fh has the bit address 7Fh).

Three memory type specifiers can be used to refer to the internal data memory: data,
idata, and bdata.

_________________________‘\
/ . Acgessed by Accessed by Accessed by
direct and indirect di dd . indi dd F
addressing irect addressing indirect addressing
00 hex| 1 80 hex | |
Bank 0
Bank 1
Bank 2
Bank 3

1F hex

16 bit addressable q"b
registers \

Z
A
2 |
:‘%
3 __
2%
O‘GQ P
0@

2F hex \’\ \9 “
o >
o° !‘@Q o°
80 free
registers
RAM memory |
e s
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External Data Memory

Access to external memory is slower than access to internal data memory. There
may be up to 64K Bytes of external data memory. Several 8051 devices provide on-
chip XRAM space that is accessed with the same instructions as the traditional
external data space. This XRAM space is typically enabled via proper setting of SFR
register and overlaps the external memory space. Setting of that register must be
manualy done in code, before any access to external memory or XRAM space is
made.

The mikroC for 8051 has two memory type specifiers that refers to external memo-
Iy space: xdata and pdata.

SFR Memory

The 8051 provides 128 bytes of memory for Special Function Registers (SFRs).
SFRs are bit, byte, or word-sized registers that are used to control timers, counters,
serial I/O, port I/O, and peripherals.

Refer to Special Function Registers for more information. See sbit also.

Related topics: Accessing individual bits, SFRs, Memory type specifiers, Memory
models
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MEMORY MODELS

The memory model determines the default memory type to use for function argu-
ments, automatic variables, and declarations that include no explicit memory type.
The mikroC for 8051 provides three memory models:

- Small
- Compact
- Large

You may also specify the memory model on a function-by-function basis by adding
the memory model to the function declaration.

Small memory model generates the fastest, most efficient code. This is default mem-
ory model. You may override the default memory type imposed by the memory
model by explicitly declaring a variable with a memory type specifier.

Small model

In this model, all variables, by default, reside in the internal data memory of the
8051 system—as if they were declared explicitly using the dat2 memory type spec-
ifier.

In this memory model, variable access is very efficient. However, all objects (that
are not explicitly located in another memory area) and the call stack must fit into the
internal RAM.

Call Stack size is critical because the stack space used depends on the nesting depth
of the various functions.

Compact model

Using the compact model, by default, all variables are allocated in a single page 256
bytes of external data memory of the 8051 system—as if they were explicitly
declared using the pdata memory type specifier. This memory model can accom-
modate a maximum of 256 bytes of variables. The limitation is due to the address-
ing scheme used which is indirect through registers RO and R1 (@RO0, @R1). This
memory model is not as efficient as the small model and variable access is not as
fast. However, the compact model is faster than the large model. mikroC for 8051
uses the @R0 and @R1 operands to acess external memory with instructions that
use 8 bit wide pointers and provide only the low-order byte of the address. The high-
order address byte (or page) is provided by Port 2 on most 8051 derivates (see data
sheet for details).
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Large model

In the large model all variables reside in external data memory (which may be up to
64K Bytes). This is the same as if they were explicitly declared using the xdata
memory type specifier. The DPTR is used to address external memory. Instruction
set is not optimized for this memory model(access to external memory) so it neeeds
more code than the small or compact model to manipulate with the variables.

char xadd(char al,char a2 ) large{ //allocate parameters and
local variables in xdata space
return al + a2;

}

Related topics: Memory type specifiers, 8051 Memory Organization, Accessing
individual bits, SFRs, Project Settings

MEMORY TYPE SPECIFIERS

The mikroC for 8051 supports usage of all memory areas. Each variable may be
explicitly assigned to a specific memory space by including a memory type specifi-
er in the declaration, or implicitly assigned (based on a memory model).

The following memory type specifiers can be used:

- code
- data
- idata
- bdata
- xdata

- pdata

Memory type specifiers can be included in svariable declaration.
For example:

char data data buffer;
// puts data buffer in data ram
const char code txt[] = "ENTER PARAMETER:";

// puts text in program memory
unsigned long xdata arrayl[ 100] ;
// puts array in external memory
float idata ibuffer;
// puts ibuffer in idata ramm
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If no memory type is specified for a variable, the compiler locates the variable in the
memory space determined by the memory model: Small, Compact, or Large.

code
Description Program memory (64 KBytes); accessed by opcode MOVC
@A+DPTR.
The code memory type may be used for constants and func-
tions. This memory is accessed using 16-bit addresses and
may be on-chip or external.
Exan“Me // puts txt in program memory
const char code txt[] = "ENTER PARAMETER:";
data
Description Directly addressable internal data memory; fastest access to
variables (128 bytes).
This memory is directly accessed using 8-bit addresses and
is the on-chip RAM of the 8051. It has the shortest (fastest)
access time but the amount of data is limited in size (to 128
bytes or less).
Example // puts x in data ram
unsigned char data x;
idata
Description Indirectly addressable internal data memory; accessed across
the full internal address space (256 bytes).
This memory is indirectly accessed using 8-bit addresses and
is the on-chip RAM of the 8051. The amount of idata is lim-
ited in size (to 128 bytes or less) it is upper 128 addresses of
RAM
Example // puts x in data ram
unsigned char data x;
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bdata

Description Bit-addressable internal data memory; supports mixed bit
and byte access (16 bytes).

This memory is directly accessed using 8-bit addresses and
is the on-chip bit-addressable RAM of the 8051. Variables
declared with the bdata type are bit-addressable and may be
read and written using bit instructions.

For more information about the bdata type refer to the
Accessing Individual Bits.

Example // puts x in data ram
unsigned char data x;

xdata

Description External data memory (64 KBytes); accessed by opcode
MOVX @DPTR.

This memory is indirectly accessed using 16-bit addresses
and is the external data RAM of the 8051. The amount of
xdata is limited in size (to 64K or less).

Example // puts x in data ram
unsigned char data x;
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pdata
Description Paged (256 bytes) external data memory; accessed by

opcode MOVX @Rn.

This memory is indirectly accessed using 8-bit addresses and
is one 256-byte page of external data RAM of the 8051. The
amount of pdata is limited in size (to 256 bytes).

Example // puts x in data ram
unsigned char data x;

Related topics: 8051 Memory Organization, Memory models, Accessing individual
bits, SFRs, Constants, Functions
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MIKROC LANGUAGE REFERENCE
LEXICAL ELEMENTS OVERVIEW

The following topics provide a formal definition of the mikroC for 8051 lexical ele-
ments. They describe different categories of word-like units (tokens) recognized by
the mikroC for 8051.

In the tokenizing phase of compilation, the source code file is parsed (that is, bro-
ken down) into tokens and whitespace. The tokens in the mikroC for 8051 are
derived from a series of operations performed on your programs by the compiler and
its built-in preprocessor.
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WHITESPACE

Whitespace is a collective name given to spaces (blanks), horizontal and vertical
tabs, newline characters and comments. Whitespace can serve to indicate where
tokens start and end, but beyond this function, any surplus whitespace is discarded.
For example, two sequences

int i; float f;
and

int

float f;
are lexically equivalent and parse identically to give six tokens:

int

i

float
f

Whitespace in Strings

The ASCII characters representing whitespace can occur within string literals. In
that case they are protected from the normal parsing process (they remain as a part
of the string). For example,

char name[] = "mikro foo";
parses into seven tokens, including a single string literal token:

char
name
[
1

"mikro foo" /* just one token here! */
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Line Splicing with Backslash (\)

A special case occurs if a line ends with a backslash (\). Both backslash and new line
character are discarded, allowing two physical lines of a text to be treated as one
unit. So, the following code

"mikroC \

Compiler"
parses into "mikroC Compiler". Refer to String Constants for more information.
COMMENTS

Comments are pieces of a text used to annotate a program and technically are anoth-
er form of whitespace. Comments are for the programmer’s use only; they are
stripped from the source text before parsing. There are two ways to delineate com-
ments: the C method and the C++ method. Both are supported by mikroC for 8051.

You should also follow the guidelines on the use of whitespace and delimiters in
comments, discussed later in this topic to avoid other portability problems.

C comments
C comment is any sequence of characters placed after the symbol pair /= . The com-
ment terminates at the first occurance of the pair ~ / following the initial /= . The
entire sequence, including four comment-delimiter symbols, is replaced by one
space after macro expansion.
In the mikroC for 8051,

int /* type */ i /* identifier */;
parses as:

int i;
Note that the mikroC for 8051 does not support a nonportable token pasting strate-

gy using /** /. For more information on token pasting, refer to the Preprocessor
Operators.
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C++ comments

The mikroC for 8051 allows single-line comments using two adjacent slashes (//) .
The comment can start in any position and extends until the next new line.

The following code

int i; // this is a comment
int j;

parses as:

int i;
int j;

Nested comments

ANSI C doesn’t allow nested comments. The attempt to nest a comment like this
/* int /* declaration */ i; */

fails, because the scope of the first /+ ends at the first » /. This gives us
i */

which would generate a syntax error.
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TOKENS

Token is the smallest element of a C program that compiler can recognize. The pars-
er separates tokens from the input stream by creating the longest token possible
using the input characters in a left—to—right scan.

The mikroC for 8051 recognizes the following kinds of tokens:

- keywords
- identifiers
- constants
- operators

punctuators (also known as separators)
Tokens can be concatenated (pasted) by means of the preprocessor operator ##. See
the Preprocessor Operators for details.

Token Extraction Example

Here is an example of token extraction. Take a look at the following example code
sequence:

inter = a+++b;

First, note that inter would be parsed as a single identifier, rather than as the key-
word int followed by the identifier er.

The programmer who has written the code might have intended to write inter = =
+ (++b), but it wouldn’t work that way. The compiler would parse it into the seven
following tokens:

inter // variable identifier
= // assignment operator

a // variable identifier

++ // postincrement operator
+ // addition operator

b // variable identifier

; // statement terminator
Note that +++ parses as ++ (the longest token possible) followed by - .
According to the operator precedence rules, our code sequence is actually:

inter (a++)+b;
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CONSTANTS
Constants or literals are tokens representing fixed numeric or character values.
The mikroC for 8051 supports:

- integer constants

- floating point constants

- character constants

- string constants (strings literals)
- enumeration constants

The data type of a constant is deduced by the compiler using such clues as a numer-
ic value and format used in the source code.

INTEGER CONSTANTS

Integer constants can be decimal (base 10), hexadecimal (base 16), binary (base 2),
or octal (base 8). In the absence of any overriding suffixes, the data type of an inte-
ger constant is derived from its value.

Long and Unsigned Suffixes

The suffix 1 (or 1) attached to any constant forces that constant to be represented as
a long. Similarly, the suffix v (or u) forces a constant to be unsigned. Both 1. and U
suffixes can be used with the same constant in any order or case: u1, Lu, UL, etc.

In the absence of any suffix (U, u, 1, or 1), a constant is assigned the “smallest” of

the following types that can accommodate its value: short, unsigned short,
int, unsigned int, long int, unsigned long int.

Otherwise:

- If a constant has the U suffix, its data type will be the first of the following that
can accommodate its value: unsigned short, unsigned int, unsigned
long int.

- If a constant has the L suffix, its data type will be the first of the following that
can accommodate its value: 1ong int, unsigned long int.

- If a constant has both L and U suffixes, (LU or UL), its data type will be

unsigned long int.
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Decimal

Decimal constants from -2147483648 to 4294967295 are allowed. Constants
exceeding these bounds will produce an “Out of range” error. Decimal constants
must not use an initial zero. An integer constant that has an initial zero is interpret-
ed as an octal constant. Thus,

int i = 10; /* decimal 10 */
int 1 = 010; /* decimal 8 */
int 1 = 0; /* decimal 0 = octal 0 */

In the absence of any overriding suffixes, the data type of a decimal constant is
derived from its value, as shown below:

Value Assigned to Constant Assumed Type
<-2147483648 Error: Out of range!
-2147483648 — -32769 long

-32768 — -129 int

-128 — 127 short

128 — 255 unsigned short
256 — 32767 int

32768 — 65535 unsigned int
65536 — 2147483647 long

2147483648 — 4294967295 unsigned long

> 4294967295 Error: Out of range!

Hexadecimal

All constants starting with 0x (or 0x) are taken to be hexadecimal. In the absence of
any overriding suffixes, the data type of an hexadecimal constant is derived from its
value, according to the rules presented above. For example, 0xc367 will be treated
as unsigned int.
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Binary

All constants starting with 0b (or 0&) are taken to be binary. In the absence of any
overriding suffixes, the data type of an binary constant is derived from its value,
according to the rules presented above. For example, ob11101 will be treated as
short.

Octal

All constants with an initial zero are taken to be octal. If an octal constant contains
the illegal digits 8 or 9, an error is reported. In the absence of any overriding suffix-
es, the data type of an octal constant is derived from its value, according to the rules
presented above. For example, 0777 will be treated as int.

FLOATING POINT CONSTANTS
A floating-point constant consists of:

- Decimal integer

- Decimal point

- Decimal fraction

- e or & and a signed integer exponent (optional)
- Type suffix: £ or = or 1 or L. (optional)

Either decimal integer or decimal fraction (but not both) can be omitted. Either dec-
imal point or letter e (or =) with a signed integer exponent (but not both) can be
omitted. These rules allow conventional and scientific (exponent) notations.

Negative floating constants are taken as positive constants with an unary operator
minus (-) prefixed.

The mikroC for 8051 limits floating-point constants to the range £1.17549435082 *
10-38 .. £6.80564774407 * 1038.

Here are some examples:

0. // = 0.0

-1.23 // = -1.23
23.45e6 // = 23.45 * 10"6
2e-5 // = 2.0 * 10"-5
3E+10 // = 3.0 * 10710

.09E34 // = 0.09 * 10734

The mikroC for 8051 floating-point constants are of the type double. Note that the
mikroC for 8051°s implementation of ANSI Standard considers f1oat and double
(together with the 10ng double variant) to be the same type.
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CHARACTER CONSTANTS

A character constant is one or more characters enclosed in single quotes, such as
‘A', '+', or "\n'.In the mikroC for 8051, single-character constants are of the
unsigned int type. Multi-character constants are referred to as string constants or
string literals. For more information refer to String Constants.

Escape Sequences

A backslash character (\) is used to introduce an escape sequence, which allows a
visual representation of certain nongraphic characters. One of the most common
escape constants is the newline character (\n).

A backslash is used with octal or hexadecimal numbers to represent an ASCII sym-
bol or control code corresponding to that value; for example, '\ x37' for the ques-
tion mark. Any value within legal range for data type char (0 to 0xrr for the mikroC
for 8051) can be used. Larger numbers will generate the compiler error “Out of
range”.

For example, the octal number \ 777 is larger than the maximum value allowed
(\377) and will generate an error. The first nonoctal or nonhexadecimal character
encountered in an octal or hexadecimal escape sequence marks the end of the
sequence.

Note: You must use the sequence \\ to represent an ASCII backslash, as used in
operating system paths.

The following table shows the available escape sequences:
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Sequence Value Char What it does

\a 0x07 BEL Audible bell

\b 0x08 BS Backspace

\ £ 0x0C FF Formfeed

\n 0x0A LF Newline (Linefeed)

\r 0x0D CR Carriage Return

\t 0x09 HT Tab (horizontal)

\v 0x0B VT Vertical Tab

AN\ 0x5C \ Backslash

\ 0x27 ‘ Single quote (Apostrophe)
\ " 0x22 « Double quote

\? 0x3F ? Question mark

\O any O = string of up to 3 octal digits
\ xH any H = string of hex digits

\ XH any H = string of hex digits

Disambiguation

Some ambiguous situations might arise when using escape sequences.

Here is an example:

Led Out Cp("\x091.0 Intro");

This is intended to be interpreted as \ =09 and "1.0 Intro". However, the mikroC
for 8051 compiles it as the hexadecimal number \ =091 and literal string ".0
Tntro". To avoid such problems, we could rewrite the code in the following way:

Led Out Cp("\x09"™ "1.0 Intro");

For more information on the previous line, refer to String Constants.

Ambiguities might also arise if an octal escape sequence is followed by a nonoctal

digit. For example, the following constant:

"\118"

would be interpreted as a two-character constant made up of the characters \ 11 and
8, because ¢ is not a legal octal digit.
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STRING CONSTANTS

String constants, also known as string literals, are a special type of constants which
store fixed sequences of characters. A string literal is a sequence of any number of
characters surrounded by double quotes:

"This is a string."
The null string, or empty string, is written like " . A literal string is stored internal-
ly as a given sequence of characters plus a final null character. A null string is stored

as a single null character.

The characters inside the double quotes can include escape sequences. This code, for
example:

"\ t\ "Name\ "\\\ tAddress\n\n"
prints like this:
"Name"\ Address
The "Name" is preceded by two tabs; The Address is preceded by one tab. The line
is followed by two new lines. The \ " provides interior double quotes. The escape

character sequence \\ is translated into \ by the compiler.

Adjacent string literals separated only by whitespace are concatenated during the
parsing phase. For example:

"This is " "just"

" an example."
is equivalent to
"This is just an example."
Line Continuation with Backslash

You can also use the backslash (\) as a continuation character to extend a string
constant across line boundaries:

"This is really \

a one-line string."
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ENUMERATION CONSTANTS

Enumeration constants are identifiers defined in enum type declarations. The identi-
fiers are usually chosen as mnemonics to contribute to legibility. Enumeration con-
stants are of int type. They can be used in any expression where integer constants
are valid.

For example:
enum weekdays { SUN = 0, MON, TUE, WED, THU, FRI, SAT };

The identifiers (enumerators) used must be unique within the scope of the enum dec-
laration. Negative initializers are allowed. See Enumerations for details about enum
declarations.

POINTER CONSTANTS

A pointer or pointed-at object can be declared with the const modifier. Anything
declared as const cannot change its value. It is also illegal to create a pointer that
might violate a non-assignability of the constant object.

Consider the following examples:

int i; // 1 1is an 1int
int * pi; // pi 1is a pointer to int
(uninitialized)
int * const cp = &i; // cp 1s a constant pointer to
int
const int ci = 7; // ci 1s a constant int
const int * pci; // pci 1is a pointer to constant
int
const int * const cpc = &ci; // cpc 1s a constant pointer
to a

/7 constant int

The following assignments are legal:

i = ci; // Assign const-int to int
*cp = ci; // Assign const-int to

// object-pointed-at-by-a-
const-pointer
++pci; // Increment a pointer-to-const
pci = cpc; // Assign a const-pointer-to-a-

const to a
// pointer-to-const
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The following assignments are illegal:

ci = 0; // NO--cannot assign to a const-int
ci--; // NO--cannot change a const-int
*pci = 3; // NO--cannot assign to an object
// pointed at by pointer-to-const.
cp = &ci; // NO--cannot assign to a const-pointer,
// even 1f value would be unchanged.
cpc++; // NO--cannot change const-pointer
pi = pci; // NO--if this assignment were allowed,
// you would be able to assign to *pci
// (a const value) by assigning to *pi.

Similar rules are applayed to the volatile modifier. Note that both const and
volatile can appear as modifiers to the same identifier.

CONSTANT EXPRESSIONS

A constant expressions can be evaluated during translation rather that runtime and
accordingly may be used in any place that a constant may be.

Constant expressions can consist only of the following:

- literals,

- enumeration constants,

- simple constants (no constant arrays or structures),
- sizeof operators.

Constant expressions cannot contain any of the following operators, unless the oper-
ators are contained within the operand of a sizeof operator: assignment, comma,
decrement, function call, increment.

Each constant expression can evaluate to a constant that is in the range of repre-
sentable values for its type.

Constant expression can be used anywhere a constant is legal.

134 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 5
mikroC for 8051 Language Reference

KEYWORDS

Keywords are words reserved for special purposes and must not be used as normal
identifier names.

Beside standard C keywords, all relevant SFR are defined as global variables and
represent reserved words that cannot be redefined (for example: Tvr0O, pCL, etc).
Probe the Code Assistant for specific letters (Ctrl+Space in Editor) or refer to
Predefined Globals and Constants.

Here is an alphabetical listing of keywords in C:

- asm
- auto

- break

- case

- char

- const

- continue
- default
- do

- double

- else

- enum

- extern

- float

- for

- goto

- 1if

- int

- long

- register
- return

- short

- signed

- sizeof

- static

- struct

- switch

- typedef
- union

- unsigned
- void

- volatile
- while

Also, the mikroC for 8051 includes a number of predefined identifiers used in
libraries. You could replace them by your own definitions, if you want to develop
your own libraries. For more information, see mikroC for 8051 Libraries.
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IDENTIFIERS

Identifiers are arbitrary names of any length given to functions, variables, symbolic
constants, user-defined data types, and labels. All these program elements will be
referred to as objects throughout the help (don't get confused with the meaning of
object in object-oriented programming).

e

Identifiers can contain the letters a to z and A to Z, underscore character “ ”, and
digits 0 to 9. The only restriction is that the first character must be a letter or an
underscore.

Case Sensitivity

The mikroC for 8051 identifiers are not case sensitive by default, so that sum, sum,
and sum represent an equivalent identifier. Case sensitivity can be activated or sus-
pended in Output Settings window. Even if case sensitivity is turned off Keywords
remain case sensitive and they must be written in lower case.

Uniqueness and Scope

Although identifier names are arbitrary (according to the stated rules), if the same
name is used for more than one identifier within the same scope and sharing the
same name space then error arises. Duplicate names are legal for different name
spaces regardless of scope rules. For more information on scope, refer to Scope and
Visibility.

Identifier Examples

Here are some valid identifiers:

temperature V1
Pressure

no hit
dat2string
SUM3

_vtext..

and here are some invalid identifiers:

7temp // NO -- cannot begin with a numeral

$higher // NO -- cannot contain special characters

int // NO -- cannot match reserved word

323.07.04 // NO -- cannot contain special characters (dot)
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PUNCTUATORS
The mikroC for 8051 punctuators (also known as separators) are:

- [ ] — Brackets

- () — Parentheses
- { } — Braces

-, — Comma

- ; — Semicolon

- :—Colon

- * — Asterisk

- =— Equal sign

- # — Pound sign

Most of these punctuators also function as operators.

Brackets

Brackets [ | indicate single and multidimensional array subscripts:
char ch, str[] = "mikro";

int mat[ 3] 4] ; /* 3 x 4 matrix */

ch = strf 3] ; /* 4th element */Parentheses
Parentheses

() are used to group expressions, isolate conditional expressions, and indicate func-
tion calls and function parameters:

d=c¢c* (a + b); /* override normal precedence */

if (d == z) ++x; /* essential with conditional statement */
func () ; /* function call, no args */

void func2 (int n); /* function declaration with parameters */

Parentheses are recommended in macro definitions to avoid potential precedence
problems during an expansion:

#define CUBE (x) ((x) * (x) * (x))

For more information, refer to Operators Precedence And Associativity and
Expressions.
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Braces
Braces { } indicate the start and end of a compound statement:

if (d == z) {
++x;
func () ;

}
Closing brace serves as a terminator for the compound statement, so a semicolon is
not required after }, except in structure declarations. Sometimes, the semicolon can
be illegal, as in
if (statement)

{ ...} /* illegal semicolon! */

else
{ ...}t

For more information, refer to the Compound Statements.

Comma

Comma (,) separates the elements of a function argument list:

void func(int n, float f, char ch);

Comma is also used as an operator in comma expressions. Mixing two uses of

comma is legal, but you must use parentheses to distinguish them. Note that (expl,
exp2) evalutates both but is equal to the second:

func (i, Jj): /* call func with two args */
func ((expl, exp2), (exp3, expid, expb)); /* also calls func with two
args! */

Semicolon

Semicolon (;) is a statement terminator. Any legal C expression (including the empty
expression) followed by a semicolon is interpreted as a statement, known as an
expression statement. The expression is evaluated and its value is discarded. If the
expression statement has no side effects, the mikroC for 8051 might ignore it.

a + b; /* Evaluate a + b, but discard value */
++a; /* Side effect on a, but discard value of ++a */
; /* Empty expression, or a null statement */
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Semicolons are sometimes used to create an empty statement:
for (1 = 0; 1 < n; i++)

For more information, see the Statements.

Colon
Use colon (:) to indicate the labeled statement:
start: x = 0;

goé;istart;

Labels are discussed in the Labeled Statements.

Asterisk (Pointer Declaration)

Asterisk (*) in a variable declaration denotes the creation of a pointer to a type:
char *char ptr; /* a pointer to char is declared */

Pointers with multiple levels of indirection can be declared by indicating a pertinent
number of asterisks:

int **int ptr; /* a pointer to an array of integers */
double ***double ptr; /* a pointer to a matrix of doubles */

You can also use asterisk as an operator to either dereference a pointer or as multi-
plication operator:

i = *int ptr;
a=>b * 3.14;

For more information, see the Pointers.
Equal Sign
Equal sign (=) separates variable declarations from initialization lists:

int test[ 5] ={ 1, 2, 3, 4, 5 };
int x = 5;

Equal sign is also used as an assignment operator in expressions:
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int a, b, c¢;
a=>b + c;

For more information, see Assignment Operators.
Pound Sign (Preprocessor Directive)

Pound sign (#) indicates a preprocessor directive when it occurs as the first non-
whitespace character on a line. It signifies a compiler action, not necessarily associ-
ated with a code generation. See the Preprocessor Directives for more information.

# and ## are also used as operators to perform token replacement and merging dur-
ing the preprocessor scanning phase. See the Preprocessor Operators.

CONCEPTS

This section covers some basic concepts of language, essential for understanding of
how C programs work. First, we need to establish the following terms that will be
used throughout the help:

- Objects and lvalues
- Scope and Visibility
- Name Spaces

- Duration

OBJECTS

An object is a specific region of memory that can hold a fixed or variable value (or
set of values). This use of a term object is different from the same term, used in
object-oriented languages, which is more general. Our definiton of the word would
encompass functions, variables, symbolic constants, user-defined data types, and
labels.

Each value has an associated name and type (also known as a data type). The name
is used to access the object and can be a simple identifier or complex expression that
uniquely refers the object.
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Objects and Declarations

Declarations establish a necessary mapping between identifiers and objects. Each
declaration associates an identifier with a data type.

Associating identifiers with objects requires each identifier to have at least two
attributes: storage class and type (sometimes referred to as data type). The mikroC
for 8051 compiler deduces these attributes from implicit or explicit declarations in
the source code. Usually, only the type is explicitly specified and the storage class
specifier assumes the automatic value auto.

Generally speaking, an identifier cannot be legally used in a program before its dec-
laration point in the source code. Legal exceptions to this rule (known as forward
references) are labels, calls to undeclared functions, and struct or union tags.

The range of objects that can be declared includes:

- Variables

- Functions

- Types

- Arrays of other types

- Structure, union, and enumeration tags
- Structure members

- Union members

- Enumeration constants

- Statement labels

- Preprocessor macros

The recursive nature of the declarator syntax allows complex declarators. You’ll
probably want to use typedefs to improve legibility if constructing complex objects.

Lvalues

Lvalue is an object locator: an expression that designates an object. An example of
lvalue expression is * P, where P is any expression evaluating to a non-null pointer.
A modifiable lvalue is an identifier or expression that relates to an object that can be
accessed and legally changed in memory. A const pointer to a constant, for example,
is not a modifiable lvalue. A pointer to a constant can be changed (but its derefer-
enced value cannot).
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Historically, | stood for “left”, meaning that Ivalue could legally stand on the left
(the receiving end) of an assignment statement. Now only modifiable Ivalues can
legally stand to the left of an assignment operator. For example, if a and b are non-
constant integer identifiers with properly allocated memory storage, they are both
modifiable lvalues, and assignments such as a=1 and b =a + b are legal.

Rvalues

The expression = + b is not lvalue: = + b = = is illegal because the expression on
the left is not related to an object. Such expressions are sometimes called rvalues
(short for right values).

SCOPE AND VISIBILITY
Scope

The scope of an identifier is a part of the program in which the identifier can be used
to access its object. There are different categories of scope: block (or local), func-
tion, function prototype, and file. These categories depend on how and where iden-
tifiers are declared.

- Block: The scope of an identifier with block (or local) scope starts at the decl
aration point and ends at the end of the block containing the declaration (such
block is known as the enclosing block). Parameter declarations with a function
definition also have block scope, limited to the scope of the function body.

- File: File scope identifiers, also known as globals, are declared outside of all
blocks; their scope is from the point of declaration to the end of the source file.

- Function: The only identifiers having function scope are statement labels.
Label names can be used with goto statements anywhere in the function in
which the label is declared. Labels are declared implicitly by writing
label name: followed by a statement. Label names must be unique within a
function.

- Function prototype: Identifiers declared within the list of parameter declara
tions in a function prototype (not as a part of a function definition) have a
function prototype scope. This scope ends at the end of the function prototype.

Visibility

The visibility of an identifier is a region of the program source code from which an
identifier’s associated object can be legally accessed.
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Scope and visibility usually coincide, though there are circumstances under which
an object becomes temporarily hidden by the appearance of a duplicate identifier:
the object still exists but the original identifier cannot be used to access it until the
scope of the duplicate identifier ends.

Technically, visibility cannot exceed a scope, but a scope can exceed visibility. See
the following example:

void £ (int i) {
int j; // auto by default
J o= 3; // int i and j are in scope and visible

{ // nested block
double 7; // j 1is local name in the nested block
3 = 0.1; // 1 and double j are visible;
// int j = 3 in scope but hidden
}
// double j out of scope
J o+= 1; // int j visible and = 4
}
// 1 and j are both out of scope

NAME SPACES

Name space is a scope within which an identifier must be unique. The mikroC for
8051 uses four distinct categories of identifiers:

1.goto label names - must be unique within the function in which they are
declared.

2.Structure, union, and enumeration tags - must be unique within the block in
which they are defined. Tags declared outside of any function must be unique.

3.Structure and union member names - must be unique within the structure or
union in which they are defined. There is no restriction on the type or offset of
members with the same member name in different structures.

4.Variables, typedefs, functions, and enumeration members - must be unique
within the scope in which they are defined. Externally declared identifiers
must be unique among externally declared variables.

Duplicate names are legal for different name spaces regardless of the scope rules.

For example:
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int blue = 73;

{ // open a block

enum colors { black, red, green, blue, violet, white } c;
/* enumerator blue = 3 now hides outer declaration of int blue */
struct colors { int i, 7J; }; // ILLEGAL: colors duplicate tag
double red = 2; // ILLEGAL: redefinition of red
t
blue = 37; // back in int blue scope
DURATION

Duration, closely related to a storage class, defines a period during which the
declared identifiers have real, physical objects allocated in memory. We also distin-
guish between compile-time and run-time objects. Variables, for instance, unlike
typedefs and types, have real memory allocated during run time. There are two kinds
of duration: static and local.

Static Duration

Memory is allocated to objects with static duration as soon as execution is under-
way; this storage allocation lasts until the program terminates. Static duration
objects usually reside in fixed data segments allocated according to the memory
model in force. All globals have static duration. All functions, wherever defined, are
objects with static duration. Other variables can be given static duration by using the
explicit static or extern storage class specifiers.

In the mikroC for 8051, static duration objects are not initialized to zero (or null) in
the absence of any explicit initializer.

Don’t mix static duration with file or global scope. An object can have static dura-
tion and local scope — see the example below.

Local Duration

Local duration objects are also known as automatic objects. They are created on the
stack (or in a register) when an enclosing block or a function is entered. They are
deallocated when the program exits that block or function. Local duration objects
must be explicitly initialized; otherwise, their contents are unpredictable
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The storage class specifier auto can be used when declaring local duration variables,
but it is usually redundant, because auto is default for variables declared within a
block.

An object with local duration also has local scope because it does not exist outside
of its enclosing block. On the other hand, a local scope object can have static dura-
tion. For example:

void f () {
/* local duration variable; init a upon every call to f */
int a = 1;
/* static duration variable; init b only upon first call to f */
static int b = 1;
/* checkpoint! */
at+;
b++;
}

void main () {
/* At checkpoint, we will have: */

£(); // a=1, b=1, after first call,

£(); // a=1, b=2, after second call,

£(); // a=1, b=3, after third call,
// etc.

}

TYPES

The mikroC for 8051 is a strictly typed language, which means that every object,
function, and expression must have a strictly defined type, known in the time of
compilation. Note that the mikroC for 8051 works exclusively with numeric types.

The type serves:

- to determine the correct memory allocation required initially.

- to interpret the bit patterns found in the object during subsequent access.

- in many type-checking situations, to ensure that illegal assignments are
trapped.

The mikroC for 8051 supports many standard (predefined) and user-defined data
types, including signed and unsigned integers in various sizes, floating-point num-
bers with various precisions, arrays, structures, and unions. In addition, pointers to
most of these objects can be established and manipulated in memory.
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The type determines how much memory is allocated to an object and how the pro-
gram will interpret the bit patterns found in the object’s storage allocation. A given
data type can be viewed as a set of values (often implementation-dependent) that
identifiers of that type can assume, together with a set of operations allowed with
these values. The compile-time operator sizcof allows you to determine the size in
bytes of any standard or user-defined type.

The mikroC for 8051 standard libraries and your own program and header files must
provide unambiguous identifiers (or expressions derived from them) and types so
that the mikroC for 8051 can consistently access, interpret, and (possibly) change
the bit patterns in memory corresponding to each active object in your program.

Type Categories
A common way to categorize types is to divide them into:

- fundamental
- derived

The fudamental types represent types that cannot be split up into smaller parts. They
are sometimes referred to as unstructured types. The fundamental types are void,
char, int, float, and double, together with short, long, signed, and
unsigned variants of some of them. For more information on fundamental types,
refer to the topic Fundamental Types.

The derived types are also known as structured types and they include pointers to
other types, arrays of other types, function types, structures, and unions. For more
information on derived types, refer to the topic Derived Types.

FUNDAMENTAL TYPES

The fudamental types represent types that cannot be divided into more basic ele-
ments, and are the model for representing elementary data on machine level. The
fudamental types are sometimes referred to as unstructured types, and are used as
elements in creating more complex derived or user-defined types.

The fundamental types include:
- Arithmetic Types

- Enumerations
- Void Type
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ARITHMETIC TYPES

The arithmetic type specifiers are built up from the following keywords: void,
char, int, float and double, together with the preﬁxes short, long, signed
and unsigned. From these keywords you can build both integral and floating-point

types.

Integral Types

The types char and int, together with their variants, are considered to be integral
data types. Variants are created by using one of the prefix modifiers short, 1long,
signed and unsigned.

In the table below is an overview of the integral types — keywords in parentheses can
be (and often are) omitted.

The modifiers signed and unsigned can be applied to both char and int. In the
absence of the unsigned prefix, signed is automatically assumed for integral types.
The only exception is char, which is unsigned by default. The keywords signed and
unsigned, when used on their own, mean signed int and unsigned int, respective-

ly.

The modifiers short and 1ong can only be applied to int. The keywords short and
long, used on their own, mean short int and long int, respectively.

Type Size in bytes Range
(unsigned) char 1 0.. 255
signed char 1 - 128 .. 127
(signed) short (int) 1 -128.. 127
unsigned short (int) 1 0. 255
(signed) int 2 -32768 .. 32767
unsigned (int) 2 0..65535
(signed) long (int) 4 -2147483648 .. 2147483647
unsigned long (int) 4 0 .. 4294967295
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Floating-point Types
The types float and double, together with the long double variant, are considered to
be floating-point types. The mikroC for 8051’s implementation of an ANSI Standard

considers all three to be the same type.

Floating point in the mikroC for 8051 is implemented using the Microchip AN575
32-bit format (IEEE 754 compliant).

An overview of the floating-point types is shown in the table below:

Size
Type in Range
bytes
45 38
float 4 -1.5 % 107 . +3.4 * 10
45 38
double 4 -1.5* 1070 .. +3.4 * 10
45 38
long double 4 -1.5%10%° . +3.4* 10
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ENUMERATIONS

An enumeration data type is used for representing an abstract, discreet set of values
with appropriate symbolic names.

Enumeration Declaration

Enumeration is declared like this:

enum tag {enumeration-list} ;

Here, tag is an optional name of the enumeration; enumeration-1ist is a comma-
delimited list of discreet values, enumerators (or enumeration constants). Each enu-
merator is assigned a fixed integral value. In the absence of explicit initializers, the
first enumerator is set to zero, and the value of each succeeding enumerator is set to
a value of its predecessor increased by one.

Variables of the enum type are declared the same as variables of any other type. For
example, the following declaration:

enum colors { black, red, green, blue, violet, white } c;

establishes a unique integral type, enum colors, variable ¢ of this type, and set of
enumerators with constant integer values (black = 0, red = 1, ...). In the mikroC for
8051, a variable of an enumerated type can be assigned any value of the type int —
no type checking beyond that is enforced. That is:

c = red; // OK
1; // Also OK, means the same

Q
Il

With explicit integral initializers, you can set one or more enumerators to specific
values. The initializer can be any expression yielding a positive or negative integer
value (after possible integer promotions). Any subsequent names without initializ-
ers will be increased by one. These values are usually unique, but duplicates are
legal

The order of constants can be explicitly re-arranged. For example:
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enum colors { black, // value 0
red, // value 1
green, // value 2
blue=6, // value 6
violet, // value 7
white=4 }; // value 4

Initializer expression can include previously declared enumerators. For example, in
the following declaration:

enum memory sizes { bit = 1, nibble = 4 * bit, byte = 2 * nibble,
kilobyte = 1024 * byte };

nibble would acquire the value 4, byte the value 8, and kilobyte the value 8192.

Anonymous Enum Type

In our previous declaration, the identifier colors is an optional enumeration tag that
can be used in subsequent declarations of enumeration variables of the enum colors

type:

enum colors bg, border; /* declare variables bg and border */

Like with struct and union declarations, you can omit the tag if no further variables
of this enum type are required:

/* Anonymous enum type: */
enum { black, red, green, blue, violet, white } color;

Enumeration Scope

Enumeration tags share the same name space as structure and union tags.
Enumerators share the same name space as ordinary variable identifiers:

int blue = 73;

{ // open a block

enum colors { black, red, green, blue, violet, white } c;
/* enumerator blue = 3 now hides outer declaration of int blue */
struct colors { int i, j; }; // ILLEGAL: colors duplicate tag
double red = 2; // ILLEGAL: redefinition of red
}
blue = 37; // back in int blue scope
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VOID TYPE

void is a special type indicating the absence of any value. There are no objects of
void; instead, void is used for deriving more complex types.

Void Functions

Use the void keyword as a function return type if the function does not return a
value.

void print temp (char temp) ({
Lcd Out Cp ("Temperature:");
Lcd Out Cp (temp) ;
Led Chr Cp(223); // degree character
Lecd Chr Cp('C');
}

Use void as a function heading if the function does not take any parameters.
Alternatively, you can just write empty parentheses:

main (void) { // same as main /()

}
Generic Pointers

Pointers can be declared as void, which means that they can point to any type. These
pointers are sometimes called generic.

DERIVED TYPES

The derived types are also known as structured types. They are used as elements in
creating more complex user-defined types.

The derived types include:

- arrays
- pointers

- structures
- unions
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ARRAYS

Array is the simplest and most commonly used structured type. A variable of array
type is actually an array of objects of the same type. These objects represent ele-
ments of an array and are identified by their position in array. An array consists of a
contiguous region of storage exactly large enough to hold all of its elements.

Array Declaration

Array declaration is similar to variable declaration, with the brackets added after
identifer:

type array name[ constant-expression]

This declares an array named as array name and composed of elements of type. The
type can be any scalar type (except void), user-defined type, pointer, enumeration,
or another array. Result of constant-expression within the brackets determines a
number of elements in array. If an expression is given in an array declarator, it must
evaluate to a positive constant integer. The value is a number of elements in an array.

Each of the elements of an array is indexed from 0 to the number of elements minus
one. If a number of elements is n, elements of array can be approached as varizables

array name[ 0] .. array name[ n-1] of type

Here are a few examples of array declaration:

#define MAX = 50

int vector one[ 10] ; /* declares an array of 10 integers */
float vector two[ MAX] ; /* declares an array of 50 floats */
float vector threel MAX - 20]; /* declares an array

Array Initialization

An array can be initialized in declaration by assigning it a comma-delimited
sequence of values within braces. When initializing an array in declaration, you can
omit the number of elements — it will be automatically determined according to the
number of elements assigned. For example:

/* Declare an array which holds number of days in each month: */
int days( 12] = {31,28,31,30,31,30,31,31,30,31,30,31};
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/* This declaration is identical to the previous one */
int days[] = {31,28,31,30,31,30,31,31,30,31,30,31};

If you specify both the length and starting values, the number of starting values must
not exceed the specified length. The opposite is possible, in this case the trailing
“excess” elements will be assigned to some encountered runtime values from mem-

ory.
In case of array of char, you can use a shorter string literal notation. For example:

/* The two declarations are identical: */
const char msgl[] = {'T', 'e', 's', 't', "\0'};

const char msg2[] = "Test";

For more information on string literals, refer to String Constants.

Arrays in Expressions

When the name of an array comes up in expression evaluation (except with opera-
tors « and sizeof ), it is implicitly converted to the pointer pointing to array’s first
element. See Arrays and Pointers for more information.

Multi-dimensional Arrays

An array is one-dimensional if it is of scalar type. One-dimensional arrays are some-
times referred to as vectors.

Multidimensional arrays are constructed by declaring arrays of array type. These
arrays are stored in memory in such way that the right most subscript changes
fastest, i.e. arrays are stored “in rows”. Here is a sample of 2-dimensional array:

float m[ 50][ 20] ; /* 2-dimensional array of size 50x20 */

A variable m is an array of 50 elements, which in turn are arrays of 20 floats each.
Thus, we have a matrix of 50x20 elements: the first element is m[0][0], the last one
is [ 4911 19] . The first element of the 5th row would be [ 411 07 .

If you don't initialize the array in the declaration, you can omit the first dimension
of multi-dimensional array. In that case, array is located elsewhere, e.g. in another
file. This is a commonly used technique when passing arrays as function parameters:
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int af 3][ 21[ 4] ; /* 3-dimensional array of size 3x2x4 */
void func(int n[1[2][4]) { /* we can omit first dimension */
r;[‘é][ 110 3] ++; /* increment the last element*/
Y/~

void main () {

func(a);

Y/~

You can initialize a multi-dimensional array with an appropriate set of values with-
in braces. For example:

int a[3][2] = {{1,2}, (2,6}, {3, T}
POINTERS

Pointers are special objects for holding (or “pointing to”’) memory addresses. In the
mikroC for 8051, address of an object in memory can be obtained by means of an
unary operator &. To reach the pointed object, we use an indirection operator (*) on
a pointer.

A pointer of type “pointer to object of type” holds the address of (that is, points to)
an object of type. Since pointers are objects, you can have a pointer pointing to a
pointer (and so on). Other objects commonly pointed to include arrays, structures,
and unions.

A pointer to a function is best thought of as an address, usually in a code segment,
where that function’s executable code is stored; that is, the address to which control
is transferred when that function is called.

Although pointers contain numbers with most of the characteristics of unsigned inte-
gers, they have their own rules and restrictions for declarations, assignments, con-
versions, and arithmetic. The examples in the next few sections illustrate these rules
and restrictions.

Pointer Declarations

Pointers are declared the same as any other variable, but with * ahead of identifier.
A type at the beginning of declaration specifies the type of a pointed object. A point-
er must be declared as pointing to some particular type, even if that type is void,
which really means a pointer to anything. Pointers to void are often called generic
pointers, and are treated as pointers to char in the mikroC for 8051.
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If t ype is any predefined or user-defined type, including void, the declaration
type *p; /* Uninitialized pointer */

declares p to be of type “pointer to «ype”. All scoping, duration, and visibility rules
are applied to the p object just declared. You can view the declaration in this way: if
*p is an object of type, then p has to be a pointer to such object (object of type).

Note: You must initialize pointers before using them! Our previously declared point-
er *p is not initialized (i.e. assigned a value), so it cannot be used yet.

Note: In case of multiple pointer declarations, each identifier requires an indirect
operator. For example:

int *pa, *pb, *pc;
/* is same as: */
int *pa;
int *pb;
int *pc;

Once declared, though, a pointer can usually be reassigned so that it points to an
object of another type. The mikroC for 8051 lets you reassign pointers without type-
casting, but the compiler will warn you unless the pointer was originally declared to
be pointing to void. You can assign the void* pointer to the non-void* pointer —
refer to void for details.

Null Pointers

A null pointer value is an address that is guaranteed to be different from any valid
pointer in use in a program. Assigning the integer constant O to a pointer assigns a
null pointer value to it.

For example:
int *pn = 0; /* Here's one null pointer */

/* We can test the pointer like this: */
if ( pn == y { ...}

The pointer type “pointer to void” must not be confused with the null pointer. The
declaration

void *vp;
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declares that vp is a generic pointer capable of being assigned to by any “pointer to
type” value, including null, without complaint.

Assignments without proper casting between a “pointer to type1” and a “pointer to
type2”, where typel and type2 are different types, can invoke a compiler warning
or error. If type1 is a function and type2 isn’t (or vice versa), pointer assignments
are illegal. If type1 is a pointer to void, no cast is needed. If type2 is a pointer to
void, no cast is needed.

FUNCTION POINTERS

Function Pointers are pointers, i.e. variables, which point to the address of a func-
tion.

// Define a function pointer
int (*pt2Function) (float, char, char);

Note: Thus functions and function pointers with different calling convention (argu-
ment order, arguments type or return type is different) are incompatible with each
other.

Assign an address to a Function Pointer

It's quite easy to assign the address of a function to a function pointer. Simply take
the name of a suitable and known function. Using the address operator & infront of
the function's name is optional.

//Assign an address to the function pointer

int Dolt (float a, char b, char c¢){ return at+b+c; }
pt2Function = &Dolt; // assignment
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Example:

int addC (char x,char vy)({

return x+y;

}
int subC (char x,char vy)({

return x-y;

}
int mulC (char x,char vy)({

return x*vy;

int divC (char x,char vy)({

return x/vy;

int modC (char x,char vy)({

return x%y;

//array of pointer to functions that receive two chars and returns

int

int (*arrpf[ ] ) (char,char) = { addC ,subC,mulC,divC,modC} ;
int res;

char i;

void main () {
for (i=0;i<5;1i++){
res = arrpf[ i] (10,20);
}

Y/~

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 157



CHAPTER 5
Language Reference mikroC for 8051

POINTER ARITHMETIC
Pointer arithmetic in the mikroC for 8051 is limited to:

- assigning one pointer to another,

- comparing two pointers,

- comparing pointer to zero,

- adding/subtracting pointer and an integer value,

- subtracting two pointers.
The internal arithmetic performed on pointers depends on the memory model in
force and the presence of any overriding pointer modifiers. When performing arith-
metic with pointers, it is assumed that the pointer points to an array of objects.
Arrays and Pointers
Arrays and pointers are not completely independent types in the mikroC for 8051.
When the name of an array comes up in expression evaluation (except with opera-
tors « and sizeof ), it is implicitly converted to the pointer pointing to array’s first
element. Due to this fact, arrays are not modifiable lvalues.
Brackets [ ] indicate array subscripts. The expression
idl exp]
is defined as
*((id) + (exp))

where either:

- id is a pointer and exp is an integer, or
- id is an integer and exp is a pointer.

The following statements are true:

&al 1] = a + i
al 1] = *(a + 1)

According to these guidelines, it can be written:
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pa = &a[ 4] ; // pa points to al4]
x = *(pa + 3); // x = al7]

/* .. but: */
y = *pa + 3; // y = al4] + 3

Also the care should be taken when using operator precedence:

*pa++; // Equal to *(pa++), 1increments the pointer
b q I P
(*pa) ++; // Increments the pointed object!

The following examples are also valid, but better avoid this syntax as it can make
the code really illegible:

(a + 1)[ 1] = 3;
// same as: *((a + 1) + 1) = 3, 1i.e. afi + 1] = 3
(1 + 2)[a] = 0O;
// same as: *((i + 2) + a) =0, i.e. afi + 2] =0

Assignment and Comparison

The simple assignment operator (=) can be used to assign value of one pointer to
another if they are of the same type. If they are of different types, you must use a
typecast operator. Explicit type conversion is not necessary if one of the pointers is
generic (of the void type).

Assigning the integer constant 0 to a pointer assigns a null pointer value to it.

Two pointers pointing to the same array may be compared by using relational oper-
ators ==, !=, <, <=, >, and >=. Results of these operations are the same as if
they were used on subscript values of array elements in question:

int *pa = &al 4], *pb = &a[ 2] ;

if (pa == pb) {... /* won't be executed as 4 is not equal to 2 */}
if (pa > pb) {... /* will be executed as 4 is greater than 2 */ }

You can also compare pointers to zero value — testing in that way if the pointer actu-
ally points to anything. All pointers can be successfully tested for equality or
inequality to null:
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if (pa == ) I
if (pb !'= 0) { ...}

Note: Comparing pointers pointing to different objects/arrays can be performed at
programmer’s own responsibility — a precise overview of data’s physical storage is
required.

Pointer Addition

You can use operators +, ++, and += to add an integral value to a pointer. The result
of addition is defined only if the pointer points to an element of an array and if the
result is a pointer pointing to the same array (or one element beyond it).

If a pointer is declared to point to type, adding an integral value n to the pointer
increments the pointer value by n * sizeof (type) as long as the pointer remains
within the legal range (first element to one beyond the last element). If type has a
size of 10 bytes, then adding 5 to a pointer to type advances the pointer 50 bytes in
memory. In case of the void type, the size of a step is one byte.

For example:

int af 10] ; /* array a containing 10 elements of type int */
int *pa = &a[ 0] ; /* pa 1is pointer to int, pointing to a[0] */

* (pa + 3) = 6; /* pa+3 1s a polnter pointing to a[3], so a[3] now
equals 6 */

pa+t+; /* pa now points to the next element of array a:
al1] */

There is no such element as “one past the last element”, of course, but the pointer is
allowed to assume such value. C “guarantees” that the result of addition is defined
even when pointing to one element past array. If » points to the last array element,
p + 1islegal, but  + 2 is undefined.

This allows you to write loops which access the array elements in a sequence by
means of incrementing pointer — in the last iteration you will have the pointer
pointing to one element past the array, which is legal. However, applying an indirec-
tion operator (<) to a “pointer to one past the last element” leads to undefined
behavior.

For example:
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void f (some type a[], int n) {
/* function f handles elements of array a; */
/* array a has n elements of type some type */

int 1i;
some_type *p=é&a[ 0] ;

for (1 = 0; 1 < n; i++ ) {
/* .. here we do something with *p .. */
pt++; /* .. and with the last iteration p exceeds

the last element of array a */

}
/* at this point, *p is undefined! */

Pointer Subtraction

Similar to addition, you can use operators -, -- , and -= to subtract an integral
value from a pointer.

Also, you may subtract two pointers. The difference will be equal to the distance
between two pointed addresses, in bytes.

For example:

int af 10] ;

int *pil = &al 0] ;

int *pi2 = &al 4] ;

i = pi2 - pil; /* 1 equals 8 */

pi2 -= (1 >> 1); /* pi2 = pi2 - 4: pi2 now points to [0] */
STRUCTURES

A structure is a derived type usually representing a user-defined collection of named
members (or components). These members can be of any type, either fundamental
or derived (with some restrictions to be discussed later), in any sequence. In addi-
tion, a structure member can be a bit field.

Unlike arrays, structures are considered to be single objects. The mikroC for 8051
structure type lets you handle complex data structures almost as easily as single vari-
ables.

Note: the mikroC for 8051 does not support anonymous structures (ANSI diver-
gence).
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Structure Declaration and Initialization
Structures are declared using the keyword struct:
struct tag { member-declarator-1list} ;

Here, =g is the name of a structure; member-declarator-1ist is a list of structure
members, actually a list of variable declarations. Variables of structured type are
declared the same as variables of any other type.

The member type cannot be the same as the struct type being currently declared.
However, a member can be a pointer to the structure being declared, as in the fol-
lowing example:

struct mystruct {mystruct s;}; /* illegal! */
struct mystruct {mystruct *ps;}; /* OK */

Also, a structure can contain previously defined structure types when declaring an
instance of declared structure. Here is an example:

/* Structure defining a dot: */
struct Dot { float x, vy;};

/* Structure defining a circle: */
struct Circle {
float r;
struct Dot center;
} ol, o02;
/* declare variables ol and o2 of Circle */

Note that the structure tag can be omitted, but then additional objects of this type
cannot be declared elsewhere. For more information, see the Untagged Structures
below.

Structure is initialized by assigning it a comma-delimited sequence of values with-
in braces, similar to array. For example:

/* Referring to declarations from the example above: */

/* Declare and initialize dots p and q: */
struct Dot p = (1., 1.}, g ={3.7, -0.5};

/* Declare and initialize circle ol: */
struct Circle ol ={1., {0., 0.}}; // radius is 1, center is at (0,
0)
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Incomplete Declarations

Incomplete declarations are also known as forward declarations. A pointer to a struc-
ture type A can legally appear in the declaration of another structure B before A has
been declared:

struct A; // incomplete
struct B { struct A *pa;};

struct A { struct B *pb;};

The first appearance of 2 is called incomplete because there is no definition for it at
that point. An incomplete declaration is allowed here, because the definition of 5
doesn’t need the size of 2.

Untagged Structures and Typedefs

If the structure tag is omitted, an untagged structure is created. The untagged struc-
tures can be used to declare the identifiers in the comma-delimited member-
declarator-list to be of the given structure type (or derived from it), but addi-
tional objects of this type cannot be declared elsewhere.

It is possible to create a typedef while declaring a structure, with or without tag:

/* With tag: */
typedef struct mystruct { ... } Mystruct;
Mystruct s, *ps, arrs[ 10] ; /* same as struct mystruct s, etc. */

/* Without tag: */
typedef struct { ... } Mystruct;
Mystruct s, *ps, arrs[ 10] ;

Usually, there is no need to use both tzg and typedef: either can be used in struc-
ture type declarations.

Untagged structure and union members are ignored during initialization.

Note: See also Working with structures.
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WORKING WITH STRUCTURES

Structures represent user-defined types. A set of rules regarding the application of
structures is strictly defined.

Assignment

Variables of the same structured type may be assigned one to another by means of
simple assignment operator (=). This will copy the entire contents of the variable to
destination, regardless of the inner complexity of a given structure.

Note that two variables are of the same structured type only if they are both defined
by the same instruction or using the same type identifier. For example:

/* a and b are of the same type: */
struct {int ml, m2;} a, b;

/* But c¢ and d are not_ of the same type although
their structure descriptions are identical: */

struct {int ml, m2;} c;

struct {int ml, m2;} d;

Size of Structure
The size of the structure in memory can be retrieved by means of the operator size-

of. It is not necessary that the size of the structure is equal to the sum of its mem-
bers’ sizes. It is often greater due to certain limitations of memory storage.

Structures and Functions

A function can return a structure type or a pointer to a structure type:

mystruct funcl (void) ; /* funcl () returns a structure */
mystruct *func2 (void) ; /* func2 () returns pointer to structure */

A structure can be passed as an argument to a function in the following ways:

void funcl (mystruct s;); /* directly */
void func2 (mystruct *sptr;); /* via a pointer */
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STRUCTURE MEMBER ACCESS

Structure and union members are accessed using the following two selection opera-
tors:

- . (period)

- -> (right arrow)
The operator . is called the direct member selector and it is used to directly access
one of the structure’s members. Suppose that the object s is of the struct type S and
m is a member identifier of the type M declared in s, then the expression

s.m // direct access to member m
is of the type M, and represents the member object m in S.

The operator > is called the indirect (or pointer) member selector. Suppose that the
object s is of the struct type s and ps is a pointer to s. Then if m is a member iden-
tifier of the type M declared in =, the expression

ps->m // indirect access to member m;
// identical to (*ps).m

is of the type 1, and represents the member object n in s. The expression ps->m is a
convenient shorthand for (<ps) .m.

For example:

struct mystruct {
int i;
char str[ 21] ;
double d;

} s, *sptr = &s;

s.i = 3; // assign to the 1 member of mystruct s

sptr => d = 1.23; // assign to the d member of mystruct s

The expression s.m is lvalue, providing that s is lvalue and m is not an array type.
The expression sptr->m is an lvalue unless m is an array type.
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Accessing Nested Structures

If the structure B contains a field whose type is the structure A, the members of A
can be accessed by two applications of the member selectors:

struct A {
int j; double x;
b
struct B {
int i; struct A aa; double d;
} s, *sptr;

s.i = 3; // assign 3 to the 1 member of B
s.aa.j = 2; // assign 2 to the j member of A
sptr->d = 1.23; // assign 1.23 to the d member of B
sptr->aa.x = 3.14; // assign 3.14 to x member of A

Structure Uniqueness

Each structure declaration introduces a unique structure type, so that in

struct A {
int i,j; double d;
} aa, aaa;

struct B {
int i,j; double d;
} bb;

the objects aa and aaa are both of the type struct A, but the objects aa and bb are of
different structure types. Structures can be assigned only if the source and destina-
tion have the same type:

aa = aaa; /* OK: same type, member by member assignment */
aa = bb; /* ILLEGAL: different types */

/* but you can assign member by member: */
aa.i = bb.i;
aa.j = bb.j;
aa.d = bb.d;
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UNIONS

Union types are derived types sharing many of syntactic and functional features of
structure types. The key difference is that a union members share the same memory
space.

Note: The mikroC for 8051 does not support anonymous unions (ANSI divergence).
Union Declaration

Unions have the same declaration as structures, with the keyword union used instead
of struct:

union tag { member-declarator-list };

Unlike structures’ members, the value of only one of union’s members can be stored
at any time. Here is a simple example:

union myunion { // union tag is 'myunion'
int i;
double d;
char ch;

} mu, *pm;

The identifier mu, of the type myunion, can be used to hold a 2-byte int, 4-byte

double or single-byte char, but only one of them at a certain moment. The identifi-
er pm is a pointer to union myunion.

Size of Union

The size of a union is the size of its largest member. In our previous example, both
sizeof (union myunion) and sizeof (mu) return 4, but 2 bytes are unused (padded)
when mu holds the int object, and 3 bytes are unused when mu holds char.

Union Member Access

Union members can be accessed with the structure member selectors (. and —>), be
careful when doing this:
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/* Referring to declarations from the example above: */
pm = &mu;

mu.d = 4.016;

tmp = mu.d; // OK: mu.d = 4.016

tmp = mu.i; // peculiar result

pm->i = 3;
tmp = mu.i; // OK: mu.i = 3

The third line is legal, since mu. i is an integral type. However, the bit pattern in
mu. i corresponds to parts of the previously assigned double. As such, it probably
won’t provide an useful integer interpretation.

When properly converted, a pointer to a union points to each of its members, and
vice versa.

BIT FIELDS

Bit fields are specified numbers of bits that may or may not have an associated iden-
tifier. Bit fields offer a way of subdividing structures into named parts of user-
defined sizes.

Structures and unions can contain bit fields that can be up to 16 bits.
You cannot take the address of a bit field.

Note: If you need to handle specific bits of 8-bit variables (char and unsigned short)
or registers, you don’t need to declare bit fields. Much more elegant solution is to
use the mikroC for 8051°s intrinsic ability for individual bit access — see Accessing
Individual Bits for more information.

Bit Fields Declaration

Bit fields can be declared only in structures and unions. Declare a structure normal-
ly and assign individual fields like this (fields need to be unsigned):

struct tag {
unsigned bitfield-declarator-list;

}

Here, tag is an optional name of the structure; bitfield-declarator-list is a list
of bit fields. Each component identifer requires a colon and its width in bits to be
explicitly specified. Total width of all components cannot exceed two bytes (16
bits).
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As an object, bit fields structure takes two bytes. Individual fields are packed with-
in two bytes from right to left. In bitfield-declarator-1list, you can omit iden-
tifier(s) to create an artificial “padding”, thus skipping irrelevant bits.

For example, if there is a need to manipulate only bits 2—4 of a register as one block,
create a structure like this:

struct {
unsigned : 2, // Skip bits 0 and 1, no identifier here
mybits : 3; // Relevant bits 2, 3 and 4
// Bits 5, 6 and 7 are implicitly left out
} myreg;

Here is an example:

typedef struct {
lo nibble 4;
hi nibble 4
high byte 8;} myunsigned;

which declares the structured type myunsigned containing three components:
1o nibble (bits 3..0), hi nibble (bits 7..4) and high byte (bits 15..8).

Bit Fields Access

Bit fields can be accessed in the same way as the structure members. Use direct and
indirect member selector (. and ->). For example, we could work with our previ-
ously declared myunsigned like this:

// This example writes low byte of bit field of myunsigned type to
PORTO :

myunsigned Value For PORTO;

void main () {

Value For PORTO.lo nibble = 7;
Value For PORTO.hi nibble = 0x0C;
PO = * (char *) (void *)&Value For PORTO;
// typecasting :
// 1. address of structure to pointer to void
// 2. pointer to void to pointer to char
// 3. dereferencing to obtain the value
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TYPES CONVERSIONS

The mikroC for 8051 is a strictly typed language, with each operator, statement and
function demanding appropriately typed operands/arguments. However, we often
have to use objects of “mismatching” types in expressions. In that case, type con-
version is needed.

Conversion of object of one type means that object's type is changed into another
type. The mikroC for 8051 defines a set of standard conversions for built-in types,
provided by compiler when necessary. For more information, refer to the Standard
Conversions.

Conversion is required in the following situations:

- if a statement requires an expression of particular type (according to language
definition), and we use an expression of different type,

- if an operator requires an operand of particular type, and we use an operand of
different type,

- if a function requires a formal parameter of particular type, and we pass it an
object of different type,

- if an expression following the keyword return does not match the declared
function return type,

- if intializing an object (in declaration) with an object of different type.

In these situations, compiler will provide an automatic implicit conversion of types,
without any programmer's interference. Also, the programmer can demand conver-
sion explicitly by means of the typecast operator. For more information, refer to the
Explicit Typecasting.

STANDARD CONVERSIONS

Standard conversions are built in the mikroC for 8051. These conversions are per-
formed automatically, whenever required in the program. They can also be explicit-
ly required by means of the typecast operator (refer to the Explicit Typecasting).

The basic rule of automatic (implicit) conversion is that the operand of simpler type
is converted (promoted) to the type of more complex operand. Then, the type of the
result is that of more complex operand.
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Arithmetic Conversions

When using arithmetic expression, such as = + b, where = and b are of different
arithmetic types, the mikroC for 8051 performs implicit type conversions before the
expression is evaluated. These standard conversions include promotions of “lower”
types to “higher” types in the interests of accuracy and consistency.

Assigning a signed character object (such as a variable) to an integral object results
in automatic sign extension. Objects of type signed char always use sign extension;
objects of type unsigned char always has its high byte set to zero when converted to
int.

Converting a longer integral type to a shorter type truncates the higher order bits and
leaves low-order bits unchanged. Converting a shorter integral type to a longer type
either sign-extends or zero-fills the extra bits of the new value, depending on
whether the shorter type is signed or unsigned, respectively.

Note: Conversion of floating point data into integral value (in assignments or via
explicit typecast) produces correct results only if the float value does not exceed the
scope of destination integral type.

In details:

Here are the steps the mikroC for 8051 uses to convert the operands in an arithmetic
expression:

First, any small integral types are converted according to the following rules:

. char converts to int

. signed char converts to int, with the same value

. short converts to int, with the same value, sign-extended

. unsigned short converts to unsigned int, with the same value, zero-filled
5. enum converts to int, with the same value

AW N~

After this, any two values associated with an operator are either int (including the
long and unsigned modifiers) or f1loat (equivalent with double and long double
in the mikroC for 8051).

1. If either operand is float, the other operand is converted to float.
2. Otherwise, if either operand is unsigned long, the other operand is converted
to unsigned long.
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3. Otherwise, if either operand is 1ong, then the other operand is converted to
long.

4. Otherwise, if either operand is unsigned, then the other operand is converted
to unsigned.

5. Otherwise, both operands are int.

The result of the expression is the same type as that of the two operands.

Here are several examples of implicit conversion:

2 + 3.1 /* 2 2. + 3.1 2 5.1 */
5/ 4 * 3. /* 2 (5/4)*3. 2 1*3. ? 1.*3. ? 3. */
3. x 5/ 4 /* 2 (3.*%5)/4 2 (3.*5.)/4 ? 15./4 ? 15./4. ? 3.75 */

Pointer Conversions

Pointer types can be converted to other pointer types using the typecasting mecha-
nism:

char *str;

int *ip;
str = (char *)ip;

More generally, the cast typer will convert a pointer to type “pointer to type”.

EXPLICIT TYPES CONVERSIONS (TYPECASTING)

In most situations, compiler will provide an automatic implicit conversion of types
where needed, without any user's interference. Also, the user can explicitly convert
an operand to another type using the prefix unary typecast operator:

(type) object
This will convert ocbject to a specified +ype. Parentheses are mandatory.
For example:

/* Let's have two variables of char type: */
char a, Db;

/* Following line will coerce a to unsigned int: */
(unsigned int) a;

/* Following line will coerce a to double,
then coerce b to double automatically,
resulting in double type value: */
(double) a + b; // equivalent to ((double) a) + b;
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DECLARATIONS

A declaration introduces one or several names to a program — it informs the compil-
er what the name represents, what its type is, what operations are allowed with it,
etc. This section reviews concepts related to declarations: declarations, definitions,
declaration specifiers, and initialization.

The range of objects that can be declared includes:

- Variables

- Constants

- Functions

- Types

- Structure, union, and enumeration tags
- Structure members

- Union members

- Arrays of other types

- Statement labels

-Preprocessor macros

Declarations and Definitions
Defining declarations, also known as definitions, beside introducing the name of an
object, also establish the creation (where and when) of an object; that is, the alloca-
tion of physical memory and its possible initialization. Referencing declarations, or
just declarations, simply make their identifiers and types known to the compiler.
Here is an overview. Declaration is also a definition, except if:

- it declares a function without specifying its body

- it has the extern specifier, and has no initializator or body (in case of func.)

- it 18 the typedet declaration

There can be many referencing declarations for the same identifier, especially in a
multifile program, but only one defining declaration for that identifier is allowed.

For example:
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/* Here 1is a nondefining declaration of function max; */
/* it merely informs compiler that max is a function */
int max () ;

/* Here 1is a definition of function max: */
int max (int x, int y) {
return (x >= vy) ? x : y;

}

/* Definition of variable i: */
int i;
/* Following line is an error, 1 1s already defined! */

int i;
Declarations and Declarators

The declaration contains specifier(s) followed by one or more identifiers (declara-
tors). The declaration begins with optional storage class specifiers, type specifiers,
and other modifiers. The identifiers are separated by commas and the list is termi-
nated by a semicolon.

Declarations of variable identifiers have the following pattern:

storage-class [ type-qualifier] type varl [ =initl], var2 [ =init2],

’

where varl, var2, ... are any sequence of distinct identifiers with optional initial-
izers. Each of the variables is declared to be of type; if omitted, +ype defaults to
int. The speciﬁer storage-class can take the values extern, static, regis-
ter, or the default auto. Optional type-qualifier can take values const or
volatile. For more details, refer to Storage Classes and Type Qualifiers.

For example:

/* Create 3 integer variables called x, y, and z
and initialize x and y to the values 1 and 2, respectively: */
int x =1, v = 2, z; // z remains uninitialized

/* Create a floating-point variable g with static modifier,
and initialize it to 0.25: */
static float g = .25;

These are all defining declarations; storage is allocated and any optional initializers
are applied.
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LINKAGE

An executable program is usually created by compiling several independent transla-
tion units, then linking the resulting object files with preexisting libraries. A term
translation unit refers to a source code file together with any included files, but with-
out the source lines omitted by conditional preprocessor directives. A problem aris-
es when the same identifier is declared in different scopes (for example, in different
files), or declared more than once in the same scope.

The linkage is a process that allows each instance of an identifier to be associated
correctly with one particular object or function. All identifiers have one of two link-
age attributes, closely related to their scope: external linkage or internal linkage.
These attributes are determined by the placement and format of your declarations,
together with an explicit (or implicit by default) use of the storage class specifier
static or extern.

Each instance of a particular identifier with external linkage represents the same
object or function throughout the entire set of files and libraries making up the pro-
gram. Each instance of a particular identifier with internal linkage represents the
same object or function within one file only.

Linkage Rules

Local names have internal linkage; the same identifier can be used in different files
to signify different objects. Global names have external linkage; identifier signifies
the same object throughout all program files.

If the same identifier appears with both internal and external linkage within the same
file, the identifier will have internal linkage.

Internal Linkage Rules

1. names having file scope, explicitly declared as static, have internal linkage

2. names having file scope, explicitly declared as const and not explicitly
declared as extern, have internal linkage

. typedef names have internal linkage

4. enumeration constants have internal linkage

98]
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External Linkage Rules

1. names having file scope, that do not comply to any of previously stated
internal linkage rules, have external linkage

The storage class specifiers auto and register cannot appear in an external decla-
ration. No more than one external definition can be given for each identifier in a
translation unit declared with internal linkage. An external definition is an external
declaration that defines an object or a function and also allocates a storage. If an
identifier declared with external linkage is used in an expression (other than as part
of the operand of sizeof), then exactly one external definition of that identifier
must be somewhere in the entire program.

STORAGE CLASSES

Associating identifiers with objects requires each identifier to have at least two
attributes: storage class and type (sometimes referred to as data type). The mikroC
for 8051 compiler deduces these attributes from implicit or explicit declarations in
the source code.

A storage class dictates the location (data segment, register, heap, or stack) of object
and its duration or lifetime (the entire running time of the program, or during exe-
cution of some blocks of code). A storage class can be established by the syntax of
a declaration, by its placement in the source code, or by both of these factors:

storage-class type identifier

The storage class specifiers in the mikroC for 8051 are:
- auto
- register

- static
- extern

Auto

The auto modifer is used to define that a local variable has a local duration. This is
the default for local variables and is rarely used. auto can not be used with globals.
See also Functions.
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Register

At the moment the modifier register technically has no special meaning. The
mikroC for 8051 compiler simply ignores requests for register allocation.

Static

A global name declared with the static specifier has internal linkage, meaning that
it is local for a given file. See Linkage for more information.

A local name declared with the static specifier has static duration. Use static
with a local variable to preserve the last value between successive calls to that func-
tion. See Duration for more information.

Extern

A name declared with the extern specifier has external linkage, unless it has been
previously declared as having internal linkage. A declaration is not a definition if it
has the extern specifier and is not initialized. The keyword extern is optional for
a function prototype.

Use the extern modifier to indicate that the actual storage and initial value of the
variable, or body of the function, is defined in a separate source code module.
Functions declared with extern are visible throughout all source files in the pro-

gram, unless the function is redefined as static.

See Linkage for more information.

TYPE QUALIFIERS

The type qualifiers const and volatile are optional in declarations and do not actu-
ally affect the type of declared object.

Qualifier const

The qualifier const implies that a declared object will not change its value during
runtime. In declarations with the const qualifier all objects need to be initialized.

The mikroC for 8051 treats objects declared with the const qualifier the same as lit-
erals or preprocessor constants. If the user tries to change an object declared with
the const qualifier compiler will report an error.
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For example:
const double PI = 3.14159;
Qualifier volatile

The qualifier volatile implies that a variable may change its value during runtime
independently from the program. Use the volatile modifier to indicate that a variable
can be changed by a background routine, an interrupt routine, or I/O port. Declaring
an object to be volatile warns the compiler not to make assumptions concerning the
value of an object while evaluating expressions in which it occurs because the value
could be changed at any moment.

TYPEDEF SPECIFIER

The specifier typedef introduces a synonym for a specified type. The typedet dec-
larations are used to construct shorter or more convenient names for types already
defined by the language or declared by the user.

The specifier typedet stands first in the declaration:
typedef <type definition> synonym;

The typedef keyword assigns synonymto <type definition>. The synonym needs
to be a valid identifier.

A declaration starting with the typedes specifier does not introduce an object or a
function of a given type, but rather a new name for a given type. In other words, the
typedef declaration is identical to a “normal” declaration, but instead of objects, it
declares types. It is a common practice to name custom type identifiers with start-
ing capital letter — this is not required by the mikroC for 8051.

For example:

/* Let's declare a synonym for "unsigned long int" */
typedef unsigned long int Distance;

/* Now, synonym '"Distance" can be used as type identifier: */
Y Y yp

Distance 1i; // declare variable i of unsigned long int
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In the t ypedef declaration, as in any other declaration, several types can be declared
at once. For example:

typedef int *Pti, Arrayl 10];

Here, pti is a synonym for type “pointer to int”, and Array is a synonym for type
“array of 10 int elements”.

ASM DECLARATION

The mikroC for 8051 allows embedding assembly in the source code by means of
the asm declaration. The declarations asm and asm are also allowed in the
mikroC for 8051 and have the same meaning. Note that numerals cannnot be used
as absolute addresses for SFR or GPR variables in assembly instructions. Symbolic
names may be used instead (listing will display these names as well as addresses).

Assembly instructions can be grouped by the asm keyword (or asm, or  asm):
asm {

block of assembly instructions

}

There are two ways to embeding single assembly instruction to C code:
asm assembly instruction ;

and

asm assembly instruction

Note: semicolon and LF are terminating asm scope for single assembly instructions.
This is the reason why the following syntax is not asm block:

asm

{

block of assembly instructions

}

This code will be interpreted as single empty asm line followed by C compound
statement.
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The mikroC for 8051 comments (both single-line and multi-line) are allowed in
embedded assembly code.

Accessing individual bytes is different as well. For example, a global variable
"g var" of type long (i.e. 4 bytes) can be accessed like this:

MOV g var+0, #1 ;puts
MOV g var+l, #2 ;puts
MOV g var+2, #3 ;puts
MOV g var+3, #4 ;puts
. etc.
If you want to know details about asm syntax supported by mikroC for 8051 it is
recomended to study asm and 1st files generated by compiler. It is also recomend-

ed to check "Include source lines in output files" checkbox in Output settings

INITIALIZATION

in low byte of g var
in high byte of g var
in higher byte of g var
in highest byte of g var

DSw N

The initial value of a declared object can be set at the time of declaration (initializa-
tion). A part of the declaration which specifies the initialization is called initializer.

Initializers for globals and static objects must be constants or constant expres-
sions. The initializer for an automatic object can be any legal expression that evalu-
ates to an assignment-compatible value for the type of the variable involved.

Scalar types are initialized with a single expression, which can optionally be
enclosed in braces. The initial value of an object is that of the expression; the same
constraints for type and conversions as for simple assignments are applied to initial-
izations too.

For example:

int 1 = 1;
char *s = "hello";
struct complex ¢ = {0.1, -0.2};

// where 'complex' is a structure (float, float)

For structures or unions with automatic storage duration, the initializer must be one
of the following:

- An initializer list.
- A single expression with compatible union or structure type. In this case, the
initial value of the object is that of the expression.
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For example:
struct dot {int x; int y; } m = {30, 40};
For more information, refer to Structures and Unions.

Also, you can initialize arrays of character type with a literal string, optionally
enclosed in braces. Each character in the string, including the null terminator, ini-
tializes successive elements in the array. For more information, refer to Arrays.

Automatic Initialization

The mikroC for 8051 does not provide automatic initialization for objects.
Uninitialized globals and objects with static duration will take random values from
memory.

FUNCTIONS

Functions are central to C programming. Functions are usually defined as subpro-
grams which return a value based on a number of input parameters. Return value of
the function can be used in expressions — technically, function call is considered to
be an expression like any other.

C allows a function to create results other than its return value, referred to as side
effects. Often, the function return value is not used at all, depending on the side
effects. These functions are equivalent to procedures of other programming lan-
guages, such as Pascal. C does not distinguish between procedure and function —
functions play both roles.

Each program must have a single external function named mzin marking the entry
point of the program. Functions are usually declared as prototypes in standard or
user-supplied header files, or within program files. Functions have external linkage
by default and are normally accessible from any file in the program. This can be
restricted by using the static storage class specifier in function declaration (see
Storage Classes and Linkage).

Note: Check the 8051 Specifics for more information on functions’ limitations on
the 8051 compliant micros.
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Function Declaration

Functions are declared in user's source files or made available by linking precom-
piled libraries. The declaration syntax of the function is:

type functionﬁname (parameter-declarator-1ist);

The function name must be a valid identifier. This name is used to call the func-
tion; see Function Calls for more information.

type represents the type of function result, and can be of any standard or user-
defined type. For functions that do not return value the void type should be used.
The type can be omitted in global function declarations, and function will assume
the int type by default.

Function type can also be a pointer. For example, f10at* means that a function
result is a pointer to float. The generic pointer void* is also allowed.

The function cannot return an array or another function.

Within parentheses, parameter-declarator-1ist is a list of formal arguments that
function takes. These declarators specify the type of each function parameter. The
compiler uses this information to check validity of function calls. If the list is empty,
a function does not take any arguments. Also, if the list is vo1id, a function also does
not take any arguments; note that this is the only case when void can be used as an
argument’s type.

Unlike variable declaration, each argument in the list needs its own type specifier
and possible qualifier const or volatile,

Function Prototypes

A function can be defined only once in the program, but can be declared several
times, assuming that the declarations are compatible. When declaring a function, the
formal argument's identifier does not have to be specified, but its type does.

This kind of declaration, commonly known as the function prototype, allows better
control over argument number, type checking and type conversions. The name of a
parameter in function prototype has its scope limited to the prototype. This allows
one parameter identifier to have different name in different declarations of the same
function:
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/* Here are two prototypes of the same function: */

int test (const char*) /* declares function test */

int test (const char*p) /* declares the same function test */

Function prototypes are very useful in documenting code. For example, the function
cf Init takes two parameters: Control Port and Data Port. The question is, which
is which? The function prototype:

void Cf Init(char *ctrlport, char *dataport);

makes it clear. If a header file contains function prototypes, the user can read that
file to get the information needed for writing programs that call these functions. If a
prototype parameter includes an identifier, then the indentifier is only used for error
checking.

Function Definition

Function definition consists of its declaration and function body. The function body
is technically a block — a sequence of local definitions and statements enclosed with-
in braces {} . All variables declared within function body are local to the function,
i.e. they have function scope.

The function itself can be defined only within the file scope, which means that func-
tion declarations cannot be nested.

To return the function result, use the return statement. The statement return in func-
tions of the void type cannot have a parameter — in fact, the return statement can
be omitted altogether if it is the last statement in the function body.

Here is a sample function definition:

/* function max returns greater one of its 2 arguments: */
int max(int x, int y) {

return (x>=y) ? x : y;

}

Here is a sample function which depends on side effects rather than return value:
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/* function converts Descartes coordinates (x,y) to polar (r,fi): */
#include <math.h>

void polar (double x, double y, double *r, double *fi) {
*r = sqrt(x * x + vy * y);
*fi = (x == 0 && y == 0) 2 0 : atan2(y, x);
return; /* this line can be omitted */

}
Functions reentrancy

Functions reentrancy is allowed. Remember that the 8051 has stack and memory
limitations which can varies greatly between MCU .

FUNCTION CALLS AND ARGUMENT CONVERSIONS
Function Calls

A function is called with actual arguments placed in the same sequence as their
matching formal parameters. Use the function-call operator () :

function name (expression 1, ... , expression n)

Each expression in the function call is an actual argument. Number and types of
actual arguments should match those of formal function parameters. If types do not
match, implicit type conversions rules will be applied. Actual arguments can be of
any complexity, but order of their evaluation is not specified.

Upon function call, all formal parameters are created as local objects initialized by
the values of actual arguments. Upon return from a function, a temporary object is
created in the place of the call, and it is initialized by the expression of the return
statement. This means that the function call as an operand in complex expression is
treated as a function result.

If the function has no result (type void) or the result is not needed, then the function
call can be written as a self-contained expression.

In C, scalar arguments are always passed to the function by value. The function can
modify the values of its formal parameters, but this has no effect on the actual argu-
ments in the calling routine. A scalar object can be passed by the address if a formal
parameter is declared as a pointer. The pointed object can be accessed by using the
indirection operator * .
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// For example, Soft Uart Read takes the pointer to error variable,
// so it can change the value of an actual argument:
Soft Uart Read(&error);

// The following code would be wrong,; you would pass the value
// of error variable to the function:

Soft Uart Read(error);

Argument Conversions

If a function prototype has not been previously declared, the mikroC for 8051 con-
verts integral arguments to a function call according to the integral widening (expan-
sion) rules described in Standard Conversions. If a function prototype is in scope,
the mikroC for 8051 converts the passed argument to the type of the declared param-
eter according to the same conversion rules as in assignment statements.

If a prototype is present, the number of arguments must match. The types need to be
compatible only to the extent that an assignment can legally convert them. The user
can always use an explicit cast to convert an argument to a type that is acceptable to
a function prototype.

Note: If the function prototype does not match the actual function definition, the
mikroC for 8051 will detect this if and only if that definition is in the same compi-
lation unit as the prototype. If you create a library of routines with the correspon-
ding header file of prototypes, consider including that header file when you compile
the library, so that any discrepancies between the prototypes and actual definitions
will be detected.

The compiler is also able to force arguments to change their type to a proper one.
Consider the following code:

int limit = 32;
char ch = 'A';
long res;

// prototype
extern long func(long parl, long par2);

main () {

res = func(limit, ch); // function call

}
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Since the program has the function prototype for func, it converts 1imit and ch to
1ong, using the standard rules of assignment, before it places them on the stack for
the call to func.

Without the function prototype, 1imit and ch would be placed on the stack as an
integer and a character, respectively; in that case, the stack passed to func will not
match size or content that func expects, which can cause problems.

ELLIPSIS ('...") OPERATOR

The ellipsis ('...") consists of three successive periods with no whitespace interven-
ing. An ellipsis can be used in the formal argument lists of function prototypes to
indicate a variable number of arguments, or arguments with varying types. For
example:

void func (int n, char ch, ...);

This declaration indicates that func will be defined in such a way that calls must
have at least two arguments, int and char, but can also have any number of addition-
al arguments.

Example:

#include <stdarg.h>

int addvararg(char al,...){
va list ap;

char temp;

va_start (ap,al);

while( temp = va arg(ap,char))
al += temp;
return al;

}

int res;
void main () {

res = addvararg(l,2,3,4,5,0);
res = addvararg(l,2,3,4,5,6,7,8,9,10,0);

Y/~
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OPERATORS

Operators are tokens that trigger some computation when applied to variables and
other objects in an expression.

- Arithmetic Operators

- Assignment Operators

- Bitwise Operators

- Logical Operators

- Reference/Indirect Operators
- Relational Operators

- Structure Member Selectors
- Comma Operator ,

- Conditional Operator -

- Array subscript operator [ ]

- Function call operator ()

- sizeof Operator

- Preprocessor Operators # and ##

OPERATORS PRECEDENCE AND ASSOCIATIVITY

There are 15 precedence categories, some of them contain only one operator.
Operators in the same category have equal precedence.

If duplicates of operators appear in the table, the first occurrence is unary and the
second binary. Each category has an associativity rule: left-to-right (->), or right-
to-left (<-) . In the absence of parentheses, these rules resolve a grouping of expres-
sions with operators of equal precedence.
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Precedence

Operands

Operators

Associativity

15

2

>

14

~ o+t

(type)

sizeof

13

12

11

10

9
8
7
6
5
4
3
2

(NSRRI \S N NS A SRR \S T i (S I (S R NS \S B SR )
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ARITHMETIC OPERATORS

Arithmetic operators are used to perform mathematical computations. They have
numerical operands and return numerical results. The type char technically repre-
sents small integers, so the char variables can be used as operands in arithmetic

operations.

All arithmetic operators associate from left to right

Arithmetic Operators Overview

Operator Operation Precedence
Binary Operators
+ addition 12
- subtraction 12
* multiplication 13
/ division 13
modulus operator returns the remainder of inte-
% ger division (cannot be used with floating 13
points)
Unary Operators
+ unary plus does not affect the operand 14
- unary minus changes the sign of the operand 14
increment adds one to the value of the operand.
Postincrement adds one to the value of the 14
++ operand after it evaluates; while preincrement
adds one before it evaluates
decrement subtracts one from the value of the
operand. Postdecrement subtracts one from the 14
-- value of the operand after it evaluates; while
predecrement subtracts one before it evaluates

Note: Operator * is context sensitive and can also represent the pointer reference

operator.

Binary Arithmetic Operators

Division of two integers returns an integer, while remainder is simply truncated:

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

189



CHAPTER 5

Language Reference mikroC for 8051
/* for example: */
7/ 4; /* equals 1 */
7 * 3/ 4; /* equals 5 */
/* but: */
7. % 3./ 4.; /* equals 5.25 because we are working with floats */

Remainder operand % works only with integers; the sign of result is equal to the
sign of the first operand:

/* for example: */

9 % 3; /* equals 0 */
7% 3; /* equals 1 */
-7 % 3; /* equals -1 */

Arithmetic operators can be used for manipulating characters:

'A' + 32; /* equals 'a' (ASCII only) */
'G' - 'A'" + 'a'; /* equals 'g' (both ASCII and EBCDIC) */

Unary Arithmetic Operators

Unary operators ++ and -- are the only operators in C which can be either prefix
(e.g. ++k, --x)or postfix (e.g. k++, k--).

When used as prefix, operators ++ and -- (preincrement and predecrement) add or
subtract one from the value of the operand before the evaluation. When used as suf-
fix, operators ++ and -- (postincrement and postdecrement) add or subtract one from
the value of the operand after the evaluation.

For example:

int j = 5;

J o= ++k; /* k =k + 1, j = k, which gives us j = 6, kK = 6
*/

but:

int j = 5;

J = kt++; /* j =k, k =k + 1, which gives us j = 5, kK = 6
*/
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RELATIONAL OPERATORS

Use relational operators to test equality or inequality of expressions. If an expres-
sion evaluates to be true, it returns 1; otherwise it returns 0.

All relational operators associate from left to right.

Operator Operation Precedence
== equal 9
! not equal 9
> greater than 10
< less than 10
>= greater than or equal 10
<= less than or equal 10

Relational Operators Overview

Precedence of arithmetic and relational operators is designated in such a way to
allow complex expressions without parentheses to have expected meaning:

a + 5> ¢ -1.0/ e /* => (a + 5) >= (¢ - (1.0 / e)) */

Do not forget that relational operators return either 0 or 1. Consider the following

examples:

/* ok: */

5> 7 /* returns 0 */
10 <= 20 /* returns 1 */

/* this can be tricky: */

8 == 13 > 5 /* returns 0, as: 8 == (13 > 5) -> 8 == 1
> 0 */
14 > 5 < 3 /* returns 1, as: (14 > 5) < 3 -> 1 < 3
> 1 */
a< b < 5 /* returns 1, as: (a < b) < 5 -> (0 or 1)

<5 -=> 1%/
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BITWISE OPERATORS
Use the bitwise operators to modify individual bits of numerical operands.

Bitwise operators associate from left to right. The only exception is the bitwise com-
plement operator ~ which associates from right to left.

Bitwise Operators Overview

Operator Operation Precedence

. bitwise AND; compares pairs of bits and returns 3
1 if both bits are 1, otherwise returns 0

bitwise (inclusive) OR; compares pairs of bits
and returns 1 if either or both bits are 1, other- 6
wise returns 0

bitwise exclusive OR (XOR); compares pairs of
" bits and returns 1 if the bits are complementary, | 7
otherwise returns 0

~ bitwise complement (unary); inverts each bit 14
bitwise shift left; moves the bits to the left, dis-

<< cards the far left bit and assigns 0 to the far 11
right bit.

bitwise shift right; moves the bits to the right,
>> discards the far right bit and if unsigned assigns | 11
0 to the far left bit, otherwise sign extends

Logical Operations on Bit Level

& 0 1 | 0 1 a 0 1
0 0 0 0 0 1 0 0 1
1 0 1 1 0 1 1 1 0
~ 0 1

1 0
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Bitwise operators «, | and ~ perform logical operations on the appropriate pairs of
bits of their operands. Operator ~ complements each bit of its operand. For exam-
ple:

0x1234 & 0x5678 /* equals 0x1230 */
/* because ..

0x1234 : 0001 0010 0011 0100
0x5678 : 0101 0110 0111 1000

& : 0001 0010 0011 0000
. that is, 0x1230 */

/* Similarly: */

0x1234 | 0x5678; /* equals 0x567C */
0x1234 ~ 0x5678; /* equals 0x444C */
~ 0x1234; /* equals O0xEDCB */

Note: Operator s can also be a pointer reference operator. Refer to Pointers for more
information.

Bitwise Shift Operators

Binary operators << and >> move the bits of the left operand by a number of posi-
tions specified by the right operand, to the left or right, respectively. Right operand
has to be positive.

With shift left (<<), far left bits are discarded and “new” bits on the right are
assigned zeroes. Thus, shifting unsigned operand to the left by n positions is equiv-

alent to multiplying it by 21" if all discarded bits are zero. This is also true for signed
operands if all discarded bits are equal to a sign bit.
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000001 << 5; /* equals 000040 */
0x3801 << 4; /* equals 0x8010, overflow! */

With shift right (>>), far right bits are discarded and the “freed” bits on the left are
assigned zeroes (in case of unsigned operand) or the value of a sign bit (in case of
signed operand). Shifting operand to the right by 7 positions is equivalent to divid-

ing it by 21
0xFF56 >> 4; /* equals OxFFF5 */
0xFF56u >> 4; /* equals 0xO0FF5 */

Bitwise vs. Logical

Do not forget of the principle difference between how bitwise and logical operators
work. For example:

0222222 & 0555555; /* equals 000000 */
0222222 && 0555555; /* equals 1 */
~ 0x1234; /* equals O0xEDCB */
! 0x1234; /* equals 0 */

LOGICAL OPERATORS
Operands of logical operations are considered true or false, that is non-zero or zero.
Logical operators always return 1 or 0. Operands in a logical expression must be of

scalar type.

Logical operators s and | | associate from left to right. Logical negation operator !
associates from right to left.

Logical Operators Overview

Operator Operation Precedence
&& logical AND 5
I logical OR 4
! logical negation 14
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Logical Operations

&& 0 X || 1] X ! 0 X
0 0 0 0 0 1 1 0
X 0 1 X 1 1

Precedence of logical, relational, and arithmetic operators was designated in such a
way to allow complex expressions without parentheses to have an expected mean-

ng:
c >= '0"'" && c <= '9'; /* reads as: (c >= '0') && (c <= '9'") */
a+ 1 =="D || ! f(x); /* reads as: ((a + 1) ==Db) || (! (f(x)))
*/

Logical AND s« returns 1 only if both expressions evaluate to be nonzero, otherwise
returns 0. If the first expression evaluates to false, the second expression will not be
evaluated. For example:

a > Db && c < d; /* reads as (a > b) && (c < d) */
/* 1f (a > b) 1is false (0), (c < d) will not be evaluated */

Logical OR || returns 1 if either of expression evaluates to be nonzero, otherwise
returns 0. If the first expression evaluates to true, the second expression is not eval-
uated. For example:

a && b || ¢ && d; /* reads as: (a && b) || (c && d) */
/* 1f (a && b) 1s true (1), (c && d) will not be evaluated */

Logical Expressions and Side Effects

General rule regarding complex logical expressions is that the evaluation of consec-
utive logical operands stops at the very moment the final result is known. For exam-
ple, if we have an expression 2 ¢« b s c where a is false (0), then operands b and
c will not be evaluated. This is very important if b and c are expressions, as their
possible side effects will not take place!
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Logical vs. Bitwise

Be aware of the principle difference between how bitwise and logical operators
work. For example:

0222222 & 0555555 /* equals 000000 */
0222222 && 0555555 /* equals 1 */
~ 0x1234 /* equals O0xEDCB */
! 0x1234 /* equals 0 */

CONDITIONAL OPERATOR ? :

The conditional operator > : is the only ternary operator in C. Syntax of the condi-
tional operator is:

expressionl ? expression2 : expression3

The expressioni is evaluated first. If its value is true, then expression2 evaluates
and expression3 is ignored. If expressioni evaluates to false, then expression3
evaluates and expression? is ignored. The result will be a value of either expres-
sion2 or expression3 depending upon which of them evaluates.

Note: The fact that only one of these two expressions evaluates is very important if
they are expected to produce side effects!

Conditional operator associates from right to left.

Here are a couple of practical examples:

/* Find max(a, b): */
max = (a > b ) ? a : b;

/* Convert small letter to capital: */

/* (no parentheses are actually necessary) */
c = (c>= 'a'" && c <= "'z" ) ? (c - 32) : c;

Conditional Operator Rules

expressionl must be a scalar expression; expression2 and expression3 must
obey one of the following rules:
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1. Both expressions have to be of arithmetic type. expression2 and
expression3 are subject to usual arithmetic conversions, which determines
the resulting type.

2. Both expressions have to be of compatible struct or union types. The

resulting type is a structure or union type of expression2 and expression3.

. Both expressions have to be of void type. The resulting type is void.

4. Both expressions have to be of type pointer to qualified or unqualified
versionsof compatible types. The resulting type is a pointer to a type qualified
with all type qualifiers of the types pointed to by both expressions.

5. One expression is a pointer, and the other is a null pointer constant. The
resulting type is a pointer to a type qualified with all type qualifiers of the
types pointed to by both expressions.

6. One expression is a pointer to an object or incomplete type, and the other is a
pointer to a qualified or unqualified version of void. The resulting type is that
of the non-pointer-to-void expression.

W

ASSIGNMENT OPERATORS

Unlike many other programming languages, C treats value assignment as operation
(represented by an operator) rather than instruction.

Simple Assignment Operator

For a common value assignment, a simple assignment operator (=) is used:
expressionl = expression2

The expressionl is an object (memory location) to which the value of expres-
sion2 is assigned. Operand expressionl has to be lvalue and expression2 can be
any expression. The assignment expression itself is not lvalue.

If expressionl and expression2 are of different types, the result of the expres-
sion2 will be converted to the type of expressioni, if necessary. Refer to Type
Conversions for more information.

Compound Assignment Operators

C allows more comlex assignments by means of compound assignment operators.
The syntax of compound assignment operators is:
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expressionl op= expression?
where op can be one of binary operators +, -, *, /, %, &, |, *, <<, or >>,

Thus, we have 10 different compound assignment operators: +=, -=, *=, /=, %=
&=, |=, "=, <<= and >>=. All of them associate from right to left. Spaces sepa—
rating compound operators (e.g. + =) will generate error.

Compound assignment has the same effect as
expressionl = expressionl op expression?2

except the lvalue expressionl is evaluated only once. For example, expressioni
+= expression? 18 the same as expressionl = expressionl + expression?.

Assignment Rules

For both simple and compound assignment, the operands expressionl and expres-
sion2 must obey one of the following rules:

1. expressionl is of qualified or unqualified arithmetic type and expression2
is of arithmetic type.

2. expressionl has a qualified or unqualified version of structure or union type
compatible with the type of expression2,

3. expressionl and expression2 are pointers to qualified or unqualified
versions of compatible types and the type pointed to by left has all qualifiers
of the type pointed to by right.

4. Either expressionl or expression? is a pointer to an object or incomplete
type and the other is a pointer to a qualified or unqualified version of void.
The type pointed to by left has all qualifiers of the type pointed to by right.

5. expressionl is a pointer and expression? is a null pointer constant.

SIZEOF OPERATOR

The prefix unary operator sizeof returns an integer constant that represents the size
of memory space (in bytes) used by its operand (determined by its type, with some
exceptions).

The operator sizeof can take either a type identifier or an unary expression as an
operand. You cannot use sizeof with expressions of function type, incomplete
types, parenthesized names of such types, or with lvalue that designates a bit field
object.

198 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 5
mikroC for 8051 Language Reference

Sizeof Applied to Expression

If applied to expression, the size of an operand is determined without evaluating the
expression (and therefore without side effects). The result of the operation will be
the size of the type of the expression’s result.

Sizeof Applied to Type
If applied to a type identifier, sizeof returns the size of the specified type. The unit

for type size is sizeof (char) which is equivalent to one byte. The operation size-
of(char) gives the result 1, whether char is signed or unsigned.

Thus:

sizeof (char) /* returns 1 */
sizeof (int) /* returns 2 */
sizeof (unsigned long) /* returns 4 */
sizeof (float) /* returns 4 */

When the operand is a non-parameter of array type, the result is the total number of
bytes in the array (in other words, an array name is not converted to a pointer type):

int i, 3, al 10];

sizeof (af 1]1); /* j = sizeof(int) = 2 */
sizeof (a); /* 1 = 10*sizeof (int) = 20 */

]

/* To get the number of elements in an array: */
int num elem = 1i/3j;

If the operand is a parameter declared as array type or function type, sizeof gives the
size of the pointer. When applied to structures and unions, sizecof gives the total
number of bytes, including any padding. The operator sizeof cannot be applied to
a function.
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EXPRESSIONS

Expression is a sequence of operators, operands, and punctuators that specifies a
computation. Formally, expressions are defined recursively: subexpressions can be
nested without formal limit. However, the compiler will report an out-of-memory
error if it can’t compile an expression that is too complex.

In ANSI C, the primary expressions are: constant (also referred to as literal), identi-
fier, and (expression), defined recursively.

Expressions are evaluated according to a certain conversion, grouping, associativi-
ty and precedence rules, which depends on the operators used, presence of parenthe-
ses and data types of the operands. The precedence and associativity of the opera-
tors are summarized in Operator Precedence and Associativity. The way operands
and subexpressions are grouped does not necessarily specify the actual order in
which they are evaluated by the mikroC for 8051.

Expressions can produce lvalue, rvalue, or no value. Expressions might cause side
effects whether they produce a value or not.

COMMA EXPRESSIONS

One of the specifics of C is that it allows using of comma as a sequence operator to
form so-called comma expressions or sequences. Comma expression is a comma-
delimited list of expressions — it is formally treated as a single expression so it can
be used in places where an expression is expected. The following sequence:

expression 1, expression 2;

results in the left-to-right evaluation of each expression, with the value and type of
expression 2 giving the result of the whole expression. Result of expression 1is
discarded.

Binary operator comma (,) has the lowest precedence and associates from left to
right, so that =, b, cisthesameas (a, b), c.This allows writing sequences with
any number of expressions:

expression 1, expression 2, ... expression n;
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which results in the left-to-right evaluation of each expression, with the value and
type of expression n giving the result of the whole expression. Results of other
expressions are discarded, but their (possible) side-effect do occur.

For example:

result = (a =5, b /=2, ct++ );
/* returns preincremented value of variable c,
but also intializes a, divides b by 2 and increments c */

result = ( x =10, vy = x + 3, x--, z -= x * 3 - --y );
/* returns computed value of variable z,
and also computes x and y */

Note

Do not confuse comma operator (sequence operator) with comma punctuator which
separates elements in a function argument list and initializator lists. To avoid ambi-
guity with commas in function argument and initializer lists, use parentheses. For
example,

func(i, (3 =1, 3 + 4), k);
calls the function func with three arguments (i, 5, k), not four.

STATEMENTS

Statements specify a flow of control as the program executes. In the absence of spe-
cific jump and selection statements, statements are executed sequentially in the
order of appearance in the source code.

Statements can be roughly divided into:

- Labeled Statements

- Expression Statements

- Selection Statements

- Iteration Statements (Loops)

- Jump Statements

- Compound Statements (Blocks)
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LABELED STATEMENTS

Each statement in a program can be labeled. A label is an identifier added before the
statement like this:

label identifier: statement;

There is no special declaration of a label — it just “tags” the statement.
Label identifier has a function scope and the same label cannot be redefined
within the same function.

Labels have their own namespace: label identifier can match any other identifier in
the program.

A statement can be labeled for two reasons:
1. The label identifier serves as a target for the unconditional goto statement,

2. The label identifier serves as a target for the switch statement. For this pu
rpose, only case and default labeled statements are used:

case constant-expression : statement
default : statement

EXPRESSION STATEMENTS

Any expression followed by a semicolon forms an expression statement:
expression,

The mikroC for 8051 executes an expression statement by evaluating the expres-
sion. All side effects from this evaluation are completed before the next statement
starts executing. Most of expression statements are assignment statements or func-
tion calls.

A null statement is a special case, consisting of a single semicolon (;) . The null
statement does nothing, and therefore is useful in situations where the mikroC for
8051 syntax expects a statement but the program does not need one. For example, a
null statement is commonly used in “empty” loops:

for (; *gt+t = *pt++ ;); /* body of this loop is a null statement */
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SELECTION STATEMENTS

Selection or flow-control statements select one of alternative courses of action by
testing certain values. There are two types of selection statements:

- if

- switch

IF STATEMENT

The if statement is used to implement a conditional statement. The syntax of the if
statement is:

if (expression) statementl [ else statement?2]

If expression evaluates to true, statementl executes. If expression is false,
statement2 executes. The expression must evaluate to an integral value; other-
wise, the condition is ill-formed. Parentheses around the expression are mandato-

ry.

The c1se keyword is optional, but no statements can come between if and e1se.
Nested If statements

Nested i statements require additional attention. A general rule is that the nested
conditionals are parsed starting from the innermost conditional, with each c1se
bound to the nearest available i on its left:

if (expressionl) statementl
else if (expression?2)
if (expression3) statement2

else statement3 /* this belongs to: 1if (expression3) */
else statementd /* this belongs to: 1if (expression2) */
Note

#if and #else preprocessor statements (directives) look similar to i and else
statements, but have very different effects. They control which source file lines are
compiled and which are ignored.
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SWITCH STATEMENT

The switch statement is used to pass control to a specific program branch, based on
a certain condition. The syntax of the switch statement is:

switch (expression) {
case constant-expression 1 : statement 1;

case constant-expression n : statement n;
[ default : statement;]

}

First, the expression (condition) is evaluated. The switch statement then compares
it to all available constant-expressions following the keyword case. If a match is
found, switch passes control to that matching case causing the statement follow-
ing the match evaluates. Note that constant-expressions must evaluate to integer.
It is not possible to have two same constant expressions evaluating to the same
value.

Parentheses around expression are mandatory.

Upon finding a match, program flow continues normally: the following instructions
will be executed in natural order regardless of the possible case label. If no case
satisfies the condition, the default case evaluates (if the label default is speci-
fied).

For example, if a variable : has value between 1 and 3, the following switch would
always return it as 4:

switch (i) {
case 1: i++;
case 2: i++;
case 3: i++;

}

To avoid evaluating any other cases and relinquish control from switch, each case
should be terminated with break.

Here is a simple example with switch. Suppose we have a variable phase with only
3 different states (0, 1, or 2) and a corresponding function (event) for each of these
states. This is how we could switch the code to the appopriate routine:
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switch (phase) {
case 0: Lo(); break;
case 1: Mid(); break;
case 2: Hi(); break;

default: Message("Invalid state!");
}

Nested switch

Conditional switch statements can be nested — labels case and default are then
assigned to the innermost enclosing switch statement.

ITERATION STATEMENTS (LOOPS)

Iteration statements allows to loop a set of statements. There are three forms of iter-
ation statements in the mikroC for 8051:

- while
-do
- for

WHILE STATEMENT

The while keyword is used to conditionally iterate a statement. The syntax of the
while statement is:

while (expression) statement

The statement executes repeatedly until the value of expression is false. The test
takes place before statement is executed. Thus, if expression evaluates to false on
the first pass, the loop does not execute. Note that parentheses around expression
are mandatory.

Here is an example of calculating scalar product of two vectors, using the while
statement:

int s = 0, 1 = 0;
while (i < n) {
s += al 1] * D[ i];
i++;

}
Note that body of the loop can be a null statement. For example:

while (*g++ = *p++);
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DO STATEMENT

The do statement executes until the condition becomes false. The syntax of the do
statement is:

do statement while (expression);

The statement is executed repeatedly as long as the value of expression remains
non-zero. The expression is evaluated after each iteration, so the loop will execute
statement at least once.

Parentheses around expression are mandatory.

Note that do is the only control structure in C which explicitly ends with semi-
colon (;) . Other control structures end with statement, which means that they

implicitly include a semicolon or closing brace.

Here is an example of calculating scalar product of two vectors, using the do state-
ment:

do {
s += al i] * bl i];
i++;

} while ( i < n );

FOR STATEMENT
The for statement implements an iterative loop. The syntax of the for statement is:

for ([ init-expression]; [ condition-expression] ; [ increment-expres-
sion] ) statement

Before the first iteration of the loop, init-expression sets the starting variables
for the loop. You cannot pass declarations in init-expression.

condition-expression is checked before the first entry into the block; state-
ment is executed repeatedly until the value of condition-expression is false.
After each iteration of the loop, increment-expression increments a loop count-
er. Consequently, i++ is functionally the same as ++1.

All expressions are optional. If condition-expression is left out, it is assumed to
be always true. Thus, “empty” for statement is commonly used to create an end-
less loop in C:
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for ( ; ; ) statement
The only way to break out of this loop is by means of the brezk statement.

Here is an example of calculating scalar product of two vectors, using the for state-
ment:

for (s =0, i = 0; i < n; i++ ) s += a[i] * W[ i];
There is another way to do this:

for (s =0, i =0; 1 < n; s += a[i] * bl 1], 1i++ ); /* valid, but
ugly */

but it is considered a bad programming style. Although legal, calculating the sum
should not be a part of the incrementing expression, because it is not in the service
of loop routine. Note that null statement (;) is used for the loop body.

JUMP STATEMENTS

The jump statement, when executed, transfers control unconditionally. There are
four such statements in the mikroC for 8051:

- break

- continue
- goto

- return

BREAK AND CONTINUE STATEMENTS

Break Statement

Sometimes it is necessary to stop the loop within its body. Use the break statement
within loops to pass control to the first statement following the innermost switch,

for, while, Or do block.

Break is commonly used in the switch statements to stop its execution upon the first
positive match. For example:
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switch (state) {
case 0: Lo(); break;
case 1: Mid(); break;
case 2: Hi(); break;

default: Message ("Invalid state!");

Continue Statement

The continue statement within loops is used to “skip the cycle”. It passes control
to the end of the innermost enclosing end brace belonging to a looping construct. At
that point the loop continuation condition is re-evaluated. This means that contin-
ue demands the next iteration if the loop continuation condition is true.

Specifically, the continue statement within the loop will jump to the marked posi-
tion as it is shown below:

while (..) { do {

if (val>0) continue; if (val>0) continue;
// continue jumps here // continue jumps here
} while (..);

for (..;..;..) {

if (val>0) continue;

// continue jumps here

}
GOTO STATEMENT

The goto statement is used for unconditional jump to a local label — for more infor-
mation on labels, refer to Labeled Statements. The syntax of the goto statement is:

goto label identifier ;

This will transfer control to the location of a local label specified by 1zabel iden-
tifier. The label identifier has to be a name of the label within the same function
in which the goto statement is. The goto line can come before or after the label.
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goto is used to break out from any level of nested control structures but it cannot be
used to jump into block while skipping that block’s initializations — for example,
jumping into loop’s body, etc.

The use of goto statement is generally discouraged as practically every algorithm
can be realized without it, resulting in legible structured programs. One possible
application of the goto statement is breaking out from deeply nested control struc-
tures:

for (...) {
for (...) {

if (disaster) goto Error;

Error: /* error handling code */
RETURN STATEMENT

The return statement is used to exit from the current function back to the calling rou-
tine, optionally returning a value. The syntax is:

return [ expression] ;

This will evaluate expression and return the result. Returned value will be auto-
matically converted to the expected function type, if needed. The expression is
optional; if omitted, the function will return a random value from memory.

Note: The statement return in functions of the void type cannot have expression
—1n fact, the return statement can be omitted altogether if it is the last statement in
the function body.

COMPOUND STATEMENTS (BLOCKS)

The compound statement, or block, is a list (possibly empty) of statements enclosed
in matching braces { }. Syntactically, the block can be considered to be a single
statement, but it also plays a role in the scoping of identifiers. An identifier declared
within the block has a scope starting at the point of declaration and ending at the
closing brace. Blocks can be nested to any depth up to the limits of memory.
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For example, the for loop expects one statement in its body, so we can pass it a com-
pound statement:

for (i = 0; 1 < n; i++ ) {
int temp = a[ i]
al i] = bl 1] ;
bl 1] = temp;

}

Note that, unlike other statements, compound statements do not end with semicolon
(;), 1.e. there is never a semicolon following the closing brace.

PREPROCESSOR

Preprocessor is an integrated text processor which prepares the source code for com-
piling. Preprocessor allows:

- inserting text from a specifed file to a certain point in the code (see File
Inclusion),
- replacing specific lexical symbols with other symbols (see Macros),
- conditional compiling which conditionally includes or omits parts of the code
(see Conditional Compilation).
Note that preprocessor analyzes text at token level, not at individual character level.
Preprocessor is controled by means of preprocessor directives and preprocessor
operators.

PREPROCESSOR DIRECTIVES

Any line in the source code with a leading # is taken as a preprocessing directive (or
control line), unless # is within a string literal, in a character constant, or embedded
in a comment. The initial # can be preceded or followed by a whitespace (excluding
new lines).

A null directive consists of a line containing the single character #. This line is
always ignored.

Preprocessor directives are usually placed at the beginning of the source code, but
they can legally appear at any point in a program. The mikroC for 8051 preproces-
sor detects preprocessor directives and parses the tokens embedded in them. A direc-
tive is in effect from its declaration to the end of the program file.
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Here is one commonly used directive:

#include <math.h>

For more information on including files with the #inciude directive, refer to File
Inclusion.

The mikroC for 8051 supports standard preprocessor directives:

# (null directive) #1f
#define #ifdef
#elif #ifndef
#else #include
#endif #line
#error #undef

Note: For the time being only funcall pragma is supported.
Line Continuation with Backslash (\)

To break directive into multiple lines end the line with a backslash (\) :

#define MACRO This directive continues to \
the following line.

MACROS

Macros provide a mechanism for a token replacement, prior to compilation, with or
without a set of formal, function-like parameters.

Defining Macros and Macro Expansions

The #define directive defines a macro:
#define macro identifier <token sequence>

Each occurrence of macro identifier in the source code following this control
line will be replaced in the original position with the possibly empty
token sequence (there are some exceptions, which are discussed later). Such
replacements are known as macro expansions. token sequence is sometimes called
the body of a macro. An empty token sequence results in the removal of each affect-
ed macro identifier from the source code.
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No semicolon (;) is needed to terminate a preprocessor directive. Any character
found in the token sequence, including semicolons, will appear in a macro expan-
sion.token sequence terminates at the first non-backslashed new line encountered.
Any sequence of whitespace, including comments in the token sequence, is replaced
with a single-space character.

After each individual macro expansion, a further scan is made of the newly expand-
ed text. This allows the possibility of using nested macros: the expanded text can
contain macro identifiers that are subject to replacement. However, if the macro
expands into something that looks like a preprocessing directive, such directive will
not be recognized by the preprocessor. Any occurrences of the macro identifier
found within literal strings, character constants, or comments in the source code will
not be expanded.

A macro won’t be expanded during its own expansion (SO #define MACRO MACRO
won’t expand indefinitely).

Here is an example:

/* Here are some simple macros: */
#define ERR _MSG "Out of range!"
#define EVERLOOP for( ; ; )

/* which we could use like this: */

main () {
EVERLOOP ({

if (error) { Lcd Out Cp(ERR MSG); break; }

}

Attempting to redefine an already defined macro identifier will result in a warning
unless a new definition is exactly the same token-by-token definition as the existing
one. The preferred strategy when definitions might exist in other header files is as
follows:

#ifndef BLOCK _SIZE
#define BLOCK SIZE 512
#endif

The middle line is bypassed if crock s1zE is currently defined; if Bt.ock s1zE is not
currently defined, the middle line is invoked to define it.
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Macros with Parameters

The following syntax is used to define a macro with parameters:

#define macro identifier (<arg list>) <token sequence>

Note that there can be no whitespace between macro identifier and “(”. The
optional zrg 1ist is a sequence of identifiers separated by commas, like the argu-
ment list of a C function. Each comma-delimited identifier has the role of a formal
argument or placeholder.

Such macros are called by writing

macro identifier (<actual arg list>)

in the subsequent source code. The syntax is identical to that of a function call;
indeed, many standard library C “functions” are implemented as macros. However,
there are some important semantic differences.

The optional actual arg 1ist must contain the same number of comma-delimited
token sequences, known as actual arguments, as found in the formal arg_list of the
#define line — there must be an actual argument for each formal argument. An error
will be reported if the number of arguments in two lists is not the same.

A macro call results in two sets of replacements. First, the macro identifier and the
parenthesis-enclosed arguments are replaced by the token sequence. Next, any for-
mal arguments occurring in the token sequence are replaced by the corresponding
real arguments appearing in actual arg 1ist. Like with simple macro definitions,
rescanning occurs to detect any embedded macro identifiers eligible for expansion.

Here is a simple example:

/* A simple macro which returns greater of its 2 arguments: */
#define MAX (A, B) ((A) > (B)) ? (A) : (B)

/* Let's call it: */
x = MAX(a + b, c + d);

/* Preprocessor will transform the previous line into:
x = ((a +b) > (¢c+d)) ? (a+Db) : (¢c +d */
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It is highly recommended to put parentheses around each argument in the macro
body in order to avoid possible problems with operator precedence.

Undefining Macros

The #under directive is used to undefine a macro.

#undef macro identifier

The directive #undef detaches any previous token sequence from macro identi-
fier; the macro definition has been forgotten, and macro identifier is undefined.
No macro expansion occurs within the #undef lines.

The state of being defined or undefined is an important property of an identifier,
regardless of the actual definition. The #ifdef and #1i fndef conditional directives,
used to test whether any identifier is currently defined or not, offer a flexible mech-
anism for controlling many aspects of a compilation.

After a macro identifier has been undefined, it can be redefined with #define, using
the same or different token sequence.

FILE INCLUSION

The preprocessor directive #include pulls in header files (extension .n) into the
source code. Do not rely on preprocessor to include source files (extension .c) —
see Add/Remove Files from Project for more information.

The syntax of the #inciude directive has two formats:

#include <header name>
#include "header name"

The preprocessor removes the #include line and replaces it with the entire text of
a header file at that point in the source code. The placement of #inc1ude can there-
fore influence the scope and duration of any identifiers in the included file.

The difference between these two formats lies in searching algorithm employed in
trying to locate the include file.

If the #incilude directive is used with the <header name> version, the search is
made successively in each of the following locations, in this particular order:
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1. the mikroC for 8051 installation folder » “include” folder
2. user's custom search paths

The "header name" version specifies a user-supplied include file; the mikroC for
8051 will look for the header file in the following locations, in this particular order:

1. the project folder (folder which contains the project file . opc)
2. the mikroC for 8051 installation folder » “include” folder
3. user's custom search paths

Explicit Path

By placing an explicit path in header nzame, only that directory will be searched. For
example:

#include "C:\my files\test.h"
Note

There is also a third version of the #inciude directive, rarely used, which assumes
that neither < nor " appear as the first non-whitespace character following

#include:
#include macro identifier

It assumes that macro definition that will expand macro identifier into a valid delim-
ited header name with either <header name> Or "header name" formats exists.

PREPROCESSOR OPERATORS

The # (pound sign) is a preprocessor directive when it occurs as the first non-white-
space character on a line. Also, # and ## perform operator replacement and merging
during the preprocessor scanning phase.

Operator #

In C preprocessor, a character sequence enclosed by quotes is considered a token
and its content is not analyzed. This means that macro names within quotes are not
expanded.
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If you need an actual argument (the exact sequence of characters within quotes) as
a result of preprocessing, use the # operator in macro body. It can be placed in front
of a formal macro argument in definition in order to convert the actual argument to
a string after replacement.

For example, let’s have macro 1.cp prInT for printing variable name and value on
LCD:

#define LCD PRINT (val) Lcd Custom Out Cp(#val ": "); \
Lcd Custom Out Cp (IntToStr(val));

Now, the following code,
LCD_PRINT (temp)
will be preprocessed to this:
Lcd Custom Out Cp ("temp" ": "); Lcd Custom Out Cp(IntToStr (temp));

Operator ##

Operator ## is used for token pasting. Two tokens can be pasted(merged) together
by placing ## in between them (plus optional whitespace on either side). The pre-
processor removes whitespace and #+#, combining the separate tokens into one new
token. This is commonly used for constructing identifiers.

For example, see the definition of macro srr.1ce for pasting two tokens into one
identifier:

#define SPLICE(x,y) x ##  ## y
Now, the call spr1ce (ent, 2) will expand to the identifier cnt 2.

Note

The mikroC for 8051 does not support the older nonportable method of token past-
ing using (1/**/r).
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CONDITIONAL COMPILATION

Conditional compilation directives are typically used to make source programs easy
to change and easy to compile in different execution environments. The mikroC for
8051 supports conditional compilation by replacing the appropriate source-code
lines with a blank line.

All conditional compilation directives must be completed in the source or include
file in which they have begun.

Directives #if, #elif, #else, and #endif

The conditional directives #if, #eclif, #else, and #endif work very similar to
the common C conditional statements. If the expression you write after #i has a
nonzero value, the line group immediately following the #1i ¢ directive is retained in
the translation unit.

The syntax is:

#1f constant expression 1
<section 1>

[ #elif constant expression 2
<section 2>]

[ #elif constant expression n
<section n>]

[ #else
<final section>]

#endif

Each #: f directive in a source file must be matched by a closing #endif directive.
Any number of #<1: £ directives can appear between #if and #endi £ directives, but
at most one #e1se directive is allowed. The #e1se directive, if present, must be the
last directive before #endif.

sections can be any program text that has meaning to compiler or preprocessor.
The preprocessor selects a single section by evaluating constant expression fol-
lowing each #if or #e1if directive until it finds a true (nonzero) constant expres-
sion. The constant expressions are subject to macro expansion.
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If all occurrences of constant-expression are false, or if no #e11i directives appear,
the preprocessor selects the text block after the #c1se clause. If the #c1se clause is
omitted and all instances of constant expression in the #if block are false, no
section is selected for further processing.

Any processed section can contain further conditional clauses, nested to any depth.
Each nested #c1se, #elif, or #endif directive belongs to the closest preceding the

41 £ directive.

The net result of the preceding scenario is that only one code section (possibly
empty) will be compiled.

Directives #ifdef and #ifndef

The #ifdef and #1fndef directives can be used anywhere #1i £ can be used and they
can test whether an identifier is currently defined or not. The line

#ifdef identifier

has exactly the same effect as #if 1 if identifier is currently defined, and the
same effect as #if 0 if identifier is currently undefined. The other directive,
#ifndef, tests true for the “not-defined” condition, producing the opposite results.

The syntax thereafter follows that of #if, #elif, #eclse, and #endif.

An identifier defined as nvuLL is considered to be defined.
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mikroC for 8051 provides a set of libraries which simplify the initialization and
use of 8051 compliant MCUs and their modules
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MIKROC FOR 8051 LIBRARIES

mikroC for 8051 provides a set of libraries which simplify the initialization and use
of 8051 compliant MCUs and their modules:

Use Library manager to include mikroC for 8051 Libraries in you project.
Hardware 8051-specific Libraries

- CANSPI Library

- EEPROM Library

- Graphic LCD Library

- Keypad Library

- LCD Library

- Manchester Code Library
- OneWire Library

- Port Expander Library

- PS/2 Library

- RS-485 Library

- Software 12C Library

- Software SPI Library

- Software UART Library

- Sound Library

- SPI Library

- SPI Ethernet Library

- SPI Graphic LCD Library
- SPI LCD Library

- SPI LCD8 Library

- SPI T6963C Graphic LCD Library
- T6963C Graphic LCD Library

Standard ANSI C Libraries

- ANSI C Ctype Library
- ANSI C Math Library
- ANSI C Stdlib Library
- ANSI C String Library

Miscellaneous Libraries

- Button Library

- Conversions Library
- Sprint Library

- Time Library

- Trigonometry Library

See also Built-in Routines.
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LIBRARY DEPENDENCIES

Certain libraries use (depend on) function and/or variables, constants defined in
other libraries.
Image below shows clear representation about these dependencies.

For example, SPI_Glcd uses Gled_Fonts and Port Expander library which uses SPI
library.

This means that if you check SPI Gled library in Library manager, all libraries on
which it depends will be checked too.
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CANSPI LIBRARY

The SPI module is available with a number of the 8051 compliant MCUs. The
mikroC for 8051 provides a library (driver) for working with mikroElektronika's
CANSPI Add-on boards (with MCP2515 or MCP2510) via SPI interface.

The CAN is a very robust protocol that has error detection and signalization,
self—checking and fault confinement. Faulty CAN data and remote frames are re-
transmitted automatically, similar to the Ethernet.

Data transfer rates depend on distance. For example, 1 Mbit/s can be achieved at
network lengths below 40m while 250 Kbit/s can be achieved at network lengths
below 250m. The greater distance the lower maximum bitrate that can be achieved.
The lowest bitrate defined by the standard is 200Kbit/s. Cables used are shielded
twisted pairs.

CAN supports two message formats:

- Standard format, with 11 identifier bits and
- Extended format, with 29 identifier bits

Note:

- Consult the CAN standard about CAN bus termination resistance.

- An effective CANSPI communication speed depends on SPI and certainly is
slower than “real” CAN.

- CANSPI module refers to mikroElektronika's CANSPI Add-on board
connected to SPI module of MCU.

External dependecies of CANSPI Library

The following variables must be

defined in all projects using Description: Example:

CANSPI Library:

extern sbit CanSpi CS; Chip Select line. sbit CanSpi CS
at P1.BO;

extern sbit CanSpi Rst; Reset line. sbit CanSpi Rst
at P1.B2;
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Library Routines

- CANSPISetOperationMode
- CANSPIGetOperationMode
- CANSPIInitialize

- CANSPISetBaudRate

- CANSPISetMask

- CANSPISetFilter

- CANSPIread

- CANSPIWrite

The following routines are for an internal use by the library only:

- RegsToCANSPIID
- CANSPIIDToRegs

Be sure to check CANSPI constants necessary for using some of the functions.

CANSPISetOperationMode

Prototype void CANSPISetOperationMode (char mode, char WAIT);

Returns | Nothing.

Description | Sets the CANSPI module to requested mode.
Parameters :

- mode: CANSPI module operation mode. Valid values: can
sp1 op MODE constants (see CANSPI constants).
- wa1T: CANSPI mode switching verification request. If warT
== 0, the call is non-blocking. The function does not verify if
the CANSPI module is switched to requested mode or not.
Caller must use CANSPIGetOperationMode to verify correct
operation mode before performing mode specific operation. If
WATT != 0, the call is ]lj)locking — the function won’t “return”
until the requested mode is set.

Requires Thez1 ClANSPI routines are supported only by MCUs with the SPI
module.

MCU has to be properly connected to mikroElektronika's CANSPI
Extra Board or similar hardware. See connection example at the
bottom of this page.

Example |// set the CANSPI module into configuration mode (wait
inside CANSPISetOperationMode until this mode is set)
CANSPISetOperationMode(CANSPIiMODE7CONFIG, O0xFF) ;
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CANSPIGetOperationMode

Prototype

char CANSPIGetOperationMode (void) ;

Returns

Current operation mode.

Description

The function returns current operation mode of the CANSPI mod-
ule. Check canspr op mMoDE constants (see CANSPI constants) or
device datasheet for operation mode codes.

Requires

The CANSPI routines are supported only by MCUs with the SPI
module.

MCU has to be properly connected to mikroElektronika's CAN-
SPI Extra Board or similar hardware. See connection example at
the bottom of this page.

Example

// check whether the CANSPI module is in Normal mode
and 1f it is do something.
if (CANSPIGetOperationMode () == CANSPI MODE NORMAL) {

}
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CANSPIInitialize

Prototype void CANSPIInitialize( char SJW, char BRP, char
PHSEG1, char PHSEG2, char PROPSEG, char
CAN CONFIG FLAGS) ;

Returns | Nothing.

Description | Initializes the CANSPI module.
Stand-Alone CAN controller in the CANSPI module is set to:

- Disable CAN capture

- Continue CAN operation in Idle mode

- Do not abort pending transmissions

- Fcan clock : 4*Tcy (Fosc)

- Baud rate is set according to given parameters

- CAN mode : Normal

- Filter and mask registers IDs are set to zero

- Filter and mask message frame type is set according
to CAN CONFIG FLAGS value

SAM, SEG2PHTS, WAKFIL and DBEN bits are set according to
CAN CONFIG FLAGS value.

Parameters:

- suw as defined in CAN controller's datasheet

- Brp as defined in CAN controller's datasheet

- puseG1 as defined in CAN controller's datasheet

- puseG2 as defined in CAN controller's datasheet

- propseG as defined in CAN controller's datasheet

- caN conrF1G FLAGS is formed from predefined constants (see
CANSPI constants)

Requires | canspi Cs and canspi Rst variables must be defined before
using this function.

The CANSPI routines are supported only by MCUs with the SPI
module.

The SPI module needs to be initialized. See the Spi_Init and
Spi_Init Advanced routines.

MCU has to be properly connected to mikroElektronika's CAN-
SPI Extra Board or similar hardware. See connection example at
the bottom of this page.
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Example // initialize the CANSPI module with the appropriate
baud rate and message acceptance flags along with the
sampling rules

char Can Init Flags;

Can Init Flags = CAN CONFIG SAMPLE THRICE &
// form value to be used
CAN CONFIG PHSEG2 PRG ON &
// with CANSPIInitialize
CAN CONFIG XTD MSG &
CAN CONFIG DBL BUFFER ON &
CAN CONFIG VALID XTD MSG;

Spi Init(); // initialize SPI module
CANSPIInitialize(1,3,3,3,1,Can Init Flags);
// initialize external CANSPI module

CANSPISetBaudRate

Prototype void CANSPISetBaudRate( char SJW, char BRP, char
PHSEG1, char PHSEG2, char PROPSEG, char
CAN CONFIG FLAGS);

Returns | Nothing.

Description | Sets the CANSPI module baud rate. Due to complexity of the
CAN protocol, you can not simply force a bps value. Instead, use
this function when the CANSPI module is in Config mode.

saM, sec2puTs and WAKFTL bits are set according to cAn con-
F1G FLAGS value. Refer to datasheet for details.

Parameters:

- suw as defined in CAN controller's datasheet

- Brp as defined in CAN controller's datasheet

- rusecl as defined in CAN controller's datasheet

- pusec2 as defined in CAN controller's datasheet

- proprskG as defined in CAN controller's datasheet

- CAN cONFIG FLAGS is formed from predefined constants (see
CANSPI constants)
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Requires | The CANSPI module must be in Config mode, otherwise the
function will be ignored. See CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI
module.

MCU has to be properly connected to mikroElektronika's CAN-
SPI Extra Board or similar hardware. See connection example at
the bottom of this page.

Example // set required baud rate and sampling rules
char can config flags;

CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF);

// set CONFIGURATION mode (CANSPI module mast be 1in

config mode for baud rate settings)

can config flags = CANSPI CONFIG SAMPLE THRICE &
CANSP17CONFIG7PHSEG27PRG7©N &
CANSPI CONFIG STD MSG &
CANSPI CONFIG DBL BUFFER ON &
CANSPI CONFIG VALID XTD MSG &
CANSPI CONFIG LINE FILTER OFF;

CANSPISetBaudRate(l, 1, 3, 3, 1, can config flags);

CANSPISetMask

Prounype void CANSPISetMask (char CAN MASK, long val, char
CAN CONFIG_FLAGS) ;

Returns | Nothing.

Description | Configures mask for advanced filtering of messages. The parame-
ter value is bit-adjusted to the appropriate mask registers.

Parameters:

- can mask: CANSPI module mask number. Valid values:
CANSPI_MASK constants (see CANSPI constants)

- val: mask register value

- CAN CONFIG FLAGS: selects type of message to filter. Valid

values:

CANSPI CONFIG ALL VALID MSG,
CANSPI CONFIG MATCH MSG TYPE & CANSPI CON
FIG STD MSG,
CANSPI CONFIG MATCH MSG TYPE & CANSPI CON
FIG_XTD MSG.

(see CANSPI constants)
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Requires | The CANSPI module must be in Config mode, otherwise the
function will be ignored. See CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI
module.

MCU has to be properly connected to mikroElektronika's CAN-
SPI Extra Board or similar hardware. See connection example at
the bottom of this page.

Exanqﬂe // set the appropriate filter mask and message type
value
CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF);

// set CONFIGURATION mode (CANSPI module must be 1in
config mode for mask settings)

// Set all Bl mask bits to 1 (all filtered bits are

relevant) :

// Note that -1 is just a cheaper way to write
OxFFFFFFFF.

// Complement will do the trick and fill it up with
ones.

CANSPISetMask (CANSPI MASK Bl, -1,
CANSPI CONFIG MATCH MSG_TYPE & CANSPI CONFIG XTD MSG)

CANSPISetFilter

Prounype void CANSPISetFilter (char CAN FILTER, long val, char
CAN CONFIG FLAGS) ;

Returns | Nothing.

Description | Configures message filter. The parameter value is bit-adjusted to
the appropriate filter registers.

Parameters:

- can_r1nTErR: CANSPI module filter number. Valid values:
canspl FILTER constants (see CANSPI constants)
- wval: filter register value
- CAN CONFIG FLAGS: selects type of message to filter. Valid
values:
CANSPI CONFIG _ALL VALID MSG,
CANSPI CONFIG MATCH MSG_TYPE & CANSPI CONFIG_STD MSG,
CANSPI_CONFIG MATCH MSG TYPE & CANSPI_CONFIG XTD MSG.
(see CANSPI constants)
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Requires | The CANSPI module must be in Config mode, otherwise the
function will be ignored. See CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI
module.

MCU has to be properly connected to mikroElektronika's CAN-
SPI Extra Board or similar hardware. See connection example at
the bottom of this page.

Example // set the appropriate filter value and message type
CANSPISetOperationMode (CANSPI MODE CONFIG, OxFF);

// set CONFIGURATION mode (CANSPI module must be in
config mode for filter settings)

/* Set 1id of filter Bl F1 to 3: */
CANSPISetFilter (CANSPI FILTER Bl F1, 3, CANSPI CON-
FIG_XTD_MSG) ;

CANSPIRead

Prototype char CANSPIRead(long *id, char *rd data, char
*data len, char *CAN RX MSG FLAGS) ;

Returns | - 0 if nothing is received
- oxrr if one of the Receive Buffers is full (message received)

Description | If at least one full Receive Buffer is found, it will be processed in
the following way:

- Message ID is retrieved and stored to location provided by the
id parameter

- Message data is retrieved and stored to a buffer provided by the
rd data parameter

- Message length is retrieved and stored to location provided by
the data 1en parameter

- Message flags are retrieved and stored to location provided by
the cAN Rx MSG FLAGS parameter

Parameters:

- id: message identifier storage address

- rd data: data buffer (an array of bytes up to 8 bytes in length)
- data len: data length storage address.

- CAN RX MSG FLAGS: message flags storage address
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Requires | The CANSPI module must be in a mode in which receiving is
possible. See CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI
module.

MCU has to be properly connected to mikroElektronika's CAN-
SPI Extra Board or similar hardware. See connection example at
the bottom of this page.

Example // check the CANSPI module for received messages. If
any was received do something.

char msg rcvd, rx flags, data len;

char datal 8] ;

long msg id;

CANSPISetOperationMode (CANSPIiMODEiNORMAL, OxXFF) ;
// set NORMAL mode (CANSPI module must be in mode 1in
which receive 1is possible)

rx flags = 0;

// clear message flags

if (msg rcvd = CANSPIRead(msg id, data, data len,
rx flags)) {

}

CANSPIWrite

Prototype char CANSPIWrite (long id, char *wr data, char
data len, char CAN TX MSG FLAGS) ;

Returns | - o if all Transmit Buffers are busy
- oxrr if at least one Transmit Buffer is available

Description | If at least one empty Transmit Buffer is found, the function sends
message in the queue for transmission.

Parameters:

- 1d:CAN message identifier. Valid values: 11 or 29 bit values,
depending on message type (standard or extended)

- wr data: data to be sent (an array of bytes up to 8 bytes in
length)

- data len: data length. Valid values: 1 to 8

- CAN RX MSG FLAGS: message flags
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Requires | The CANSPI module must be in mode in which transmission is
possible. See CANSPISetOperationMode.

The CANSPI routines are supported only by MCUs with the SPI
module.

MCU has to be properly connected to mikroElektronika's CAN-
SPI Extra Board or similar hardware. See connection example at
the bottom of this page.

Exanqﬂe // send message extended CAN message with the appro-
priate ID and data

char tx flags;

char datal 8] ;

long msg_ id;

CANSPISetOperationMode(CANiMODEANORMAL,OxFF);
// set NORMAL mode (CANSPI must be in mode in which
transmission is possible)

tx flags = CANSPI TX PRIORITY 0 & CANSPI TX XTD FRAME;
// set message flags
CANSPIWrite (msg_id, data, 2, tx flags);

CANSPI Constants

There is a number of constants predefined in the CANSPI library. You need to be
familiar with them in order to be able to use the library effectively. Check the
example at the end of the chapter.

CANSPI_OP_MODE

The CANSPI_OP_MODE constants define CANSPI operation mode. Function
CANSPISetOperationMode expects one of these as it's argument:

const char
CANSPI MODE BITS

0xEO, // Use this to access opmode bits

CANSPI MODE NORMAL = 0x00,
CANSPI MODE SLEEP = 0x20,
CANSPI MODE LOOP = 0x40,

CANSPI MODE LISTEN = 0x60,
CANSPI MODE CONFIG = 0x80;
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CANSPI_CONFIG_FLAGS

The CANSPI CONFIG_FLAGS constants define flags related to the CANSPI
module configuration. The functions CANSPIInitialize, CANSPISetBaudRate,
CANSPISetMask and CANSPISetFilter expect one of these (or a bitwise combina-
tion) as their argument:

const char

CANSPI CONFIG DEFAULT = OxFF, // 11111111
CANSPI CONFIG PHSEG2 PRG BIT 0x01,

CANSPI CONFIG PHSEG2 PRG ON = OxFF, // XXXXXXX1
CANSPI CONFIG PHSEG2 PRG OFF = OxFE, // XXXXXXXO0
CANSPI CONFIG LINE FILTER BIT 0x02,

CANSPI CONFIG LINE FILTER ON = OxFF, // XXXXXX1X
CANSPI CONFIG LINE FILTER OFF = OxFD, // XXXXXX0X
CANSPI CONFIG SAMPLE BIT 0x04,

CANSPI CONFIG SAMPLE ONCE = OxFF, // XXXXXIXX
CANSPI CONFIG SAMPLE THRICE = OxFB, // XXXXX0XX
CANSPI CONFIG MSG TYPE BIT = 0x08,

CANSPI CONFIG STD MSG = OxFF, // XXXXIXXX
CANSPI CONFIG XTD MSG = 0xF7, // XXXX0XXX
CANSPI CONFIG DBL BUFFER BIT 0x10,

CANSPI CONFIG DBL BUFFER ON = OxFF, // XXX1XXXX
CANSPI CONFIG DBL BUFFER OFF = OxEF, // XXXO0XXXX
CANSPI CONFIG MSG BITS 0x60,

CANSPI CONFIG ALL MSG = OxFF, // X11XXXXX
CANSPI CONFIG VALID XTD MSG 0xDF, // X10XXXXX
CANSPI CONFIG VALID STD MSG = OxBF, // X01XXXXX
CANSPI CONFIG ALL VALID MSG = 0x9F; // X00XXXXX

You may use bitwise AND () to form config byte out of these values. For exam-
ple:

init = CANSPI CONFIG SAMPLE THRICE &
CANSPI CONFIG PHSEG2 PRG ON &
CANSPI CONFIG STD MSG &
CANSPI CONFIG DBL BUFFER ON &
CANSPI CONFIG VALID XTD MSG &
CANSPI CONFIG LINE FILTER OFF;

CANSPIInitialize(1l, 1, 3, 3, 1, init); // initialize CANSPI
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CANSPI_TX_MSG_FLAGS

CANSPI TX MSG FLAGS are flags related to transmission of a CAN message:

const char
CANSPI TX PRIORITY BITS = 0x03,

CANSPI TX PRIORITY O = 0xFC, // XXXXXX00
CANSPI TX PRIORITY 1 = 0xFD, // XXXXXX01
CANSPI TX PRIORITY 2 = OxFE, // XXXXXX10
CANSPI TX PRIORITY 3 = OxFF, // XXXXXX11
CANSPI TX FRAME BIT = 0x08,

CANSPI TX STD FRAME = OxFF, // XXXXX1XX
CANSPI TX XTD FRAME = 0xF7, // XXXXX0XX
CANSPI TX RTR BIT = 0x40,

CANSPI TX NO RTR FRAME = OxFF, // XIXXXXXX
CANSPI TX RTR FRAME = 0xBF; // XOXXXXXX

You may use bitwise AND (&) to adjust the appropriate flags. For example:
/* form value to be used as sending message flag : */
send config = CANSPI TX PRIORITY 0 &

CANSPI TX XTD FRAME &

CANSPI TX NO RTR FRAME;

CANSPIWrite (id, data, 1, send config);

CANSPI_RX_MSG_FLAGS

CANSPI RX MSG_FLAGS are flags related to reception of CAN message. If a
particular bit is set then corresponding meaning is TRUE or else it will be FALSE.

const char

CANSPI RX FILTER BITS = 0x07, // Use this to access filter
bits
CANSPI RX FILTER 1 = 0x00,
CANSPI RX FILTER 2 = 0x01,
CANSPI RX FILTER 3 = 0x02,
CANSPI RX FILTER 4 = 0x03,
CANSPI RX FILTER 5 = 0x04,
CANSPI RX FILTER 6 = 0x05,
CANSPI RX OVERFLOW = 0x08, // Set if Overflowed else cleared

CANSPI_RX INVALID MSG = 0x10, // Set if invalid else cleared
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CANSPI RX XTD FRAME = 0x20, // Set if XTD message else
cleared
CANSPI RX RTR FRAME = 0x40, // Set if RTR message else
cleared

CANSPI_RX DBL_BUFFERED = 0x80; // Set if this message was
hardware double-buffered

You may use bitwise AND («) to adjust the appropriate flags. For example:

if (MsgFlag & CANSPI RX OVERFLOW != 0) f{

// Receiver overflow has occurred.
// We have lost our previous message.

CANSPI_MASK

The CANSPI_MASK constants define mask codes. Function CANSPISetMask
expects one of these as it's argument:

const char
CANSPI MASK Bl
CANSPI MASK B2

Il
— o
~e o~

CANSPI_FILTER

The CANSPI_FILTER constants define filter codes. Functions CANSPISetFilter
expects one of these as it's argument:

const char
CANSPI FILTER Bl F1 =
CANSPI FILTER Bl F2 =
CANSPI FILTER B2 F1 =
CANSPI FILTER B2 F2 =
CANSPI FILTER B2 F3 =
CANSPI FILTER B2 F4 =

g W N PO
Ne N N N NN

Library Example

This is a simple demonstration of CANSPI Library routines usage. First node initi-
ates the communication with the second node by sending some data to its address.
The second node responds by sending back the data incremented by 1. First node
then does the same and sends incremented data back to second node, etc.
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Code for the first CANSPI node:

unsigned char Can Init Flags, Can Send Flags, Can Rcv_Flags;
// CAN flags

unsigned char Rx Data Len;

// Received data length in bytes

char RxTx Datal 8] ;

// CAN rx/tx data buffer

char Msg Rcvd;

// Reception flag

long Tx ID, Rx ID;

// CAN rx and tx ID

// CANSPI module connections
sbit CanSpi CS at P1.BO;

sbit CanSpi Rst at P1.B2;

// End CANSPI module connections

void main () {

Can_Init Flags = 0;
//

Can_Send Flags = 0;
// Clear flags
Can_Rcv_Flags = 0;
//

Can_Send Flags = CAN TX PRIORITY 0 &
// Form value to be used
CAN TX XTD FRAME §&
// with CANSPIWrite
CAN TX NO RTR_FRAME;

Can_Init Flags = CAN CONFIG SAMPLE THRICE &
// Form value to be used
CAN CONFIG PHSEG2 PRG ON &
// with CANSPIInit
CAN CONFIG XTD MSG &
CAN CONFIG DBL BUFFER ON &
CAN CONFIG VALID XTD MSG;

Spi Init();

// Initialize SPI module
CANSPIInitialize(1,3,3,3,1,Can Init Flags);
// Initialize external CANSPI module

CANSPISetOperationMode (CAN MODE CONFIG, OxFF);
// Set CONFIGURATION mode
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CANSPISetMask (CAN _MASK B1,-1,CAN CONFIG XTD MSG) ;

// Set all maskl bits to ones

CANSPISetMask (CAN _MASK B2,-1,CAN CONFIG XTD MSG) ;

// Set all mask2 bits to ones

CANSPISetFilter (CANiFILTER7B27F4, 3, CAN7CONFIG7XTD7MSG) ;
// Set id of filter B2 F4 to 3

CANSPISetOperationMode (CAN MODE NORMAL, OXFF) ;
// Set NORMAL mode

RxTx Datal 0] = 9;
// Set initial data to be sent

Tx ID = 12111;
// Set transmit ID

CANSPIWrite (Tx ID, RxTx Data, 1, Can Send Flags);
// Send initial message

while (1) {
// Endless loop
Msg Rcvd = CANSPIRead(&Rx ID , RxTx Data , &Rx Data Len,
&Can Rcv_Flags) ; // Receive message
if ((Rx _ID == 3u) && Msg Rcvd) {
// If message received check id
PO = RxTx Data[ 0] ;
// ID correct, output data at PORTO
RxTx Data[l 0] ++ ;
// Increment received data
Delay ms (10);
CANSPIWrite (Tx ID, RxTx Data, 1, Can Send Flags);
// Send incremented data back

}
VAT

Code for the second CANSPI node:

unsigned char Can Init Flags, Can Send Flags, Can Rcv Flags;
//CAN flags

unsigned char Rx Data Len;

// Received data length in bytes

char RxTx Datal 8] ;

// CAN rx/tx data buffer

char Msg Rcvd;

// Reception flag

long Tx ID, Rx ID;

// CAN rx and tx ID
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// CANSPI module connections
sbit CanSpi CS at P1.BO;

sbit CanSpi Rst at P1.B2;

// End CANSPI module connections

void main () {

Can_Init Flags = 0;
7/

Can_Send Flags = 0;
// Clear flags

Can _Rcv_Flags = 0;
7/

Can_Send Flags = CAN TX PRIORITY 0 &
// Form value to be used
CAN TX XTD FRAME §&
// with CANSPIWrite
CAN TX NO RTR_FRAME;

Can_Init Flags = CAN CONFIG SAMPLE THRICE &
// Form value to be used
CAN CONFIG PHSEG2 PRG ON & // with CANSPIInit
CAN CONFIG XTD MSG &
CAN CONFIG DBL BUFFER ON &
CAN CONFIG VALID XTD MSG &
CAN CONFIG LINE FILTER OFF;

Spi Init();

// Initialize SPI module
CANSPIInitialize(1,3,3,3,1,Can _Init Flags);
// Initialize CAN-SPI module

CANSPISetOperationMode (CAN MODE CONFIG, OxFF);
// Set CONFIGURATION mode

CANSPISetMask (CAN _MASK B1,-1,CAN CONFIG_XTD MSG);

// Set all maskl bits to ones
CANSPISetMask (CAN _MASK B2,-1,CAN CONFIG_XTD MSG);

// Set all mask2 bits to ones

CANSPISetFilter (CANiFILTER7B27F3, 12111, CAN7CONFIG7XTD7MSG) ;
// Set id of filter B2 F3 to 12111

CANSPISetOperationMode (CAN MODE NORMAL, OxFF) ;
// Set NORMAL mode

Tx_ID = 3; // Set tx ID

238 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroC for 8051 Libraries

while (1) {
// Endless loop
Msg Rcvd = CANSPIRead(&Rx ID , RxTx Data , &Rx Data Len,
&Can_Rcv_Flags); // Receive message
if ((Rx_ID == 12111u) && Msg Rcvd) {
// If message received check id
PO = RxTx Data[ 0] ;
// ID correct, output data at PORTO
RxTx Datal 0] ++ ;
// Increment received data
CANSPIWrite (Tx ID, RxTx Data, 1, Can Send Flags);
// Send incremented data back

}
}
VAT

HW Connection
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6.1. Example of interfacing CAN transceiver MCP2510 with MCU via SPI

interface
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EEPROM LIBRARY

EEPROM data memory is available with a number of 8051 family. The mikroC
for 8051 includes a library for comfortable work with MCU's internal EEPROM.

Note: EEPROM Library functions implementation is MCU dependent, consult the
appropriate MCU datasheet for details about available EEPROM size and con-
strains.
Library Routines

- Eeprom_Read

- Eeprom_Write

- Eeprom_Write Block

Eeprom_Read

Prototype unsigned short Eeprom Read(unsigned int address);

Returns | Byte from the specified address.

Description | Reads data from specified address.
Parameters :

- address: address of the EEPROM memory location to be read.

Requires | Nothing

Example |unsigned int eehddr = 2;
unsigned short temp;

temp = Eeprom Read (eeAddr);
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Eeprom_Write

Prototype unsigned short Eeprom Write(unsigned int address,
unsigned short wrdata);

Returns |- 0 writing was successful
- 1 if error occured

Description | Writes wrdata to specified address.
Parameters :

- address: address of the EEPROM memory location to be writ-
ten.
- wrdata: data to be written.

Note: Specified memory location will be erased before writing
starts.

Requires | Nothing

Example unsigned short eeWrite = 0x55;
unsigned int wrAddr = 0x732;

Eeprom Write (wrAddr, eeWrite);

Eeprom_Write_Block

Prototype unsigned short Eeprom Write Block(unsigned int
address, unsigned short *ptrdata);

Returns |- 0 writing was successful
- 1 if error occured

Description | Writes one EEPROM row (32 bytes block) of data.

Parameters :

- address: starting address of the EEPROM memory block to be
written.

- ptrdata: data block to be written.

Note: Specified memory block will be erased before writing starts.

Requires | EEPROM module must support block write operations.

It is the user's responsibility to maintain proper address alignment.
In this case, address has to be a multiply of 32, which is the size
(in bytes) of one row of MCU's EEPROM memory.

Example unsigned int wrAddr = 0x0100;

unsigned short iArr[( 32] = {'m', 'i', 'k', 'r', 'o',
'E', lll, 'e', lkl’ 't', ‘r', 'O', lnl’ 'i', lkl, 'a',
0} 7

Eeprom Write Block(wrAddr, iArr);
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Library Example
This example demonstrates using the EEPROM Library with AT89S8253 MCU.

First, some data is written to EEPROM in byte and block mode; then the data is read
from the same locations and displayed on PO, P1 and P2.

char dat[ 32], ii; // Data buffer, loop variable
void main (){
for(ii = 31; dat[ ii] = ii; ii--) // Fill data buffer
Eeprom Write (2, 0xARA); // Write some data at address 2
Eeprom Write (0x732,0x55); // Write some data at address 0x732
Eeprom Write Block(0x100,dat); // Write 32 bytes block at
address 0x100
Delay ms (1000) ; // Blink PO and Pl diodes
PO = OxFF;
// to indicate reading start
Pl = OxFF;
Delay ms (1000);
PO = 0x00;
P1 = 0x00;

Delay ms (1000);

PO = Eeprom Read(2);

// Read data from address 2 and display it on PORTO
P1 = Eeprom Read(0x732);

// Read data from address 0x732 and display it on PORTI
Delay ms (1000);

for(ii = 0; 1ii < 32; 1ii++) {
// Read 32 bytes block from address 0x100
P2 = Eeprom Read(0x100+ii);
// and display data on PORTZ2
Delay ms (500);
}
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GRAPHIC LCD LIBRARY

The mikroC for 8051 provides a library for operating Graphic LCD 128x64 (with
commonly used Samsung KS108/KS107 controller).

For creating a custom set of GLCD images use GLCD Bitmap Editor Tool.

External dependencies of Graphic LCD Library

The following variables
must be defined in all

projects using Graphic Description: Example :
LCD Library:
extern volatile sfr LCD Data Port. sfr char GLCD DataPort
char GLCD DataPort; at PO;

extern sbit GLCD CsSl: Chip Select 1 line. sbit GLCD CS1 at P2.BO;

extern sbit GLCD CS2: Chip Select 2 line. sbit GLCD CSl at P2.Bl;

extern sbit GLCD RS: Register select line. | sbit GLCD RS at P2.B2;
extern sbit GLCD RW: Read/Write line. sbit GLCD RW at P2.B3;
extern sbit GLCD RST: | Reset line. sbit GLCD RST at P2.B5;
extern sbit GLCD EN: Enable line. sbit GLCD EN at P2.B4;
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Library Routines
Basic routines:

- Gled Init

- Gled_Set_Side

- Gled Set X

- Gled_Set Page

- Gled_Read Data
- Gled_Write Data

Advanced routines:

- Gled Fill

- Gled_Dot

- Gled_Line

- Gled V_Line

- Gled_H_Line

- Gled_Rectangle
- Gled_Box

- Gled Circle

- Gled_Set_Font

- Gled_Write_Char
- Gled_Write Text
- Gled_Image

244 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroC for 8051 Libraries

Glcd_Init

Prototype void Gled Init();

Returns | Nothing.

Description | Initializes the GLCD module. Each of the control lines is both port
and pin configurable, while data lines must be on a single port
(pins <0:7>).

Requires | Global variables :

- crcp csto: chip select 1 signal pin
- GLep_cs2 : chip select 2 signal pin
- GLCD Rs :register select signal pin
- cLCD RW : read/write si%nal pin

- cLcD EN : enable signal pin

- GLCD RST : reset signal pin

- GLCD DataPort : data port

must be defined before using this function.

Example // glcd pinout settings
sfr char GLCD DataPort at PO;

sbit GLCD CS1 at P2.BO;
sbit GLCD Cs2 at P2.B1;
sbit GLCD RS at P2.B2;
sbit GLCD RW at P2.B3;
sbit GLCD RST at P2.B5;
sbit GLCD EN at P2.B4;

Gled Tnit();
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Glcd_Set_Side
Prototype void Glcd Set Side (unsigned short x pos);
Returns | Nothing.
Description | Selects GLCD side. Refer to the GLCD datasheet for detailed

explaination.
Parameters :
- x_pos: position on x-axis. Valid values: 0..127
The parameter x_pos specifies the GLCD side: values from 0 to
63 specify the left side, values from 64 to 127 specify the right
side.
Note: For side, x axis and page layout explanation see schematic
at the bottom of this page.

Requires | GLCD needs to be initialized, see Gled_Init routine.

Example | The following two lines are equivalent, and both of them select
the left side of GLCD:
Glcd Select Side (0);
Glcd Select Side (10);

Glcd_Set_X
Prototype void Glcd Set X(unsigned short x pos);
Returns | Nothing.
Description | Sets x-axis position to = pos dots from the left border of GLCD

within the selected side.
Parameters :
- x_pos: position on x-axis. Valid values: 0..63
Note: For side, x axis and page layout explanation see schematic
at the bottom of this page.

Requires | GLCD needs to be initialized, see Gled Init routine.

Examp]e Glcd Set X (25);
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Glcd_Set_Page

Prototype | void Glcd Set Page (unsigned short page);
Returns | Nothing.
Description | Selects page of the GLCD.
Parameters :
- page: page number. Valid values: 0..7
Note: For side, x axis and page layout explanation see schematic
at the bottom of this page.
Requires | GLCD needs to be initialized, see Gled_Init routine.
Example | Clcd Set Page(5);
Glcd_Read_Data
Prototype | unsigned short Glecd Read Datal();
Returns | One byte from GLCD memory.
Description | Reads data from from the current location of GLCD memory and
moves to the next location.
Requires | GLCD needs to be initialized, see Gled Init routine.
GLCD side, x-axis position and page should be set first. See
functions Glcd_Set Side, Gled Set X, and Glcd Set Page.
Example | unsigned short data;
data = Glcd Read Data();
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Glcd_Write_Data

Prototype void Glcd Write Data (unsigned short ddata);

Returns | Nothing.

Description | Writes one byte to the current location in GLCD memory and
moves to the next location.

Parameters :

- ddata: data to be written

Requires | GLCD needs to be initialized, see Gled_Init routine.

GLCD side, x-axis position and page should be set first. See
functions Glcd_Set Side, Gled Set X, and Glcd Set Page.

Example unsigned short data;

Glcd Write Data(data);

Glcd_Fill

Prototype void Glcd Fill (unsigned short pattern);

Returns | Nothing.

Description | Fills GLCD memory with the byte pattern.
Parameters :

- pattern: byte to fill GLCD memory with

To clear the GLCD screen, use Glcd Fill (0) .

To fill the screen completely, use Glcd Fill (0xFF) .

Requires | GLCD needs to be initialized, see Glcd Init routine.

Example |// Clear screen
Gled Fill(0);
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Glcd_Dot

Prototype void Glcd Dot (unsigned short x pos, unsigned short
y pos, unsigned short color);

Returns | Nothing.

Description | Draws a dot on GLCD at coordinates (x pos, vy pos).

Parameters :
- x_pos: X position. Valid values: 0..127
- y_pos: y position. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines a dot state: 0 clears dot, 1 puts a
dot, and 2 inverts dot state.
Note: For x and y axis layout explanation see schematic at the
bottom of this page.

Requires | GLCD needs to be initialized, see Glcd _Init routine.

Example // Invert the dot in the upper left corner
Glcd Dot (0, 0, 2);

Glcd_Line

Prototype void Glcd Line(int x start, int y start, int x end,
int y end, unsigned short color);

Returns | Nothing.

Description | Draws a line on GLCD.

Parameters :
- x_start: X coordinate of the line start. Valid values: 0..127
- y_start:y coordinate of the line start. Valid values: 0..63
- x_end: X coordinate of the line end. Valid values: 0..127
- y_end: y coordinate of the line end. Valid values: 0..63
- color: color parameter. Valid values: 0..2
The parameter color determines the line color: 0 white, 1 black,
and 2 inverts each dot.

Requires | GLCD needs to be initialized, see Gled_Init routine.

Example // Draw a line between dots (0,0) and (20,30)
Gled Line(0, 0, 20, 30, 1);
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Glcd_V_Line

Prototype void Glcd V Line(unsigned short y start, unsigned
short y end, unsigned short x pos, unsigned short
color) ;

Returns | Nothing.

Description | Draws a vertical line on GLCD.
Parameters :

-y start:y coordinate of the line start. Valid values: 0..63
- v _end:y coordinate of the line end. Valid values: 0..63

- x_pos: X coordinate of vertical line. Valid values: 0..127

- color: color parameter. Valid values: 0..2

The parameter color determines the line color: 0 white, 1 black,
and 2 inverts each dot.

Requires | GLCD needs to be initialized, see Glcd Init routine.

Exanqﬂe // Draw a vertical line between dots (10,5) and
(10,25)
Gled V_Line(5, 25, 10, 1);

Glcd_H_Line

Prototype void Glcd H Line(unsigned short x start, unsigned
short x end, unsigned short y pos, unsigned short
color) ;

Returns | Nothing.
Description | Draws a horizontal line on GLCD.

Parameters :

- x_start: x coordinate of the line start. Valid values: 0..127
- x_end: X coordinate of the line end. Valid values: 0..127

- v pos:y coordinate of horizontal line. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the line color: 0 white, 1 black,
and 2 inverts each dot.

Requires | GLCD needs to be initialized, see Gled_Init routine.

Example // Draw a horizontal line between dots (10,20) and
(50,20)
Glcd H Line (10, 50, 20, 1);
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Glcd_Rectangle

Prototype void Glcd Rectangle (unsigned short x upper left,
unsigned short y upper left, unsigned short x bot-
tom right, unsigned short y bottom right, unsigned
short color);

Returns | Nothing.

Description | Draws a rectangle on GLCD.
Parameters :

- x upper left:x coordinate of the upper left rectangle corner.
Valid values: 0..127

-y upper left:y coordinate of the upper left rectangle corner.
Valid values: 0..63

- x bottom right: X coordinate of the lower right rectangle cor-

ner. Valid values: 0..127

- v bottom right:y coordinate of the lower right rectangle cor-

ner. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the rectangle bor-
der: 0 white, 1 black, and 2 inverts each dot.

Requires | GLCD needs to be initialized, see Gled_Init routine.

Example // Draw a rectangle between dots (5,5) and (40,40)
Glcd Rectangle(5, 5, 40, 40, 1);
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Glcd_Box
Prototype void Glcd Box (unsigned short
x upper left, unsigned short
y upper left, unsigned short
x bottom right, unsigned short
y bottom right, unsigned short color);
Returns | Nothing.
Description | Draws a box on GLCD.
Parameters :
- x upper left: X coordinate of the upper left box corner. Valid
values: 0..127 _ _
-y upper left:y coordinate of the upper left box corner. Valid
values: 0..63 ) .
- x_bottom right: X coordinate of the lower right box corner.
Valid values: 0..127 ] _
- vy bottom right:y coordinate of the lower right box corner.
Valid values: 0..63 '
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the box fill: 0 white,
1 black, and 2 inverts each dot.
Requires | GLCD needs to be initialized, see Glcd Init routine.
Example // Draw a box between dots (5,15) and (20,40)
Glcd Box (5, 15, 20, 40, 1);
Glcd_Circle
Prototype |void Glcd Circle(int x center, int y center, int
radius, unsigned short color);
Returns | Nothing.
Description | Draws a circle on GLCD.
Parameters :
- x_center: X coordinate of the circle center. Valid values: 0..127
- y_center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size )
- color: color parameter. Valid values: 0..2
The parameter color determines the color of the circle line: 0
white, 1 black, and 2 inverts each dot.
Requires | GLCD needs to be initialized, see Gled_Init routine.
Examp]e // Draw a circle with center in (50,50) and radius=10
Glcd Circle (50, 50, 10, 1);
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Glcd_Set_Font

Prototype void Glcd Set Font (const char *activeFont, unsigned
short aFontWidth, unsigned short aFontHeight,
unsigned int aFontOffs);

Returns | Nothing.

Description | Sets font that will be used with Gled Write Char and
Glcd_Write Text routines.

Parameters :

- activeront: font to be set. Needs to be formatted as an array of
char

- arontnidth: width of the font characters in dots.

- arontHeight: height of the font characters in dots.

- arontOf fs: number that represents difference between the
mikroC for 8051 character set and regular ASCII set (eg. if 'A’ is
65 in ASCII character, and 'A' is 45 in the mikroC for 8051
character set, aFontOffs is 20). Demo fonts supplied with the
library have an offset of 32, which means that they start with
space.

The user can use fonts given in the file “ Lib GLCDFonts.c”
file located in the Uses folder or create his own fonts.

Requires | GLCD needs to be initialized, see Gled Init routine.

Example // Use the custom 5x7 font "myfont" which starts with
space (32):
Glcd Set Font (myfont, 5, 7, 32);
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Glcd_Write_Char

Prototype void Glcd Write Char (unsigned short chr, unsigned
short x pos, unsigned short page num, unsigned short
color) ;

Returns | Nothing.

Description | Prints character on the GLCD.
Parameters :

- chr: character to be written

- x pos: character starting position on x-axis. Valid values:
0..(127-FontWidth)

- page num: the number of the page on which character will be
written. Valid values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0
white, 1 black, and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the
bottom of this page.

Requires | GLCD needs to be initialized, see Glcd_Init routine. Use
Glcd Set Font to specify the font for display; if no font is speci-
fied, then default 5x8 font supplied with the library will be used.

Example // Write character 'C' on the position 10 inside the
page 2:
Glcd Write Char('C', 10, 2, 1);
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Glcd_Write_Text

Prototype void Glcd Write Text (char *text, unsigned short x pos,
unsigned short page num, unsigned short color);

Returns | Nothing.

Description | Prints text on GLCD.
Parameters :

- text: text to be written

- x_pos: text starting position on x-axis.

- page num: the number of the page on which text will be
written. Valid values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the text: 0 white, 1
black, and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the
bottom of this page.

Requires | GLCD needs to be initialized, see Gled_Init routine. Use
Glcd Set Font to specify the font for display; if no font is speci-
fied, then default 5x8 font supplied with the library will be used.

Example // Write text "Hello world!" on the position 10
inside the page 2:
Glcd Write Text ("Hello world!"™, 10, 2, 1);

Glcd_Image

Prototype void Glcd Image (code const unsigned short *image);

Returns | Nothing.

Description | Displays bitmap on GLCD.
Parameters :

- image: image to be displayed. Bitmap array must be located in
code memory.

Use the mikroC for 8051 integrated GLCD Bitmap Editor to con-
vert image to a constant array suitable for displaying on GLCD

Requires | GLCD needs to be initialized, see Glcd Init routine.

Example // Draw image my image on GLCD
Glcd Image (my image);
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Library Example
The following example demonstrates routines of the GLCD library: initialization,

clear(pattern fill), image displaying, drawing lines, circles, boxes and rectangles,
text displaying and handling.

declarations

// Glcd module connections

sfr char GLCD DataPort at PO; // GLCD data port
sbit GLCD CS1 at P2.BO; // GLCD chip select 1 signal
sbit GLCD CS2 at P2.B1; // GLCD chip select 2 signal
sbit GLCD RS at P2.B2; // GLCD register select signal
sbit GLCD RW at P2.B3; // GLCD read/write signal
sbit GLCD RST at P2.BS5; // GLCD reset signal
sbit GLCD EN at P2.B4; // GLCD enable signal

// End Glcd module connections

void delay?2S (){ // 2 seconds delay function
delay ms (2000) ;
}

void main () {
unsigned short ii;
char *someText;

Glced Init(); // Initialize GLCD
Glcd Fill (0x00); // Clear GLCD
while (1) {
Glcd Image (advanced8051 bmp) ; // Draw image
delay2S(); delay2S();

Glcd Fill(0x00);

Glcd Box(62,40,124,56,1); // Draw box
Glcd Rectangle(5,5,84,35,1); // Draw rectangle
Glcd Line(0, 63, 127, 0,1); // Draw line
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delay2S();

for(ii = 5; ii < 60; 1ii+=5 ){

// Draw horizontal and vertical lines
Delay ms (250);
Glcd V Line (2, 54, ii, 1);
Gled H Line(2, 120, ii, 1);
}

delay2S();

Glcd Fill(0x00);

Glcd Set Font (Character8x8, 8, 8, 32);
// Choose font, see  Lib GLCDFonts.c in Uses folder

Glcd Write Text ("mikroE", 5, 7, 2); // Write string

for (ii = 1; ii <= 10; ii++) // Draw circles
Glcd Circle (63,32, 3*ii, 1);

delay2S();

Glcd Box (12,20, 70,57, 2); // Draw box

delay2S();

Glcd Set Font (FontSystemb5x8, 5, 8, 32); // Change font

someText = "BIG:ONE";

Glcd Write Text (someText, 5,3, 2); // Write string
delay2S();

someText = "SMALL:NOT:SMALLER";

Glcd Write Text (someText, 20,5, 1); // Write string
delay2S();

Y/~

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 257



CHAPTER 6
Libraries mikroC for 8051

HW Connection
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KEYPAD LIBRARY

The mikroC for 8051 provides a library for working with 4x4 keypad. The library
routines can also be used with 4x1, 4x2, or 4x3 keypad. For connections explana-
tion see schematic at the bottom of this page.

Note: Since sampling lines for 8051 MCUs are activated by logical zero Keypad
Library can not be used with hardwares that have protective diodes connected with
anode to MCU side, such as mikroElektronika's Keypad extra board HW.Rev v1.20

External dependencies of Keypad Library
Library Routines

The following variable
must be defined in all

rojects using Keypad Description: Example :
] Y
Library:
extern sfr char ‘KﬁypadQPon sfr char keypadPort
keypadPort; ’ at PO;

- Keypad_Init
- Keypad Key Press
- Keypad Key Click

Keypad_lInit

Prototype void Keypad Init(wvoid);

Returns | Nothing.

Description | Initializes port for working with keypad.

Requires | keypadrort variable must be defined before using this function.

Exanuﬂe // Initialize PO for communication with keypad
sfr char keypadPort at PO;

Keypad Init();
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Keypad_Key Press
Prototype char Keypad Key Press(void);
Returns | The code of a pressed key (1..16).
If no key is pressed, returns 0.

Description | Reads the key from keypad when key gets pressed.

Requires | Port needs to be initialized for working with the Keypad library,
see Keypad_Init.

Example |char kp;
kp . = Keypad Key Press();

Keypad_Key_Click

Prototype char Keypad Key Click(void) ;

Returns | The code of a clicked key (1..16).
If no key is clicked, returns 0.

Description | Call to keypad xey click is a blocking call: the function waits
until some key is pressed and released. When released, the func-
tion returns 1 to 16, depending on the key. If more than one key
is pressed simultaneously the function will wait until all pressed
keys are released. After that the function will return the code of
the first pressed key.

Requires | Port needs to be initialized for working with the Keypad library,
see Keypad Init.

Example |char kp;
kp: Keypad Key Click();
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Library Example

This is a simple example of using the Keypad Library. It supports keypads with 1..4

TOWS

and 1..4 columns. The code being returned by Keypad Key Click() function

is in range from 1..16. In this example, the code returned is transformed into ASCII
codes [0..9,A..F] and displayed on LCD. In addition, a small single-byte counter dis-
plays in the second LCD row number of key presses.

unsigned short kp, cnt, oldstate = 0;

char

txt[ 5] ;

// Keypad module connections
sfr char keypadPort at PO;
// End Keypad module connections

// lcd pinout definition

sbit
sbit

sbit
sbit
sbit
sbit

LCD RS at P2.BO;
LCD EN at P2.Bl;

LCD D7 at P2.B5;
LCD D6 at P2.B4;
LCD D5 at P2.B3;
LCD D4 at P2.B2;

// end lcd definitions

void main () {
cnt = 0; // Reset counter
Keypad Init(); // Initialize Keypad
Led Init(); // Initialize LCD
Lcd Cmd (LCD_CLEAR) ; // Clear display
Lcd Cmd (LCD _CURSOR OFF) ; // Cursor off
Led Out (1, 1, "Key :"); // Write message text on LCD

Led Out (2, 1, "Times:");

do {

/7

kp = 0; // Reset key code variable

// Wait for key to be pressed and released
do

kp = Keypad Key Click(); // Store key code in kp variable
while ('kp);

Prepare value for output, transform key to it's ASCII value
switch (kp) {
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//case 10: kp = 42; break; // '*'
// Uncomment this block for keypad4x3
//case 11: kp = 48; break; // '0'
//case 12: kp = 35; break; // "#'
//default: kp += 48;

case 1: kp = 49; break; // 1
// Uncomment this block for keypad4x4
case 2: kp = 50; break; //

case kp = 51; break; //
case kp = 65; break; //
case = 52; break; //

case kp = 53; break; //
case kp = 54; break; //
case kp = 66; break; //

2
3
A
4
5
6
B
case 9: kp = 55; break; // 7
8
9
C
*
0
#
D

W ~J oUW
~
o]
|

case 10: kp = 56; break; //
case 11: kp = 57; break; //
case 12: kp = 67; break; //
case 13: kp = 42; break; //
case 14: kp = 48; break; //
case 15: kp = 35; break; //
case 16: kp = 68; break; //

}

if (kp != oldstate) { // Pressed key differs from previous
cnt = 1;
oldstate = kp;
}

else { // Pressed key 1s same as previous
cnt++;
}

Led Chr (1, 10, kp); // Print key ASCII value on LCD

if (cnt == 255) { // If counter varialble overflow
cnt = 0;

Led Out (2, 10, ™ ")
}

WordToStr (cnt, txt); // Transform counter value to string
Lcd Out (2, 10, txt); // Display counter value on LCD
} while (1);

b/
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LCD LIBRARY

The mikroC for 8051 provides a library for communication with LCDs (with
HD44780 compliant controllers) through the 4-bit interface. An example of LCD
connections is given on the schematic at the bottom of this page.

For creating a set of custom LCD characters use LCD Custom Character Tool.

External dependencies of LCD Library

The following variables

must be defined in all

projects using LCD Description: Example :

Library:

extern sbit LCD RS: | Register Select line. | sbit LCD RS at P2.B0;
extern sbit ILCD EN: Enable line. sbit LCD EN at P2.B1;
extern sbit 1CD D7; Data 7 line. sbit LCD D7 at P2.B5;
extern sbit ILCD D6; Data 6 line. sbit LCD D6 at P2.B4;
extern sbit LCD D5; Data 5 line. sbit LCD D5 at P2.B3;
extern sbit LCD D4; Data 4 line. sbit LCD D4 at P2.B2;

Library Routines

- Led Init

- Led Out

- Led Out Cp
- Led Chr

- Led Chr Cp
-Led Cmd
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Lcd_Init

Prototype |void Lcd Init()
Returns | Nothing.

Description | Initializes LCD module.

Requires | Global variables:

- 1D D7: data bit 7

- .cD_Dé: data bit 6

- LcD D5: data bit 5

- 1D D4: data bit 4

- rs: register select (data/instruction) signal pin
- EN: enable signal pin

must be defined before using this function.

Example |// lcd pinout settings

sbit LCD RS at P2.BO;
sbit LCD EN at P2.B1;
sbit LCD D7 at P2.B5;
sbit LCD D6 at P2.B4;
sbit LCD D5 at P2.B3;
sbit LCD D4 at P2.B2;

Led Init (),

Lcd_Out

Prototype void Lcd Out(char row, char column, char *text);

Returns | Nothing.

Description | Prints text on LCD starting from specified position. Both string
variables and literals can be passed as a text.

Parameters :
- row: starting position row number

- colunn: starting position column number
- text: text to be written

Requires | The LCD module needs to be initialized. See Lcd _Init routine.

Example // Write text "Hello!" on LCD starting from row 1,
column 3:
Lcd Out(l, 3, "Hello!");
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Lcd_Out_Cp
Prototype void Lcd Out Cp(char *text);
Returns | Nothing.
Description | Prints text on LCD at current cursor position. Both string vari-

ables and literals can be passed as a text.
Parameters :
- text: text to be written

Requires | The LCD module needs to be initialized. See Lcd Init routine.

Example | // Write text "Here!" at current cursor position:
Led Out Cp ("Here!™);

Lcd_Chr
Prototype |void Lcd Chr(char row, char column, char out char);
Returns | Nothing.
Description | Prints character on LCD at specified position. Both variables and

literals can be passed as a character.
Parameters :
- row: writing position row number
- column: writing position column number
- out char: character to be written

Requires | The LCD module needs to be initialized. See Led_Init routine.

Example | // Write character "i" at row 2, column 3:

Led Chr(2, 3, 'i');
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Lcd_Chr_Cp

Prototype void Lcd Chr Cp(char out char);

Returns | Nothing.

Description | Prints character on LCD at current cursor position. Both variables
and literals can be passed as a character.

Parameters :

- out char: character to be written

Requires | The LCD module needs to be initialized. See Lcd Init routine.

Example // Write character "e" at current cursor position:
Lcd Chr Cp('e');

Lcd_Cmd

Prototype void Lcd Cmd(char out char);

Returns | Nothing.

Description | Sends command to LCD.
Parameters :
- out char: command to be sent

Note: Predefined constants can be passed to the function, see
Available LCD Commands.

Requires | The LCD module needs to be initialized. See Lcd_Init routine.

Example | // Clear LCD display:
Lcd Cmd (LCD_CLEAR) ;
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Available LCD Commands

LCD Command

Purpose

LCD_FIRST ROW

Move cursor to the 1st row

LCD SECOND_ ROW

Move cursor to the 2nd row

LCD_THIRD ROW

Move cursor to the 3rd row

LCD_FOURTH_ROW

Move cursor to the 4th row

LCD_CLEAR

Clear display

LCD_RETURN HOME

Return cursor to home position, returns a shifted dis-

play to its original position. Display data RAM is
unaffected.

LCD_CURSOR OFF

Turn off cursor

LCD_UNDERLINE ON

Underline cursor on

LCD BLINK CURSOR ON

Blink cursor on

LCD MOVE CURSOR LEFT

Move cursor left without changing display data
RAM

LCD_MOVE CURSOR_RIGHT

Move cursor right without changing display data
RAM

LCD_TURN ON

Turn LCD display on

LCD_TURN OFF

Turn LCD display off

LCD_SHIFT LEFT

Shift display left without changing display data
RAM

LCD_SHIFT RIGHT

Shift display right without changing display data
RAM

Library Example

The following code demonstrates usage of the LCD Library routines:

// LCD module connections

sbit LCD RS at P2.BO;
sbit LCD EN at P2.Bl;
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sbit ILCD D7 at P2.B5;
sbit LCD D6 at P2.B4;
sbit LCD D5 at P2.B3;
sbit LCD D4 at P2.B2;
// End LCD module connections
char txtl[] = "mikroElektronika";
char txt2[] "Easy8051B";
char txt3[] = "lcd4bit";
char txt4[] = "example";
char i; // Loop variable
void Move Delay () { // Function used for text moving
Delay ms (500); // You can change the moving speed here
t
void main (){
Led Init(); // Initialize LCD
Lcd Cmd (LCD_CLEAR) ; // Clear display
Led Cmd (LCD_CURSOR _OFF) ; // Cursor off
LCD Out (1,6,txt3); // Write text 1in first row
LCD Out (2,6, txt4); // Write text 1in second row
Delay ms (2000);
Lcd Cmd (LCD_CLEAR) ; // Clear display
LCD Out(1,1,txtl); // Write text 1in first row
LCD Out (2,4, txt2); // Write text 1in second row
Delay ms (500);
// Moving text
for (i=0; i<4; 1i++) { // Move text to the right 4
times
Led Cmd (LCD SHIFT RIGHT) ;
Move Delay () ;
}
while (1) { // Endless loop
for (i=0; i<7; 1i++) { // Move text to the left 7 times
Led Cmd (LCD_SHIFT LEFT) ;
Move Delay () ;
}
for (i=0; i<7; 1i++) { // Move text to the right 7 times

Led Cmd (LCD_SHIFT RIGHT) ;
Move Delay () ;

}
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HW connection
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6.4. LCD HW connection
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ONEWIRE LIBRARY

The OneWire library provides routines for communication via the Dallas OneWire
protocol, e.g. with DS18x20 digital thermometer. OneWire is a Master/Slave proto-
col, and all communication cabling required is a single wire. OneWire enabled
devices should have open collector drivers (with single pull-up resistor) on the
shared data line.

Slave devices on the OneWire bus can even get their power supply from data line.
For detailed schematic see device datasheet.

Some basic characteristics of this protocol are:

- single master system,

- low cost,

- low transfer rates (up to 16 kbps),

- fairly long distances (up to 300 meters),
- small data transfer packages.

Each OneWire device has also a unique 64-bit registration number (8-bit device
type, 48-bit serial number and 8-bit CRC), so multiple slaves can co-exist on the

same bus.

Note: Oscillator frequency Fosc needs to be at least 8MHz in order to use the rou-
tines with Dallas digital thermometers.

External dependencies of OneWire Library

This variable must be
defined in any project
that is using OneWire Description: Example :

Library:

extern sbit OW Bit; sbit OW Bit at P2.B7;

OneWire line.
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Library Routines
- Ow_Reset
- Ow_Read
- Ow_Write

Ow_Reset

Prototype unsigned short Ow Reset ();

Returns | - 0 if the device is present
- 1 if the device is not present

Description | Issues OneWire reset signal for DS18x20.
Parameters :

- None.

Requires | Devices compliant with the Dallas OneWire protocol.

Global variable ow rit must be defined before using this
function.

Example // Issue Reset signal on One-Wire Bus
Ow_Reset ()

Ow_Read

Prototype unsigned short Ow Read();

Returns Data read from an external device over the OneWire bus.

Description | Reads one byte of data via the OneWire bus.

Requires | Devices compliant with the Dallas OneWire protocol.

Global variable ow rit must be defined before using this
function.

Example // Read a byte from the One-Wire Bus
unsigned short read data;

read data = Ow_Read();
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Ow_Write

Prototype void Ow Write (char par);

Returns | Nothing.

Description | Writes one byte of data via the OneWire bus.
Parameters :

- par: data to be written

Requires | Devices compliant with the Dallas OneWire protocol.

Global variable ow Bit must be defined before using this func-
tion.

Example // Send a byte to the One-Wire Bus
Ow_Write (0xCC);

Library Example

This example reads the temperature using DS18x20 connected to pin P1.2. After
reset, MCU obtains temperature from the sensor and prints it on the LCD. Make
sure to pull-up P1.2 line and to turn off the P1 leds.

// lcd pinout definition
sbit LCD RS at P2.BO;
sbit LCD EN at P2.Bl1;

sbit LCD D7 at P2.B5;
sbit LCD D6 at P2.B4;
sbit LCD D5 at P2.B3;
sbit LCD D4 at P2.B2;
// end lcd definition

// OneWire pinout
sbit OW Bit at P1.B2;
// end OneWire definition

// ~Set TEMP RESOLUTION to the corresponding resolution of used
DS18x20 sensor:

// 18520: 9 (default setting; can be 9,10,11,or 12)

// 18B20: 12

const unsigned short TEMP RESOLUTION = 9;
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char *text = "000.0000";
unsigned temp;

void Display Temperature (unsigned int tempZwrite) ({
const unsigned short RES SHIFT = TEMP RESOLUTION - 8;
char temp whole;
unsigned int temp fraction;

// check if temperature 1is negative
if (temp2write & 0x8000) {

text[ 0] = '-';

temp2write = ~temp2write + 1;

}

// extract temp whole
temp whole = temp2write >> RES SHIFT ;

// convert temp whole to characters
if (temp whole/100)

text[ 0] = temp whole/100 + 48;
text[ 1] = (temp whole/10)%10 + 48; // Extract tens digit
text[ 2] = temp whole%10 + 48; // Extract ones digit

// extract temp fraction and convert it to unsigned int
temp fraction = tempZwrite << (4-RES SHIFT);

temp fraction &= 0x000F;

temp fraction *= 625;

// convert temp fraction to characters

text[ 4] temp fraction/1000 + 48; // Extract thousands digit
text[ 5] = (temp fraction/100)%10 + 48; // Extract hundreds digit
text[ 6] = (temp fraction/10)%10 + 48; // Extract tens digit
text[ 7] = temp fraction%10 + 48; // Extract ones digit

// print temperature on LCD
Lcd Out (2, 5, text);
Y/~

void main () {

Led Init(); // Initialize LCD
Lcd Cmd (LCD_CLEAR) ; // Clear LCD

Lcd Cmd (LCD _CURSOR OFF) ; // Turn cursor off
Lcd Out(l, 1, " Temperature: ")

// Print degree character, 'C' for Centigrades
Lcd Chr(2,13,223);
Led Chr(2,14,'C');
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//--- main loop

do {
//--- perform temperature reading
Ow_Reset () ; // Onewire reset signal
Ow Write (0xCC); // Issue command SKIP ROM
Ow Write (0x44); // Issue command CONVERT T
Delay us(120);
Ow_Reset();
Ow Write (0xCC); // Issue command SKIP ROM
Ow Write (0xBE); // Issue command READ SCRATCHPAD
temp = Ow Read();
temp = (Ow_Read() << 8) + temp;
//=-=-- Format and display result on Lcd

Display Temperature (temp) ;

Delay ms (500);
} while (1);
Y/~
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HW Connection
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MANCHESTER CODE LIBRARY

The mikroC for 8051 provides a library for handling Manchester coded signals. The
Manchester code is a code in which data and clock signals are combined to form a
single self-synchronizing data stream; each encoded bit contains a transition at the
midpoint of a bit period, the direction of transition determines whether the bit is 0
or 1; the second half is the true bit value and the first half is the complement of the
true bit value (as shown in the figure below).

Manchester RF_Send Byte format

st1|st2|ctr |B7 |B6|B5|B4| B3| B2|B1|BO)
Bi-phase coding
o
1 0
2ms_ | Example of transmission

117000100011

Notes: The Manchester receive routines are blocking calls (Man Receive Tnit and
Man Synchro). This means that MCU will wait until the task has been performed
(e.g. byte is received, synchronization achieved, etc).

External dependencies of Manchester Code Library

The following variables
must be defined in all
projects using Description: Example :
Manchester Code
Library:

extern sbit MANRXPIN; Keypad Port. sfr char keypadPort at PO;

extern sbit MANTXPIN; | Transmit line. sbit MANTXPIN at P1.B1;
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Library Routines

- Man_Receive_Init
- Man_Receive

- Man_Send_Init

- Man_Send

- Man_Synchro

The following routines are for the internal use by compiler only:
- Manchester 0
- Manchester 1

- Manchester Out

Man_Receive_Init

Prototype unsigned int Man Receive Init();

Returns | - 0 - if initialization and synchronization were successful.
- 1 - upon unsuccessful synchronization.

Description | The function configures Receiver pin and performs synchroniza-
tion procedure in order to retrieve baud rate out of the incoming
signal.

Note: In case of multiple persistent errors on reception, the user
should call this routine once again or Man_Synchro routine to
enable synchronization.

Requires | manrxp1n variable must be defined before using this function.

Example // Initialize Receiver
sbit MANRXPIN at P0.BO;

Man Receive Init();

278 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroC for 8051 Libraries

Man_Receive

Prototype unsigned char Man Receive (unsigned char *error);

Returns | A byte read from the incoming signal.

Description | The function extracts one byte from incoming signal.
Parameters :

- error: error flag. If signal format does not match the expected,
the error flag will be set to non-zero.

Requires | To use this function, the user must prepare the MCU for receiv-
ing. See Man_Receive Init.

Example unsigned char data = 0, error = 0;

data = Man Receive (&error);
if (error)
{ /* error handling */ }

Man_Send_Init

Prototype void Man Send Init();

Returns | Nothing.

Description | The function configures Transmitter pin.

Requires | vanTxp1n variable must be defined before using this function.

Example // Initialize Transmitter:
sbit MANTXPIN at P1.Bl;

Man Send Init();
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Man_Send

Prototype void Man Send (unsigned char tr data);

Returns | Nothing.

Description | Sends one byte.
Parameters :
- tr data: data to be sent

Note: Baud rate used is 500 bps.

Requires To use this function, the user must prepare the MCU
for sending. See Man Send Init.

Example unsigned char msg;

Man Send (msqg) ;

Man_Synchro

Prototype unsigned int Man Synchro();

Returns | - 0 - if synchronization was not successful.
- Half of the manchester bit length, given in multiples of 10us -
upon successful synchronization.

Description | Measures half of the manchester bit length with 10us resolution.

Requires | To use this function, you must first prepare the MCU for receiv-
ing. See Man_Receive Init.

Example unsigned int man half bit len;

man_half bit len = Man Synchro();

Library Example

The following code is code for the Manchester receiver, it shows how to use the
Manchester Library for receiving data:

// LCD module connections
sbit LCD RS at P2.BO;
sbit LCD EN at P2.Bl;

sbit LCD D7 at P2.B5;
sbit LCD D6 at P2.B4;
sbit LCD D5 at P2.B3;
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sbit LCD D4 at P2.B2;
// End LCD module connections
// Manchester module connections
sbit MANRXPIN at PO.BO;
sbit MANTXPIN at P1.B1;
// End Manchester module connections
char error, ErrorCount, temp;
void main () {
ErrorCount = 0;
Led Init(); // Initialize LCD
Lcd Cmd (LCD_CLEAR) ; // Clear LCD display
Man Receive Init(); // Initialize Receiver
while (1) { // Endless loop
Lcd Cmd (LCD_FIRST ROW) ; // Move cursor to the 1st row
while (1) { // Wait for the '"start" byte
temp = Man Receive (&error); // Attempt byte receive
if (temp == 0xO0B) // "Start" byte, see
Transmitter example
break; // We got the starting sequence
if (error) // Exit so we do not loop forever
break;
t
do
{
temp = Man Receive (&error); // Attempt byte receive
if (error) { // If error occured
Lcd Chr CP('2'"); // Write question mark on LCD
ErrorCount++; // Update error counter
if (ErrorCount > 20) { // In case of multiple errors
temp = Man_ Synchro(); // Try to synchronize again
//Man Receive Init(); // Alternative, try to
Initialize Receiver again
ErrorCount = 0;
}
}
else { // No error occured
if (temp != O0x0E)

// If "End" byte was received(see Transmitter example)
Lcd Chr CP(temp) ;
}
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Delay ms (25);
}
while (temp != O0xO0E) ;
// If "End" byte was received exit do loop
}

The following code is code for the Manchester transmitter, it shows how to use the
Manchester Library for transmitting data:

// Manchester module connections
sbit MANRXPIN at PO.BO;

sbit MANTXPIN at P1.B1;

// End Manchester module connections

char index, character;
char sl[] = "mikroElektronika";

void main () {

Man Send Init(); // Initialize transmitter
while (1) { // Endless loop
Man Send (0x0B) ; // Send "start" byte
Delay ms (100); // Wait for a while
character = s1[ 0] ; // Take first char from string
index = 0; // Initialize index variable
while (character) { // String ends with zero
Man Send(character); // Send character
Delay ms (90); // Wait for a while
index++; // Increment index variable
character = sl1[ index] ; // Take next char from string
}
Man Send (0x0E) ; // Send "end" byte

Delay ms (1000) ;
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Connection Example
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6.6. Simple Receiver connection
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PORT EXPANDER LIBRARY

The mikroC for 8051 provides a library for communication with the Microchip’s
Port Expander MCP23S17 via SPI interface. Connections of the 8051 compliant
MCU and MCP23S17 is given on the schematic at the bottom of this page.

Note: Library uses the SPI module for communication. The user must initialize SPI
module before using the Port Expander Library.

Note: Library does not use Port Expander interrupts.

External dependencies of Port Expander Library

The following vari-
ables must be defined

in all projects using Description: Example :
Port Expander
Library:
extern sbit ChH)SdCCthne' sbit SPExpanderCS at P1.Bl;
SPExpanderCS; !

extern sbit

i i PE RST P1.BO;
SPExpanderRST; Reset line. sbit SPExpanderRST at

Library Routines

- Expander_Init

- Expander Read Byte

- Expander Write Byte

- Expander Read PortA

- Expander Read PortB

- Expander Read PortAB

- Expander Write PortA

- Expander Write PortB

- Expander Write PortAB

- Expander_Set DirectionPortA
- Expander_Set DirectionPortB
- Expander Set DirectionPortAB
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- Expander Set PullUpsPortA
- Expander Set PullUpsPortB
- Expander Set PullUpsPortAB

Expander_Init

Prototype void Expander Init (char ModuleAddress);

Returns | Nothing.

Description | Initializes Port Expander using SPI communication.

Port Expander module settings :

- hardware addressing enabled

- automatic address pointer incrementing disabled (byte mode)
- BANK 0 register adressing

- slew rate enabled

Parameters :

- Modulenddress: Port Expander hardware address, see schematic
at the bottom of this page

Requires | sPExpandercs and sPExpanderrsT variables must be defined
before using this function.

SPI module needs to be initialized. See Spi_Init and
Spi_Init Advanced routines.

Example // port expander pinout definition
sbit SPExpanderRST at P1.BO;
sbit SPExpanderCS at P1.B1l;

Spi Init(); // initialize SPI module
Expander Init(0); // initialize port expander
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Expander_Read_Byte

Prototype char Expander Read Byte (char ModuleAddress, char
RegAddress) ;

Returns | Byte read.

Description | The function reads byte from Port Expander.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic
at the bottom of this page
- Regiddress: Port Expander's internal register address

Requires | Port Expander must be initialized. See Expander Init

Example // Read a byte from Port Expander's register
char read data;

read data = ExpanderiReadiByte(O,l);

Expander_Write_Byte

Prounype void Expander Write Byte (char ModuleAddress,char
RegAddress, char Data);

Returns | Nothing

Description | Routine writes a byte to Port Expander.
Parameters :

- ModuleAddress: Port Expander hardware address, see
schematic at the bottom of this page

- RegAddress: Port Expander's internal register address

- Data: data to be written

Requires | Port Expander must be initialized. See Expander_Init

Example // Write a byte to the Port Expander's register
Expander Write Byte(0,1,SFF);
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Expander_Read_PortA

Prototype char Expander Read PortA(char ModuleAddress) ;

Returns | Byte read.

Description | The function reads byte from Port Expander's PortA.
Parameters :

- Moduleaddress: Port Expander hardware address, see schematic
at the bottom of this page

Requires | Port Expander must be initialized. See Expander_Init.

Port Expander's PortA should be configured as input. See
Expander_Set DirectionPortA and
Expander_Set DirectionPortAB routines.

Example // Read a byte from Port Expander's PORTA
char read data;

Expander Set DirectionPortA(0,0xFF);
// set expander's porta to be input

read data = Expander Read PortA(0);

Expander_Read_PortB

Prototype char Expander Read PortB(char ModuleAddress);

Returns | Byte read.

Description | The function reads byte from Port Expander's PortB.
Parameters :

- Moduleaddress: Port Expander hardware address, see schematic
at the bottom of this page

Requires | Port Expander must be initialized. See Expander_Init.

Port Expander's PortB should be configured as input. See
Expander_Set DirectionPortB and
Expander_Set DirectionPortAB routines

Example // Read a byte from Port Expander's PORTB
char read data;

Expander Set DirectionPortB (0, OxFF); // set
expander's portb to be input

read data = Expander Read PortB(0);
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Expander_Read_PortAB

Prototype unsigned int Expander Read PortAB (char ModuleAddress);

Returns | Word read.

Description | The function reads word from Port Expander's ports. PortA read-
ings are in the higher byte of the result. PortB readings are in the
lower byte of the result.

Parameters :

- Moduleaddress: Port Expander hardware address, see schematic
at the bottom of this page

Requires | Port Expander must be initialized. See Expander_Init.

Port Expander's PortA and PortB should be configured as inputs.
See Expander_Set DirectionPortA,

Expander Set DirectionPortB and
Expander Set DirectionPortAB routines.

Exaone // Read a byte from Port Expander's PORTA and PORTB
unsigned int read data;

Expander Set DirectionPortAB (0, OxFFFF);
// set expander's porta and portb to be input

read data = Expander Read PortAB(0);
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Expander_Write_PortA

Prototype

void Expander Write PortA(char ModuleAddress, char
Data) ;

Returns

Nothing

Description

The function writes byte to Port Expander's PortA.

Parameters :

- Modulerddress; Port Expander hardware address, see schematic

at the bottom of this page
- Data: data to be written

Requires

Port Expander must be initialized. See Expander Init.

Port Expander's PortA should be configured as output. See
Expander_Set DirectionPortA and
Expander_Set” DirectionPortAB routines.

Example

// Write a byte to Port Expander's PORTA

Expander Set DirectionPortA (0, 0x00);
// set expander's porta to be output

Expander Write PortA (0, OxAA);

Expander_Write_PortB

Prototype

void Expander Write PortB(char ModuleAddress, char
Data) ;

Returns

Nothing.

Description

The function writes byte to Port Expander's PortB.
Parameters :
- ModuleAddress: Port Expander hardware address, see

schematic at the bottom of this page
- Data: data to be written

Requires

Port Expander must be initialized. See Expander Init.

Port Expander's PortB should be configured as output. See
Expander_Set DirectionPortB and
Expander_Set DirectionPortAB routines.

Example

// Write a byte to Port Expander's PORTB

Expander Set DirectionPortB(0,0x00);
// set expander's portb to be output

Expander Write PortB(0, 0x55);
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Expander_Write_PortAB

Prounype void Expander Write PortAB (char ModuleAddress,
unsigned int Data);

Returns | Nothing.

Description | The function writes word to Port Expander's ports.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic
at the bottom of this page

- Data: data to be written. Data to be written to PortA are passed
in Data's higher byte. Data to be written to PortB are passed in
Data's lower byte

Requires | Port Expander must be initialized. See Expander_Init.

Port Expander's PortA and PortB should be configured as outputs.
See Expander_Set DirectionPortA,

Expander_Set DirectionPortB and
Expander Set DirectionPortAB routines.

Example // Write a byte to Port Expander's PORTA and PORTB

Expander Set DirectionPortAB(0,0x0000);
// set expander's porta and portb to be output

Expander Write PortAB (0, O0xAA55);
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Expander_Set_DirectionPortA

Prototype void Expander Set DirectionPortA(char ModuleAddress,
char Data);

Returns | Nothing.

Description | The function sets Port Expander's PortA direction.
Parameters :

- Moduleaddress: Port Expander hardware address, see schematic
at the bottom of this page

- Data: data to be written to the PortA direction register. Each bit
corresponds to the appropriate pin of the PortA register. Set bit
designates corresponding pin as input. Cleared bit designates
corresponding pin as output.

Requires | Port Expander must be initialized. See Expander_Init.

Example | // Set Port Expander's PORTA to be output
Expander Set DirectionPortA(0,0x00),

Expander_Set_DirectionPortB

Prototype void Expander Set DirectionPortB(char ModuleAddress,
char Data);

Returns | Nothing.

Description | The function sets Port Expander's PortB direction.
Parameters :

- ModuleAddress: Port Expander hardware address, see schematic
at the bottom of this page

- Data: data to be written to the PortB direction register. Each bit
corresponds to the appropriate pin of the PortB register. Set bit
designates corresponding pin as input. Cleared bit designates
corresponding pin as output.

Requires | Port Expander must be initialized. See Expander_Init.

Example | // Set Port Expander's PORTE to be input
Expander Set DirectionPortB(0,0xFF)
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Expander_Set_DirectionPortAB

Prototype void Expander Set DirectionPortAB (char ModuleAddress,
unsigned int Direction);

Returns | Nothing

Description | The function sets Port Expander's PortA and PortB direction.
Parameters :

- Moduleaddress: Port Expander hardware address, see schemat-
ic at the bottom of this page

- Direction: data to be written to direction registers. Data to be
written to the PortA direction register are passed in Direction's
higher byte. Data to be written to the PortB direction register
are passed in Direction's lower byte. Each bit corresponds to the
appropriate pin of the PortA/PortB register. Set bit designates
corresponding pin as input. Cleared bit designates
corresponding pin as output.

Requires | Port Expander must be initialized. See Expander Init.

Example // Set Port Expander's PORTA to be output and PORTB
to be input
Expander Set DirectionPortAB(0,0x00FF)

Expander_Set_PullUpsPortA

Prototype void Expander Set PullUpsPortA(char ModuleAddress,
char Data);

Returns | Nothing.

Description | The function sets Port Expander's PortA pull up/down resistors.
Parameters :

- Modulerddress: Port Expander hardware address, see schematic
at the bottom of this page

- pata: data for choosing pull up/down resistors configuration.
Each bit corresponds to the appropriate pin of the PortA register.
Set bit enables pull-up for corresponding pin.

Requires | Port Expander must be initialized. See Expander_Init.

Example // Set Port Expander's PORTA pull-up resistors
Expander Set PullUpsPortA (0, OxFF);
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Expander_Set_PullUpsPortB

Prototype void Expander Set PullUpsPortB(char ModuleAddress,
char Data);

Returns | Nothing.

Description | The function sets Port Expander's PortB pull up/down resistors.
Parameters :

- Modulerddress: Port Expander hardware address, see schematic
at the bottom of this page

- Data: data for choosing pull up/down resistors configuration.
Each bit corresponds to the appropriate pin of the PortB register.
Set bit enables pull-up for corresponding pin.

Requires | Port Expander must be initialized. See Expander_Init.

Example | // Set Port Expander's PORTB pull-up resistors
Expander Set PullUpsPortB (0, OxFF);

Expander_Set PullUpsPortAB

Prounype void Expander Set PullUpsPortAB (char ModuleAddress,
unsigned int PullUps);

Returns | Nothing.

Description | The function sets Port Expander's PortA and PortB pull up/down
resistors.

Parameters :

- Modulenddress: Port Expander hardware address, see schematic
at the bottom of this page

- pullups: data for choosing pull up/down resistors configurati
on. PortA pull up/down resistors configuration is passed in
PullUps's higher byte. PortB pull up/down resistors configura
tion is passed in PullUps's lower byte. Each bit corresponds to
the appropriate pin of the PortA/PortB register. Set bit enables
pull-up for corresponding pin.

Requires | Port Expander must be initialized. See Expander_Init.

Example |// Set Port Expander's PORTA and PORTB pull-up resis-
tors
Expander Set PullUpsPortAB (0, OxFFFF);
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Library Example
The example demonstrates how to communicate with Port Expander MCP23S17.

Note that Port Expander pins A2 A1 A0 are connected to GND so Port Expander
Hardware Address is 0.

unsigned char i=0;

// Port Expander module connections
sbit SPExpanderRST at P1.BO;

sbit SPExpanderCs at P1.B1l;

// End Port Expander module connections

void main (){
Spi Init(); // Initialize SPI module
Expander Init (0); // Initialize Port Expander

Expander Set DirectionPortA (0, 0x00);
// Set Expander's PORTA to be output

Expander Set DirectionPortB(0,0xFF);
// Set Expander's PORTB to be input
Expander Set PullUpsPortB (0, 0xFF);
// Set pull-ups to all of the Expander's PORTB pins

while (1) { // Endless loop
Expander Write PortA (0, i++); // Write i to expander's PORTA
PO = Expander Read PortB(0);
// Read expander's PORTB and write it to PORTO
Delay ms (100);
}
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HW Connection
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6.7. Port Expander HW connection
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PS/2 LIBRARY

The mikroC for 8051 provides a library for communication with the common PS/2
keyboard.

Note: The library does not utilize interrupts for data retrieval, and requires the oscil-
lator clock to be at least 6MHz.

Note: The pins to which a PS/2 keyboard is attached should be connected to the pull-
up resistors.

Note: Although PS/2 is a two-way communication bus, this library does not provide
MCU-to-keyboard communication; e.g. pressing the Caps Lock key will not turn on
the Caps Lock LED.

External dependencies of PS/2 Library

The following variables
must be defined in all proj- | Description: Example :
ects using PS/2 Library:

extern sbit PS2 DATA; PS/2 Dataline. | i+ PS2 DATA at P0.BO;

extern sbit PS2 CLOCK; PS/2 Clock line. | sbit Ps2 CLOCK at P0.BI1;

Library Routines

- Ps2 Config
- Ps2 Key Read

Ps2_Config
Prototype void Ps2 Config();

Returns | Nothing.

Description | Initializes the MCU for work with the PS/2 keyboard.

Requires | Global variables :

- ps2_pata: Data signal pin
- ps2_crock: Clock signal pin .
must be defined before using this function.

Example |// PS2 pinout definition
sbit PS2 DATA at P0.BO;
sbit PS2 CLOCK at P0.B1;

Ps2 Config(); // Init PS/2 Keyboard
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Ps2_Key Read

Prototype unsigned short Ps2 Key Read(unsigned short *value,
unsigned short *special, unsigned short *pressed);

Returns | - 1 if reading of a key from the keyboard was successful
- 0 if no key was pressed

Description | The function retrieves information on key pressed.
Parameters :

- value: holds the value of the key pressed. For characters,
numerals, punctuation marks, and space value will store the
a%propriate ASCII code. Routine “recognizes” the function of
Shift and Caps Lock, and behaves appropriately. For special
function keys see Special Function Keys Table.

- special: is a flag for special function keys (F1, Enter, Esc, etc).
If key pressed is one of these, special will be set to 1,
otherwise 0.

- pressed: is set to 1 if the key is pressed, and 0 if it is released.

Requires | PS/2 keyboard needs to be initialized. See Ps2_Config routine.

Example unsigned short value, special, pressed;

// Press Enter to continue:
do {
if (Ps2 Key Read(&value, é&special, &pressed)) {
if ((value == 13) && (special == 1)) break;
}
} while (1);
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Special Function Keys

Key Value returned | | Print Screen 23
F1 1 Pause 24
F2 2 Caps Lock 25
F3 3 End 26
F4 4 Home 27
FS 3 Scroll Lock 28
Fo 6 Num Lock 29
F7 7

Left Arrow 30
F8 8 .

Right Arrow 31
F9 9

Up Arrow 32
F10 10

Down Arrow 33
F11 11

Escape 34
F12 12

Tab 35
Enter 13
Page Up 14
Page Down 15
Backspace 16
Insert 17
Delete 18
Windows 19
Ctrl 20
Shift 21
Alt 22
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Library Example

This simple example reads values of the pressed keys on the PS/2 keyboard and
sends them via UART.

char keydata = 0, special = 0, down = 0;

// PS2 module connections
sbit PS27DATA at P0.BRO;

sbit PS2 CLOCK at P0.B1;

// End PS2 module connections

void main () {

Uart Init (4800); // Initialize UART module at 4800 bps
Ps2 Config(); // Initialize PS/2 Keyboard
Delay ms (100); // Wait for keyboard to finish

do { // Endless loop

if (Ps2 Key Read(&keydata, é&special, &down)) {
// If data was read from PS/2
if (down && (keydata == 16)) { // Backspace read
Uart Write (0x08); // Send Backspace to usart terminal
}

else if (down && (keydata == 13)) { // Enter read
Uart Write('\r');// Send carriage return to usart terminal
//Uart Write('\n');

// Uncomment this line if usart terminal also expects line feed

// for new line transition
}
else if (down && !special && keydata) { // Common key read
Uart Write (keydata); // Send key to usart terminal
}
}
Delay ms (10); // Debounce period

} while (1);
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HW Connection
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Example of PS2 keyboard connection

300 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroC for 8051 Libraries

RS-485 LIBRARY

RS-485 is a multipoint communication which allows multiple devices to be connect-
ed to a single bus. The mikroC for 8051 provides a set of library routines for com-
fortable work with RS485 system using Master/Slave architecture. Master and Slave
devices interchange packets of information. Each of these packets contains synchro-
nization bytes, CRC byte, address byte and the data. Each Slave has unique address
and receives only packets addressed to it. The Slave can never initiate communica-
tion.

It is the user’s responsibility to ensure that only one device transmits via 485 bus at
a time.

The RS-485 routines require the UART module. Pins of UART need to be attached
to RS-485 interface transceiver, such as LTC485 or similar (see schematic at the bot-
tom of this page).

Library constants:

- START byte value = 150

- STOP byte value = 169

- Address 50 is the broadcast address for all Slaves (packets containing address
50 will be received by all Slaves except the Slaves with addresses
150 and 169).

External dependencies of RS-485 Library

The following vari-

able must be defined

in all projects using
RS-485 Library:

Description: Example :

Control RS-485
extern sbit ‘ Transmit/Receive | sbit rs485 transceive at P3.B2;
rs485 transceive; operation mode
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Library Routines

- RS485master Init

- RS485master Receive
- RS485master Send

- RS485slave Init

- RS485slave Receive
- RS485slave _Send

RS485master_Init

Prototype void Rs485master Init();

Returns | Nothing.

Description | Initializes MCU as a Master for RS-485 communication.

Requires | rs485 transceive variable must be defined before using this
function. This pin is connected to RE/DE input of RS-485 trans-
ceiverﬁsee schematic at the bottom of this page). RE/DE signal
controls RS-485 transceiver operation mode. Valid values: 1 (for
transmitting) and o (for receiving)

UART HW module needs to be initialized. See Uart_Init.

Example // rs485 module pinout
sbit rs485 transceive at P3.B2;
// transmit/receive control set to port3.bit2

Uart Init (9600); // initialize

usart module
Rs485master Init(); // intialize

mcu as a Master for RS-485 communication
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RS485master_Receive

Prototype void Rs485master Receive (char *data buffer);

Returns | Nothing.

Description | Receives messages from Slaves. Messages are multi-byte, so this
routine must be called for each byte received.

Parameters :
- data buffer: 7 byte buffer for storing received data, in the fol

lowing manner:
- datal 0..2] :message content

- datal 3] : number of message bytes received, 1-3

- datal 4] : is set to 255 when message is received

- datal 5] : is set to 255 if error has occurred

- datal 6] : address of the Slave which sent the message

The function automatically adjusts data[4] and data[5] upon every
received message. These tlags need to be cleared by software.

Requires | MCU must be initialized as a Master for RS-485 communication.
See RS485master Init.

Example |char msol 8]

RS485masteriReceive (msqg) ;

RS485master_Send

Prototype void Rs485master Send(char *data buffer, char
datalen, char slave address) ;

Returns | Nothing.

Description | Sends message to Slave(s). Message format can be found at the
bottom of this page.

Parameters :

- data buffer: data to be sent o )
- datalen: number of bytes for transmition. Valid values: 0...3.
- slave address: Slave(s) address

Requires | MCU must be initialized as a Master for RS-485 communication.
See RS485master_Init.

It is the user’s responsibility to ensure (by protocol) that only one
device sends data via 485 bus at a time.

Example |char msdl 8]

// send 3 bytes of data to slave with address 0x12
RS485master Send(msg, 3, 0x12);
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RS485slave_Init

Prototype void Rs485slave Init (char slave address);

Returns | Nothing.

Description | Initializes MCU as a Slave for RS-485 communication.
Parameters :

- slave address: Slave address

Requires |rs485 transceive variable must be defined before using this
function. This pin is connected to RE/DE input of RS-485 trans-
ceiverﬁsee schematic at the bottom of this page). RE/DE signal
controls RS-485 transceiver operation mode. Valid values: 1 (for
transmitting) and o (for receiving)

UART HW module needs to be initialized. See Uart_Init.

Example | // rs485 module pinout
sbit rs485 transceive at P3.B2Z;
// transmit/receive control set to port3.bit2

Uart Init(9600); // initialize usart module
Rs485slave Init (160); // intialize mcu as a Slave
for RS-485 communication with address 160

RS485slave_Receive

Prototype void RS485slave Receive (char *data buffer);

Returns | Nothing.

Description | Receives messages from Master. If Slave address and Message
address field don't match then the message will be discarded.
Messages are multi-byte, so this routine must be called for each
byte received.

Parameters :

- data buffer: 6 byte buffer for storing received data, in the fol
lowing manner:

- data[ 0..2] : message content

- datal 3] : number of message bytes received, 1-3

- datal 4] : is set to 255 when message is received

- datal 5] : is set to 255 if error has occurred

The function automatically adjusts datal 4] and datal 5] upon

every received message. These flags need to be cleared by soft-

ware.

Requires | MCU must be initialized as a Slave for RS-485 communication.
See RS485slave Init.

Example |char msdl 8]

RS485slave Read (msqg) ;
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RS485slave_Send

Prototype void Rs485slave Send(char *data buffer, char
datalen) ;

Returns | Nothing.

Description | Sends message to Master. Message format can be found at the
bottom of this page.

Parameters :

- data buffer: data to be sent N )
- datalen: number of bytes for transmition. Valid values: 0...3.

Requires | MCU must be initialized as a Slave for RS-485 communication.
See RS485slave Init. It is the user’s responsibility to ensure (by
protocol) that only one device sends data via 485 bus at a time.

Example |char msol 8]

// send 2 bytes of data to the master
RS485slave Send(msg, 2);

Library Example
This is a simple demonstration of RS485 Library routines usage.

Master sends message to Slave with address 160 and waits for a response. The Slave
accepts data, increments it and sends it back to the Master. Master then does the
same and sends incremented data back to Slave, etc.

Master displays received data on PO, while error on receive (0xAA) and number of
consecutive unsuccessful retries are displayed on P1. Slave displays received data
on PO, while error on receive (0xAA) is displayed on P1. Hardware configurations
in this example are made for the Easy8051B board and AT89S8253.
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RS485 Master code:

char dat[ 10] ; // Buffer for receving/sending messages
char i,j;
long count = 0;

// RS485 module connections

sbit rs485 transceive at P3.B2; // Transmit/Receive control set
to P3.2

// End RS485 module connections

Y Interrupt routine
void UartRxHandler () org 0x23 {
EA = 0; // Clear global interrupt enable flag
if (RI) { // Test UART receive interrupt flag
Rs485master Receive(dat); // UART receive interrupt detected,
// receive data using RS485
communication

RI = 0; // Clear UART interrupt flag
}
EA = 1; // Set global interrupt enable flag
Y/~
void main (){
PO = 0; // Clear ports
Pl = 0;
Uart Init (9600); // Initialize UART module at 9600 bps

Delay ms (100);

Rs485master Init(); // Intialize MCU as RS485 master
dat[ 0] = 0x55; // Fill buffer
dat[ 1] = 0x00;
dat[ 2] = 0x00;
dat[ 4] = 0; // Ensure that message received flag is 0
dat[ 5] = 0; // Ensure that error flag is 0
dat[ 6] = 0;
Rs485master Send(dat,1,160); // Send message to slave with
address 160
// message data is stored in dat

// message 1s 1 byte long

ES = 1; // Enable UART interrupt

RI = 0; // Clear UART RX interrupt flag
EA = 1; // Enable interrupts

while (1){ // Endless loop

// Upon completed valid message receiving
// datal 4] 1is set to 255
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count++; // Increment loop pass counter
if (dat[ 5] ) { // If error detected, signal it by
P1 = OxAA; // setting PORT1 to OxAA
}
if (dat[ 4] ) { // If message received successfully
count = 0; // Reset loop pass counter
dat[ 4] = 0; // Clear message received flag
J = dat[ 3] ; // Read number of message received
bytes
for (i = 1; 1 <= 3; 1i++){
PO = dat[ i-1] ; // Show received data on PORTO
}
dat[ 0] = dat[ 0] + 1; // Increment first received byte
dat[0]

Delay ms (10);
Rs485master Send(dat,1,160); // And send it back to Slave
}

if (count > 10000) { // If loop 1is passed 100000
times with
// no message received
Pl++; // Signal receive message failure
on PORTI
count = 0; // Reset loop pass counter
Rs485master Send(dat,1,160); // Retry send message
if (P1 > 10) { // If sending failed 10 times
P1 = 0; // Clear PORTI
Rs485master Send(dat,1,50); // Send message on broadcast
address

}

RS485 Slave code:

char dat[ 9] ; // Buffer for receving/sending messages
char i,7j;

// RS485 module connections

sbit rs485 transceive at P3.B2;

// Transmit/Receive control set to P3.2
// End RS485 module connections

e Interrupt routine
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void UartRxHandler () org 0x23 {

EA = 0; // Clear global interrupt enable
flag
if (RI) { // Test UART receive interrupt flag
Rs485slave Receive (dat); // UART receive interrupt detected,
// receive data using RS485
communication
RI = 0; // Clear UART interrupt flag
}
EA = 1; // Set global interrupt enable flag
Y/
void main (){
PO = 0; // Clear ports
Pl = 0;
Uart Init (9600); // Initialize UART module at 9600 bps
Delay ms (100);
Rs485slave Init(160); // Intialize MCU as slave, address 160
dat[ 4] = 0; // ensure that message received flag is 0
dat[ 5] = 0; // ensure that error flag is 0
ES = 1; // Enable UART interrupt
RI = 0; // Clear UART RX interrupt flag
EA = 1; // Enable interrupts
while (1){ // Endless loop
// Upon completed valid message receiving
// data[4] is set to 255
if (dat[ 5] ) { // If error detected, signal it by
Pl = OxAA; // setting PORT1 to O0xAA
}
if (dat[ 4] ) { // If message received successfully
dat[ 4] = 0; // Clear message received flag
J = dat[ 3] ; // Read number of message received bytes
for (i = 1; i <= j; i++){
PO = dat[ i-1]; // Show received data on PORTO
}
dat[ 0] = dat[ 0] + 1; // Increment received dat[0]

Delay ms (10);
Rs485slave Send(dat,1); // And send back to Master
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HW Connection
| ! Shielded pair
¢ nolonger than 300m
1L
— 56R
| S
1
vcc O S6R K7 \\ vee VvCC
1 =4 8 Ij
—| R0 Ve
2 RE B ]7
_EE DE A ]6
LTC485 o0
= ] P30 ©
] P3.1 (D 1
1rs2 ©O i
I N 1
()] I
VCC o ; w %
[]4K7 56R 56R
1 o uvcc ]J OSCILLATOR %
_E§E RE B 3: ------------- ] xraLs ]
DE A : GND ]
o oo ii _;
4K7
LTC485 '_[,]
F
]
I PC
I
i
I
I
RTS
GND
% o™
RX /A \
r— )

6.9. Example of interfacing PC to 8051 MCU via RS485 bus with LTC485 as
RS-485 transceiver
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Message format and CRC calculations

Q: How is CRC checksum calculated on RS485 master side?

START BYTE = 0x96; // 10010110
STOP BYTE = 0xA9; // 10101001

PACKAGE:

START BYTE 0x96

ADDRESS

DATALEN

[ DATA1] // 1f exists
[ DATA2] // 1f exists
[ DATA3] // 1if exists
CRC

STOP BYTE 0xA9

DATALEN bits
bit7 = 1 MASTER SENDS

0 SLAVE SENDS
bit6 = 1 ADDRESS WAS XORed with 1, IT WAS EQUAL TO START BYTE or
STOP BYTE

0 ADDRESS UNCHANGED
bit5 = 0 FIXED
bit4 = 1 DATA3 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATA3 (if exists) UNCHANGED
bit3 = 1 DATA2 (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATA2 (if exists) UNCHANGED
bit2 = 1 DATAl (if exists) WAS XORed with 1, IT WAS EQUAL TO
START BYTE or STOP BYTE

0 DATAL (if exists) UNCHANGED
bitlbit0 = 0 to 3 NUMBER OF DATA BYTES SEND

CRC generation

crc_send = datalen " address;

crc_send “= datal 0] ; // if exists

crc_send ~= datal 1] ; // if exists

crc_send “= datal 2] ; // if exists

crc_send = ~crc send;

if ((crc_send == START BYTE) || (crc send == STOP BYTE))

crc_send++;

NOTE: DATALEN<4..0> can not take the START BYTE<4..0> or
STOP BYTE<4..0> values.
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SOFTWARE I’C LIBRARY

The mikroC for 8051 provides routines for implementing Software [*C communica-
tion. These routines are hardware independent and can be used with any MCU. The
Software I?C library enables you to use MCU as Master in [°C communication.
Multi-master mode is not supported.

Note: This library implements time-based activities, so interrupts need to be dis-
abled when using Software I*C.

Note: All I>C Library functions are blocking-call functions (they are waiting for I*C
clock line to become logical one).

Note: The pins used for [*C communication should be connected to the pull-up resis-
tors. Turning off the LEDs connected to these pins may also be required.

External dependecies of Soft_I2C Library

The following vari-
ables must be defined
in all projects using
Soft_I2C Library:

Description: Example :

extern sbit Soft IC Clock line. | cpit sort 120 sc1 at p1.B3;
Soft I2C Scl; - = ’

extern sbit Soft IC Data line. | _pic sore 120 sda at p1.84;
Soft I2C Sda; - - !

Library Routines

- Soft I2C Init

- Soft I2C Start

- Soft I2C_Read
- Soft 12C_Write
- Soft I2C Stop
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Soft_I2C_lInit
Prototype void Soft I2C Init();
Returns | Nothing.
Description | Configures the software [°C module.
Requires | soft 12¢ scland soft 12C sda variables must be defined
before using this function.
Example |// soft i2c pinout definition

sbit Soft I2C Scl at P1.B3;
sbit Soft I2C Sda at P1.B4;

Soft I2C Init();

Soft_I2C_Start

Prototype void SoftiIzcistart (void) ;
Returns | Nothing.
Description | Determines if the I?C bus is free and issues START signal.

Requires | Software I*C must be configured before using this function. See
Soft 12C_Init routine.

Example | // Issue START signal
Soft I2C Start();

Soft_12C_Read
Prototype unsigned short Soft I2C Read(unsigned int ack);
Returns | One byte from the Slave.
Description | Reads one byte from the slave.

Parameters :
- ack: acknowledge signal parameter. If the 2ck==0 not
acknowledge signal will be sent after reading, otherwise the
acknowledge signal will be sent.

Requires | Soft I°C must be configured before using this function. See
Soft 12C Init routine.
Also, START signal needs to be issued in order to use this func-
tion. See Soft 12C Start routine.

Example unsigned short take;

// Read data and send the not acknowledge signal

take = Soft I2C Read(0);

312 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD




CHAPTER 6
mikroC for 8051 Libraries

Soft_I2C_Write

Prototype unsigned short Soft I2C Write (unsigned short Data);

Returns - 0 if there were no errors.
- 1 if write collision was detected on the I?C bus. .

Description | Sends data byte via the I°C bus.
Parameters :

- Data: data to be sent

Requires | Soft [°C must be configured before using this function. See
Soft 12C Init routine.

Also, START signal needs to be issued in order to use this func-
tion. See Soft 12C Start routine.

Example unsigned short data, error;

error

= Soft I2C Write(data);
error = Soft I2C Write (0xA3);
Soft_I2C_Stop

Prototype void Soft_I2C_Stop(void);

Returns | Nothing. .

Description | Issues STOP signal.

Requires | Soft [>°C must be configured before using this function. See
Soft 12C_Init routine.

Example | // Issue STOP signal
Soft I2C Stop();
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Library Example

The example demonstrates Software [*C Library routines usage. The 8051 MCU is
connected (SCL, SDA pins) to PCF8583 RTC (real-time clock). Program reads date
and time are read from the RTC and prints it on LCD.

char seconds, minutes, hours, day, month, year;
// Global date/time variables

// Software I2C connections
sbit Soft I2C Scl at P1.B3;
sbit Soft I2C Sda at P1.B4;
// End Software I2C connections

// LCD module connections
sbit LCD RS at P2.BO;
sbit LCD EN at P2.B1;

sbit LCD D7 at P2.B5;
sbit LCD D6 at P2.B4;
sbit LCD D5 at P2.B3;
sbit LCD D4 at P2.B2;
// End LCD module connections

J) e e Reads time and date information from RTC
(PCF8583)
void Read Time () {
Soft I2C Start();
Soft I2C Write (0xAQ);

// Issue start signal
// Address PCF8583, see PCF8583
datasheet

Soft I2C Write(2);
Soft I2C Start();
Soft I2C Write (0xAl);

seconds = Soft I2C Read(l);
minutes = Soft I2C Read(l);
hours = Soft I2C Read(l);
day = Soft I2C Read(l);
month = Soft I2C Read(0);
Soft I2C Stop();

Y/~

// Start from address 2

// Issue repeated start signal

// Address PCF8583 for reading
R/W=1

// Read seconds byte

// Read minutes byte

// Read hours byte

// Read year/day byte

// Read weekday/month byte

// Issue stop signal

[/ e Formats date and time

void Transform Time () {

seconds = ((seconds & O0xFO)
// Transform seconds
minutes = ((minutes & OxFO)

// Transform months

>> 4)*10 + (seconds & O0xOF);

>> 4)*10 + (minutes & O0xOF);
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hours = ((hours & OxFO0)
// Transform hours
year = (day & 0xCO)
// Transform year
day = ((day & 0x30)
// Transform day
month = ((month & 0x10
// Transform month
Y/~
[/ m e e
void Display Time () {
Led Chr(l, 6, (day / 10)
Led Chr(l, 7, (day % 10)
Led Chr(l, 9, (month / 10
Lcd Chr (1,10, (month % 10
Lcd Chr(1,15, year
Lcd Chr(2, 6, (hours / 10
Lcd Chr(2, 7, (hours % 10
Lcd Chr (2, 9, (minutes /
Led Chr(2,1 (minutes %
Lcd Chr (2, 12 (seconds /
Lcd Chr (2,13, (seconds %

void Init Main ()
Soft I2C Init();
Led Init();

Lcd Cmd (LCD _CLEAR) ;
Led Cmd (LCD _CURSOR OFF) ;

LCD Out(1l,1,"Date:");
LCD Chr(1,8,"':");
LCD7Chr(1,ll, "),
LCDiout(Z,l,"Tlme Y ;
LCDichr(2,8 ')?

LCD Chr (2,1 : ")
LCDiout(1,12,"200");

Y/~

Libraries
>> 4)*10 + (hours & O0xOF);
>> 6;
>> 4)*10 + (day & O0xO0F);

)

L e

>> 4)*10 + (month & OxOF);

Output values to LCD

+ 48); // Print tens digit of day
variable
+ 48); // Print oness digit of
day variable
+ 48);
+ 48);
+ 56); // Print year vaiable + 8
(start from year 2008)
+ 48)
+ 48);
0) + 48);
0) + 48);
0) + 48);
0) + 48);

Performs project-wide init

// Initialize Soft I2C communication

// Initialize LCD
// Clear LCD display
// Turn cursor off

// Prepare and output static text on
LCD
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void main () {
Init Main(); // Perform initialization
while (1) { // Endless loop
Read Time () ; // Read time from RTC (PCF8583)
Transform Time () ; // Format date and time
Display Time () ; // Prepare and display on LCD
Delay ms (1000); // Wait 1 second

}
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SOFTWARE SPI LIBRARY

The mikroC for 8051 provides routines for implementing Software SPI communi-
cation. These routines are hardware independent and can be used with any MCU.
The Software SPI Library provides easy communication with other devices via SPI:
A/D converters, D/A converters, MAX7219, LTC1290, etc.

Library configuration:

- SPI to Master mode

- Clock value = 20 kHz.

- Data sampled at the middle of interval.
- Clock idle state low.

- Data sampled at the middle of interval.
- Data transmitted at low to high edge.

Note: The Software SPI library implements time-based activities, so interrupts need
to be disabled when using it.

External dependencies of Software SPI Library

The following vari-
ables must be defined
in all projects using
Software SPI Library:

Description: Example :

extern sbit Data In line. sbit SoftSpi SDI at PO.B4;
SoftSpi SDI; _

extern sbit Data Out line ; ;
. f D! PO.B5;
SoftSpi SDO; e e

extern sbit Clock line ; i
. Softs LK P0.B3;
SoftSpi CLK; e

Library Routines

- Soft Spi_Init
- Soft Spi_Read
- Soft Spi_Write
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Soft_Spi_Init

Prototype void Soft SPI Init();

Returns | Nothing. .

Description | Configures and initializes the software SPI module.

Requires | softspi CLK, softspi spl and sSoftspi spo variables must
be defined before using this function.

Example | // soft spi pinout definition
sbit SoftSpi SDI at P0.B4;
sbit SoftSpi SDO at P0.B5;
sbit SoftSpi CLK at pP0.B3;

Soft SPI_Init(); // Init Soft SPT

Soft_Spi_Read

Prototype unsigned short Soft Spi Read(char sdata);

Returns | Byte received via the SPI bus.

Description | This routine performs 3 operations simultaneously. It provides
clock for the Software SPI bus, reads a byte and sends a byte.

Parameters :

- sdata: data to be sent.

Requires | Soft SPI must be initialized before using this function. See
Soft Spi_Init routine.

Example unsigned short data read;
char data send;

// Read a byte and assign it to data read variable
// (data_send byte will be sent via SPI during the
Read operation)

data read = SoftispiiRead(dataisend);
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Soft_Spi_Write

Prototype void Soft Spi Write(char sdata);

Returns | Nothing.

Description | This routine sends one byte via the Software SPI bus.
Parameters :

- sdata: data to be sent.

Requires | Soft SPI must be initialized before using this function. See
Soft Spi_Init routine.

Example // Write a byte to the Soft SPI bus
Soft Spi Write (0xAA);
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Library Example

This code demonstrates using library routines for Soft SPI communication. Also,
this example demonstrates working with Microchip's MCP4921 12-bit D/A con-
verter.

// DAC module connections
sbit Chip Select at P3.B4;
sbit SoftSpi CLK at P1.B7;
sbit SoftSpi SDI at P1.B6;
sbit SoftSpi SDO at P1.B5;
// End DAC module connections

unsigned int value;

void InitMain () {

PO = 255; // Set PORTO as input
Soft SPI Init(); // Initialize Soft SPI
Y/~

// DAC increments (0..4095) --> output voltage (0..Vref)
void DAC Output (unsigned int valueDAC) {
char temp;

Chip Select = 0; // Select DAC chip

// Send High Byte
temp = (valueDAC >> 8) & O0xO0F;
// Store valueDAC[11..8] to temp[3..0]
temp |= 0x30;
// Define DAC setting, see MCP4921 datasheet
Soft SPI Write (temp); // Send high byte via Soft SPI

// Send Low Byte

temp = valueDAC; // Store valueDAC[7..0] to temp[7..0]
Soft SPI Write (temp); // Send low byte via Soft SPI
Chip Select = 1; // Deselect DAC chip

Y/~

void main () {

InitMain () ; // Perform main initialization
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value = 2048; // When program starts, DAC gives
// the output in the mid-range

while (1) { // Endless loop
if ((!PO_0) && (value < 4095)) {
// If P0.0 is connected to GND
value++; // increment value
}
else {
if ((!'PO_1) && (value > 0)) { // If P0.1 is connected to GND
value--; // decrement value
}
}
DAC Output (value) ; // Perform output
Delay ms (10); // Slow down key repeat pace

}
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SOFTWARE UART LIBRARY

The mikroC for 8051 provides routines for implementing Software UART commu-
nication. These routines are hardware independent and can be used with any MCU.
The Software UART Library provides easy communication with other devices via
the RS232 protocol.

Note: The Software UART library implements time-based activities, so interrupts
need to be disabled when using it.

External dependencies of Software UART Library

The following vari-
ables must be defined

in all projects using Description: Example :
Software UART
Library:
extern sbit Receive line. sbit Soft Uart RX at P3.B0;

Soft Uart RX ;

extern sbit Transmit line. sbit Soft Uart TX at P3.B1;
Soft Uart TX ; - -

Library Routines

- Soft Uart Init
- Soft Uart Read
- Soft Uart Write
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Soft_Uart_lInit

Prototype unsigned Soft Uart Init (unsigned long baud rate, char
inverted) ;

Returns | Nothing.
Description | Configures and initializes the software UART module.

Parameters :

- baud rate: baud rate to be set. Maximum baud rate depends on
the MCU’s clock and working conditions.

- inverted: inverted output flag. When set to a non-zero value,
inverted logic on output is used.

Requires | Global variables:

- Soft Uart RX receiver pin.
- Soft Uart TX transmiter pin

must be defined before using this function.

Exan“ﬂe // Initialize Software UART communication on pins Rx,
Tx, at 9600 bps
Soft Uart Init (9600, 0);

Soft_Uart_Read

Prototype char Soft Uart Read(char * error);

Returns | Byte received via UART.

Description | The function receives a byte via software UART. This is a block-
ing function call (waits for start bit).

Parameters :

- error: Error flag. Error code is returned through this variable.
Upon successful transfer this flag will be set to zero. An non
zero value indicates communication error.

Requires | Software UART must be initialized before using this function.
See the Soft Uart_Init routine.

Example char data;
int error;

// wait until data is received
do

data = Soft Uart Read(&error);
while (error);

// Now we can work with data:
if (data) { ...}
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Soft_Uart_Write

Prototype void Soft Uart Write(char udata);

Returns | Nothing.

Description | This routine sends one byte via the Software UART bus.
Parameters :

- udata: data to be sent.

Requires | Software UART must be initialized before using this function.
See the Soft Uart Init routine.

Be aware that during transmission, software UART is incapable
of receiving data — data transfer protocol must be set in such a
way to prevent loss of information.

Example char some byte = 0x0A;

// Write a byte via Soft Uart
Soft Uart Write (some byte);

Library Example

This example demonstrates simple data exchange via software UART. If MCU is
connected to the PC, you can test the example from the mikroC for 8051 USART
Terminal Tool.

// Soft UART connections

sbit Soft Uart RX at P3.BO;
sbit Soft Uart TX at P3.Bl;
// End Soft UART connections

char i, error, byte read; // Auxiliary variables
void main (){

Soft Uart Init (4800, 0); // Initialize Soft UART at 4800 bps
for (i = '"z'; i >= 'A'; i--) { // Send bytes from 'z' downto 'A'
Soft Uart Write(i);
Delay ms (100);
t

while (1) { // Endless loop
byte read = Soft Uart Read(&error);
// Read byte, then test error flag
if (error) // If error was detected
PO = OxAA; // signal it on PORTO
else
Soft Uart Write(byte read);
// If error was not detected, return byte read
}
}
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SOUND LIBRARY

The mikroC for 8051 provides a Sound Library to supply users with routines neces-
sary for sound signalization in their applications. Sound generation needs addition-
al hardware, such as piezo-speaker (example of piezo-speaker interface is given on
the schematic at the bottom of this page).

External dependencies of Sound Library

The following variables
must be defined in all

. . Description: Example :
projects using Sound P P
Library:
extern sbit Sound(nnputphL sbit Sound Play Pin at PO.B3;

Sound Play Pin;

Library Routines

- Sound_Init
- Sound Play
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Sound_lInit

Prototype void Sound Init();

Returns | Nothing.

Description | Configures the appropriate MCU pin for sound generation.

Requires | sound rlay pin variable must be defined before using this
function.

Exanqﬂe // Initialize the pin P0.3 for playing sound
sbit Sound Play Pin at PO.B3;

Sound Init();

Sound_Play

Prototype | void Sound Play(unsigned freg in_hz, unsigned
duration ms) ;

Returns | Nothing.

Description | Generates the square wave signal on the appropriate pin.
Parameters :

- freq in hz: signal frequency in Hertz (Hz)
- duration ms: signal duration in miliseconds (ms)

Requires | In order to hear the sound, you need a piezo speaker (or other
hardware) on designated port. Also, you must call Sound_Init to
prepare hardware for output before using this function.

Exanqﬂe // Play sound of 1KHz in duration of 100ms
Sound Play (1000, 100);

Library Example

The example is a simple demonstration of how to use the Sound Library for play-
ing tones on a piezo speaker.

326 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroC for 8051 Libraries

// Sound connections
sbit Sound Play Pin at P0.B3;
// End Sound connections

void Tonel () {
Sound_ Play (500, 200); // Frequency = 500Hz, Duration = 200ms
Y/~

void Tone2 () {
Sound_ Play (555, 200); // Frequency = 555Hz, Duration = 200ms
Y/~

void Tone3 () {
Sound Play (625, 200); // Frequency = 625Hz, Duration = 200ms
Y/~

void Melody () { // Plays the melody "Yellow house"
Tonel (); Tone2(); Tone3 () Tone3 () ;
Tonel (); Tone2(); Tone3 ()
Tonel (); Tone2(); Tone3();
Tonel (); Tone2(); Tone3(); Tone3();
() () 0)
() () 0)

’

; Tone3();

’

Tonel (); Tone2(); Tone3
Tone3(); Tone3(); Tone2

Y/~

; Tone2(); Tonel();

void ToneA () { // Tones used in MelodyZ2 function
Sound Play (1250, 20);

}

void ToneC () {
Sound Play (1450, 20);

}

void ToneE () {
Sound Play (1650, 80);

}

void Melody2 () { // Plays MelodyZ2
unsigned short i;
for (i = 9; i > 0; i--) {
ToneA () ;
ToneC () ;
ToneE () ;
}
Y/~

void main () {
Pl = 255; // Configure PORT1 as input
Sound Init(); // Initialize sound pin
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Sound Play (2000, 1000)

while (1) {

if (1(P1_7))
Tonel () ;

while (! (P1_7))
if (! (P1_6))
Tone?2 () ;

while (! (P1_6)) ;
if (! (P1_5))
Tone3 () ;

while (! (P1_5)) ;
if (! (P1_4))
Melody?2 () ;
while (! (P1_4)) ;
if (1 (P1_3))
Melody () ;

while (! (P1_3)) ;

}

HW Connection

JJ

; // Play starting sound, Z2kHz,

// endless loop

1 second

// If P1.7 is pressed play Tonel

//

// Wait for button to be released

// If Pl1.6 is pressed play Tone2

/7

// Wait for button to be released

// If P1.5 is pressed play Tone3

/7

// Wait for button to be released

// If P1.4 is pressed play Melody?2

/7

// Wait for button to be released

// If P1.3 is pressed play Melody

/7

// Wait for button to be released

)l
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SPI LIBRARY

mikroC for 8051 provides a library for comfortable with SPI work in Master mode.
The 8051 MCU can easily communicate with other devices via SPI: A/D convert-
ers, D/A converters, MAX7219, LTC1290, etc.

Library Routines
- Spi_Init
- Spi_Init Advanced
- Spi_Read
- Spi_Write

Spi_Init

Prototype void Spi Init(void);

Returns | Nothing.

Description | This routine configures and enables SPI module with the follow-
ing settings:

- master mode

- clock idle low

- 8 bit data transfer

- most significant bit sent first

- serial output data changes on idle to active transition of
clock state

- serial clock = fosc/128 (fosc/64 in x2 mode)

Requires | MCU must have SPI module.

Example // Initialize the SPI module with default settings
SpiiInit();
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Spi_lnit_Advanced

Prototype void Spi Init Advanced(unsigned short adv_setting)

Returns | Nothing.

Description | This routine configures and enables the SPI module with the user
defined settings.

Parameters :
- adv_setting: SPI module configuration flags. Predefined

library constants (see the table below) can be ORed to form
appropriate configuration value.

Bit |Mask Description Predefined library const
Master/slave [ 4] and clock rate select [ 1:0] bits
0x10 Sck = Fosc/4 (Fosc/2 in x2 mode), MASTER OSC DIVA
Master mode - -
4,1, 0x11 Sck = Fosc/l6 (f/8 in x2 mode), MASTER OSC DIVL6
0 Master mode - -
0x12 Sck = Fosc/64 (f/32 in x2 mode), MASTER OSC DIV64
Master mode - -
0x13 Sck = Fosc/128 (f/64 in x2 mode), MASTER OSC DIV1Z2S8
Master mode - -
SPI clock phase
5 0%00 Data chagggs on idle to active IDLE 2 ACTIVE
transition of the clock - =
0x04 Data chagggs on active to idle ACTIVE 2 IDLE
transition of the clock - =
SPI clock polarity
3 0x00 Clock idle level is low CLK_IDLE LOW
0x08 Clock idle level is high CLK_IDLE HIGH
Data order
5 0x00 | Most significant bit sent first DATA ORDER MSB
0x20 | Least significant bit sent first DATA ORDER_LSB

Requires | MCU must have SPI module.

Example // Set SPI to the Master Mode, clock = Fosc/4 , clock
IDLE state low and data transmitted at low to high
clock edge:

Spi Init Advanced (MASTER OSC DIV4 | DATA ORDER MSB |
CLK _IDLE LOW | IDLE 2 ACTIVE);
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Spi_Read

Prototype unsigned short Spi Read (unsigned short buffer);

Returns Received data.

Description | Reads one byte from the SPI bus.
Parameters :

- buffer: dummy data for clock generation (see device Datasheet
for SPI modules implementation details)

Requires | SPI module must be initialized before using this function. See
Spi_Init and Spi_Init Advanced routines.

Example // read a byte from the SPI bus
unsigned short take, dummyl;

take = Spi Read(dummyl) ;

Spi_Write

Prototype void Spi Write (unsigned short wrdata);

Returns | Nothing.

Description | Writes byte via the SPI bus.
Parameters :

- wrdata: data to be sent

Requires | SPI module must be initialized before using this function. See
Spi_Init and Spi Init Advanced routines.

Example // write a byte to the SPI bus
unsigned short buffer;

Spi Write (buffer);

Library Example

The code demonstrates how to use SPI library functions for communication between
SPI module of the MCU and MAX7219 chip. MAX7219 controls eight 7 segment
displays.
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// Serial 7-seg Display connections
sbit CHIP SEL at P1.BO; // Chip Select pin definition
// End Serial 7-seg Display connections

void Select max() { // Function for selecting MAX7219
CHIP SEL = 0;
Delay us(1);

void Deselect max () { // Function for deselecting MAX7219
Delay us(1);
CHIP SEL = 1;

void Max7219 init () { // Initializing MAX7219
Select max();
Spi Write (0x09); // BCD mode for digit decoding

Spi Write (OxFF);
Deselect max () ;

Select max();

Spi Write (0x0A);

Spi Write (0xOF) ; // Segment luminosity intensity
Deselect max () ;

Select max();

Spi Write (0xO0B);

Spi Write (0x07); // Display refresh
Deselect max () ;

Select max () ;

Spi Write (0x0C);

Spi Write (0x01); // Turn on the display
Deselect max () ;

Select max();

Spi Write (0x00);

Spi Write (0xXFF) ; // No test
Deselect max () ;

}
char digit position, digit value;
void main () {

Spi Init(); // Initialize SPI module, standard configuration
// Instead of SPI init, you can use
SPI init Advanced as shown below
//  Spi Init Advanced (MASTER OSC DIV4 |
DATA ORDER MSB | CLK IDLE LOW | IDLE 2 ACTIVE);
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Max7219 init(); // Initialize max7219

while (1) {
// Endless loop
for (digit value=0; digit value<=9; digit value++) {
for (digit position=8; digit position>=1; digit position--) {

Select max();

// Select max7219
Spi Write(digit position);

// Send digit position
Spi Write(digit value);

// Send digit value
Deselect max();

// Deselect max7219

Delay ms (300);

HW Connection

VOCC
DIS7 DIS6é DIS5 DIs4
N\
|_1[ N 24
DIN pout/[}
—;[ DIGO see [125
‘[ DIG4  SEGDP ]i_:\
“ “ @ —5[ GND SEGE ];)\
| s[ bies  SEGC [} L] >
| | ___7[ oz v 113 r1 VCC —I
| “E DIG3 ISET ]T — o)
DIS3 DIS2 DIs1 DIS0 AR ©
GND SEGB ]‘_5\ m
mﬂ DIGS SEGF
11 ]1_4\ (o)
uﬂ DIG1 SEGA ]1—3\ N
LOAD CLk [} '3y
go go 80 go MAX7219 w
I ILLATOR

6.11. SPI HW connection
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SPI ETHERNET LIBRARY

The ENC28J60 is a stand-alone Ethernet controller with an industry standard Serial
Peripheral Interface (SPI™). It is designed to serve as an Ethernet network interface
for any controller equipped with SPI.

The ENC28J60 meets all of the IEEE 802.3 specifications. It incorporates a number
of packet filtering schemes to limit incoming packets. It also provides an internal
DMA module for fast data throughput and hardware assisted IP checksum calcula-
tions. Communication with the host controller is implemented via two interrupt pins
and the SPI, with data rates of up to 10 Mb/s. Two dedicated pins are used for LED
link and network activity indication.

This library is designed to simplify handling of the underlying hardware
(enc28760). It works with any 8051 MCU with integrated SPI and more than 4 Kb
ROM memory.

SPI Ethernet library supports:

- [Pv4 protocol.

- ARP requests.

- ICMP echo requests.

- UDP requests.

- TCP requests (no stack, no packet reconstruction).
- packet fragmentation is NOT supported.

Note: For advanced users there are header files ("eth enc28j60Libbes.h" and
"eth enc28960LibPrivate.h") in Uses folder of the compiler with description of
all routines and global variables, relevant to the user, implemented in the SPI
Ethernet Library.

Note: The appropriate hardware SPI module must be initialized before using any of
the SPI Ethernet library routines. Refer to Spi Library.
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External dependencies of SPI Ethernet Library

The following vari-
ables must be defined .

. . . Description: Example :

in all projects using
SPI Ethernet Library:
extern sfr sbit ENC28J60 chip |sfr sbit Spi Ethernet CS at
Spi Ethernet CS; select pin. P1.B1;
extern sfr sbit ENC28J60 reset |sfr sbit Spi Ethernet RST at
Spi Ethernet RST; pin. P1.BO;

The following routines must be
defined in all project using SPI Description: Example :
Ethernet Library:

unsigned int

Spi Ethernet UserTCP
- - Refer to the

(unsigned char *remoteHost, library example at

TCP request | 1o pott £ thi

unsigned int remotePort, handler. € pottom O is
page for code

unsigned int localPort, implementation.

unsigned int reqglength) ;

unsigned int

Spi Ethernet UserUDP
- - Refer to the

(unsigned char *remoteHost, library example at

UDP request the bott £ thi
unsigned int remotePort, handler. € bottom © LS
page for code

unsigned int destPort, implementation.

unsigned int reqglength) ;

Library Routines

- Spi_Ethernet Init

- Spi_Ethernet Enable

- Spi_Ethernet Disable
- Spi_Ethernet doPacket
- Spi_Ethernet putByte
- Spi_Ethernet putBytes
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- Spi_Ethernet putString

- Spi_Ethernet putConstString
- Spi_Ethernet putConstBytes
- Spi_Ethernet getByte

- Spi_Ethernet getBytes

- Spi_Ethernet UserTCP

- Spi_Ethernet UserUDP

Spi_Ethernet_Init

Prototype void Spi Ethernet Init (unsigned char *mac, unsigned
char *ip, unsigned char fullDuplex);

Returns | Nothing.

Description | This is MAC module routine. It initializes ENC28J60 controller.
This function is internaly splited into 2 parts to help linker when
coming short of memory.

ENC28J60 controller settings (parameters not mentioned here are
set to default):

- receive buffer start address : 0x0000.

- receive buffer end address : 0x19AD.

- transmit buffer start address: 0x19AE.

- transmit buffer end address : 0x1rrF.

- RAM buffer read/write pointers in auto-increment mode.

- receive filters set to default: CRC + MAC Unicast + MAC -
Broadcast in OR mode.

- flow control with TX and RX pause frames in full duplex mode.

- frames are padded to ¢0 bytes + CRC.

- maximum packet size is set to 1518.

- Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12
in half duplex mode.

- Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex
mode; 0x0c12 in half duplex mode.

- Collision window is set to 63 in half duplex mode to accomo
date some =NC28760 revisions silicon bugs.

- CLKOUT output is disabled to reduce EMI generation.

- half duplex loopback disabled.

- LED configuration: default (LEDA-link status, LEDB-link
activity).

Parameters:

- mac: RAM buffer containing valid MAC address.

- ip: RAM buffer containing valid IP address.

- fullbpuplex: ethernet duplex mode switch. Valid values: 0 (half
duplex mode) and 1 (full duplex mode).
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Requires | The appropriate hardware SPI module must be previously initial-

ized.
Example #define Spi Ethernet HALFDUPLEX 0
#define Spi Ethernet FULLDUPLEX 1
unsigned char myMacAddr[ 6] = { 0x00, 0x14, OxA5, 0x76,
0x19, 0x3f} ; // my MAC address
unsigned char myIpAddr = {192, 168, 1, 60} ;

// my IP addr

Spi_Init();
Spi Ethernet Init (&PORTC, 0, &PORTC, 1, myMacAddr,
myIpAddr, Spi Ethernet FULLDUPLEX) ;

Spi_Ethernet_Enable

Prototype void Spi Ethernet Enable (unsigned char enFlt) ;

Returns | Nothing.

Description | This is MAC module routine. This routine enables appropriate

network traffic on the £nc28760 module by the means of it's

receive filters (unicast, multicast, broadcast, crc). Specific type of

network traffic will be enabled if a corresponding bit of this rou-

tine's input parameter is set. Therefore, more than one type of net-

work traffic can be enabled at the same time. For this purpose,
redefined library constants (see the table below) can Ee ORed to
orm appropriate input value.

Parameters:

- enrlt: network traffic/receive filter flags. Each bit corresponds
to the appropriate network traffic/receive filter:
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Description

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive fil-
0 0x01 | ter flag. When set, MAC broadcast | Spi Ethernet BROADCAST
traffic will be enabled.

MAC Multicast traffic/receive filter
1 0x02 flag. When set, MAC multicast Spi Ethernet MULTICAST
traffic will be enabled.

2 0x04 not used none
3 0x08 not used none
4 0x10 not used none
CRC check flag. When set, packets
5 0x20 | with invalid CRC field will be dis- Spi_Ethernet CRC
carded.
6 0x40 not used none

MAC Unicast traffic/receive filter
7 0280 |flag. When set, MAC unicast traffic| Spi Ethernet UNICAST
will be enabled.

Note: Advance filtering available in the rnc28760 module such as
Pattern Match, Magic Packet and Hash Table can not be
enabled by this routine. Additionaly, all filters, except CRC,
enabled with this routine will work in OR mode, which means
that packet will be received if any of the enabled filters accepts it.

Note: This routine will change receive filter configuration on-the-
fly. It will not, in any way, mess with enabling/disabling
receive/transmit logic or any other part of the £nc28760 module.
The £nc28760 module should be properly cofigured by the means
of Spi_Ethernet_Init routine.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example Spi Ethernet Enable (Spi Ethernet CRC |
Spi_Ethernet UNICAST); // enable CRC checking and
Unicast traffic
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Spi_Ethernet_Disable

Prototype void Spi Ethernet Disable (unsigned char disFlt)

Returns | Nothing.

Description | This is MAC module routine. This routine disables appropriate

network traffic on the ENC28J60 module by the means of it's

receive filters (unicast, multicast, broadcast, crc). Specific type of

network traffic will be disabled if a corresponding bit of this rou-

tine's input parameter is set. Therefore, more than one type of net-

work traffic can be disabled at the same time. For this purpose,
redefined library constants (see the table below) can be ORed to
orm appropriate input value.

Parameters:

- disrlc: network traffic/receive filter flags. Each bit corresponds
to the appropriate network traffic/receive filter:

Bit | Mask Description Predefined library const

MAC Broadcast traffic/receive fil-
0 0201 | ter flag. When set, MAC broadcast | Spi Ethernet BROADCAST
traffic will be disabled.

MAC Multicast traffic/receive filter
1 0x02 flag. When set, MAC multicast Spi Ethernet MULTICAST
traffic will be disabled.

2 0x04 not used none
3 0x08 not used none
4 0x10 not used none

CRC check flag. When set, CRC
check will be disabled and packets

5 0x20 . . . Spi Eth t CRC
. with invalid CRC field will be pi_tthernet_
accepted.
6 0x40 not used none

MAC Unicast traffic/receive filter
7 0280 |flag. When set, MAC unicast traffic| Spi Ethernet UNICAST
will be disabled.
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Description | Note: Advance filtering available in the rnc28760 module such as
Pattern Match, Magic Packet and Hash Table can not be
disabled by this routine.

Note: This routine will change receive filter configuration on-the-
fly. It will not, in any way, mess with enabling/disabling
receive/transmit logic or any other part of the rnc28760 module.
The enc28760 mofule should be properly cofigured by the means
of Spi_Ethernet_Init routine.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Examp]e Spi Ethernet Disable(Spi Ethernet CRC |
Spi_ Ethernet UNICAST); // disable CRC checking and
Unicast traffic

Spi_Ethernet_doPacket

Prototype unsigned char Spi Ethernet doPacket ();

Returns | - 0 - upon successful packet processing (zero packets received or
received packet processed successfully).

- 1 - upon reception error or receive buffer corruption.
ENC28760 controller needs to be restarted.

- 2 - received packet was not sent to us (not our IP, nor IP broad
cast address).

- 3 - received IP packet was not IPv4.

- 4 - received packet was of type unknown to the library.

Description | This is MAC module routine. It processes next received packet if
such exists. Packets are processed in the following manner:

- ARP & ICMP requests are replied automatically.

- upon TCP request the Spi_Ethernet UserTCP function is called
for further processing.

- upon UDP request the Spi_Ethernet UserUDP function is called
for further processing.

Note: spi Ethernet doPacket must be called as often as possi-

ble in user's code.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example | while (1) {

Spi_ Ethernet doPacket (); // process received pack-
ets

}
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Spi_Ethernet_putByte

Prototype void Spi Ethernet putByte (unsigned char v);

Returns | Nothing.

Description | This is MAC module routine. It stores one byte to address point-
ed by the current Enc28760 write pointer (EWRPT).

Parameters:

- v: value to store

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example char data;

Spi Ethernet putByte(data); // put an byte into
ENC28J60 buffer

Spi_Ethernet_putBytes

Prototype void Spi Ethernet putBytes (unsigned char *ptr,
unsigned char n);

Returns Nothing.

Description | This is MAC module routine. It stores requested number of bytes
into ENC28J60 RAM starting from current ENC28J60 write
pointer (EWRPT) location.

Parameters:
- ptr: RAM buffer containing bytes to be written into ENC28760

RAM.
- n: number of bytes to be written.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example char *buffer = "mikroElektronika";

Spi Ethernet putBytes (buffer, 16); // put an RAM
array into ENC28J60 buffer
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Spi_Ethernet_putConstBytes

Prototype void Spi Ethernet putConstBytes (const unsigned char
*ptr, unsigned char n);

Returns Nothing.

Description | This is MAC module routine. It stores requested number of const
bﬁes into enc28760 RAM starting from current £NC28760 write
pointer (cwrpT) location.

Parameters:
- ptr: const buffer containing bytes to be written into Enc28760

RAM.
- n: number of bytes to be written.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example const char *buffer = "mikroElektronika";

Spi Ethernet putConstBytes (buffer, 16); // put a
const array into ENC28J60 buffer

Spi_Ethernet_putString

Prototype unsigned int Spi Ethernet putString(unsigned char
*ptr);

Returns | Number of bytes written into =nc28760 RAM.

Description | This is MAC module routine. It stores whole string (excluding
null termination) into =nc28760 RAM starting from current
ENC28J60 write pointer (ewrPT) location.

Parameters:

- ptr: string to be written into Enc28760 RAM.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Exanqﬂe char *buffer = "mikroElektronika";

Spi Ethernet putString(buffer); // put a RAM string
into ENC28J60 buffer
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Spi_Ethernet_putConstString

Prounype unsigned int Spi Ethernet putConstString(const
unsigned char *ptr);

Returns | Number of bytes written into enc28760 RAM.

Description | This is MAC module routine. It stores whole const string (exclud-
ing null termination) into Enc28760 RAM starting from current
ENC28760 write pointer (EwrpT) location.

Parameters:

- ptr: const string to be written into =nc28760 RAM.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example const char *buffer = "mikroElektronika";

Spi Ethernet putConstString(buffer); // put a const
string into ENC28J60 buffer

Spi_Ethernet_getByte

Prototype unsigned char Spi Ethernet getByte();

Returns | Byte read from enc28560 RAM.

Description | This is MAC module routine. It fetches a byte from address
pointed to by current nc28J60 read pointer (ERDPT).

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example char buffer;

buffer = Spi Ethernet getByte(); // read a byte from
ENC28J60 buffer
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Spi_Ethernet_getBytes

Prototype void Spi Ethernet getBytes (unsigned char *ptr,
unsigned int addr, unsigned char n);

Returns | Nothing.

Description | This is MAC module routine. It fetches equested number of bytes
from Enc28s60 RAM starting from given address. If value of
0xFEEF is passed as the address parameter, the reading will start
from current =nc28760 read pointer (ErRDPT) location.

Parameters:
- ptr: buffer for storing bytes read from =nc28s60 RAM.

- addr: ENC28J60 RAM start address. Valid values: 0..8192.
- n: number of bytes to be read.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Examp]e char buffer| 16] ;

Spi Ethernet getBytes (buffer, 0x100, 16); // read 16
bytes, starting from address 0x100
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Spi_Ethernet_UserTCP

Prototype unsigned int Spi Ethernet UserTCP (unsigned char
*remoteHost, unsigned int remotePort, unsigned int
localPort, unsigned int reqglength);

Returns | - 0 - there should not be a reply to the request.
- Length of TCP/HTTP reply data field - otherwise.

Description | This is TCP module routine. It is internally called by the library.
The user accesses to the TCP/HTTP request by using some of the
Spi_Ethernet get routines. The user puts data in the transmit
buffer by using some of the Spi_Ethernet put routines. The func-
tion must return the length in %ytes of the TCP/HTTP reply, or 0
if there is nothing to transmit. If there is no need to reply to the
TCP/HTTP requests, just define this function with return(0) as a
single statement.

Parameters:

- remoteHost: client's IP address.

- remotePort: client's TCP port.

- localport: port to which the request is sent.

- reqLength: TCP/HTTP request data field length.

Note: The function source code is provided with appropriate
example (Frojects. The code should be adjusted by the user to
achieve desired reply.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example | This function is internally called by the library and should not be
called by the user's code.
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Spi_Ethernet_UserUDP

Prototype unsigned int Spi Ethernet UserUDP (unsigned char
*remoteHost, unsigned int remotePort, unsigned int
destPort, unsigned int reglength);

Returns | - 0 - there should not be a reply to the request.
- Length of UDP reply data field - otherwise.

Description | This is UDP module routine. It is internally called by the library.
The user accesses to the UDP request by using some of the
Spi_Ethernet get routines. The user puts data in the transmit
buffer by using some of the Spi_Ethernet put routines. The func-
tion must return the length in gytes of the UDP reply, or 0 if noth-
ing to transmit. If you don't need to reply to the UDP requests,
just define this function with a return(g) as single statement.

Parameters:

- remotetost: client's IP address.

- remoterort: client's port.

- destport: port to which the request is sent.
- reqLength: UDP request data field length.

Note: The function source code is provided with appropriate
example (Frojects. The code should be adjusted by the user to
achieve desired reply.

Requires | Ethernet module has to be initialized. See Spi_Ethernet Init.

Example | This function is internally called by the library and should not be
called by the user's code.

Library Example
This code shows how to use the 8051 mini Ethernet library :

- the board will reply to ARP & ICMP echo requests

- the board will reply to UDP requests on any port :
returns the request in upper char with a header made of remote host IP &
port number

- the board will reply to HTTP requests on port 80, GET method with pathnames
/ will return the HTML main page
/s will return board status as text string
/t0 ... /t7 will toggle P3.b0 to P3.b7 bit and return HTML main page
all other requests return also HTML main page.
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// duplex config flags
#define Spi Ethernet HALFDUPLEX 0x00 // half duplex
#define Spi Ethernet FULLDUPLEX 0x01 // full duplex

// mE ehternet NIC pinout

sfr sbit Spi Ethernet RST at P1.BO;
sfr sbit Spi Ethernet CS at P1.B1;
// end ethernet NIC definitions

/************************************************************

* ROM constant strings

*/

const code unsigned char httpHeader[] = "HTTP/1.1 200 OK\nContent-
type: " ; // HTTP header

const code unsigned char httpMimeTypeHTML[] = "text/html\n\n" ;

// HTML MIME type

const code unsigned char httpMimeTypeScript[] = "text/plain\n\n"
// TEXT MIME type

idata unsigned char httpMethod[] = "GET /";

/*

* web page, splited into 2 parts
* when coming short of ROM, fragmented data is handled more effi-
ciently by linker
*
* this HTML page calls the boards to get its status, and builds
itself with javascript
*/
const code char *indexPage = // Change the
IP address of the page to be refreshed
"<meta http-equiv=\"refresh\"
content=\"3;url=http://192.168.1.60\ ">\
<HTML><HEAD></HEAD><BODY>\
<h1>8051 + ENC28J60 Mini Web Server</hl>\
<a href=/>Reload</a>\
<script src=/s></script>\
<table><tr><td><table border=1 style=\"font-size:20px ;font-family:
terminal ;\ ">\
<tr><th colspan=2>P0</th></tr>\
<script>\
var str,i;\
str=\"\";\
for (1=0;1<8;i++)\
{ str+=\"<tr><td bgcolor=pink>BUTTON #\ "+i+\"</td>\";\
if (PO& (1<<i)){ str+=\"<td bgcolor=red>ON\";}\
else { str+=\"<td bgcolor=#cccccc>0OFF\";}\
str+=\"</td></tr>\";}\
document.write (str) ;\
</script>\

LU
’
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const char *indexPage2 = "</table></td><td>\

<table border=1 style=\"font-size:20px ;font-family: terminal ;\'">\
<tr><th colspan=3>P3</th></tr>\

<script>\

var str,i;\

str=\"\";\

for (i=0;1<8;i++)\

{ str+=\"<tr><td bgcolor=yellow>LED #\"+i+\"</td>\";\

if (P36 (1<<i)){ str+=\"<td bgcolor=red>ON\";}\

else { str+=\"<td bgcolor=#cccccc>OFF\ ";}\
str+=\"</td><td><a href=/t\"+i+\">Toggle</a></td></tr>\";}\
document.write (str) ;\

</script>\

</table></td></tr></table>\

This is HTTP request

f<script>document.write (REQ)</script></BODY></HTML>\

LA
’

/***********************************

* RAM variables

*/
idata unsigned char myMacAddr[ 6] = {0x00, 0x14, 0xAS5, 0x76, 0x19,
0x3f} ; // my MAC address
idata unsigned char myIpAddr| 4] = {192, 168, 1, 60} ;
// my IP address
idata unsigned char getRequest[ 15] ;
// HTTP request buffer
idata unsigned char dynal 29] ;

// buffer for dynamic response
idata unsigned long httpCounter = 0 ;
// counter of HTTP requests

/*******************************************

* functions

*/
/*
* put the constant string pointed to by s to the ENC transmit
buffer.
*/
/*unsigned int putConstString (const code char *s)
{
unsigned int ctr = 0 ;
while (*s)

{
Spi Ethernet putByte (*s++) ;
ctr++ ;

}
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return(ctr) ;
bx/
/*
* it will be much faster to use library
Spi Ethernet putConstString routine
* instead of putConstString routine above. However, the code will
be a little
* bit bigger. User should choose between size and speed and pick
the implementation that
* suites him best. If you choose to go with the putConstString
definition above

* the #define 1line below should be commented out.
*

*/
#define putConstString Spi Ethernet putConstString

/*
* put the string pointed to by s to the ENC transmit buffer
*/

/*unsigned int putString (char *s)
{
unsigned int ctr = 0 ;

while (*s)
{
Spi Ethernet putByte (*s++) ;

ctr++ ;
}
return (ctr) ;

}*/

/*

* it will be much faster to use library Spi Ethernet putString
routine

* instead of putString routine above. However, the code will be a
little

* bit bigger. User should choose between size and speed and pick
the implementation that

* suites him best. If you choose to go with the putString defini-
tion above

* the #define 1line below should be commented out.
*

*/
#define putString Spi Ethernet putString

/*
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this function is called by the library

* the user accesses to the HTTP request by successive calls to
Spi Ethernet getByte()

* the user puts data in the transmit buffer by successive calls
to Spi Ethernet putByte()

* the function must return the length in bytes of the HTTP reply,
or 0 if nothing to transmit

*
* if you don't need to reply to HTTP requests,
* just define this function with a return(0) as single statement
*
*/
unsigned int Spi Ethernet UserTCP (unsigned char *remoteHost,

unsigned int remotePort, unsigned int localPort, unsigned int
reglength)

{

idata unsigned int len; // my reply length

if (localPort != 80) // I listen only to
web request on port 80
{
return (0) ;

}

// get 10 first bytes only of the request, the rest does
not matter here
for(len = 0 ; len < 10 ; len++)
{

getRequest[ len] = Spi Ethernet getByte() ;
}
getRequest[ len] = 0 ;
len = 0;
if (memcmp (getRequest, httpMethod, 5)) // only GET method
is supported here
{
return (0) ;
}
httpCounter++ ; // one more request done
if (getRequest[ 5] == 's') // 1f request path name starts with s,

store dynamic data in transmit buffer

// the text string replied by this request can be
interpreted as javascript statements
// by browsers
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len = putConstString (httpHeader) ;
// HTTP header

len += putConstString (httpMimeTypeScript) ;
// with text MIME type

// add P3 value (buttons) to reply
len += putConstString("var P3=") ;
WordToStr (P3, dyna) ;

len += putString(dyna) ;

len += putConstString(";")

// add PO value (LEDs) to reply
len += putConstString("var PO=") ;
WordToStr (PO, dyna) ;

len += putString(dyna) ;

len += putConstString(";")

// add HTTP requests counter to reply
WordToStr (httpCounter, dyna) ;
len += putConstString("var REQ=") ;
len += putString(dyna) ;
len += putConstString(";")
}
else if (getRequest[ 5] == 't')
// 1f request path name starts with t,
toggle P3 (LED) bit number that comes after
{
unsigned char bitMask = 0 ;
// for bit mask

if (isdigit (getRequest[ 6] ))
// 1f 0 <= bit number <= 9, bits 8 & 9
does not exist but does not matter
{
bitMask = getRequest[ 6] - '0' ;
// convert ASCII to integer
bitMask = 1 << bitMask ;
// create bit mask
P3 *= bitMask ;
// toggle P3 with xor operator
}

if(len == 0) // what do to by default
{
len = putConstString (httpHeader) ;
// HTTP header
len += putConstString (httpMimeTypeHTML) ;
// with HTML MIME typ
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len += putConstString(indexPage) ;
// HTML page first part

len += putConstString(indexPage2) ;
// HTML page second part

return (len) ;
// return to the library with the number of bytes to transmit

}

J*

* this function is called by the library

* the user accesses to the UDP request by successive calls to
Spi Ethernet getByte()

* the user puts data in the transmit buffer by successive calls
to Spi Ethernet putByte()

* the function must return the length in bytes of the UDP reply,
or 0 if nothing to transmit

* if you don't need to reply to UDP requests,
* just define this function with a return(0) as single statement
*
*/
unsigned int Spi Ethernet UserUDP (unsigned char *remoteHost,
unsigned int remotePort, unsigned int destPort, unsigned int
reglength)
{
idata unsigned int len ; // my reply length
idata unsigned char * ptr ; // pointer to the dynamic
buffer

// reply is made of the remote host IP address in human
readable format

ByteToStr (remoteHost[ 0] , dyna) ; // first IP address byte
dynal 3] = "'".' ;
ByteToStr (remoteHost[ 1] , dyna + 4) ; // second
dynal 7] = "'.' ;
ByteToStr (remoteHost[ 2] , dyna + 8) ; // third
dyna[ 11] = '.'
ByteToStr (remoteHost[ 3], dyna + 12) ; // fourth
dyna[ 15] = ':' ; // add separator

// then remote host port number
WordToStr (remotePort, dyna + 16) ;

dynal 21] = '[ "

WordToStr (destPort, dyna + 22) ;
dyna[ 27] = ']"' ;

dynal 28] = 0 ;
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// the total length of the request is the length of the
dynamic string plus the text of the request

len = 28 + reqgqlLength;

// puts the dynamic string into the transmit buffer

Spi Ethernet putBytes(dyna, 28) ;

// then puts the request string converted into upper char
into the transmit buffer
while (regLength--)
{
Spi Ethernet putByte (toupper (Spi Ethernet getByte()))
}

return (len) ; // back to the library with the length
of the UDP reply

/*
* main entry
*/
void main ()
{
J*
* starts ENC28J60 with
* reset bit on P1 0
* CS bit on PI 1
* my MAC & IP address
* full duplex
*/

Spi Init Advanced (MASTER OSC DIV16 | CLK IDLE LOW |
IDLE 2 ACTIVE | DATA ORDER MSB);
Spi Ethernet Init (myMacAddr, myIpAddr, Spi Ethernet FULLDU-

PLEX) ; // full duplex, CRC + MAC Unicast + MAC Broadcast filtering
while (1) // do forever

{

/*

* 1f necessary, test the return value to get error code

*/

Spi Ethernet doPacket () ; // process incoming
Ethernet packets

J*

* add your stuff here 1if needed

* Spi Ethernet doPacket () must be called as often as
possible

* otherwise packets could be lost

*/
}
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HW Connection
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SPI GRAPHIC LCD LIBRARY

The mikroC for 8051 provides a library for operating Graphic LCD 128x64 (with
commonly used Samsung KS108/KS107 controller) via SPI interface.

For creating a custom set of GLCD images use GLCD Bitmap Editor Tool.

Note: The library uses the SPI module for communication. User must initialize SPI
module before using the SPI Graphic LCD Library.

Note: This Library is designed to work with the mikroElektronika's Serial
LCD/GLCD Adapter Board pinout, see schematic at the bottom of this page for
details.

External dependencies of SPI Graphic LCD Library

The implementation of SPI Graphic LCD Library routines is based on Port
Expander Library routines.

External dependencies are the same as Port Expander Library external dependen-
cies.

Library Routines
Basic routines:

- Spi_Gled Init

- Spi_Gled Set Side

- Spi_Gled Set Page

- Spi_Gled Set X

- Spi_Glecd Read Data
- Spi_Gled Write Data

Advanced routines:

- Spi_Gled_Fill

- Spi_Gled Dot

- Spi_Gled Line

- Spi_Gled V Line
- Spi_Gled H Line
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- Spi_Glcd_Rectangle

- Spi_Glcd Box

- Spi_Glcd_Circle

- Spi_Glcd_Set Font

- Spi_Glcd Write Char
- Spi_Glcd Write Text
- Spi_Glcd Image

Spi_Glcd_lInit

Prototype void Spi Glcd Init(char DeviceAddress);

Returns | Nothing.

Description | Initializes the GLCD module via SPI interface.
Parameters :

- Deviceaddress: spi expander hardware address, see schematic
at the bottom of this page

Requires | srexpandercs and spExpanderrsT variables must be defined
before using this function.

The SPI module needs to be initialized. See Spi_Init and
Spi_Init Advanced routines.

Example // port expander pinout definition
sbit SPExpanderRST at P1.BO;
sbit SPExpanderCS at P1.B1l;

Spi_Init Advanced (MASTER OSC _DIV4 | CLK IDLE LOW |
IDLE 2 ACTIVE | DATA ORDER MSB);
Spi Gled Init(0);
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Spi_Glcd_Set_Side

Prototype void SPI Glcd Set Side(char x pos);

Returns | Nothing.

Description | Selects GLCD side. Refer to the GLCD datasheet for detail expla-
nation.

Parameters :

- x_pos: position on x-axis. Valid values: 0..127

The parameter x fpos specifies the GLCD side: values from 0 to
6% specify the left side, values from 64 to 127 specify the right
side.

Note: For side, x axis and page layout explanation see schematic
at the bottom of this page.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example | The following two lines are equivalent, and both of them select
the left side of GLCD:

SPI Glcd Set Side(0);
SPI Glcd Set Side(10);

Spi_Glcd_Set_Page

Prototype void Spi Glcd Set Page (char page);

Returns | Nothing.

Description | Selects page of GLCD.
Parameters :
- page: page number. Valid values: 0..7

Note: For side, x axis and page layout explanation see schematic
at the bottom of this page.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example |Spi_Glcd Set Page(5);
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Spi_Glcd_Set_X

Prototype void SPI Glcd Set X (char x pos);

Returns | Nothing.

Description | Sets x-axis position to x pos dots from the left border of GLCD
within the selected side.

Parameters :
- x_pos: position on x-axis. Valid values: 0..63

Note: For side, x axis and page layout explanation see schematic
at the bottom of this page.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Glcd_Init routines.

Examp]e Spi_GlCd_Set_X (25);

Spi_Glcd_Read_Data

Prototype char Spi Glcd Read Data();

Returns | One byte from GLCD memory.

Description | Reads data from the current location of GLCD memory and
moves to the next location.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

GLCD side, x-axis position and page should be set first. See the
functions Spi_Glcd_Set Side, Spi_Gled_Set X, and
Spi_Glcd_Set Page.

Example char data;

data = Spi Glcd Read Data();
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Spi_Glcd_Write_Data

Prototype |void Spi Glcd Write Data(char Ddata);
Returns | Nothing.
Description | Writes one byte to the current location in GLCD memory and

moves to the next location.
Parameters :
- Ddata: data to be written

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.
GLCD side, x-axis position and page should be set first. See the
functions Spi_Glcd_Set Side, Spi_Gled Set X, and
Spi_Glcd_Set Page.

Example |char data;
Spi Glcd Write Data(data);

Spi_Glcd_Fill
Prototype void Spi Glcd Fill (char pattern);
Returns | Nothing.
Description | Fills GLCD memory with byte pattern.

Parameters :
- pattern: byte to fill GLCD memory with
To clear the GLCD screen, use spi Glcd Fill (0).
To fill the screen completely, use spi Glcd Fill (0xFF).

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example |// Clear screen
Spi Gled Fill(0);
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Spi_Glcd_Dot

Prototype void Spi_Glcd Dot (char x_pos, char y pos, char color)

Returns | Nothing.

Description | Draws a dot on GLCD at coordinates (x_pos, y_pos).
Parameters :

- x_pos: X position. Valid values: 0..127

- v pos:y position. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the dot state: 0 clears dot, 1 puts
a dot, and 2 inverts dot state.

Note: For x and y axis layout explanation see schematic at the
bottom of this page.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example // Invert the dot in the upper left corner
Spi Glecd Dot (0, 0, 2);

Spi_Glcd_Line

Prototype void SPI Glcd Line(int x start, int y start, int
x end, int y end, char color);

Returns | Nothing.

Description | Draws a line on GLCD.
Parameters :

- x_start: X coordinate of the line start. Valid values: 0..127
-y start:y coordinate of the line start. Valid values: 0..63
- x_end: X coordinate of the line end. Valid values: 0..127

- v _end: y coordinate of the line end. Valid values: 0..63

- color: color parameter. Valid values: 0..2

Parameter color determines the line color: 0 white, 1 black, and 2
inverts each dot.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Glcd_Init routines.

Example // Draw a line between dots (0,0) and (20,30)
Spi Glcd Line(0, 0, 20, 30, 1);
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Spi_Glcd_V_Line

Prototype void Spi Glcd V Line(char y start, char y end, char
x pos, char color);

Returns | Nothing.

Description | Draws a vertical line on GLCD.
Parameters :

- v _start:y coordinate of the line start. Valid values: 0..63
- v _end:y coordinate of the line end. Valid values: 0..63

- x_pos: X coordinate of vertical line. Valid values: 0..127

- color: color parameter. Valid values: 0..2

Parameter color determines the line color: 0 white, 1 black, and 2
inverts each dot.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example // Draw a vertical line between dots (10,5) and
(10,25)
Spi Glcd V Line(5, 25, 10, 1);

Spi_Glcd_H_Line

Prototype void Spi Glcd H Line(char x start, char x end, char
y pos, char color);

Returns | Nothing.

Description | Draws a horizontal line on GLCD.
Parameters :

- x_start: x coordinate of the line start. Valid values: 0..127
- x_end: X coordinate of the line end. Valid values: 0..127

- v _pos:y coordinate of horizontal line. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the line color: 0 white, 1 black,
and 2 inverts each dot.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example // Draw a horizontal line between dots (10,20) and
(50,20)
Spi Gled H Line (10, 50, 20, 1);
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Spi_Glcd_Rectangle

Prototype void Spi Glcd Rectangle(char x upper left, char
y upper left, char x bottom right, char
y bottom right, char color);

Returns | Nothing.

Description | Draws a rectangle on GLCD.
Parameters :

- x upper left: X coordinate of the upper left rectangle corner.
Valid values: 0..127

-y upper left:y coordinate of the upper left rectangle corner.
Valid values: 0..63

- x bottom right: X coordinate of the lower right rectangle
corner. Valid values: 0..127

-y bottom right:y coordinate of the lower right rectangle
corner. Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the rectangle border:
0 white, 1 black, and 2 inverts each dot.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Glcd_Init routines.

Example // Draw a rectangle between dots (5,5) and (40,40)
Spi Glcd Rectangle(5, 5, 40, 40, 1);
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Spi_Glcd_Box

Prototype void Spi Glcd Box (char x upper left, char
y upper left, char x bottom right, char
y bottom right, char color);

Returns | Nothing.

Description | Draws a box on GLCD.
Parameters :

- x upper left: X coordinate of the upper left box corner. Valid
values: 0..127

-y upper left:y coordinate of the upper left box corner. Valid
values: 0..63

- x bottom right: X coordinate of the lower right box corner.
Valid values: 0..127

-y bottom right:y coordinate of the lower right box corner.
Valid values: 0..63

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the box fill: 0 white,
1 black, and 2 inverts each dot.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Exanqﬂe // Draw a box between dots (5,15) and (20,40)
Spi Gled Box (5, 15, 20, 40, 1);

Spi_Glcd_Circle

Prototype void Spi Glcd Circle(int x center, int y center, int
radius, char color);

Returns | Nothing.

Description | Draws a circle on GLCD.
Parameters :

- x _center: X coordinate of the circle center. Valid values: 0..127
- v _center:y coordinate of the circle center. Valid values: 0..63
- radius: radius size

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the circle line: 0
white, 1 black, and 2 inverts each dot.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example // Draw a circle with center in (50,50) and radius=10
Spi Glcd Circle(50, 50, 10, 1);
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Spi_Glcd_Set Font

Prototype |void SPI_Glcd_Set_Font (const char *activeFont, char
aFontWidth, char aFontHeight, unsigned int aFontOffs);

Returns | Nothing.

Description | Sets font that will be used with Spi_Glcd Write Char and
Spi_Gled_Write Text routines.

Parameters :

- activeront: font to be set. Needs to be formatted as an array
of char

- arontwidth: width of the font characters in dots.

- arontHeight: height of the font characters in dots.

- aFontOf fs: number that represents difference between the
mikroC character set and regular ASCII set (eg. if 'A" is 65 in
ASCII character, and 'A' is 45 in the mikroC character set,
aFontOffs is 20). Demo fonts supplied with the library have an
offset of 32, which means that they start with space.

The user can use fonts given in the file “_ Lib_GLCD_fonts.c”
file located in the Uses folder or create his own fonts.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example // Use the custom 5x7 font "myfont" which starts with
space (32):
Spi Glcd Set Font (myfont, 5, 7, 32);
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Spi_Glcd_Write_Char

Prototype void SPI Glcd Write Char (char chrl, char x pos, char
page num, char color);

Returns | Nothing.

Description | Prints character on GLCD.
Parameters :

- chri1: character to be written

- x pos: character starting position on x-axis. Valid values:
0..(127-FontWidth)

- page num: the number of the page on which character will be
written. Valid values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the character: 0
white, 1 black, and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the
bottom of this page.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Use the Spi_Glcd Set Font to specify the font for display; if no
font is specified, then the default 5x8 font supplied with the
library will be used.

Example // Write character 'C' on the position 10 inside the
page 2:
Spi Glecd Write Char('C', 10, 2, 1);
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Spi_Glcd_Write_Text

Prounype void SPI Glcd Write Text (char text[] , char x pos, char
page num, char color);

Returns | Nothing.

Description | Prints text on GLCD.
Parameters :

- text: text to be written

- x_pos: text starting position on Xx-axis.

- page num: the number of the page on which text will be written.
Valid values: 0..7

- color: color parameter. Valid values: 0..2

The parameter color determines the color of the text: 0 white, 1
black, and 2 inverts each dot.

Note: For x axis and page layout explanation see schematic at the
bottom of this page.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Use the Spi_Glcd Set Font to specify the font for display; if no
font is specified, then the default 5x8 font supplied with the
library will be used.

Example |// Write text "Hello world!" on the position 10
inside the page 2:
Spi Glcd Write Text ("Hello world!", 10, 2, 1);
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Spi_Glcd_Image

Prototype void Spi Glcd Image (const code char *image);

Returns | Nothing.

Description | Displays bitmap on GLCD.
Parameters :

- image: image to be displayed. Bitmap array can be located in
both code and RAM memory (due to the mikroC for 8051
pointer to const and pointer to RAM equivalency).

Use the mikroC’s integrated GLCD Bitmap Editor (menu option
Tools » GLCD Bitmap Editor) to convert image to a constant
array suitable for displaying on GLCD.

Requires | GLCD needs to be initialized for SPI communication, see
Spi_Gled_Init routines.

Example // Draw image my image on GLCD
Spi Glcd Image (my image);

Library Example

The example demonstrates how to communicate to KS0108 GLCD via the SPI
module, using serial to parallel convertor MCP23S17.

const code char advanced8051 bmp[ ] ;

// Port Expander module connections
sbit SPExpanderRST at P1.BO;

sbit SPExpanderCs at P1.B1l;

// End Port Expander module connections

void Delay?2S (){ // 2 seconds delay function
Delay ms (2000) ;
}

void main () {
unsigned short ii;
unsigned int jj;
char *someText;

// Initialize SPI module
Spi Init Advanced (MASTER OSC DIV4 | CLK IDLE LOW | IDLE 2 ACTIVE
| DATA ORDER MSB) ;
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Spi Glcd Init(0); // Initialize GLCD
via SPI
Spi Glcd Fill (0x00); // Clear GLCD
while (1) {
Spi Glcd Image (advanced8051 bmp) ; // Draw image
Delay2S(); Delay2Ss();

Spi Gled Fill (0x0);

Spi Glcd Box(62,40,124,56,1); // Draw box

Spi Glcd Rectangle(5,5,84,35,1); // Draw rectangle
Spi Glcd Line(0, 63, 127, 0,1); // Draw line
Delay2S () ;

for(ii = 5; 11 < 60; 1ii+=5 ) { // Draw horizontal

and vertical line
delay ms (250);
Spi Glcd V Line(2, 54, 1ii, 1);
Spi Glcd H Line(2, 120, ii, 1);
}

Delay2S () ;

Spi Glcd Fill (0x00);

Spi Glcd Set Font(Character8x8, 8, 8, 32); // Choose font, see
~ Lib GLCDFonts.c in Uses folder

Spi Glcd Write Text ("mikroE", 5, 7, 2); // Write string

for (ii = 1; ii <= 10; ii++) // Draw circles

Spi Glcd Circle (63,32, 3*ii, 1);

Delay2S () ;

Spi Glcd Box (12,20, 70,57, 2); // Draw box

Delay2S () ;

Spi Glcd Set Font (FontSystem5x8, 5, 8, 32); // Change font

someText = "BIG:LETTERS";

Spi Glcd Write Text (someText, 5, 3, 2); // Write string
Delay2S () ;

someText = "SMALL:NOT:SMALLER";

Spi Glcd Write Text (someText, 20,5, 1); // Write string
Delay2S () ;

}
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HW Connection
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SPI LCD LIBRARY

The mikroC for 8051 provides a library for communication with LCD (with
HD44780 compliant controllers) in 4-bit mode via SPI interface.

For creating a custom set of LCD characters use LCD Custom Character Tool.

Note: The library uses the SPI module for communication. The user must initialize
the SPI module before using the SPI LCD Library.

Note: This Library is designed to work with the mikroElektronika's Serial LCD
Adapter Board pinout. See schematic at the bottom of this page for details.

External dependencies of SPI LCD Library

The implementation of SPI LCD Library routines is based on Port Expander Library
routines.

External dependencies are the same as Port Expander Library external dependen-
cies.

Library Routines

- Spi_Lcd Config
- Spi_Led Out

- Spi_Led Out Cp
- Spi_Led Chr

- Spi_Led Chr Cp
- Spi_Led Cmd
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Spi_Lcd_Config

Prototype void Spi Lcd Config(char DeviceAddress);

Returns | Nothing.

Description | Initializes the LCD module via SPI interface.
Parameters :

- Devicenddress: spi expander hardware address, see schematic
at the bottom of this page

Requires | spixpandercs and spExpanderrsT variables must be defined
before using this function.

The SPI module needs to be initialized. See Spi_Init and
Spi_Init_Advanced routines.

Example |// port expander pinout definition
sbit SPExpanderRST at P1.BO;
sbit SPExpanderCS at P1.Bl;

Spi Init(); // initialize spi
Spi Lcd Config(0);
// initialize lcd over spi interface

Spi_Lcd_Out

Prototype void Spi Lcd Out (char row, char column, char *text);

Returns | Nothing.

Description | Prints text on the LCD starting from specified position. Both
string variables and literals can be passed as a text.

Parameters :
- row: starting position row number

- column: starting position column number
- text: text to be written

Requires | LCD needs to be initialized for SPI communication, see
Spi_Lcd Config routines.

Example |// Write text "Hello!" on LCD starting from row 1,
column 3:
Spi Lcd Out(l, 3, "Hello!");
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Spi_Lcd_Out_Cp

Prototype void Spi Lcd Out CP(char *text);

Returns | Nothing.

Description | Prints text on the LCD at current cursor position. Both string vari-
ables and literals can be passed as a text.

Parameters :

- text: text to be written

Requires |LCD needs to be initialized for SPI communication, see
Spi_Lcd_Config routines.

Example // Write text "Here!" at current cursor position:
Spi Lcd Out CP("Herel!');

Spi_Lcd_Chr
Prototype void Spi Lcd Chr (char Row, char Column, char
Out Char);

Returns | Nothing.

Description | Prints character on LCD at specified position. Both variables and
literals can be passed as character.

Parameters :
- Row: writing position row number

- Column: writing position column number
- out Char: character to be written

Requires | LCD needs to be initialized for SPI communication, see
Spi_Lcd_Config routines.

Example // Write character "i" at row 2, column 3:
Spi Led Chr(2, 3, 'i');
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Spi_Lcd _Chr_Cp

Prototype void Spi_LCd_ChI_CP (char Out_Char) ;

Returns | Nothing.

Description | Prints character on LCD at current cursor position. Both variables
and literals can be passed as character.

Parameters :

- out char: character to be written

Requires |LCD needs to be initialized for SPI communication, see
Spi_Lcd_Config routines.

Example // Write character "i" at row 2, column 3:
Spi_Led Chr(2, 3, 'i');

Spi_Lcd Cmd

Prototype void Spi Lcd Cmd(char out char);

Returns | Nothing.

Description | Sends command to LCD.
Parameters :
- out char: command to be sent

Note: Predefined constants can be passed to the function, see
Available LCD Commands.

Requires | LCD needs to be initialized for SPI communication, see
Spi_Lcd_Config routines.

Example |// Clear LCD display:
Spi Lcd Cmd (LCD_CLEAR) ;
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Available LCD Commands

LCD Command

Purpose

LCD_FIRST ROW

Move cursor to the 1st row

LCD _SECOND_ROW

Move cursor to the 2nd row

LCD_THIRD ROW

Move cursor to the 3rd row

LCD_FOURTH_ROW

Move cursor to the 4th row

LCD_CLEAR

Clear display

LCD_RETURN HOME

Return cursor to home position, returns a shifted dis-
play to its original position. Display data RAM is unaf-
fected.

LCD_CURSOR_OFF

Turn off cursor

LCD_UNDERLINE ON

Underline cursor on

LCD BLINK CURSOR ON

Blink cursor on

LCD_MOVE CURSOR_LEFT

Move cursor left without changing display data RAM

LCD _MOVE CURSOR RIGH
T

Move cursor right without changing display data RAM

LCD_TURN_ON

Turn LCD display on

LCD_TURN OFF

Turn LCD display off

LCD SHIFT LEFT

Shift display left without changing display data RAM

LCD_SHIFT RIGHT

Shift display right without changing display data RAM
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Library Example

This example demonstrates how to communicate LCD via the SPI module, using
serial to parallel convertor MCP23S17.

char *text = "mikroElektronika";

// Port Expander module connections
sbit SPExpanderRST at P1.BO;

sbit SPExpanderCs at P1.B1;

// End Port Expander module connections

void main () {

Spi Init(); // Initialize SPI

Spi Lcd Config(0); // Initialize LCD over SPI interface

Spi Lcd Cmd (LCD CLEAR) ; // Clear display

Spi Lecd Cmd (LCD _CURSOR OFF); // Turn cursor off

Spi Lecd Out (1,6, "mikroE"); // Print text to LCD, 1st row, 6th
column

Spi Led Chr CP('!'); // Append '!'

Spi Led Out (2,1, text); // Print text to LCD, 2nd row, 1st
column

Spi Led Out (3,1, "mikroE") ; // For LCD with more than two rows

Spi Lcd Out (4,15,"mikroE"); // For LCD with more than two rows
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HW Connection
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SPI LCD8 (8-BIT INTERFACE) LIBRARY

The mikroC for 8051 provides a library for communication with LCD (with
HD44780 compliant controllers) in 8-bit mode via SPI interface.

For creating a custom set of LCD characters use LCD Custom Character Tool.

Note: Library uses the SPI module for communication. The user must initialize the
SPI module before using the SPI LCD Library.

Note: This Library is designed to work with mikroElektronika's Serial LCD/GLCD
Adapter Board pinout, see schematic at the bottom of this page for details.

External dependencies of SPI LCD Library
The implementation of SPI LCD Library routines is based on Port Expander Library
routines.

External dependencies are the same as Port Expander Library external dependen-
cies.

Library Routines

- Spi_Lcd8_ Config
- Spi_Lcd8 Out

- Spi_Lcd8 Out Cp
- Spi_Lcd8 Chr

- Spi_Lcd8 Chr Cp
- Spi_Led8 Cmd
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Spi_Lcd8_Config

Prototype void Spi Lcd8 Config(char DeviceAddress);

Returns | Nothing.

Description | Initializes the LCD module via SPI interface.
Parameters :

- DeviceAddress: spi expander hardware address, see schematic
at the bottom of this page

Requires | srexpandercs and spExpanderrsT variables must be defined
before using this function.

The SPI module needs to be initialized. See Spi_Init and
Spi_Init Advanced routines.

Example |// port expander pinout definition
sbit SPExpanderRST at P1.BO;
sbit SPExpanderCS at P1.Bl;

Spi Init(); // initialize spi interface
Spi Lcd8 Config(0);
// intialize lcd in 8bit mode via spi

Spi_Lcd8_ Out

Prounype void Spi Lcd8 Out (unsigned short row, unsigned short
column, char *text);

Returns | Nothing.

Description | Prints text on LCD starting from specified position. Both string
variables and literals can be passed as a text.

Parameters :
- row: starting position row number

- column: starting position column number
- text: text to be written

Requires | LCD needs to be initialized for SPI communication, see
Spi_Lcd8 Config routines.

Example // Write text "Hello!" on LCD starting from row 1,
column 3:
Spi Lcd8 Out(l, 3, "Hello!");
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Spi_Lcd8 Out_Cp

Prototype void Spi Lcd8 Out CP(char *text);

Returns | Nothing.

Description | Prints text on LCD at current cursor position. Both string vari-
ables and literals can be passed as a text.

Parameters :

- text: text to be written

Requires | LCD needs to be initialized for SPI communication, see
Spi_Lcd8 Config routines.

Example // Write text "Here!" at current cursor position:
Spi Lcd8 Out Cp("Here!");

Spi_Lcd8 _Chr

Prototype void Spi Lcd8 Chr (unsigned short row, unsigned short
column, char out char);

Returns | Nothing.

Description | Prints character on LCD at specified position. Both variables and
literals can be passed as character.

Parameters :
- row: writing position row number

- column: writing position column number
- out char: character to be written

Requires |LCD needs to be initialized for SPI communication, see
Spi_Lcd8 Config routines.

Example |// Write character "i" at row 2, column 3:
Spi Lcd8 Chr(2, 3, 'i');
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Spi_Lcd8 Chr_Cp

Prototype void Spi Lcd8 Chr CP(char out char);

Returns | Nothing.

Description | Prints character on LCD at current cursor position. Both variables
and literals can be passed as character.

Parameters :

- out char: character to be written

Requires | LCD needs to be initialized for SPI communication, see
Spi_Lcd8 Config routines.

Example | Print “e” at current cursor position:

nman

// Write character "e" at current cursor position:
Spi Lcd8 Chr Cp('e');

Spi_Lcd8 Cmd

Prototype void Spi Lcd8 Cmd(char out char);

Returns | Nothing.

Description | Sends command to LCD.
Parameters :
- out char: command to be sent

Note: Predefined constants can be passed to the function, see
Available LCD Commands.

Requires | LCD needs to be initialized for SPI communication, see
Spi_Lcd8 Config routines.

Example | // Clear LCD display:
Spi Lcd8 Cmd (LCD CLEAR) ;
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Available LCD Commands

LCD Command Purpose

LCD_FIRST_ROW Move cursor to the 1st row

LCD_SECOND_ROW Move cursor to the 2nd row

LCD_THIRD_ROW Move cursor to the 3rd row

LCD_FOURTH_ROW Move cursor to the 4th row

LCD_CLEAR Clear display

LCD_RETURN_HOME Return cursor to home position, returns a shifted dis-
play to its original position. Display data RAM is unaf-
fected.

LCD7CURSOR70 FEF Tum Off cursor

LCD_UNDERLINE ON Underline cursor on

LCD BLINK CURSOR ON Blink cursor on

LCD_MOVE_CURSOR_LEET | Move cursor left without changing display data RAM

LCD_MOVE_CURSOR_RIGHT | Move cursor right without changing display data RAM

LCD_TURN_ON Turn LCD display on

LCD_TURN_OFF Turn LCD display off

LCD_SHIFT LEFT Shift display left without changing display data RAM
LCD_SHIFT_ RIGHT Shift display right without changing display data RAM
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Library Example

This example demonstrates how to communicate LCD in 8-bit mode via the SPI
module, using serial to parallel convertor MCP23S17.

char *text = "mikroE";

// Port Expander module connections
sbit SPExpanderRST at P1.BO;

sbit SPExpanderCs at P1.B1l;

// End Port Expander module connections

void main () {

Spi Init(); // Initialize SPI interface

Spi Lcd8 Config(0); // Intialize LCD in 8bit mode via SPI
Spi Lcd8 Cmd (LCD CLEAR) ; // Clear display
Spi Lcd8 Cmd(LCD _CURSOR _OFF) ; // Turn cursor off

Spi Lcd8 Out(l,6, text);
// Print text to LCD, 1st row, 6th column...
Spi Lcd8 Chr CP('!'"); // Append '!'
Spi Lcd8 Out (2,1, "mikroelektronika");
// Print text to LCD, 2nd row, 1lst column...
Spi Lcd8 Out (3,1, text);
// For LCD modules with more than two rows
Spi Lcd8 Out (4,15, text);
// For LCD modules with more than two rows

}
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HW Connection
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SPI T6963C GRAPHIC LCD LIBRARY

The mikroC for 8051 provides a library for working with GLCDs based on TOSHI-
BA T6963C controller via SPI interface. The Toshiba T6963C is a very popular
LCD controller for the use in small graphics modules. It is capable of controlling
displays with a resolution up to 240x128. Because of its low power and small out-
line it is most suitable for mobile applications such as PDAs, MP3 players or mobile
measurement equipment. Although this controller is small, it has a capability of dis-
playing and merging text and graphics and it manages all interfacing signals to the
displays Row and Column drivers.

For creating a custom set of GLCD images use GLCD Bitmap Editor Tool.

Note: The library uses the SPI module for communication. The user must initialize
SPI module before using the Spi T6963C GLCD Library.

Note: This Library is designed to work with mikroElektronika's Serial GLCD
240x128 and 240x64 Adapter Boards pinout, see schematic at the bottom of this
page for details.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board T6369C datasheet
RS C/D
R/W /RD
E /WR

External dependencies of Spi T6963C Graphic LCD Library

The implementation of Spi T6963C Graphic LCD Library routines is based on Port
Expander Library routines.

External dependencies are the same as Port Expander Library external
dependencies.
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Library Routines

- Spi_T6963C_Config

- Spi_T6963C_WriteData
- Spi_ T6963C_WriteCommand
- Spi_T6963C_SetPtr

- Spi_T6963C_WaitReady
- Spi_T6963C Fill

- Spi_T6963C Dot

- Spi_T6963C_Write Char
- Spi_T6963C_Write Text
- Spi_T6963C_Line

- Spi_T6963C_Rectangle

- Spi_T6963C_ Box

- Spi_T6963C_Circle

- Spi_T6963C_Image

- Spi_T6963C_Sprite

- Spi_T6963C_Set Cursor

Note: The following low level library routines are implemented as macros. These
macros can be found in the spi T6963C.h header file which is located in the SPI
T6963C example projects folders.

- Spi_T6963C ClearBit

- Spi_T6963C_SetBit

- Spi_T6963C NegBit

- Spi_T6963C_DisplayGrPanel
- Spi_T6963C_DisplayTxtPanel
- Spi_ T6963C_SetGrPanel

- Spi_T6963C_SetTxtPanel

- Spi_T6963C_PanelFill

- Spi_T6963C_GrFill

- Spi_T6963C_TxtFill

- Spi_ T6963C Cursor Height
- Spi_T6963C_Graphics

- Spi_T6963C_Text

- Spi_T6963C _Cursor

- Spi_T6963C_Cursor_Blink
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Spi_T6963C_Config

Prototype void Spi T6963C Config(unsigned int width, unsigned
char height, unsigned char fntW, char DeviceAddress,
unsigned char wr, unsigned char rd, unsigned char cd,
unsigned char rst);

Returns | Nothing.

Description | Initalizes the Graphic Lcd controller.
Parameters :

- width: width of the GLCD panel

- height: height of the GLCD panel

- £ntw: font width

- Deviceaddress: SPI expander hardware address, see schematic
at the bottom of this page

- wr: write signal pin on GLCD control port

- rd: read signal pin on GLCD control port

- cd: command/data signal pin on GLCD control port

- rst: reset signal pin on GLCD control port

Display RAM organization:
The library cuts RAM into panels : a complete panel is one graph-
ics panel followed by a text panel (see schematic below).

schematic:

GRAPHICS PANEL #0
PANEL O

TEXT PANEL #0

GRAPHICS PANEL #1
PANEL 1

TEXT PANEL #2

Requires | spexpandercs and spExpanderrsT variables must be defined
before using this function.

The SPI module needs to be initialized. See the Spi_Init and
Spi_Init_Advanced routines.

Example // port expander pinout definition
sbit SPExpanderRST at P1.BO;,
sbit SPExpanderCS at Pl1.Bl;

Spi_Init Advanced (MASTER OSC_DIV4 | CLK IDLE LOW |
IDLE 2 ACTIVE | DATA ORDER MSB) ;
Spi_T6963C Config (240, 64, 8, 0, 0, 1, 3, 4) ;
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Spi_T6963C_WriteData

Prototype

void Spi T6963C WriteData (unsigned char Ddata);

Returns

Nothing.

Description

Writes data to T6963C controller via SPI interface.
Parameters :

- Ddata: data to be written

Requires

Toshiba GLCD module needs to be initialized. See
Spi_T6963C _Config routine.

Example

Spi T6963C WriteData (AddrL);

Spi_T6963C_WriteCommand

Prototype

void Spi T6963C WriteCommand(unsigned char Ddata);

Returns

Nothing.

Description

Writes command to T6963C controller via SPI interface.
Parameters :

- Ddata: command to be written

Requires

Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example

Spi T6963C WriteCommand (Spi T6963C CURSOR POINTER SET)
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Spi_T6963C_SetPtr

Prototype void Spi T6963C SetPtr (unsigned int p, unsigned char
c)i

Returns | Nothing.

Description | Sets the memory pointer p for command c.

Parameters :
- p: address where command should be written
- c: command to be written

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example Spi T6963C WriteCommand (Spi T6963C CURSOR POINTER SET)

Spi_T6963C_WaitReady

Prototype void SpiiT6963C7WaitReady (void) ;
Returns | Nothing.
Description Poczlls the status byte, and loops until Toshiba GLCD module is
ready.
Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.
Example Spi T6963C WaitReady ()
Spi_T6963C_Fill
Prototype |void Spi_T6963C_Fill (unsigned char v, unsigned int
start, unsigned int len);
Returns | Nothing.
Description | Fills controller memory block with given byte.
Parameters :
- v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.
Example |Spi_T6963C_Fill (0x33,0x00FF,0x000F) ;
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Spi_T6963C_Dot

Prototype void Spi T6963C Dot (int x, int y, unsigned char
color) ;

Returns | Nothing.

Description | Draws a dot in the current graphic panel of GLCD at coordinates
x, y)-

Parameters :

- x: dot position on x-axis

- y: dot position on y-axis

- color: color parameter. Valid values: Spi_ T6963C BLACK and
Spi_T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C Config routine.

Example Spi T6963C Dot (x0, y0, pcolor);
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Spi_T6963C_Write_Char

Prototype void Spi T6963C Write Char (unsigned char c, unsigned
char x, unsigned char y, unsigned char mode) ;

Returns | Nothing.

Description V&)/rites a char in the current text panel of GLCD at coordinates (x,
y).

Parameters :

- c: char to be written

- x: char position on x-axis

- y: char position on y-axis

- mode: mode parameter. Valid values:
Spi_ T6963C_ ROM_MODE OR,
Spi T6963C ROM_MODE XOR,
Spi_T6963C_ ROM_MODE AND and \
Spi_ T6963C_ROM_MODE TEXT

Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed
and the data is logically “OR-ed”. This is the most common way
of combining text and graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are com
bined via the logical “exclusive OR”. This can be useful to dis
play text in ne%lative mode, i.e. white text on black background.

- AND-Mode: The text and graphic data shown on display are
combined via the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just
a text. The Text Attribute values are stored in the graphic area of
display memory.

For more details see the T6963C datasheet.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example Spi T6963C Write Char ("A",22,23,AND);
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Spi_T6963C_Write_Text

Prototype void Spi T6963C Write Text (unsigned char *str,
unsigned char x, unsigned char y, unsigned char
mode) ;

Returns | Nothing.

Description V\)/rites text in the current text panel of GLCD at coordinates (X,
y).

Parameters :

- str: text to be written

- x: text position on x-axis

- yv: text position on y-axis

- mode: mode parameter. Valid values:
Spi_ T6963C_ ROM_MODE OR,
Spi T6963C ROM_MODE XOR,
Spi_T6963C_ROM_MODE_AND and
Spi_T6963C_ROM_MODE TEXT

Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed
and the data is logically “OR-ed”. This is the most common way
of combining text and graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are com
bined via the logical “exclusive OR”. This can be useful to dis
play text in negative mode, i.e. white text on black background.

- AND-Mode: The text and graphic data shown on the display are
combined via the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just
a text. The Text Attribute values are stored in the graphic area of
display memory.

For more details see the T6963C datasheet.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example |Spi_T6963C Write Text ("GLCD LIBRARY DEMO, WELCOME !",
0, 0, T6963C ROM MODE EXOR) ;
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Spi_T6963C_Line

Prototype void Spi T6963C Line(int x0, int y0, int x1, int yl1,
unsigned char pcolor);

Returns | Nothing.

Description | Draws a line from (x0, y0) to (x1, y1).
Parameters :

- x0: x coordinate of the line start

- y0: y coordinate of the line end

- x1: x coordinate of the line start

- y1:y coordinate of the line end

- pcolor: color parameter. Valid values: Spi_ T6963C_ BLACK
and Spi_T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C _Config routine.

Example Spi T6963C Line(0, 0, 239, 127, T6963C WHITE);

Spi_T6963C_Rectangle

Prototype void Spi T6963C Rectangle(int x0, int yO0, int x1, int
yl, unsigned char pcolor);

Returns | Nothing.

Description | Draws a rectangle on GLCD.
Parameters :

- x0: X coordinate of the upper left rectangle corner

- y0: y coordinate of the upper left rectangle corner

- x1: x coordinate of the lower right rectangle corner

- y1:y coordinate of the lower right rectangle corner

- pcolor: color parameter. Valid values: Spi_ T6963C BLACK
and Spi_T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example |Spi T6963C Rectangle (20, 20, 219, 107, T6963C_WHITE);
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Spi_T6963C_Box

Prototype void Spi T6963C Box(int x0, int y0, int x1, int yI1,
unsigned char pcolor);

Returns | Nothing.

Description | Draws a box on the GLCD
Parameters :

- x0: x coordinate of the upper left box corner

- y0: y coordinate of the upper left box corner

- x1: x coordinate of the lower right box corner

- y1:y coordinate of the lower right box corner

- pcolor: color parameter. Valid values: Spi_ T6963C BLACK
and Spi_T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example Spi T6963C Box (0, 119, 239, 127, T6963C WHITE)

Spi_T6963C_Circle

Prototype void Spi T6963C Circle(int x, int y, long r, unsigned
char pcolor);

Returns | Nothing.

Description | Draws a circle on the GLCD.
Parameters :

- x: X coordinate of the circle center

- y: y coordinate of the circle center

- r: radius size

- pcolor: color parameter. Valid values: Spi_ T6963C BLACK
and Spi_T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Examp]e Spi T6963C Box (0, 119, 239, 127, T6963C WHITE);
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Spi_T6963C_Image

Prototype void Spi T6963C Image (const code char *pic);

Returns | Nothing.

Description | Displays bitmap on GLCD.
Parameters :

- pic: image to be displayed. Bitmap array can be located in both
code and RAM memory (due to the mikroC for 8051 pointer to
const and pointer to RAM equivalency).

Use the mikroC'’s integrated GLCD Bitmap Editor (menu option
Tools » GLCD Bitmap Editor) to convert image to a constant
array suitable for displaying on GLCD.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example Spi T6963C Image (my image);

Spi_T6963C_Sprite

Prototype |void Spi_T6963C_Sprite (unsigned char px, unsigned char
py, const char *pic, unsigned char sx, unsigned
char sy);

Returns | Nothing.

Description | Fills graphic rectangle area (px, py) to (px+sx, py+sy) with cus-
tom size picture.

Parameters :

- px: x coordinate of the upper left picture corner. Valid values:
multiples of the font width

- py: y coordinate of the upper left picture corner

- pic: picture to be displayed

- sx: picture width. Valid values: multiples of the font width

- sy: picture height

Note: If px and sx parameters are not multiples of the font width
they will be scaled to the nearest lower number that is a multiple
of the font width.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example Spi T6963C Sprite(76, 4, einstein, 88, 119);
// draw a sprite
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Spi_T6963C_Set_Cursor

Prototype void Spi T6963C Set Cursor (unsigned char x, unsigned
char vy);

Returns | Nothing.

Description | Sets cursor to row x and column .
Parameters :

- x: cursor position row number
- y: cursor position column number

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example Spi T6963C Set Cursor (cposx, Cposy);

Spi_T6963C_ClearBit

Prototype void Spi T6963C ClearBit (char Db);

Returns | Nothing.

Description | Clears control port bit(s).
Parameters :

- b: bit mask. The function will clear bit = on control port if bit x
in bit mask is set to 1.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example // clear bits 0 and 1 on control port
Spi T6963C ClearBit (0x03);
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Spi_T6963C_SetBit

Prototype void Spi T6963C SetBit (char b);

Returns | Nothing.

Description | Sets control port bit(s).
Parameters :

- b: bit mask. The function will set bit = on control port if bit = in
bit mask is set to 1.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example // set bits 0 and 1 on control port
Spi T6963C SetBit (0x03);

Spi_T6963C_NegBit

Prototype void SpiiT6963C7Nquit (char b);

Returns | Nothing.

Description | Negates control port bit(s).
Parameters :

- b: bit mask. The function will negate bit = on control port if bit x
in bit mask is set to 1.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Examp]e // negate bits 0 and 1 on control port
Spi T6963C NegBit (0x03);

396 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroC for 8051 Libraries

Spi_T6963C_DisplayGrPanel

Prototype void Spi T6963C DisplayGrPanel (char n);

Returns | Nothing.

Description | Display selected graphic panel.
Parameters :

- n: graphic panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example // display graphic panel 1
Spi T6963C DisplayGrPanel (1) ;

Spi_T6963C_DisplayTxtPanel

Prototype void Spi T6963C DisplayTxtPanel (char n);

Returns | Nothing.

Description | Display selected text panel.
Parameters :

- n: text panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example // display text panel 1
Spi T6963C DisplayTxtPanel(l);
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Spi_T6963C_SetGrPanel

Prototype void Spi T6963C_SetGrPanel (char n);

Returns | Nothing.

Description | Compute start address for selected graphic panel and set qﬂpropri-
ate internal pointers. All subse(i.{uent graphic operations will be

preformed at this graphic panel.

Parameters :

- n: graphic panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example // set graphic panel 1 as current graphic panel.
Spi T6963C_SetGrPanel (1);

Spi_T6963C_SetTxtPanel

Prototype void Spi T6963C SetTxtPanel (char n);

Returns | Nothing.

Description | Compute start address for selected text panel and set appropriate
internal pointers. All subsequent text operations will be preformed
at this text panel.

Parameters :

- n: text panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example |// set text panel 1 as current text panel.
Spi T6963C_SetTxtPanel (1);

398 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6
mikroC for 8051 Libraries

Spi_T6963C_PanelFill

Prototype void Spi T6963C PanelFill (unsigned char v);

Returns | Nothing.

Description | Fill current panel in full (graphic+text) with appropriate value (0
to clear).

Parameters :

- v: value to fill panel with.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example clear current panel
Spi T6963C PanelFill(0);

Spi_T6963C_GrFill

Prototype void Spi T6963C GrFill (unsigned char v);

Returns | Nothing.

Description | Fill current graphic panel with appropriate value (0 to clear).
Parameters :

- v: value to fill graphic panel with.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example // clear current graphic panel
Spi T6963C GrFill (0);
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Spi_T6963C_TxtFill

Prototype void Spi T6963C TxtFill (unsigned char v);

Returns | Nothing.

Description | Fill current text panel with appropriate value (0 to clear).
Parameters :

- v: this value increased by 32 will be used to fill text panel.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example | // clear current text panel
Spi_T6963C_TxtFill (0);

Spi_T6963C_Cursor_Height

Prototype void Spi T6963C Cursor Height (unsigned char n);

Returns | Nothing.

Description | Set cursor size.
Parameters :

- n: cursor height. Valid values: 0. . 7.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example Spi T6963C Cursor Height (7);
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Spi_T6963C_Graphics

Prototype void Spi T6963C Graphics (char n);

Returns | Nothing.

Description | Enable/disable graphic displaying.
Parameters :

- n: graphic enable/disable parameter. Valid values: 0 (disable
graphic dispaying) and 1 (enable graphic displaying).

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example |// enable graphic displaying
Spi T6963C Graphics (1) ;

Spi_T6963C_Text

Prototype void Spi T6963C Text (char n);

Returns | Nothing.

Description | Enable/disable text displaying.
Parameters :

- n: text enable/disable Il)arameter. Valid values: 0 (disable text
dispaying) and 1 (enable text displaying).

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example // enable text displaying
Spi T6963C Text (1);
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Spi_T6963C_Cursor

Prototype void Spi T6963C Cursor (char n);

Returns | Nothing.

Description | Set cursor on/off.

Parameters :

- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set
cursor onf.

Requires | Toshiba GLCD module needs to be initialized. See
Spi_T6963C_Config routine.

Example // enable text displaying
Spi T6963C Text (1);

Spi_T6963C_Cursor_Blink

Prototype void Spi T6963C Cursor Blink(char n);

Returns | Nothing.

Description | Enable/disable cursor blinking.
Parameters :

- n: cursor blinking enable/disable parameter. Valid values: 0
(disable cursor blinking) and 1 (enable cursor blinking).

Requires | Toshiba GLCD module needs to be initialized. See
Spi_ T6963C Config routine.

Example |// enable cursor blinking
Spi T6963C Cursor Blink(1l);

Library Example

The following drawing demo tests advanced routines of the Spi T6963C GLCD
library. Hardware configurations in this example are made for the T6963C
240x128 display, Easy8051B board and AT89S8253.
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#include "Spi T6963C.h"

/*

* bitmap pictures stored in ROM

*/

extern const code char mc[] ;
extern const code char einstein[] ;

// Port Expander module connections
sbit SPExpanderRST at P1.BO;

sbit SPExpanderCS at P1.B1l;

// End Port Expander module connections

void main () {
char idata txtl[] = " EINSTEIN WOULD HAVE LIKED mC";
char idata txt[] = " GLCD LIBRARY DEMO, WELCOME !";
unsigned char panel ; // current panel
unsigned int i // general purpose register
unsigned char curs ; // cursor visibility
unsigned int cposx, cposy ; // cursor x-y position
PO = 255; // Configure PORT0 as input
/*
* init display for 240 pixel width and 128 pixel height
* 8 bits character width
* data bus on MCP23S17 portB
* control bus on MCP23S17 portA
* bit 2 is !WR
* bit 1 is !RD
* bit 0 is !CD
* bit 4 is RST
*
*

chip enable, reverse on, 8x8 font internaly set in library

*/

// Initialize SPI module
Spi_Init Advanced (MASTER OSC DIV4 | CLK IDLE LOW | IDLE 2 ACTIVE
DATA ORDER_MSB) ;
// Initialize SPI Toshiba 240x128
Spi T6963C Config(240, 128, 8, 0, 2, 1, 0, 4) ;
Delay ms (1000) ;
/*
* Enable both graphics and text display at the same time
*/
Spi T6963C graphics(l) ;
Spi T6963C text(l) ;
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panel = 0 ;
i=207;
curs = 0 ;
cposx = cposy = 0 ;
J*
* Text messages
*/

Spi T6963C write text(txt, 0, 0, Spi T6963C_ROM MODE XOR) ;
Spi T6963C write text(txtl, 0, 15, Spi T6963C ROM MODE XOR) ;

J*
* Cursor
*/
Spi T6963C _cursor height(8) ; // 8 pixel height
Spi T6963C_set cursor (0, 0) ; // move cursor to top left
Spi T6963C_cursor(0) ; // cursor off

J*
* Draw rectangles
*/
Spi T6963C rectangle(0, 0, 239, 127, Spi T6963C WHITE) ;
Spi T6963C rectangle (20, 20, 219, 107, Spi T6963C WHITE) ;
Spi T6963C rectangle (40, 40, 199, 87, Spi T6963C WHITE) ;
Spi T6963C rectangle (60, 60, 179, 67, Spi T6963C WHITE) ;

J*
* Draw a Cross
*/
Spi T6963C line(0, 0, 239, 127, Spi T6963C WHITE) ;
Spi T6963C line(0, 127, 239, 0, Spi T6963C WHITE) ;

J*
* Draw solid boxes
*/

Spi T6963C box (0, 0, 239, 8, Spi T6963C WHITE) ;

Spi T6963C box (0, 119, 239, 127, Spi T6963C WHITE) ;

J*
* Draw circles
*/
Spi T6963C circle (120, 64, 10, Spi T6963C WHITE)
Spi T6963C circle (120, 64, 30, Spi T6963C WHITE)
Spi T6963C _circle (120, 64, 50, Spi T6963C WHITE) ;
Spi T6963C circle (120, 64, 70, Spi T6963C WHITE)
Spi T6963C circle (120, 64, 90, Spi T6963C WHITE)
Spi T6963C circle (120, 64, 110, Spi T6963C WHITE) ;
Spi T6963C circle (120, 64, 130, Spi T6963C WHITE) ;
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Spi T6963C sprite(76, 4, einstein, 88, 119) ; // Draw a sprite

Spi T6963C_setGrPanel (1) ; // Select other graphic panel

Spi T6963C image (mc) ; // Fill the graphic screen with a picture

for(;;) { // Endless loop
%

* If PO 0 is pressed, toggle the display between graphic
panel 0 and graphic 1
*/
if (!PO_0) {
panel++ ;
panel &= 1 ;
Spi T6963C displayGrPanel (panel) ;
Delay ms (300) ;
}

Vs
* If PO 1 is pressed, display only graphic panel
*/
else if (!PO 1) {
Spi T6963C graphics(1l) ;
Spi T6963C_text (0) ;
Delay ms (300) ;
}

Vs
* If PO 2 is pressed, display only text panel
*/
else if (!PO _2) {
Spi T6963C _graphics(0) ;
Spi T6963C text(l) ;
Delay ms (300) ;
}

Vs
* If PO 3 is pressed, display text and graphic panels
*/
else if (!PO 3) {
Spi T6963C graphics(1l) ;
Spi T6963C text(l) ;
Delay ms (300) ;
}
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/*
* If PO 4 is pressed, change cursor
*/
else if (!P0_4) {
curs++
if(curs == 3) curs = 0 ;
switch (curs) {
case 0:

// no cursor
Spi T6963C cursor(0) ;
break ;
case 1:
// blinking cursor
Spi T6963C cursor(l) ;
Spi T6963C cursor blink(1l) ;
break ;
case 2:
// non blinking cursor
Spi T6963C cursor(l) ;
Spi T6963C cursor blink(0) ;
break ;
}
Delay ms (300) ;
}

/*
* Move cursor, even 1f not visible
*/

cposx++ ;

if (cposx == Spi T6963C_ txtCols) {
cposx = 0 ;
cposy++ ;
if (cposy == Spi T6963C grHeight /

Spi7T69 63C_CHARACTER HEIGHT) {
cposy = 0 ;
}

}
Spi T6963C_set cursor (cposx, cposy) ;

Delay ms (100) ;
}
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HW Connection
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T6963C GRAPHIC LCD LIBRARY

The mikroC for 8051 provides a library for working with GLCDs based on TOSHI-
BA T6963C controller. The Toshiba T6963C is a very popular LCD controller for
the use in small graphics modules. It is capable of controlling displays with a reso-
lution up to 240x128. Because of its low power and small outline it is most suitable
for mobile applications such as PDAs, MP3 players or mobile measurement equip-
ment. Although small, this contoller has a capability of displaying and merging text
and graphics and it manages all the interfacing signals to the displays Row and
Column drivers.

For creating a custom set of GLCD images use GLCD Bitmap Editor Tool.
Note: ChipEnable(CE), FontSelect(FS) and Reverse(MD) have to be set to appro-
priate levels by the user outside of the T6963c 1nit function. See the Library

Example code at the bottom of this page.

Note: Some mikroElektronika's adapter boards have pinout different from T6369C
datasheets. Appropriate relations between these labels are given in the table below:

Adapter Board T6369C datasheet
RS C/D
R/W /RD
E /WR
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External dependencies of T6963C Graphic LCD Library

The following variables
must be defined in all
projects using T6963C
Graphic LCD library:

Description : Example :

extern unsigned char unsigned char sfr
sfr 76963C dataport; | 10963C Data Port. T6963C_dataPort at PO;

extern unsigned char unsigned char sfr
sfr T6963C ctriport; | 10903C Control Port. | oese”  Dpore at p1;

sbit
T6963C ctrlwr at P1.B2;

extern sbit

T6963C ctrlwr; Write signal.

sbit
T6963C ctrlrd at P1.B1;

extern sbit

T6963C ctrlrd; Read signal.

sbit
T6963C ctrlcd at P1.BO;

extern sbit

T6963C ctrlcd; Command/Data signal.

extern sbit sbit
T6963C_ctrlrst; Reset&gnaL Ef9§j?ictrlrst at
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Library Routines

- T6963C Init

- T6963C_WriteData
- T6963C_WriteCommand
- T6963C_SetPtr

- T6963C_WaitReady
- T6963C Fill

- T6963C Dot

- T6963C_Write Char
- T6963C_Write Text
- T6963C_Line

- T6963C_Rectangle

- T6963C_Box

- T6963C Circle

- T6963C Image

- T6963C_Sprite

- T6963C_Set Cursor

Note: The following low level library routines are implemented as macros. These
macros can be found in the T6963c.h header file which is located in the T6963C
example projects folders.

- T6963C_ClearBit

- T6963C_SetBit

- T6963C_NegBit

- T6963C_DisplayGrPanel
- T6963C_DisplayTxtPanel
- T6963C_SetGrPanel

- T6963C_SetTxtPanel

- T6963C_PanelFill

- T6963C_GrFill

- T6963C_TxtFill

- T6963C_Cursor_Height
- T6963C_Graphics

- T6963C Text

- T6963C_Cursor

- T6963C_Cursor_Blink
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T6963C_Init

Prototype void T6963C Init(unsigned int width, unsigned char
height, unsigned char fntW);

Returns | Nothing.

Description | Initalizes the Graphic Lcd controller.
Parameters :

- width: width of the GLCD panel
- height: height of the GLCD panel
- fntw: font width

Display RAM organization:
The library cuts the RAM into panels : a complete panel is one
graphics panel followed by a text panel (see schematic below).

schematic:

GRAPHICS PANEL #0
PANEL O

TEXT PANEL #0

GRAPHICS PANEL #1
PANEL 1

TEXT PANEL #2

Requires | Global variables :

T6963C dataport : Data Port

T6963C ctrlport : Control Port

T6963C ctrlwr : write signal pin

- T6963C ctrlrd :read signal pin

T6963C ctrlcd : command/data signal pin
T6963C ctrlrst :reset signal pin

must be defined before using this function.

Example |// T6963CGLCD pinout definition

unsigned char sfr T6963C dataPort at PO;

// pointer to DATA BUS port

unsigned char sfr T6963C ctrlPort at PIL;

// pointer to CONTROL port

sbit T6963C ctrlwr at P1.B2; // WR write signal
sbit T6963C ctrlrd at P1.Bl; // RD read signal
sbit T6963C ctrlcd at P1.BO;

// CD command/data signal

sbit T6963C ctrlrst at P1.B4; // RST reset signal

// init display for 240 pixel width, 128 pixel height
and 8 bits character width
T6963C_init (240, 128, 8) ;
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T6963C_WriteData

Prototype |void T6963C_WriteData (unsigned char mydata);
Returns | Nothing.
Description | Writes data to T6963C controller.
Parameters :
- mydata: data to be written
Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.
Examp]e T6963C WriteData (AddrL);
T6963C_WriteCommand
Prototype |void T6963C_WriteCommand (unsigned char mydata);
Returns | Nothing.
Description | Writes command to T6963C controller.
Parameters :
- mydata: command to be written
Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.
Example T69 63C7WriteCommand (T6963C CURSOR POINTER SET) ;
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T6963C_SetPtr

Prototype void T6963C SetPtr (unsigned int p, unsigned char c);
Returns | Nothing.
Description | Sets the memory pointer p for command c.

Parameters :
- p: address where command should be written
- c¢: command to be written

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.

Example T6963C SetPtr (T6963C grHomeAddr + start,

T6963C ADDRESS POINTER SET);

T6963C_WaitReady

Prototype void T6963C7WaitReady (void) ;
Returns | Nothing.
Description | Pools the status byte, and loops until Toshiba GLCD module is
ready.
Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.
Example T6963C WaitReady ()
T6963C_Fill
Prototype void T6963C Fill (unsigned char v, unsigned int start,
unsigned int len);
Returns | Nothing.
Description | Fills controller memory block with given byte.
Parameters :
- v: byte to be written
- start: starting address of the memory block
- len: length of the memory block in bytes
Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.
Example |76963C Fill(0x33,0x008%, 0x000%) ;
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T6963C_Dot
Prototype void T6963C Dot (int x, int y, unsigned char color);
Returns | Nothing.
Description | Draws a dot in the current graphic panel of GLCD at coordinates
(X, ).
Parameters :
- x: dot position on x-axis
- v: dot position on y-axis
- color: color parameter. Valid values: T6963C_BLACK and
T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example T6963C Dot (x0, y0, pcolor);

T6963C_Write_Char

Prototype void T6963C Write Char (unsigned char c, unsigned char
%, unsigned char y, unsigned char mode);

Returns | Nothing.

Description | Writes a char in the current text panel of GLCD at coordinates (x,

y).
Parameters :

- c: char to be written

- x: char position on x-axis

- y: char position on y-axis

- mode: mode parameter. Valid values:

T6963C_ ROM_MODE OR, T6963C ROM MODE XOR,

T6963C_ROM_MODE AND and T6963C_ ROM_MODE TEXT

Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed
and the data is logically “OR-ed”. This is the most common way
of combining text and graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are com
bined via the logical “exclusive OR”. This can be useful to dis
play tgxt in the negative mode, i.e. white text on black back
ground.

- AND-Mode: The text and graphic data shown on display are
combined via the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just
a text. The Text Attribute values are stored in the graphic area of
display memory.

For more details see the T6963C datasheet.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.
Example T6963C Write Char('A',22,23,AND);
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T6963C_Write_Text

Prototype void T6963C Write Text (unsigned char *str, unsigned
char x, unsigned char y, unsigned char mode) ;

Returns | Nothing.

Description V\)/rites text in the current text panel of GLCD at coordinates (X,
y).

Parameters :

- str: text to be written

- x: text position on x-axis

- y: text position on y-axis

- mode: mode parameter. Valid values:

T6963C_ ROM_MODE OR, T6963C ROM MODE XOR,
T6963C_ROM_MODE_AND and T6963C_ ROM_MODE TEXT

Mode parameter explanation:

- OR Mode: In the OR-Mode, text and graphics can be displayed
and the data is logically “OR-ed”. This is the most common way
of combining text and graphics for example labels on buttons.

- XOR-Mode: In this mode, the text and graphics data are com
bined via the logical “exclusive OR”. This can be useful to dis
play tgxt in the negative mode, i.e. white text on black back

round.

- %ND-Mode: The text and graphic data shown on display are
combined via the logical “AND function”.

- TEXT-Mode: This option is only available when displaying just
a text. The Text Attrl%ute values are stored in the graphic area of
display memory.

For more details see the T6963C datasheet.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C_Init routine.

Example |T6963C_Write Text (" GLCD LIBRARY DEMO, WELCOME !", 0,
0, T6963C ROM MODE XOR) ;

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 415



CHAPTER 6
Libraries mikroC for 8051

T6963C_Line

Prototype void T6963C Line(int x0, int yO0, int x1, int y1,
unsigned char pcolor);

Returns | Nothing.

Description | Draws a line from (x0, y0) to (x1, y1).
Parameters :

- x0: x coordinate of the line start

- v0: y coordinate of the line end

- x1: x coordinate of the line start

- y1:y coordinate of the line end

- pcolor: color parameter. Valid values: T6963C BLACK and
T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.

Example T6963C Line(0, 0, 239, 127, T6963C WHITE);

T6963C_Rectangle

Prototype void T6963C Rectangle(int x0, int y0, int x1, int yI,
unsigned char pcolor);

Returns | Nothing.

Description | Draws a rectangle on GLCD.
Parameters :

- x0: x coordinate of the upper left rectangle corner

- y0: y coordinate of the upper left rectangle corner

- x1: x coordinate of the lower right rectangle corner

- y1: y coordinate of the lower right rectangle corner

- pcolor: color parameter. Valid values: T6963C_ BLACK and
T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.

Example T6963C Rectangle (20, 20, 219, 107, T6963C WHITE);
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T6963C_Box

Prototype void T6963C Box(int x0, int y0, int x1, int yl,
unsigned char pcolor);

Returns | Nothing.

Description | Draws a box on GLCD
Parameters :

- x0: x coordinate of the upper left box corner

- v0: y coordinate of the upper left box corner

- x1: x coordinate of the lower right box corner

- y1:y coordinate of the lower right box corner

- pcolor: color parameter. Valid values: T6963C BLACK and
T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C_Init routine.

Example |T6963C Box (0, 119, 239, 127, T6963C WHITE);

T6963C_Circle

Prototype void T6963C Circle(int x, int y, long r, unsigned
char pcolor);

Returns | Nothing.

Description | Draws a circle on GLCD.
Parameters :

- x: X coordinate of the circle center

- y: y coordinate of the circle center

- r: radius size

- pcolor: color parameter. Valid values: T6963C_ BLACK and
T6963C_WHITE

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example |T6963C Circle (120, 64, 110, T6963C WHITE);
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T6963C_Image

Prototype void T6963C Image (const code char *pic);

Returns | Nothing.

Description | Displays bitmap on GLCD.
Parameters :

- pic: image to be displayed. Bitmap array can be located in both
code and RAM memory (due to the mikroC for 8051 pointer to
const and pointer to RAM equivalency).

Use the mikroC’s integrated GLCD Bitmap Editor (menu option
Tools » GLCD Bitmap Editor) to convert image to a constant
array suitable for displaying on GLCD.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example T6963C Image (mc);

T6963C_Sprite

Prototype void T6963C Sprite (unsigned char px, unsigned char py,
const code char *pic, unsigned char sx, unsigned
char sy);

Returns | Nothing.

Description | Fills graphic rectangle area (px, py) to (px+sx, py+sy) with cus-
tom size picture.

Parameters :

- px: x coordinate of the upper left picture corner. Valid values:
multiples of the font width

- py: y coordinate of the upper left picture corner

- pic: picture to be displayed

- sx: picture width. Valid values: multiples of the font width

- sy: picture height

Note: If px and sx parameters are not multiples of the font width
they will be scaled to the nearest lower number that is a multiple
of the font width.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example |T6963C Sprite(76, 4, einstein, 88, 119); // draw a
sprite
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T6963C_Set_Cursor

Prototype void T6963C Set Cursor (unsigned char x, unsigned char
y) 7

Returns | Nothing.

Description | Sets cursor to row x and column y.
Parameters :

- x: cursor position row number
- y: cursor position column number

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example T6963C Set Cursor (cposx, cposy);

T6963C_ClearBit

Prototype void T6963C ClearBit (char b);

Returns | Nothing.

Description | Clears control port bit(s).
Parameters :

- b: bit mask. The function will clear bit x on control port if bit x
in bit mask is set to 1.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example |// clear bits 0 and 1 on control port
T6963C ClearBit (0x03);
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T6963C_SetBit

Prototype void T6963C SetBit (char b);

Returns | Nothing.

Description | Sets control port bit(s).
Parameters :

- b: bit mask. The function will set bit = on control port if bit = in
bit mask is set to 1.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.

Example // set bits 0 and 1 on control port
T6963C SetBit (0x03);

T6963C_NegBit

Prototype void T6963C7Nquit (char b);

Returns | Nothing.

Description | Negates control port bit(s).
Parameters :

- b: bit mask. The function will negate bit < on control port
if bit = in bit mask is set to 1.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.

Example // negate bits 0 and 1 on control port
T6963C NegBit (0x03);
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T6963C_DisplayGrPanel

Prototype void T6963C DisplayGrPanel (char n);

Returns | Nothing.

Description | Display selected graphic panel.
Parameters :

- n: graphic panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example // display graphic panel 1
T6963C DisplayGrPanel (1) ;

T6963C_DisplayTxtPanel

Prototype void T6963C DisplayTxtPanel (char n);

Returns | Nothing.

Description | Display selected text panel.
Parameters :

- n: graphic panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example // display text panel 1
T6963C DisplayTxtPanel (1) ;

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD 421



CHAPTER 6
Libraries mikroC for 8051

T6963C_SetGrPanel

Prototype void T6963C SetGrPanel (char n);

Returns | Nothing.

Description | Compute start address for selected graphic panel and set a}[v ropri-
ate internal pointers. All subse?uent graphic operations will be

preformed at this graphic panel.

Parameters :

- n: graphic panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example // set graphic panel 1 as current graphic panel.
T6963C SetGrPanel(1l);

T6963C_SetTxtPanel

Prototype void T6963C_SethtPanel (char n);

Returns | Nothing.

Description | Compute start address for selected text panel and set appropriate
internal pointers. All subsequent text operations will be preformed
at this text panel.

Parameters :

- n: text panel number. Valid values: 0 and 1.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Examp]e // set text panel 1 as current text panel.
T6963C SetTxtPanel (1) ;
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T6963C_PanelFill

Prototype void T6963C PanelFill (unsigned char v);

Returns | Nothing.

Description Filllcurgent panel in full (graphic+text) with appropriate value (0
to clear).

Parameters :

- v: value to fill panel with.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example clear current panel
T6963C PanelFill (0);

T6963C_GrFill

Prototype void T6963C GrFill (unsigned char v);

Returns | Nothing.

Description | Fill current graphic panel with appropriate value (0 to clear).
Parameters :

- v: value to fill graphic panel with.

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example // clear current graphic panel
T6963C_GrFill (0);
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T6963C_TxtFill

Prototype

void T6963C TxtFill (unsigned char v);

Returns

Nothing.

Description

Fill current text panel with appropriate value (0 to clear).

Parameters :

- v: this value increased by 32 will be used to fill text panel.

Requires

Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.

Example

// clear current text panel
T6963C TxtFill (0);

T6963C_Cursor_Height

Prototype

void T6963C Cursor Height (unsigned char n);

Returns

Nothing.

Description

Set cursor size.
Parameters :

- n: cursor height. Valid values: 0. . 7.

Requires

Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example

T6963C Cursor Height (7);
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T6963C_Graphics

Prototype void T6963C Graphics(char n);

Returns | Nothing.

Description | Enable/disable graphic displaying.
Parameters :

- n: on/off parameter. Valid values: 0 (disable graphic dispaying)
and 1 (enable graphic displaying

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C Init routine.

Example // enable graphic displaying
T6963C Graphics(1l);

T6963C_Text

Prototype void T6963C_Text (char n);

Returns | Nothing.

Description | Enable/disable text displaying.
Parameters :

- n: on/off parameter. Valid values: 0 (disable text dispaying) and
1 (enable text displaying).

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example // enable text displaying
T6963C Text (1);
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T6963C_Cursor

Prototype |void T6963C_Cursor (char n);

Returns | Nothing.

Description | Set cursor on/off.
Parameters :

- n: on/off parameter. Valid values: 0 (set cursor off) and 1 (set
cursor on).

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example // set cursor on
T6963C Cursor (1l);

T6963C_Cursor_Blink

Prototype void T6963C Cursor Blink(char n);

Returns | Nothing.

Description | Enable/disable cursor blinking.
Parameters :

- n: on/off parameter. Valid values: 0 (disable cursor blinking)
and 1 (enable cursor blinking).

Requires | Toshiba GLCD module needs to be initialized. See the
T6963C _Init routine.

Example // enable cursor blinking
T6963C Cursor Blink(1l);

Library Example

The following drawing demo tests advanced routines of the T6963C GLCD library.
Hardware configurations in this example are made for the T6963C 240x128 display,
Easy8051B board and AT89S8253.
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#include "T6963C.h"

// T6963C module connections

unsigned char sfr T6963C dataPort at PO;
// Pointer to DATA BUS port

unsigned char sfr T6963C ctrlPort at Pl;
// Pointer to CONTROL port

sbit T6963C ctrlwr at P1.B2; // WR
sbit T6963C ctrlrd at P1.Bl; // RD
sbit T6963C ctrlcd at P1.BO; // CD

write signal
read signal
command/data signal

sbit T6963C ctrlrst at P1.B4; // RST reset signal

// End T6963C module connections

/*
* bitmap pictures stored in ROM
*/

const code char mc[] ;

const code char einstein[] ;

void main () {

char idata txtl[] = " EINSTEIN WOULD HAVE LIKED mC";
char idata txt[] = " GLCD LIBRARY DEMO, WELCOME !'";
unsigned char panel ; // Current panel
unsigned int iy // General purpose register
unsigned char curs ; // Cursor visibility
unsigned int cposx, cposy ; // Cursor x-y position
Pl = 0; // Clear T6963C ports
PO = 0;
/*

* init display for 240 pixel width and 128 pixel height

* 8 bits character width

* data bus on PO

* control bus on PI1

* bit 2 is !WR

* bit 1 is !RD

* bit 0 is C!D

* bit 4 is RST

*/

// Initialize T6369C
T6963C init (240, 128, 8) ;

/*

* Enable both graphics and text display at the same time

*/
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T6963C graphics(l) ;
T6963C text (1) ;

panel = 0 ;
i =20 ;
curs = 0 ;
cposx = cposy = 0 ;
/*
* Text messages
*/

T6963C write text(txt, 0, 0, T6963C_ROM MODE XOR) ;
T6963C write text(txtl, 0, 15, T6963C_ROM MODE XOR) ;

J*
* Cursor
*/
T6963C cursor height (8) ; // 8 pixel height
T6963C_set cursor (0, 0) ; // Move cursor to top left
T6963C_cursor (0) ; // Cursor off
/*
* Draw rectangles
*/

T6963C _rectangle
T6963C _rectangle
T6963C _rectangle
T6963C _rectangle

J*
* Draw a Ccross
*/
T6963C line (0, 0, 239, 127, T6963C WHITE) ;
T6963C line (0, 127, 239, 0, T6963C WHITE) ;

0, 0, 239, 127, T6963C WHITE) ;

20, 20, 219, 107, T6963C WHITE) ;
40, 40, 199, 87, T6963C WHITE) ;
60, 60, 179, 67, T6963C WHITE) ;

J*
* Draw solid boxes
*/
T6963C box (0, 0, 239, 8, T6963C WHITE) ;
T6963C box (0, 119, 239, 127, T6963C WHITE) ;

/*
* Draw circles
*/
T6963C circle (120, 64, 10, T6963C _WHITE)
T6963C circle (120, 64, 30, T6963C _WHITE)
T6963C circle (120, 64, 50, T6963C WHITE) ;
T6963C circle (120, 64, 70, T6963C_WHITE)
T6963C circle (120, 64, 90, T6963C _WHITE)
T6963C circle (120, 64, 110, T6963C WHITE) ;
T6963C circle (120, 64, 130, T6963C WHITE) ;
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T6963C sprite(76, 4, einstein, 88, 119) ; // Draw a sprite
T6963C_setGrPanel (1) // Select other graphic panel

T6963C sprite(0, 0, mc, 240, 128) ;
// Fill the graphic screen with a picture

T6963C image (mc) ;

for(;;) { // Endless loop
Va3
* If P2 0 is pressed, toggle the display between graphic
panel 0 and graphic 1
*/
if (!'p2 0) {
panel++ ;
panel &= 1 ;
T6963C displayGrPanel (panel) ;
Delay ms (300) ;
}

Vas
* If P2 1 1is pressed, display only graphic panel
*/
else if (!P2 1) {
T6963C graphics (1) ;
T6963C text (0) ;
Delay ms (300) ;
}

Va3
* If P2 2 1s pressed, display only text panel
*/
else if (!P2 2) {
T6963C graphics (0) ;
T6963C text(l) -
Delay ms (300) ;
}

Va3
* If P2 3 1s pressed, display text and graphic panels
*/
else if (!P2 3) {
T6963C graphics (1) ;
T6963C text(l) ;
Delay ms (300) ;
}
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/*
* If P2 4 is pressed, change cursor
*/
else if (!P2 4) {
curs++ ;
if (curs == 3b) curs = 0 ;
switch (curs) {
case 0:

// no cursor
T6963C cursor (0) ;
break ;
case 1:
// blinking cursor
T6963C cursor (1) ;
T6963C cursor blink(l) ;
break ;
case 2:
// non blinking cursor
T6963C cursor (1) ;
T6963C cursor blink(0) ;
break ;
}
Delay ms (300) ;
}

J*
* Move cursor, even 1f not visible
*/
cposx++ ;
if (cposx == T6963C_ txtCols) {
cposx = 0 ;
cposy++ ;
if (cposy == T6963C grHeight / T6963C CHARACTER HEIGHT) {

cposy = 0 ;
}
}

T6963C set cursor (cposx, cposy) ;

Delay ms (100) ;
}
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HW Connection
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UART LIBRARY

The UART hardware module is available with a number of 8051 compliant MCUs.
The mikroC for 8051 UART Library provides comfortable work with the
Asynchronous (full duplex) mode.

Library Routines
- Uart_Init
- Uart Data Ready
- Uart_Read
- Uart_Write

Uart_Init

Prototype void Uart Init (unsigned long baud rate);

Returns | Nothing.

Description | Configures and initializes the UART module.

The internal UART module module is set to:

- 8-bit data, no parity

- 1 STOP bit

- disabled automatic address recognition

- timer] as baudrate source (mod2 = autoreload 8bit timer)
Parameters :

- baud rate: requested baud rate

Refer to the device data sheet for baud rates allowed for specific
Fosc.

Requires | MCU with the UART module and TIMERI to be used as baudrate
source.

Example // Initialize hardware UART and establish communica-
tion at 2400 bps
Uart Init (2400);
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Uart_Data_Ready

Prounype char Uart Data Ready();

Returns | - 1 if data is ready for reading
- 0 if there is no data in the receive register

Description | The function tests if data in receive buffer is ready for reading.

Requires | MCU with the UART module.

The UART module must be initialized before using this routine.
See the Uart_Init routine.

Exanqﬂe char receive;

// read data if ready
if (Uart Data Ready ()
receive = Uart Read();

Uart_Read

Prototype char Uart Read();

Returns | Received byte.

Description | The function receives a byte via UART. Use the Uart Data Ready
function to test if data is ready first.

Requires | MCU with the UART module.

The UART module must be initialized before using this routine.
See Uart Init routine.

Example char receive;

// read data 1if ready
if (Uart Data Ready ()
receive = Uart Read();
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Uart_Write

Prototype void Uart Write (char TxData);

Returns | Nothing.

Description | The function transmits a byte via the UART module.
Parameters :

- TxData: data to be sent

Requires | MCU with the UART module.

The UART module must be initialized before using this routine.
See Uart_Init routine.

Exanuﬂe char data = 0x1E;

Uart Write(data);

Library Example

This example demonstrates simple data exchange via UART. If MCU is connected
to the PC, you can test the example from the mikroC for 8051 USART Terminal.

char uart rd;

void main () {

Uart init (4800); // Initialize UART module at 4800 bps
Delay ms (100); // Wait for UART module to stabilize
while (1) { // Endless loop

if (Uart Data Ready()) {
// Check 1if UART module has received data
uart rd = Uart Read(); // Read data
Uart Write(uart rd); // Send the same data back
}
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ANSI C CTYPE LIBRARY

The mikroC for 8051 provides a set of standard ANSI C library functions for test-
ing and mapping characters.

Note: Not all of the standard functions have been included.

Note: The functions have been mostly implemented according to the ANSI C stan-
dard, but certain functions have been modified in order to facilitate 8051 program-
ming. Be sure to skim through the description before using standard C functions.

Library Functions

- isalnum
- isalpha
- iscntrl

- isdigit

- isgraph
- islower
- ispunct
- isspace
- isupper
- isxdigit
- toupper
- tolower

isalnum

Prototype unsigned short isalnum(char character);

Description | Function returns 1 if the character is alphanumeric (A-Z, a-z, 0-
9), otherwise returns zero.

isalpha

Prototype unsigned short isalpha (char character);

Description | Function returns 1 if the character is alphabetic (A-Z, a-z), oth-
erwise returns zero.
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iscntrl
Prototype unsigned short iscntrl (char character);
Description | Function returns 1 if the character is a control or delete charac-
ter(decimal 0-31 and 127), otherwise returns zero.
isdigit
Prototype unsigned short isdigit (char character);
Description | Function returns 1 if the character is a digit (0-9), otherwise
returns zero.
isgraph
Prototype unsigned short isgraph (char character);
Description | Function returns 1 if the character is a printable, excluding the
space (decimal 32), otherwise returns zero.
islower
Prototype int islower (char character);
Description | Function returns 1 if the character is a lowercase letter (a-z),
otherwise returns zero.
ispunct
Prototype unsigned short ispunct (char character);
Description | Function returns 1 if the character is a punctuation (decimal 32-
47, 58-63, 91-96, 123-126), otherwise returns zero.
isspace
Prototype unsigned short isspace (char character);
Description | Function returns 1 if the character is a white space (space, tab,

CR, HT, VT, NL, FF), otherwise returns zero.
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isupper
Prototype unsigned short isupper (char character);
Description | Function returns 1 if the character is an uppercase letter (A-Z),
otherwise returns zero.
isxdigit
Prototype unsigned short isxdigit (char character);
Description | Function returns 1 if the character is a hex digit (0-9, A-F, a-f),
otherwise returns zero.
toupper
Prototype unsigned short toupper (char character);
Description | If the character is a lowercase letter (a-z), the function returns
an uppercase letter. Otherwise, the function returns an unchanged
Input parameter.
tolower
Prototype unsigned short tolower (char character);
Description | If the character is an uppercase letter (A-Z), function returns a

lowercase letter. Otherwise, function returns an unchanged input
parameter.
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ANSI C MATH LIBRARY

The mikroC for 8051 provides a set of standard ANSI C library functions for float-
ing point math handling.

Note: Not all of the standard functions have been included.

Note: The functions have been mostly implemented according to the ANSI C stan-
dard, but certain functions have been modified in order to facilitate 8051 program-
ming. Be sure to skim through the description before using standard C functions.

Library Functions

- acos
- asin
- atan
- atan2
- ceil

- cos

- cosh
- eval_poly
- exp

- fabs
- floor
- frexp
- 1dexp
- log

- logl0
- modf
- pow
- sin

- sinh
- sqrt

- tan

- tanh
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acos
Prototype double acos (double x);
Description | Function returns the arc cosine of parameter x; that is, the value
whose cosine is x. The input parameter = must be between -1 and
1 (inclusive). The return value is in radians, between 0 and 0
(inclusive).
asin
Prototype double asin (double x);
Description | Function returns the arc sine of parameter x; that is, the value
whose sine is x. The input parameter x must be between -1 and 1
(inclusive). The return value is in radians, between -0/2 and 6/2
(inclusive).
atan
Prototype double atan (double f£);
Description | Function computes the arc tangent of parameter f; that is, the
value whose tangent is ©. The return value is in radians, between
-0/2 and 9/2 (inclusive).
atan2
Prototype double atanZ(double y, double x);
Description | This is the two-argument arc tangent function. It is similar to
computing the arc tangent of y/x, except that the signs of both
arguments are used to determine the quadrant of the result and x
is permitted to be zero. The return value is in radians, between -0
and 0 (inclusive).
ceil
Prototype double ceil (double x);
Description | Function returns value of parameter x rounded up to the next

whole number.
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cos
Prototype double cos (double f);

Description | Function returns the cosine of f in radians. The return value is

from -1 to 1.
cosh
Prototype double cosh (double x);

Description | Function returns the hyperbolic cosine of x, defined mathemati-
cally as (e*+=7%) /2. If the value of x is too large (if overflow
occurs), the function fails.

eval_poly
Prototype static double eval poly(double x, const double code *
d, int n);

Description | Function Calculates polynom for number x, with coefficients
stored in o[ 1, for degree n.

exp
Prototype double exp (double x);

Description | Function returns the value of e — the base of natural logarithms

— raised to the power = (i.e. ¢¥).
fabs
Prototype double fabs (double d);

Description | Function returns the absolute (i.e. positive) value of d.

floor
Prototype double floor (double x);

Description | Function returns the value of parameter x rounded down to the

nearest integer.
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frexp
Prototype double frexp(double value, int *eptr);

Description | Function splits a ﬂoatin%—foint value into a normalized fraction
and an 1nte§ral power of 2. The return value is the normalized
fraction and the integer exponent is stored in the object pointed to
by eptr.

Idexp
Prototype double ldexp (double value, int newexp);

Description | Function returns the result of multiplying the floating-point num-
ber num by 2 raised to the power n (i.e. returns = * 27).

log
Prototype double log(double x);
Description | Function returns the natural logarithm of x (i.e. 10g,_ (x)).
log10
Prototype double 1lo0gl0 (double x);
Description  Function returns the base-10 logarithm of = (i.e. 109 (x)).
modf
Prototype double modf (double val, double * iptr);

Description | Returns argument va1 split to the fractional part (function return
val) and integer part (in number iptr).

pow
Prototype double pow (double x, double y);

Description | Function returns the value of x raised to the power v (i.e. x). If x
is negative, the function will automatically cast v into unsigned
long.
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sin

Prototype double sin(double f);

Description | Function returns the sine of f in radians. The return value is from -
1to 1.

sinh

Prototype double sinh (double x);

Description | Function returns the hyperbolic sine of =, defined mathematically
as (e*-e %) /2, If the value of x is too large (if overflow occurs),
the function fails.

sqrt

Prototype double sqgrt (double x);

Description | Function returns the non negative square root of x.

tan

Prototype double tan(double x);

Description | Function returns the tangent of x in radians. The return value
spans the allowed range of floating point in the mikroC for 8051.

tanh

Prototype double tanh (double x);

Description | Function returns the hyperbolic tangent of x, defined mathemati-
cally as sinh (x) /cosh (x) .
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ANSI C STDLIB LIBRARY

The mikroC for 8051 provides a set of standard ANSI C library functions of gener-
al utility.

Note: Not all of the standard functions have been included.

Note: Functions have been mostly implemented according to the ANSI C standard,
but certain functions have been modified in order to facilitate 8051 programming.
Be sure to skim through the description before using standard C functions.

Library Functions

- abs

- atof
- atoi
- atol
- div

- Idiv
- uldiv
- labs
- max
- min
- rand
- srand
- xtoi

abs

Prototype |int abs(int a);

Description | Function returns the absolute (i.e. positive) value of =.
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atof
Prototype double atof (char *s)

Description | Function converts the input string s into a double precision value
and returns the value. Input string s should conform to the floating
point literal format, with an optional whitespace at the beginning.
The string will be processed one character at a time, until the
function reaches a character which it doesn’t recognize (including
a null character).

atoi
Prototype int atoi(char *s);

Description | Function converts the input string s into an integer value and
returns the value. The input string s should consist exclusively of
decimal digits, with an (_)Ftlonal whitespace and a sign at the
beginning. The string will be processed one character at a time,
until the function reaches a character which it doesn’t recognize
(including a null character).

atol
Prototype long atol (char *s)

Description | Function converts the input string s into a long integer value and
returns the value. The input string s should consist exclusively of
decimal digits, with an QFtlonal whitespace and a sign at the
beginning. The string will be processed one character at a time,
until the function reaches a character which it doesn’t recognize
(including a null character).

div
Prototype div_t div(int number, int denom);

Description | Function computes the result of division of the numerator number
by the denominator denom; the function returns a structure of type
div_t comprising quotient (quot) and remainder (rem), see Div
Structures.
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Idiv
Prototype ldiv_t 1ldiv(long number, long denom);
Description | Function is similar to the div function, except that the arguments
and result structure members all have type 1ong.
Function computes the result of division of the numerator number
by the denominator denom; the function returns a structure of type
1div_ t comprising quotient (quot) and remainder (ren), see Div
Structures.
uldiv
Prototype uldiv_t uldiv (unsigned long number, unsigned long
denom) ;
Description | Function is similar to the div function, except that the arguments
and result structure members all have type unsigned long.
Function computes the result of division of the numerator number
by the denominator denom; the function returns a structure of type
uldiv t comprising quotient (quot) and remainder (rem), see Div
Structures.
labs
Prototype long labs (long x);
Description | Function returns the absolute (i.e. positive) value of long integer
X.
max
Prototype int max(int a, int b);
Description | Function returns greater of the two integers, = and b.
min
Prototype int min(int a, int b);
Description | Function returns lower of the two integers, = and b.
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rand

Prototype |int rand();

Description | Function returns a sequence of pseudo-random numbers between
0 and 32767. The function will always produce the same sequence
of numbers unless srand is called to seed the start point.

srand

Prototype void srand(unsigned x);

Description | Function uses x as a starting point for a new sequence of pseudo-
random numbers to be returned by subsequent calls to rand. No
values are returned by this function.

xtoi

Prototype unsigned xtoi (register char *s);

Description | Function converts the input string s consisting of hexadecimal
digits into an integer value. The input parameter s should consist
exclusively of hexadecimal digits, with an optional whitespace
and a sign at the beginning. The string will be processed one char-
acter at a time, unti%the function reaches a character which it
doesn’t recognize (including a null character).

Div Structures

typedef struct divstruct {
int quot;
int rem;
}odiv_t;

typedef struct ldivstruct {
long quot;
long rem;
}o1ldiv_t;

typedef struct uldivstruct {
unsigned long quot;
unsigned long rem;
} uldiv_t;
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ANSI C STRING LIBRARY

The mikroC for 8051 provides a set of standard ANSI C library functions useful for
manipulating strings and RAM memory.

Note: Not all of the standard functions have been included.

Note: Functions have been mostly implemented according to the ANSI C standard,
but certain functions have been modified in order to facilitate 8051 programming.
Be sure to skim through the description before using standard C functions.

Library Functions

- memchr
- mememp
- memcpy
- memmove
- memset
- strcat

- strchr

- stremp

- strepy

- strlen

- strncat

- strncpy

- strspn

- strncmp
- strstr

- strespn

- strpbrk

- strrchr

memchr
Prototype void *memchr (void *p, char n, unsigned int v);

Description | Function locates the first occurrence of 1 in the initial v bytes of
memory area starting at the address p. The function returns the
pointer to this location or 0 if the n was not found.

For parameter p you can use either a numerical value (literal/vari-
able/constant) 1ndlcat1n% memory address or a dereferenced value
of an object, for example smystring or sP0.
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memcmp
Prototype int memcmp (void *sl, wvoid *s2, int n);

Description | Function comdpares the first n characters of objects pointed to by
s1 and s2 and returns zero if the objects are equal, or returns a
difference between the first differing characters (in a left-to-right
evaluation). Accordingly, the result is greater than zero if the
object pointed to by s1 1is greater than the object pointed to by =2
and vice versa.

memcpy
Prototype void *memcpy (void *dl, wvoid *sl, int n);

Description | Function copies n characters from the object pointed to by s2 into
the object pointed to by 1. If copying takes place between
objects that overlap, the behavior 1s undefined. The function
returns address of the object pointed to by d1.

memmove
Prototype void *memmove (void *to, void *from, register int n);

Description | Function copies n characters from the object pointed to by from
into the object pointed to by o. Unlike memcpy, the memory
areas to and from may overlap. The function returns address of
the object pointed to by to.

memset
Prototype void *memmove (void *to, wvoid *from, register int n);

Description | Function copies the value of the character into each of the first n
characters of the object pointed by v1. The function returns
address of the object pointed to by p1.

strcat
Prototype char *strcat (char *to, char *from);
Description | Function appends a copy of the string £rom to the string to, over-

writing the null character at the end of +o. Then, a terminating
null character is added to the result. If copying takes place
between objects that overlap, the behavior is undefined. +o string
must have enough space to store the result. The function returns
address of the object pointed to by to.
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strchr
Prototype char *strchr(char *ptr, char chr);

Description | Function locates the first occurrence of character chr in the string
ptr. The function returns a pointer to the first occurrence of char-
acter chr, or a null pointer if chr does not occur in ptr. The ter-
minating null character is considered to be a part of the string.

strcmp
Prototype int strcmp(char *sl, char *s2);

Description | Function compares strings =1 and <2 and returns zero if the
strings are equal, or returns a difference between the first differing
characters (in a left-to-right evaluation). Accordingly, the result is
greater than zero if s1 is greater than s2 and vice versa.

strcpy
Prototype char *strcpy(char *to, char *from);

Description | Function copies the string £rom into the string to. If copying is
successful, the function returns to. If copying takes place between
objects that overlap, the behavior is undetined.

strlen
Prototype int strlen(char *s);

Description | Function returns the length of the string s (the terminating null
character does not count against string’s length).

strncat
Prototype char *strncat(char *to, char *from, int size);

Description | Function appends not more than size characters from the string
from to to. The initial character of from overwrites the null char-
acter at the end of to. The terminating null character is always
appended to the result. The function returns to.
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strncpy

Prototype char *strncpy(char *to, char *from, int size);

Description | Function copies not more than s:ze characters from string from
to to. If copying takes place between objects that overlap, the
behavior is undefined. If £rom is shorter than size characters,
then o will be padded out with null characters to make up the
difference. The function returns the resulting string to.

strspn

Prototype int strspn(char *strl, char *str2);

Description | Function returns the length of the maximum initial segment of
str1 which consists entirely of characters from st 2. The termi-
nating null character at the end of the string is not compared.

Strncmp

Prototype int strncmp(char *sl, char *s2, char len);

Description | Function lexicographically compares not more than 1en characters
(characters that follow the null character are not compared) from
the string pointed by s1 to the string pointed by s2. The function
returns a value indicating the s1 and s2 relationship:

Value Meaning

< 0 sl "less than" s2
=0 sl "equal to" s2

> 0 sl "greater than" s2

Strstr

Prototype char *strstr(char *sl, char *s2);

Description | Function locates the first occurrence of the string =2 in the string
s1 (excluding the terminating null character).

The function returns pointer to first occurrence of =2 in s1; if no
string was found, function returns 0. If s2 is a null string, the
function returns 0.
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Strcspn

Prototype char *strcspn(char * sl, char *s2);

Description | Function locates the first occurrence of the string s2 in the string
s1 (excluding the terminating null character).

The function returns pointer to first occurrence of s2 in s1; if no
string was found, function returns 0. If s2 is a null string, the
function returns 0.

Strpbrk

Prototype char *strpbrk(char * sl, char *s2);

Description | Function searches <1 for the first occurrence of any character
from the string s2. The terminating null character 1s not included
in the search. The function returns pointer to the matching charac-
ter in s1. If s1 contains no characters from s2, the function
returns 0.

Strrchr

Prototype char *strrchr(char * ptr, unsigned int chr);

Description | Function searches the string ptr for the last occurrence of charac-
ter chr. The null character terminating pt  is not included in the
search. The function returns pointer to the last chr found in ptr;
if no matching character was found, function returns o.
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BUTTON LIBRARY

The Button library contains miscellaneous routines useful for a project develop-
ment.

External dependecies of Button Library

The following vari-
able must be defined
in all projects using
Button library:

Description: Example :

Declares Button Pin,
which will be used by | sbit Button Pin at PO _0;
Button Library.

extern sbit
Button Pin;

Library Routines

- Button
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Button

Prototype unsigned short Button (unsigned short time, unsigned
short active state)

Returns | - 255 if the pin was in the active state for given period.
- 0 otherwise

Description | The function eliminates the influence of contact flickering upon

pressing a button (debouncing). The Button pin is tested just after
the function call and then again after the debouncing period has
expired. If the pin was in the active state in both cases then the
function returns 255 (true).

Parameters :
- time: debouncing period in milliseconds

- active state: determines what is considered as active state.
Valid values: 0 (logical zero) and 1 (logical one)

Requires |Rutton pin variable must be defined before using this function.

Button pin must be configured as input.

Example |P2 is inverted on every P0.B0 one-to-zero transition :

// Button connections

sbit Button Pin at PO0.BO;

// Declare Button Pin. It will be used by Button
Library. B

// End Button connections

bit oldstate; // 0ld state flag
void main () {
PO = 255; // Configure PORT0 as input
P2 = OxAA; // Initial PORT2 value
do {
if (Button(l, 1)) // Detect logical one
oldstate = 1; // Update flag

if (oldstate && Button(l, 0)) {
// Detect one-to-zero transition

P2 = ~P2; // Invert PORT2
oldstate = 0; // Update flag
}

} while (1) ; // Endless loop

VA
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CONVERSIONS LIBRARY

The mikroC for 8051 Conversions Library provides routines for numerals to strings
and BCD/decimal conversions.

Library Routines

You can get text representation of numerical value by passing it to one of the fol-
lowing routines:

- ByteToStr

- ShortToStr

- WordToStr

- IntToStr

- LongToStr

- LongWordToStr
- FloatToStr

The following functions convert decimal values to BCD and vice versa:
- Dec2Bcd

- Becd2Decl6
- Dec2Bcd16

ByteToStr

Prototype void ByteToStr (unsigned short input, char *output);

Returns | Nothing.

Description | Converts input byte to a string. The output string has fixed width
of 4 characters including null character at the end (string termina-
tion). The output string 1s right justified and remaining positions
on the left (if any) are filled with blanks.

Parameters :

- input: byte to be converted
- output: destination string

Requires | Destination string should be at least 4 characters in length.

Example unsigned short t = 24;
char txt[ 4] ;

ByteToStr (t, txt); // txt is " 24" (one blank here)
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ShortToStr
Prototype void ShortToStr (short input, char *output);
Returns | Nothing.

Description | Converts input signed short number to a string. The output string
has fixed width of 5 characters including null character at the end
(string termination). The output string is right justified and
remaining positions on the left (if any) are filled with blanks.
Parameters :

- input: signed short number to be converted
- output: destination string
Requires | Destination string should be at least 5 characters in length.
Example short t = -24;
char txt[ 5] ;
éﬁértToStr(t, txt); // txt is " -24" (one blank
here)
WordToStr
Prototype void WordToStr (unsigned input, char *output);
Returns | Nothing.

Description | Converts input word to a string. The output string has fixed width
of 6 characters including null character at the end (string termina-
tion). The output string 1s right justified and the remaining posi-
tions on the left (if any) are filled with blanks.

Parameters :

- input: word to be converted

- output: destination string
Requires | Destination string should be at least 5 characters in length.
Example unsigned t = 437;

char txt[ 6] ;

Y/.\Ic.>£dToStr(t, txt); // txt is " 437" (two blanks

here)
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IntToStr

Prototype void IntToStr (int input, char *output);

Returns | Nothing.

Description | Converts input signed integer number to a string. The output
string has ﬁg)(ed width of 7 characters including null character at
the end (string termination). The output string is right justified
}?)Illcll‘{(he remaining positions on the left (if any) are filled with
anks.

Parameters :

- input: signed integer number to be converted
- output: destination string

Requires | Destination string should be at least 7 characters in length.

Example int j = -4220;
char txt[ 7];
IntToStr(j, txt); // txt is " -4220" (one blank
here)

LongToStr

Prototype void LongToStr (long input, char *output);

Returns | Nothing.

Description | Converts input signed long integer number to a string. The output
string has ﬁI;(ed width of 12 characters including nul%character at
the end (string termination). The output string is right justified
}?)Illcll‘{(he remaining positions on the left (if any) are filled with
anks.

Parameters :

- input: signed long integer number to be converted
- output: destination string

Requires | Destination string should be at least 12 characters in length.

Example | long jj -3700000;
char txt[ 12];

LongToStr(jj, txt);
// txt is " -3700000" (three blanks here)
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LongWordToStr

Prototype |void LongWordToStr (unsigned long input, char *output);

Returns | Nothing.
Converts input unsigned long integer number to a string. The out-
put string has fixed width of 11 characters including null character
at the end (string termination). The output string is I‘l%ht justified
and the remaining positions on the left (if any) are filled with

Description blanks.

Parameters :
- input: unsigned long integer number to be converted
- output: destination string

Requires | Destination string should be at least 11 characters in length.
unsigned long jj = 3700000;
char txt[ 11];

Example | ...
LongToStr(jj, txt);
// txt is " 3700000" (three blanks here)

FloatToStr

Prounype EZii??ed char FloatToStr (float fnum, unsigned char
- 3 if input number is NaN

Returns |~ 2 if input number is -INF
- 1 if input number is +INF
- 0 if conversion was successful
Converts a floating point number to a string.
Parameters :
- fnun: floating point number to be converted

Description str: destination string

The output string is left justified and null terminated after the last
digit.
Note: Given floating point number will be truncated to 7 most
significant digits before conversion.

Requires | Destination string should be at least 14 characters in length.
float ffl = -374.2;
float ff2 = 123.456789;
float f£f3 = 0.000001234;

Example char txt[ 15] ;

FloatToStr (f£f1, txt)

;. // txt is "-374.2"
FloatToStr (ff2, txt):; // txt 1is "123.4567"
FloatToStr (f£3, txt); // txt 1is "1.234e-6"
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Dec2Bcd

Prototype unsigned short Dec2Bcd (unsigned short decnum);

Returns | Converted BCD value.

Description | Converts input unsigned short integer number to its appropriate
BCD representation.

Parameters :

- decnum: unsigned short integer number to be converted

Requires | Nothing.

Example unsigned short a, b;

22;
Dec2Bcd (a) ; // b equals 34

a
b

Bcd2Dec16

Prototype unsigned Bcd2Declé6 (unsigned bcdnum) ;

Returns | Converted decimal value.

Description | Converts 16-bit BCD numeral to its decimal equivalent.
Parameters :

- bednum: 16-bit BCD numeral to be converted

Requires | Nothing.

Example unsigned a, b;
a
b

0x1234; // a equals 4660
Bcd2Decl6 (a) ; // b equals 1234
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Dec2Bcd16

Prototype unsigned Dec2Bcdl6 (unsigned decnum) ;

Returns | Converted BCD value.

Description | Converts unsigned 16-bit decimal value to its BCD equivalent.
Parameters :

- decnum unsigned 16-bit decimal number to be converted

Requires | Nothing.

Example unsigned a, b;

2345;
Dec2Bcdlé6 (a) ; // b equals 9029

a
b
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SPRINT LIBRARY

The mikroC for 8051 provides the standard ANSI C Sprintf function for easy data
formatting.

Note: In addition to ANSI C standard, the Sprint Library also includes two limited

versions of the sprintf function (sprinti and sprintl). These functions take less ROM
and RAM and may be more convenient for use in some cases.

Functions
- sprintf
- sprintl

- sprinti

sprintf

Prototype sprintf (char *wh, const char *f,...);

Returns | The function returns the number of characters actually written to
destination string.

Description |sprint is used to format data and print them into destination
string.

Parameters :

- wh: destination string
- f: format string

The f argument is a format string and may be composed of char-
acters, escape sequences, and format specifications. Ordinary
characters and escape sequences are copied to the destination
string in the order in which they are interpreted. Format specifica-
tions always begin with a percent sign (%) and require additional
arguments to be included in the function call.

The format string is read from left to right. The first format speci-
fication encountered refers to the first argument after f and then
converts and outputs it using the format specification. The second
format specification accesses the second argument after f, and so
on. If there are more arguments than format specifications, then
these extra arguments are ignored. Results are unpredictable if
there are not enough arguments for the format specifications. The
format specifications have the following format:
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Description % [ flags] [ width] [ .precision] [{ 1 | L }] conver-—
sion type

Each field in the format specification can be a single character or
a number which specifies a particular format option. The conver-
sion_type field is where a single character specifies that the argu-
ment is interpreted as a character, string, number, or pointer, as
shown in the following table:

conversion type Argument Output Format
Type
d int Signed decimal number
u unsigned int Unsigned decimal number
o unsigned int | Unsigned octal number
Unsigned hexadecimal
X unsigned int number using
0123456789abcdef
Unsigned hexadecimal
X unsigned int | number using
0123456789ABCEDF
Floating-point number
£ double using the format

[-]dddd.dddd

Floating-point number
e double using the format
[-]d.dddde[-]dd

Floating-point number
E double using the format
[-]d.ddddE[-]dd
Floating-point number
using either e or f format,
g double whichever is more
compact for the specified
value and precision

int 1s converted to

unsigned char, and the

resulting character is
written

c int
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Description

String with a terminating

h *
: char null character

Pointer value, the X for-

o) void * .
mat is used

A % is written. No argu-
ment is converted. The
complete conversion spec-
ification shall be =< .

<none>

The f1ags field is where a single character is used to justify the
output and to print +/- signs and blanks, decimal points, and octal
and hexadecimal prefixes, as shown in the following table.

flags Meaning

Left justify the output in the specified field
width.

Prefix the output value with + or - sign if the out-
put is a signed type.

Prefix the output value with a blank if it is a
space (' ') | signed positive value. Otherwise, no blank is pre-
fixed

Prefixes a non-zero output value with 0, 0x, or
0x when used with o, =, and x field types,
respectively. When used withe, =, £, g, and G

' field types, the # flag forces the output value to
include a decimal point. The # flag is ignored in
all other cases.

* Ignore format specifier.

The widtn field is a non-negative number that specifies the mini-
mum number of printed characters. If a number of characters in
the output value 1s less than width, then blanks are added on the
left or right (when the - flag is specified) to pad to the minimum
width. It width is prefixed with 0, then zeros are padded instead
of blanks. The width field never truncates a field. If a length of
the output value exceeds the specified width, all characters are
output.

Thep precision field is a non-negative number that specifies a
number of characters to print, number of significant digits or
number of decimal places. The precision field can cause trunca-
tion or rounding of the output value in the case of a floating-point
number as specified in the following table.

MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD

463



CHAPTER 6
Libraries mikroC for 8051

Description
flags Meaning of the precision field

The precision field is where you specify a mini-
mum number of digits that will be included in
the output value. Digits are not truncated if the
d, u, o, %, | number of digits in the argument exceeds that

X defined in the precision field. If a number of dig-
its in the argument is less than the precision
field, the output value is padded on the left with
Zeros.

The precision field is where you specify a num-
£ ber of digits to the right of the decimal point.
The last digit is rounded.

The precision field is where you specify a num-
e,E ber of digits to the right of the decimal point.
The last digit is rounded.

The precision field is where you specify a maxi-
g mum number of significant digits in the output
value.

The precision field has no effect on these field
types.
The precision field is where you specify a maxi-

s mum number of characters in the output value.
Excess characters are not output.

The optional characters 1 or L may immediately precede conver-
sion type to respectively specify long versions of the integer
types d, i, u, o, x, and x.

You must ensure that the argument type matches that of the for-
mat specification. You can use type casts to ensure that the proper
type is passed to sprintf.
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sprintl

Prototype sprintl (char *wh, const char *f,...);

Returns | The function returns the number of characters actually written to
destination string.

Description | The same as sprintf, except it doesn't support float-type numbers.

sprinti

Prototype sprinti (char *wh, const char *f,...);

Returns | The function returns the number of characters actually written to
destination string.

Description | The same as sprintf, except it doesn't support long integers and
float-type numbers.

Library Example

This is a demonstration of the standard C library sprintf routine usage. Three differ-
ent representations of the same floating poing number obtained by using the sprintf
routine are sent via UART.

double ww = -1.2587538e+1;
char buffer[ 15];

// Function for sending string to UART
void UartWriteText (char *txt) {
while (* txt)
Uart Write (*txt++);
t

// Function for sending const string to UART
void UartWriteConstText (const char *txt) {
while (* txt)
Uart Write (*txt++);

void main (){

Uart Init (4800); // Initialize UART module at 4800 bps
Delay ms (10);

UartWriteConstText ("Floating point number representation");
// Write message on UART
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sprintf (buffer, "%$12e", ww); // Format ww and store
it to buffer
UartWriteConstText ("\r\ne format:"); // Write message on UART
UartWriteText (buffer); // Write buffer on UART
sprintf (buffer, "$12f", ww); // Format ww and store it
to buffer
UartWriteConstText ("\r\nf format:"); // Write message on UART
UartWriteText (buffer); // Write buffer on UART
sprintf (buffer, "%$12g", ww); // Format ww and store it
to buffer

UartWriteConstText ("\r\ng format:"); // Write message on UART
UartWriteText (buffer); // Write buffer on UART

466 MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



mikroC for 8051

CHAPTER 6
Libraries

TIME LIBRARY

The Time Library contains functions and type definitions for time calculations in the
UNIX time format which counts the number of seconds since the "epoch". This is
very convenient for programs that work with time intervals: the difference between

two UNIX time values is a real-time difference measured in seconds.

What is the epoch?

Originally it was defined as the beginning of 1970 GMT. ( January 1, 1970 Julian
day ) GMT, Greenwich Mean Time, is a traditional term for the time zone in

England.

The TimeStruct type is a structure type suitable for time and date storage. Type dec-
laration is contained in timelib.h which can be found in the mikroC for 8051 Time

Library Demo example folder.

Library Routines

- Time_dateToEpoch
- Time_epochToDate

Time_dateToEpoch

Prototype

long Time dateToEpoch (TimeStruct *ts);

Returns

Number of seconds since January 1, 1970 OhOOmnO00s.

Description

This function returns the unix time : number of seconds since
January 1, 1970 OhOOmn00s.

Parameters :

- ts: time and date value for calculating unix time.

Requires

Nothing.

Example

#include "timelib.h"

TimeStruct tsl;

long epoch ;

/*
* what is the epoch of the date in ts ?
*/

epoch = Time dateToEpoch (&tsl)
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Time_epochToDate

Prototype void Time epochToDate (long e, TimeStruct *ts);

Returns | Nothing.

Description | Converts the unix time to time and date.
Parameters :

- e: unix time (seconds since unix epoch) _
- ts: time and date structure for storing conversion output

Requires | Nothing.

Exanuﬂe #include "timelib.h"
TimeStruct ts2;
long epoch ;
Z
* what date is epoch 1234567890 ?
*/

epoch = 1234567890 ;
TimegepochToDate(epoch, &ts2) ;
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Library Example

This example demonstrates Time Library usage.

#include

TimeStruct tsl,
long epoch
long diff

’

void main ()

tsl.
tsl.
tsl.
tsl
tsl
tsl.

/)(—

* What is the epoch of the date in ts

*/

epoc

/)(—

* What date is epoch 1234567890

*/

epoc

/)(—

* How much seconds between this two dates

*/
diff

Ss
mn
hh

.md
.mo

Yy

h

h

Time dateToEpoch (&tsl)

1234567890
Time epochToDate (epoch,

’

"timelib.h"

ts2

’

Time dateDiff (&tsl,
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TRIGONOMETRY LIBRARY

The mikroC for 8051 implements fundamental trigonometry functions. These func-
tions are implemented as look-up tables. Trigonometry functions are implemented
in integer format in order to save memory.

Library Routines

- sinE3
- cosE3

sinE3

Prototype int sinE3 (unsigned angle deg);

Returns | The function returns the sine of input parameter.

Description | The function calculates sine multiplied by 1000 and rounded to
the nearest integer:

result = round(sin(angle deg)*1000)
Parameters :
- angle deg: input angle in degrees

Note: Return value range: -1000..1000.

Requires | Nothing.

Example |int res;

res = sinE3(45); // result is 707
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cosE3

Prototype int cosE3(unsigned angle_degq);

Returns | The function returns the cosine of input parameter.

Description | The function calculates cosine multiplied by 1000 and rounded to
the nearest integer:

result = round(cos (angle deg)*1000)
Parameters :
- angle deg: input angle in degrees

Note: Return value range: -1000..1000.

Requires | Nothing.

Example |int res;

res = cosE3(196); // result is -193
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Contact us: |—

If you are experiencing problems with any of our products or you just want addi-
tional information, please let us know.

Technical Support for the compiler

If you are experiencing any trouble with mikroC for 8051, please do not hesitate
to contact us - it is in our mutual interest to solve these issues.

Discount for schools and universities

mikroElektronika offers a special discount for educational institutions. If you
would like to purchase mikroBasic for purely educational purposes, please con-
tact us.

Problems with transport or delivery

If you want to report a delay in delivery or any other problem concerning distri-
bution of our products, please use the link given below.

Would you like to become mikroElektronika's distributor?

We in mikroElektronika are looking forward to new partnerships. If you would
like to help us by becoming distributor of our products, please let us know.

Other

If you have any other question, comment or a business proposal, please contact
us:

mikroElektronika
Visegradska 1A
11000 Belgrade
EUROPE

Phone: + 381 (11) 36 28 830
Fax: + 381 (11) 36 28 831
E-mail: office@mikroe.com
Support: support@mikroe.com
Web:  www.mikroe.com
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